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Welcome to
NetObjects Fusion 0

NetObjects Fusion™ 3.0 is the essential tool for building dynamic Web sites. You 

can use NetObjects Fusion to create and maintain an entire site whether or not you 

know HTML. NetObjects Fusion’s Everywhere HTML™ eliminates the problems 

and confusion caused by browser differences. Because NetObjects Fusion generates 

HTML pages based on page layout and publish settings you control, you can build 

your site once and publish it everywhere.

In NetObjects Fusion’s open site environment you can work the way you want to. 

You can design pages using NetObjects Fusion’s position-based editor, its text-based 

editor, an external HTML editor, or a combination of all three. Powerful message-

based animation and interactive authoring features included in NetObjects Fusion 

make it easy for you to create sophisticated effects. You’ll also find it easy to add 

scripts, JavaTM applets and servlets, ShockwaveTM Flash, Headspace® RMF, ActiveX™ 

controls, and more.
About This User Guide
This book explains how to build a Web site using NetObjects Fusion. In addition to 

the basics of designing with text and graphics, creating links, and so on, you’ll find 

chapters that elaborate on special topics, including data publishing and using Net 

Objects Fusion components (pre-built mini-applications that add functionality to 

your site).

Before you begin your projects, refer to the NetObjects Fusion 3.0 Installation and 

Quick Start card and work through the lessons in NetObjects Fusion 3.0 Getting 

Started. This is the most efficient way to learn NetObjects Fusion. If you are already 

familiar with an earlier version of NetObjects Fusion, read Chapter 10, “Upgrading 
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From a Previous Version of NetObjects Fusion,” in NetObjects Fusion 3.0 Getting 

Started.

The manuals and online help assume you are proficient with Windows® 95 or 

Windows NT™. If you need help using these systems, consult their respective user 

guides.

This guide also assumes you are familiar with the World Wide Web and its 

terminology. For general advice about the web and examples of how to use 

NetObjects Fusion, visit the NetObjects™ Web site, www.netobjects.com. 

For readability, this manual presents all file names, path names, file extensions, 

HTML tags, and URLs in boldface. Example names that you should replace with 

your own appear in bold italic. 
Getting Help
NetObjects Fusion offers several options for getting online help: 

● Select Help Topics from the Help menu to launch the help system and display the 
table of contents.

● Right-click an object in any NetObjects Fusion window or a control in a dialog or 
palette, then select What’s This? from the shortcut menu.

● Click the question mark icon in the title bar of a dialog or palette, then click the 
item you want to learn about.

● Highlight a menu command, then press F1.

● Select NetObjects Web Site from the Help menu to open your browser and 
display the NetObjects Home page, which contains links to information about 
NetObjects Fusion. You must be connected to the Internet for this to work.
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C H A P T E R  1
NetObjects Fusion Basics 1

NetObjects Fusion 3.0 incorporates new technologies with the current browser 

environment to help you meet today’s site building challenges. Using NetObjects 

Fusion you’ll find it easy to build dynamic, content-rich sites that use the latest 

interactive technologies, including CSS Positioning and Dynamic HTML. And you 

don’t need to build multiple versions of your site; you can depend on NetObjects 

Fusion’s Everywhere HTML to generate HTML that works on all browsers.

This chapter provides an introduction to NetObjects Fusion, including:

● Basic concepts

● NetObjects Fusion window

● NetObjects Fusion views

● Navigating in NetObjects Fusion

● Choosing colors

● Setting preferences

● NetObjects Fusion folder structure
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Introducing NetObjects Fusion 3.0
NetObjects Fusion is a fully integrated, visual Web site builder. It provides an open 

environment that lets you work in your own way with a variety of tools. Using 

NetObjects Fusion you can design and publish visually enticing, dynamic content 

using the latest interactive technologies.
Work in an Open Environment
NetObjects Fusion provides an open site-building environment. You can use a 

variety of other tools for specialized purposes and then return to NetObjects Fusion 

to integrate the content into one cohesive site. Think of NetObjects Fusion as the 

control center where you create and manage all of the site’s resources.

Depending on your preference, you can lay out pages in graphical mode, text mode, 

or using an HTML editor. In graphical mode, you can place objects anywhere on the 

page and see exactly how they will look when you publish the site. In text mode, you 

can work on a page as if you were working in a word processor. You draw a text box 

and then use it to contain graphics, Java applets and servlets, components, and 

other objects, as well as text. This design method keeps your HTML code lean. For 

more information about graphical and text layout options, see Chapter 7, “Laying 

Out the Page.” 

If you want more control over HTML, you can use your favorite HTML editor for 

all or part of a page, for as many pages as you want. For more information, see 

Chapter 19, “Referencing and Editing External HTML.”
Generate HTML That Works Everywhere
A major challenge when building sites today is overcoming browser disparity 

problems. If you use the wrong site-building tool, you can waste time and energy 

building and maintaining several versions of a site, each one targeting a different 

browser. When you use NetObjects Fusion 3.0 these problems disappear. You can 

depend on the NetObjects Fusion 3.0 HTML generation capability to provide 

Everywhere HTML. Whether you’re designing for a 2.0 browser or for the latest 

DHTML-capable browser, NetObjects Fusion 3.0 generates HTML that works. For 
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information about the publishing options available in NetObjects Fusion 3.0, see 

Chapter 5, “Planning Your Site.”
Add Dynamic Content
NetObjects Fusion 3.0 makes it easy for you to add dynamic content to your site 

whether you want simple object animation or custom JavaScript™ actions.

You can have objects fly across the screen as the result of a site visitor’s action. Or 

you can launch a sequence of animations at any given time. You can also reduce 

your visitors’ download time by having text, graphics, or other objects appear as 

needed.

NetObjects Fusion 3.0 contains powerful message-based animation and interactive 

authoring capabilities that you can use to achieve these effects. For complete 

information, see Chapter 21, “Building Dynamic Pages.”
NetObjects Fusion Views
NetObjects Fusion provides five views that correspond to the tasks you complete 

when you design and build a Web site. Changes you make in one view are reflected 

in the other views. You can go to any view at any time by clicking one of the view 

buttons on the control bar at the top of the NetObjects Fusion window.

● Start with Site view to create the hierarchical structure of a new site or to import 
an existing site. You can see a structure map of your site, which is a graphical view 
that shows how the pages relate to each other, or an outline view that is similar to 
the Windows Explorer. You can quickly rearrange your site by dragging and 
dropping pages and sections. For complete information about working in Site 
view, see Chapter 2, “Creating and Managing Sites.”

● Use Page view to design pages and add content. In Page view you see the 
MasterBorder and Layout area of each page. The MasterBorder contains objects 
that repeat on a set of pages, much as headers and footers appear in a word 
processing document. The Layout area displays objects that are unique to that 
page. 

In Page view you can use the Undo command on the Edit menu repeatedly to 

step back through a series of changes.
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Note: If you try to use Undo and nothing happens, click in the Layout 
area or MasterBorder and then select Undo again.

For information about working in Page view, see Chapter 4, “Page View Basics.”

● A SiteStyle consists of a variety of elements, including navigation buttons, 
banners, lines, and text color. In Style view, you can create your own SiteStyle, or 
choose from more than 50 pre-built SiteStyles™ to give your entire site a 
consistent look and feel. For information about working with SiteStyles, see 
Chapter 12, “Using SiteStyles.”

● Assets include the files, links, data objects, and variables that you reference in 
your site. Assets view gives you centralized control over all these referenced 
entities. When you change an asset, NetObjects Fusion updates every reference to 
that asset throughout the site. For example, if your company’s logo changes, you 
just replace the old logo file with the new one in Assets view and NetObjects 
Fusion automatically updates every page that displays the logo. For information 
about working in Assets view, see Chapter 25, “Managing Assets.”

● When you are ready to publish the completed site, go to Publish view to 
configure your file transfer settings, generate the HTML for your site, and 
transfer your site to a local or remote server. For information about working in 
Publish view, see Chapter 26, “Publishing Your Site.”
Using the New Button
To create a new page in Site or Page view, click the New button on the control bar. In 

Style view, you use this button to create a new SiteStyle; in Assets view, to create a 

new file, link, data object, or variable; and in Publish view to create a new folder.
NetObjects Fusion Window
When you start NetObjects Fusion and create a new site, you see a window 

containing a Home page icon, a Standard toolbar docked at the left side of the 

screen, and a properties palette. 
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The title bar, menu bar, and control bar are at the top of the application window. 

The title bar shows name of the current site.

Title bar

Menu bar

Properties

Standard toolbar

Control bar
About the Properties Palette
When you click an object in Site or Page view, the properties palette changes to 

display the properties available for that object. Properties appear on tabs that also 

might change when the selected object changes. For example, when you select a text 

box in Page view, the Text Properties palette includes Text Box and Actions tabs. 

When you double-click in the text box to edit the text, the Format tab is added to 

the display.

You might not always be aware of making a selection, but in NetObjects Fusion, 

something is always selected. For example, when you switch from Site view to Page 

view, the Layout Properties palette appears. You might not immediately see 

evidence that the Layout is selected, but it is indicated on the properties palette. To 

check what is selected at any time, look at the properties palette.
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To shrink the properties palette to display just its title bar, click the minimize 

button; click the button again to restore the full display. To completely hide the 

properties palette, click its close box. To show the palette again, from the View 

menu, select Palettes, Properties Palette. A check mark on the menu indicates that 

the palette is displayed.
About Toolbars
When you first open NetObjects Fusion, the Standard toolbar is docked at the left 

side of the Site view window. Additional toolbars are available in Page view. 

You can move a toolbar by positioning the pointer over the double line at its top and 

dragging it anywhere in the window. To dock the toolbar again, double-click its title 

bar or drag it to the left side or top of the window.

A small triangle in the lower right corner of a tool button indicates that the tool is 

one of a group. To see the entire group, point to the tool and hold down the left 

mouse button. A flyout containing the other tools in the group appears. As you 

move the pointer over each tool, a ToolTip identifies the tool group and the name of 

the specific tool.

To select a tool from a flyout, position the pointer over the tool and release the 

mouse button. The tool you select is displayed on the toolbar. For example, if you 

point to the Draw tool on the Page view Standard toolbar and hold down the left 

mouse button, you can select the Rectangle, Rounded Rectangle, Ellipse, or Polygon 

tool.

In Page view, after you use a selected tool to create an object on the page, the Select 

tool automatically becomes active. If you want to use a tool repeatedly to add several 

objects, you can double-click it to keep it active.

To hide and show toolbars, from the View menu choose Toolbars, Name of toolbar. 

A check mark on the menu indicates that a toolbar is displayed.
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Previewing Your Site
As you build your site, to see how it will appear in the browser of your choice, click 

the Preview button on the control bar. NetObjects Fusion generates HTML from 

your pages and displays your site in the browser specified in the Preferences dialog. 

In the Preferences dialog you can also choose to preview the whole site or just the 

page you are working on. For information, see “Setting Preferences” on page 1-12.

Although previewing creates folders and files on your disk, they do not comprise a 

working site. Certain information critical to a published site—for example, relative 

paths to assets—are not included in preview files. By not including this 

information, previewing displays your site quickly. When you’re satisfied with your 

preview, go on to publish your site as described in Chapter 26, “Publishing Your 

Site.”
Navigating in NetObjects Fusion
NetObjects Fusion offers several navigation tools, including the Go menu and 

buttons on the control bar.

You use the buttons on the left side of the control bar to move between views. For an 

introduction to the NetObjects Fusion views, see “NetObjects Fusion Views” on 

page 1-3.
Finding an Object
Use the Go To button on the control bar to find any named object in NetObjects 

Fusion. Click the Go To button, enter the name, or partial name, of the object you 

want to locate in the Go To dialog, and click OK. If only one object meets your 

criteria, NetObjects Fusion opens the appropriate view or dialog to display the 

object. If several objects meet your criteria, NetObjects Fusion displays a list you can 

pick from. 
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Switching Between Views
To return to the previous view, click the Last button on the control bar. Click the 

button again to redisplay the current page or view. Use this button to quickly switch 

back and forth between the current and last view or page.

Using the Go Menu
The Go menu provides all the navigation features in one place and shows equivalent 

keyboard shortcuts. A dot to the left of a command indicates your current view. 

The Go menu commands vary slightly from view to view. 

● From all views you can go to any other view. From Site view and Assets view you 
can also navigate to the subviews; from Page view you can go to other pages. 

● Use the Go To command the same way you use the Go to button on the control 
bar to find any named NetObjects Fusion object in your site. 

● Use the Last command to go to the last page or view you were working on. 

● Use the Recent command to select from a list of the views and pages you 
displayed during the current NetObjects Fusion session. 

● Use the Preview command to launch your browser and display a preview of your 
site.

Keyboard navigation 
shortcuts
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Using Shortcut Menus
NetObjects Fusion provides shortcut menus you open by right-clicking an item in 

Site, Page, and Publish views. The menu lists commands you can use on the item 

you clicked. In all views, and in dialogs and properties palettes, you can right-click 

an item and select What’s This? from the menu to display context-sensitive help for 

the item.

Shortcut menu for a 
text box in Page view 
Choosing Colors
In NetObjects Fusion, whenever the properties palette includes a Color button, you 

can change the color of the selected object. For example, you can change the color of 

the page icons or the background in Site view, objects in Page view, or link text color 

in Style view.

To choose a color for a selected object:

1. Click the Color button in any properties palette where it is offered or 
double-click a text style element in Style view.
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The Color Picker appears.

The name of the current palette is shown above the color display. The 
last eight colors you selected from the palette are displayed in the Recent 
Colors boxes.

2. Click the color you want to assign to the object.

The Original and New boxes show the original color and the color you 
just selected. The RGB and HTML hexadecimal values are also 
displayed.

If you are not using the Browser Safe Palette, you might see a warning 
that the selected color is not Web safe. To avoid unexpected results for 
your site visitors, it is best to choose colors that are Web safe.

3. Click OK.

The new color appears in the selected object.
Using Color Palettes
When you choose colors for the objects in your site, you select from the palette 

offered in the Color Picker. You can use the Browser Safe Palette, which contains 

colors that are Web safe, the palette used by Windows, a palette you import from 

another application such as Adobe Photoshop, or a custom palette you create.
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Choosing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2.Select a palette from the drop-down list at the top of the dialog. If you 
choose Custom Palette and want to load an existing custom palette, see 
“Loading a Custom Color Palette.” If you want to create your own 
custom palette, see “Creating or Editing a Color Palette.”

The palette is displayed in the Color Picker until you change it.

3. Click OK.
Loading a Custom Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears with a blank palette.

2. Select Custom Palette from the drop-down list at the top of the dialog.

3. Click Load.

4. In the Open dialog, navigate to the palette you want to use, then click 
Open.

This palette is displayed in the Color Picker until you change it.

5. Click OK to close the Color Picker.
Creating or Editing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears with a blank palette.

2. Select Custom Palette from the drop-down list at the top of the dialog.

3. Click a blank box in the palette area.

4. Set the RGB values for the color you want to add to the palette or type 
the hexadecimal (HTML) value for the color.

5. Repeat step 4 for each color you want to add to the palette
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6. Click Save.

7. In the Save As dialog, type a file name for the palette, and click Save.

8. The new palette is displayed in the Color Picker until you change it.To 
reload this palette, follow the steps in “Loading a Custom Color Palette” 
on page 1-11.
Setting Preferences
You can change your preferences from any view at any time. Changes take place as 

soon as you click OK to close the Preferences dialog. General and Backup 

preferences apply throughout NetObjects Fusion and affect all sites; Page 

preferences affect the current site only and are saved with the site.

1. From the Edit menu, choose Preferences.

The Preferences dialog appears.

2. Set the preferences on the General tab.
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● Auto Save. When this option is selected, your site is saved each time 

you change views or pages. If you clear the Auto Save check box, be 

sure to save your site periodically by choosing Save Site from the File 

menu.

● Application window maximized at startup. If you clear the check 

box for this option, the NetObjects Fusion window opens in the last 

size you set, rather than full screen size.

● Open to most recently used file at startup. If you select this 

option, when you start NetObjects Fusion, the last site you worked 

on opens automatically, displayed in the last view you worked in.

● Use Small Fonts in Properties Palette. If you clear this check box, 

you see larger properties palettes in Page view. To maximize the area 

available for your page Layout, leave this option selected.

● Preview. Choose the Web browser you want to use for previewing 

sites by selecting it from the Browser drop-down list.

If you have more than one version of a browser installed, when 
you select Preview, NetObjects Fusion launches the version that 
was most recently opened. To use other versions, you must launch 
them manually from the Windows Start menu. For example, 
suppose you have both Netscape Navigator™ 3.0 and 4.0 
installed. You open 4.0 to check your stock portfolio, then close it 
and begin working on a site in NetObjects Fusion. When you 
preview the site, NetObjects Fusion launches Navigator 4.0 
because it was the last version opened. To preview in Netscape 
Navigator 3.0, you must launch it manually. Once you open 3.0, 
NetObjects Fusion uses it for previews until you manually launch 
another version.

Also choose whether you want to preview only the Current Page 
or the Entire Site. Previewing the entire site takes longer, but you 
can move from page to page in the browser to test your site’s 
navigation buttons. Set the Current Page option to preview only 
the current page or the current section of pages.
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You can also use keyboard shortcuts to preview either the whole 
site or just the current page or section:

- If Entire Site is selected in Preferences, pressing Alt + P or 

clicking the Preview button previews the entire site; pressing 

Ctrl + Alt + P or clicking the Preview button while pressing Ctrl 

previews just the current page or section.

- If Current Page is selected in Preferences, pressing Alt + P or 

clicking the Preview button previews the current page or 

section; pressing Ctrl + Alt + P or clicking the Preview button 

while pressing Ctrl previews the entire site.

● WYSIWYG Optimization. Choose whether Page view should 

display text spacing as it will appear in Netscape Navigator or in 

Microsoft® Internet Explorer.

● HTML editor. Click Browse and find the file that launches your 

editor. When you want to edit the HTML of an External HTML 

object, double-click the External HTML’s X in Page view to launch 

the editor you specify here. For example, you can designate Allaire 

HomeSite™ 3.0 as your HTML editor if you installed it with 

NetObjects Fusion 3.0. See Chapter 22, “Working with HTML 

Directly” for details.
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3. To set Page preferences, click the Page tab.

● Browser Font Settings. Choose Proportional and Fixed Width font 

settings. To ensure that your pages appear in your browser the way 

you design them in NetObjects Fusion, choose the same font 

settings in your browser. For example, if you use Times, size 12, and 

Courier, size 10, for your browser proportional and fixed width 

fonts, choose the same fonts and sizes in NetObjects Fusion. Note 

that the suggested settings are the defaults used by the browser when 

it was installed.

Be aware that NetObjects Fusion sizes text boxes based on the 
expected font size, so when you change sizes, you change the 
Layout of the page slightly.

● General. Choose the measurement unit you want to use as you 

build your site. Then specify a width and height in this unit of 

measurement for your default page and grid sizes. When you add a 

new page to your site, it will have this size. Changing this option 

does not change the size of existing pages in your site. However, if 
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you change the Grid Size setting, it will change the size of the grid 

on both new and existing pages. For more information about page 

size, see “Displaying a Page in Page View” on page 4-2.

● Background Image (pixels). Most Web browsers add a margin at 

the top and left of the page; this margin can vary from 6 to 16 pixels. 

However, no margin is added for background images; a background 

image is aligned at the top and left edges of the page. If you need to 

match a background pattern to objects on the page, use this setting 

to compensate for the shift of your content in the browser. Note that 

this option does not affect the generation of HTML in any way; it 

affects only the appearance of your page Layout in NetObjects 

Fusion.

The default settings (Offset selected, Left 10, Top 16) are 
optimized for Netscape Navigator 3.0 and Microsoft Internet 
Explorer 3.0 and 4.0 running on Windows. However, not all 
browsers on all platforms use the same margin. For example, 
Netscape Navigator 4.0 for Windows and 3.0 for Macintosh use 
Offset selected, Left 8, Top 8. These settings also do not apply if 
you use frames; in that case the settings are always Left 2, Top 2. If 
you set the Background Image Offset, be sure to test your pages 
using the browsers you want to support.
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4. To set Backup preferences, click the Backup tab.

● Automatic Backup. This option is selected by default. When you 

close NetObjects Fusion, the program automatically backs up your 

.nod file and saves it in the \backups subfolder under the User 

Sites\sitename folder. If you need to use one of these backup files, 

drag it from the \backups folder into the User Sites\sitename 

folder before you open it so the asset paths will be correct.

If you do not want NetObjects Fusion to automatically back up 
your sites, clear the check box.

● Backup Settings. NetObjects Fusion saves backup files in the User 

Sites\sitename folder by default. To change the location of the 

backup files, type a new path name in the Backup location field, or 

click Browse and select a new location

Select a backup file name convention from the drop-down list: 
you can choose a plain format or one that includes the date and 
time.
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Indicate the number of backups you want NetObjects Fusion to 
keep. The oldest backups are overwritten as newer backups are 
created.

● Compact database upon exit. This option is selected by default. 

Compacting the files can save you substantial hard disk space. In 

addition, when this option is selected NetObjects Fusion performs 

an error-checking procedure to verify your database as it compacts 

the files. It is recommended that you do not change this setting. 

WARNING: Do not shut down Windows while the file is being compacted. This 

could cause your .nod file to become unstable.
Editing Objects and Assets
You can edit objects created in other software applications from within NetObjects 

Fusion. In Page view, you select the object on the page, and then from the Object 

menu, select Open Object. In Assets view, you select the Asset, and then from the 

Asset menu, select Open Asset. If the correct application does not open, the file type 

of the object or asset is probably not associated with the correct application. 

For example, if you want to edit a .gif image, you select the picture in Page view and 

select Open Object from the Object menu. If Microsoft Internet Explorer opens 

rather than an image-editing application, you must change the application 

associated with .gif files.

To set the application associated with a specific file type in Windows:

1. Double-click the My Computer icon on your Windows Desktop.

2. From the View menu, select Options.

3. Click the File Types tab.

4. For every image file type in the list, click Edit and choose the appropriate 
Content Type.

5. Click OK to close the Options dialog and close the My Computer 
window.
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NetObjects Fusion Folder Structure
The NetObjects Fusion 3.0 folder contains all the files you need to use NetObjects 

Fusion.

Do not move or rename the NetObjects Fusion 3.0 folder or any folders within it. 

NetObjects Fusion performs best when the application and its parts remain in the 

folder recommended during installation. This is especially true with the User Sites 

folder. Since NetObjects Fusion keeps track of assets and links, folder names and 

locations are very important. If you change names and/or locations using Windows 

Explorer or File Manager, Net Objects Fusion might not be able to track assets and 

links properly. 

The subfolders organize files according to their use:

● Components contains the NetObjects Fusion Components, mini-applications 
that can add sophisticated functions to your site. See Chapter 18, “Using 
NetObjects Fusion Components” for information.

● Samples contains design parts such as picture files and animated .gifs, as well as 
plug-in parts such as media files and Java applets that you can use to enhance 
your site design.

● Developer contains usage notes that explain how to create a custom Actions 
menu.

● NetObjects System contains files used by the program; do not delete or remove 
these files.

● Styles contains a separate folder for each SiteStyle, including the ones you create. 
NetObjects Fusion style files have an .ssf extension. See Chapter 12, “Using 
SiteStyles” for information.

● Templates contains AutoSites™ and Page templates. A NetObjects Fusion 
Template file has an .nft extension and its own Assets folder. See Chapter 2, 
“Creating and Managing Sites” for information about templates.
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● Tutorial contains the assets you need for the lessons in NetObjects Fusion Getting 
Started.

● User Sites contains all the sites you create. NetObjects Fusion automatically 
creates a new subfolder within User Sites to keep your projects organized. Each 
NetObjects Fusion site is saved with a .nod extension. The site folder also 
includes an assets folder where all the assets used in the site are saved and a 
backups folders where backup .nod files are saved. You can also save sites in 
other locations.
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Creating and 
Managing Sites 2

Site view is where you create, view, and maintain the architecture of your site. Site 

view frees you from the details of file and link management, so you can focus on 

organizing and updating your site. For example, you can drag a page or section to 

any location in Site view, and NetObjects Fusion updates the links to other pages 

automatically.

This chapter describes Site view and its automated site-building capabilities, 

including:

● Starting NetObjects Fusion

● Starting with a blank site

● Opening an existing site

● Using Site view tools to select pages and create sections

● Setting properties

● Adding, deleting, and moving pages

● Renaming pages

● Printing the site structure

● Working with the site outline

● Saving and backing up your site
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Starting NetObjects Fusion
When you install NetObjects Fusion, it is automatically added to the Windows 95 

Start menu. To start NetObjects Fusion:

◆ From the Start menu, choose Programs, NetObjects Fusion.

When the program starts, it displays this dialog:

Creating a blank site and opening an existing site are described in “Creating and 

Opening Sites” on page 2-3. Creating a new site based on a NetObjects Fusion 

AutoSite or template is described in Chapter 3, “Importing and Exporting.”

The default option in this dialog is to open the last file you were working on. You 

can set preferences so NetObjects Fusion automatically opens your last file each 

time you start the program. See “Setting Preferences” on page 1-12.

Working with Site Files
A NetObjects Fusion site file is a database of information about your site. Site files 

have a .nod extension.

Site files are stored in a folder that has the same name you give the site. For example, 

if you name the site Apples + Oranges, the site’s folder is called Apples + Oranges, 

and the site file—Apples + Oranges.nod—is saved inside the folder. In addition, 

the site folder contains a folder with the site’s assets—embedded files, links, data 

objects, and variables—as well as a backups folder.
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By default your site folder is saved inside the User Sites folder, but you can store the 

site in any location on your local computer. Because the paths to the assets in a site 

file are absolute—they include the drive and folder names—you cannot save the site 

file on another computer on a network. To do that, export the site as a template, as 

described in Chapter 3, “Importing and Exporting.”

Creating and Opening Sites
When you create a site, you always work from a template, ranging from the most 

simple—the Blank Site template—to the professionally designed templates 

provided with NetObjects Fusion. You can even derive templates from your own 

sites.

A template is a fully designed page or site that you can use as a starting point for 

your own pages or sites. A typical template might include a banner and navigation 

buttons, an assigned SiteStyle, and—in some cases—text or other content. You can 

start a new site from a template or insert one into your current site. Templates are 

described in detail in Chapter 3, “Importing and Exporting.” 

You can also open an existing site and add to it, change its style, or modify it.

Starting with a Blank Site
You can start building a new site from a blank site, which is a template consisting of 

a Home page with a banner and navigation buttons. The blank site provides a 

starting point for creating a new site.
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To start with a blank site:

1. From the File menu, choose New Site, Blank Site.

The New Blank Site dialog appears.

You can also start a blank site by selecting the Blank Site option in the 
Welcome to NetObjects Fusion dialog.

2. Enter a site name in the dialog.

Note: For compatibility with NetObjects Fusion for Macintosh and 
Macintosh Web servers, do not give your site a name with more than 26 
characters.

Type a site file name here.

Click here to store the site in 
another location.
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3. Click Save.

Site view opens a new site, based on the Blank Site.nft template, and 
displays a Home page. You’re ready to begin adding pages to create your 
site’s structure, as described on page 2-12.
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Opening an Existing Site
1. From the File menu, choose Open Site.

The Open dialog appears.

2. Double-click the folder that contains the site you want to open.

3. Select the site’s .nod file and click Open.

You can also open an existing site by doing any of the following:

● Selecting it in the Welcome to NetObjects Fusion dialog.

● Choosing it from the list of recently used files on the File menu. NetObjects 
Fusion remembers the last four site files opened.

● Dragging the .nod file name from the Windows 95 Explorer and dropping it in 
the NetObjects Fusion window.

● Double-clicking the .nod file name in the Windows 95 Explorer.
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Viewing a Site
In Site view, the structure of your site is represented by page icons. As in a family 

tree, pages have parent, child, and sibling relationships.

The pages named Apples, Oranges, and Grapes are all children of the Home page 

and are siblings of each other. The Grapes page is the parent of two additional pages: 

Raisins and Wine.

In Site view you can add pages to the site, rename pages, move them, and complete 

other site-oriented actions. To add content to a particular page—for example, to 

add text or pictures—use Page view. As you construct a site, you typically go back 

and forth between Site view and Page view. 

In Site view one page is always selected, as indicated by a blue border. See “Selecting 

Pages” on page 2-8.

Saving Your Work
To save your work, choose Save Site from the File menu. NetObjects Fusion also has 

an auto save feature that saves your work each time you change views. See “Setting 

Preferences” on page 1-12.
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Using the Site View Tools
When you work in Site view, the toolbar contains one tool for selecting pages and 

another for zooming in and out on the Site view.

The Zoom tools are discussed on page 2-11.

Selecting Pages
Before you can add, rename, or move pages, or set page properties, you must first 

select a page. By selecting a page, you identify it as the one you will work with. 

NetObjects Fusion places a blue border around the selected page.

To select a page, do either of the following:

◆ Using the mouse, click the Selection tool and then click the icon for the 
page you want to select. If you click directly on the page’s name, 
NetObjects Fusion selects the page name and switches into text editing 
mode. See “Renaming Pages” on page 2-14.

◆ Using the keyboard, press the arrow keys to select the current page’s 
parent, child, or sibling pages.

Selection tool

Zoom tool

Selected page
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Working with Sections
In addition to selecting individual pages, you can select sections of your site. A 

section is any page and all its children, their children, and so on. You can move a 

section to a different location in the site, set section properties including 

MasterBorders—see Chapter 6, “Managing MasterBorders and AutoFrames”—and 

preview a section independently of the rest of the site.

To select a section, do either of the following:

◆ Hold down the Shift key as you click the parent page of the section.

◆ With the keyboard, select the parent page of the section and then press 
Shift+Enter.

NetObjects Fusion places a blue border around the pages in the section.

Sections are not permanent entities. You can deselect the section by clicking any 

page in the site, by clicking the Site view background, or by pressing an arrow key or 

Shift+Enter. You can preview just the selected section. For more information on 

previewing a section of pages, see “Setting Preferences” on page 1-12.

Setting Page and Section Properties
Pages and sections have a number of properties. Some properties affect the 

published site; others are for your information. For example, you can assign colors 

to the page icons to create visual groups that indicate which pages are finished or 

which are assigned to a particular author. You can instruct NetObjects Fusion 

This page and its children are a section, as 
indicated by the blue border.
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whether to publish a particular page, note whether a page is done, and enter 

comments about the selected page.

To set properties, select a page or section to display the Properties palette.

Page Properties

● Page Name. The name assigned to the page. See “Renaming Pages” on 
page 2-14 and “Using Custom Page Names and Extensions” on page 2-15.

● Custom Names. See “Using Custom Page Names and Extensions” on page 2-15.

● Page Type. Shows whether the page is a normal page or a stacked page. Stacked 
pages are created when you use a data list. For information about stacked pages, 
see Chapter 20, “Data Publishing.”

● Color. Sets the color of individual page icons in Site view. You can use colors to 
help you manage work on the site. For instance, use colors to specify pages that 
need updating or for sections that you need from another designer.The page 
icon’s color has no effect on the published site.

● Status. Marks pages as Done or Not Done, a convenient way to manage 
individual pages in a large site. This setting is for your information only and has 
no effect on the functioning of the site. The page icon displays a check mark 
when you select Done.

Page properties

Section properties
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● Publish/Don’t Publish. Makes it possible to publish some pages while not 
publishing others that might be under construction or private. The page icon 
displays a red bullet when you select Don’t Publish.

NetObjects Fusion removes pages marked Don’t Publish from the navigation 

bars of other pages in the site, disables manually created links to such pages, and 

does not produce HTML for these pages during publishing. However, you can 

preview a page that is designated Don’t Publish as an individual page.

Do not use the Don't Publish setting to exclude pages in an attempt to publish 

changed pages only to an already-published site. Doing so causes broken links 

and other undesirable results.

● Comments. Enter notes to yourself or your co-workers about the status or 
content of individual pages.

Section Properties

● Custom Names. You can only set a custom file extension. See “Using Custom 
Page Names and Extensions” on page 2-15.

● Color. Applies a color to the section.

● Status. Marks the section as Done or Not Done.

● Publish/Don’t Publish. Sets the publication flag for the section.

● MasterBorder. Sets a MasterBorder for a section of pages. Setting a 
MasterBorder for a section is described in “Applying a MasterBorder to a 
Section” on page 6-8.

Zooming In and Out
You can select the Zoom In or Zoom Out tool from the toolbar. The Zoom In tool is 

a magnifying glass with a plus sign; the Zoom Out tool has a minus sign. For 

information on using the toolbar, see “About Toolbars” on page 1-6.

Zoom Out tool

Zoom In tool
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You can reverse the function of the current Zoom tool by holding down the Alt key. 

For example, if the current tool is Zoom In, pressing Alt makes it Zoom Out. As 

soon as you release the Alt key, it becomes Zoom In again.
Adding, Deleting, and Moving Pages
In Site view, you can modify the structure of a site at any time by adding, deleting, 

and moving pages. NetObjects Fusion automatically changes the links between 

pages when you modify the structure.

Adding Pages
1. In Site view, select the page you want to be the parent of the new page.

2. Do any of the following:

● Click the New button on the control bar.

● From the Edit menu, choose New Page, or press Ctrl+N.

● Right-click the parent page and choose New Page from the shortcut 

menu.

In Site view, the new page appears beneath the selected page. The new 
page is named Untitled.
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Deleting Pages
1. In Site view, select the page you want to delete and do any of the following:

● From the Edit menu, choose Delete Page.

● Right-click the page and choose Delete Page from the shortcut 

menu.

● Press the Delete key.

2. Click Yes in the NetObjects Fusion warning dialog to confirm the 
deletion.

Note: Deleting a page removes all its child pages and cannot be undone. You cannot 
delete the Home page. 
Moving Pages
When you move pages in Site view, NetObjects Fusion automatically updates all 

affected links within the site.

1. In Site view, select the page you want to move. You cannot move the 
Home page.

2. Drag the page to the target page, where it becomes either a sibling or a 
child in its new location.

As you drag the page, a colored outline highlights the target page. The outline is red 

unless you change the Site view background color. A triangle to the left or right of 

the target page’s border indicates the moved page will be a sibling; a triangle below 

the target page’s border indicates the moved page will be a child.

A triangle on the side of the target page icon 
shows that the moved page will be a sibling.

A triangle on the bottom of the target page icon 
shows that the moved page will be a child.
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If the moved page will be the child of a page that already has children, the moved 

page becomes a sibling of those children. In that case, the outline and triangle 

appear on the target sibling page.
Renaming Pages
You can rename a page to suggest its contents.

By default, NetObjects Fusion uses the page name on banners and navigation 

buttons that identify the page. When you publish your site, NetObjects Fusion uses 

the page name as the HTML file name for the page. It also uses the page name when 

it creates links to the page.

NetObjects Fusion converts spaces and non-alphanumeric characters except 

periods (.) and hyphens (-) in the page name to underscores (_) in the HTML file 

name. To change this default, see “Defining Server Profiles” on page 26-10.

If you give two pages the same name, NetObjects Fusion adds a numeral to the file 

name when it creates the HTML files for the second and any additional pages. For 

example, if you have two pages named Great, NetObjects Fusion creates great.html 

and great1.html.

You can change the name directly on the page icon or in the Name field on the Page 

tab of the Properties palette.

To rename a page on the page icon:

1. In Site view, click the page name text and type a new name. 

2. Press Enter or click anywhere outside the page icon to enter the name.

You can switch immediately into edit mode on a selected page by pressing Enter. 

Once in edit mode, you can tab between sibling pages to edit their names. 

NetObjects Fusion remains in edit mode until you press Enter. If the page has no 

siblings, pressing Tab moves the text edit selection to the page’s parent.

To rename a page in the Properties palette:

1. Select the page you want to rename.

2. Edit the text in the Name field. 
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3. Press Tab or click anywhere outside the page icon.

Note: For compatibility with NetObjects Fusion for Macintosh and Macintosh Web 
servers, do not give your page a name with more than 26 characters. 
Using Custom Page Names and Extensions
By default, the browser window title bar, banners, and navigation buttons use the 

page name. If you prefer, you can specify different values to be used for your title, 

navigation buttons, banner, and HTML file extension. If you have a long page name, 

you can break it into two lines so it fits on the banner and button pictures.

To specify custom page names:

1. In Site view, select the page you want to give a custom name.

2. On the Page tab of the Properties palette, click the Custom Names 
button, or choose Custom Names from the Edit menu.

Click here to specify a custom name.
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3. Set the Custom Names options.

● Page Title: Appears in the title bar of the browser’s window when it 

displays this page. When your site visitors creates a bookmark on 

this page, it is named from the page title. The title is also 

emphasized in search engines queries.

● Navigation Button: Appears in navigation buttons leading to this 

page—useful when your page’s name is too long for a button. To 

add a second line to the button text, press Enter after the first line.

● Banner: Appears in the page’s banner—makes possible a banner 

with a longer name than practical for a file name or button. To add a 

second line to the banner text, press Enter after the first line.

● File Extension: Specifies a custom extension for your page file. Page 

files usually have an .htm or .html extension. In some special cases, 

a page requires a different extension to function with some server 

software. For example, pages for secure locations use the extension 

.shtml. For information on changing the default extension for 

pages, see “Defining Server Profiles” on page 26-10.

When a section is selected, you can only set a custom file 
extension, which applies to the whole section.

4. When you finish, click OK.
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Setting Site View Properties
The Site tab of the Properties palette displays site information: the site name, date 

created, date last modified, the number of pages in the site, and the site’s author. 

When you enter an author name, NetObjects Fusion includes it in a Meta tag that 

appears in each page’s HTML file header when the site is published.

On the View tab of the Properties palette, you can change the Site view orientation 

and background color. The orientation and background color are strictly for 

working in Site view. They have no effect on the published site.

Click here to change the orientation in Site view.

Click here to change the background color in Site view.
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To change background color, click the Color button and select a new color from the 

Color Picker. To change orientation, click the button for the orientation you want.

Horizontal orientationVertical orientation
Collapsing the Site Structure Display
By collapsing the display of the site structure, you hide the child pages of a selected 

page, displaying only the page icons you want to see. A page with hidden child pages 

displays a plus symbol beneath its icon.

To collapse the display of child pages, click the triangle beneath the parent’s page 

icon. To expand the display to see child pages again, click the plus sign.

Click here to collapse 
the site structure.

Click here to expand 
the site structure.
2-18 Creating and Managing Sites



P R I N T I N G  S I T E  O R  S E C T I O N  S T R U C T U R E S
You can also collapse the display by selecting a parent page and pressing Tab. To 

expand the display, press Tab again.

The Structure and Outline views display the same expanded and collapsed pages. If 

you change the child pages hidden and shown in one view, the other view reflects 

your changes. See “Sorting the Display in Outline View” on page 2-20 for a 

description of Outline view.
Printing Site or Section Structures
In Site view, the Print command on the File menu prints the Site Structure view of 

your site or of a section. You cannot print the Site Outline view. The printed 

structure shows the same magnification, colors, orientation, and expanded or 

collapsed child pages that you see on the screen. Its footer includes the author name, 

number of site or section pages, and the date the site was last modified.

● To print the entire site, select the Home page, or click All in the Print dialog.

● To print a specific page and its children, do any of the following:

– Select the top-level page.

– Select a section.

– Click Selected page and its children in the Print dialog. This option is selected 

by default.

● To view what will be printed, select Print Preview from the File menu.

● If you have a large site that might not fit on a single page, you can scale the 
printed site to the page. From the File menu, choose Print Setup, and click the 
Print to fit option in the Print Setup dialog.
Working in Site Outline View
Site Outline view displays the site structure in outline format, including a table of 

the properties—child name, page type, status, publishing status, and comments—

of the child pages of the currently selected page. If the selected page has no children, 

the table describes the selected page itself. To see the site as an outline:
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◆ Click the Outline tab.

Like Site Structure view, Site Outline view shows if a branch of the site is collapsed. 

A collapsed branch is indicated by a plus sign to the left of the page icon; an 

expanded branch is indicated by a minus sign.

◆ To expand a branch, click the plus sign to the left of a page.

◆ To collapse a branch, click the minus sign to the left of a page.

You can select sections in Site Outline view. See “Working with Sections” on 

page 2-9.

This branch of the site is collapsed.
Click the plus sign to expand it.

Click the minus sign to collapse 
this branch of the site.
Sorting the Display in Outline View
In Outline view you can sort the child pages by their properties so you can quickly 

identify pages with common characteristics.

◆ Click the heading of the column you want to use to sort the list.

NetObjects Fusion sorts the list in ascending (A-Z) order. To sort the list in 

descending (Z-A) order, point to the column heading and press Shift + Click.

For information about managing your site, see Chapter 25, “Managing Assets.”
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Backing Up Your Site
You can back up your site manually or automatically.

To make a manual backup:

1. From the File menu, choose Save Site As.

The Save Site As dialog appears.

2. Type a descriptive file name for your backup file and select a location.

3. Click Save.

NetObjects Fusion creates a copy of your .nod file in the location you specified and 

automatically opens that file.

Note: The backup you make with the Save Site As command does not collect all 
assets and make all links relative. Your backup will still refer to assets and 
components in the original site file folder. To make a backup with assets and relative 
links, export your site file as a template, as described in Chapter 3, “Importing and 
Exporting.”

For information on automatic site file backups, see “Setting Preferences” on 

page 1-12. 

Type your backup file’s 
name here.

Select a location for your 
backup file. The User Sites 
folder is the default.
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Importing and Exporting 3

NetObjects Fusion offers several ways for you to create or expand the structure and 

content of your site. You can create new sites from templates such as the AutoSites 

provided with NetObjects Fusion. You can expand an existing site quickly by 

importing page or section templates. You can import existing HTML sites and pages 

and convert them to NetObjects Fusion format. You can also expand your site by 

referencing external HTML resources; see Chapter 19, “Referencing and Editing 

External HTML,” for information. 

You can export your completed NetObjects Fusion site as a site template, so you can 

share your work with other NetObjects Fusion authors or move your site to another 

computer system.

This chapter describes NetObjects Fusion’s import and export capabilities, 

including:

● Creating new sites from AutoSite templates or existing sites

● Expanding your site by importing sites, sections, pages, or other 
content

● Exporting all or part of your site for use by others
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Using Templates and Sample Sites
A NetObjects Fusion template is a predefined set of pages and assets that you can 

modify to meet your needs. A template folder contains:

● The source site’s collected assets, stored in a TemplateName\Assets folder. A 
site’s assets are its pages, pictures, media, and other content sources—any files 
other than the Sitename.nod file that make up the site.

● The SiteStyles used by the source site, stored in a TemplateName\Styles folder. 
SiteStyles are discussed in “Using SiteStyles” on page 12-1.

● A template file, TemplateName.nft, that includes the source site’s structure, page 
layouts, and references to the site’s assets. 

Templates can contain a single page, a site section, or an entire site. NetObjects 

Fusion comes with a variety of site and page templates; see “Templates Included 

with NetObjects Fusion” on page 3-2 for information.

You can open a template to create a new site. NetObjects Fusion includes several 

templates that provide the basic structure for common types of sites. See “Creating 

New Sites” on page 3-4 for information.

You can import any NetObjects Fusion or custom templates into your current site 

to expand its structure or content. To ensure consistency with the current site, all 

imported pages, sections, and sites take on the SiteStyle of the current site. See 

“Expanding Your Site” on page 3-11 for information.

You can also export your current site into template format, so you can move or 

distribute it. See “Exporting a Site” on page 3-17 for information.

When you add a new blank page to your site, the appearance and content of that 

page is set by the default Blank Site template. To change the default appearance of 

new blank pages, you can modify the Blank Site template. See “Changing an 

Existing Template” on page 3-18 for details.

Templates Included with NetObjects Fusion
NetObjects Fusion includes three types of templates that you can use as a starting 

point for your site, or import as a section or page that you add to your current site:
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● AutoSite™ templates provide a complete site with predesigned pages, a suggested 
site structure, and placeholder content. AutoSite templates are stored in the 
NetObjects Fusion 3.0\Templates\AutoSites folder. There are five AutoSite 
templates included with NetObjects Fusion:

– An Internet-style company site

– A departmental intranet site

– A business presentation site

– An import site

– A Blank site

● Page templates are professionally designed pages containing generic content that 
you can replace with your own information. Page templates are stored in the 
NetObjectsFusion\Templates\Pages folder. NetObjects Fusion includes:

– A Blank Page template that is used whenever you add a new page to your 

current NetObjects Fusion site

– Special-use pages, such as a table of contents, a calendar, an FAQ page, an 

office directory, and a “what’s new” page

– Sample navigation pages, which provide examples of top and left frame 

navigation, a text-based page, and an empty page

– Data-derived pages, such as an employee directory, a “who’s who” function, 

and a press release catalog

● Form templates, which are predesigned form pages containing generic or 
placeholder content for typical forms:

– A billing form

– A guestbook

– An order form

– A shipping form

You can also modify or replace these templates with your own. See “Creating a 

Template” on page 3-17 or “Changing an Existing Template” on page 3-18 for 

details.
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Sample Sites Included with NetObjects Fusion
In addition to AutoSite and page templates, NetObjects Fusion comes with two 

sample sites: a small business site and a demonstration site. These are templates 

with real content rather than placeholder content; they’re designed to showcase 

many NetObjects Fusion features. You can use them as examples of how to 

implement various effects and results. See “Creating a Site from a Template” on 

page 3-4 for information.

Sample site templates are stored in the NetObjects Fusion 3.0\Samples\Sites 

folder.
Creating New Sites
When you want to create a new NetObjects Fusion site, you have three choices:

● You can start with a blank site and add all pages and content yourself. Starting 
from a blank site is described in “Creating and Opening Sites” on page 2-3. 

● You can start from an AutoSite, a NetObjects Fusion page template, or a custom 
template, and add or delete content as needed. Starting from a template is 
described in “Creating a Site from a Template” on page 3-4.

● You can start from an existing site created without NetObjects Fusion, import it 
into NetObjects Fusion, and add, delete, or re-arrange content as needed. 
Starting from an HTML-based site is described in “Importing an Existing Site” 
on page 3-7.

Creating a Site from a Template
AutoSite templates provided by NetObjects Fusion provide a complete site structure 

with predesigned pages and suggested content. You can also use templates that you 

or your colleagues create, or templates created in previous versions of NetObjects 

Fusion. 

If a template contains a data object, NetObjects Fusion stores its image fields only as 

path names to the image files. Therefore, if you create a new site from a template 

created on your computer, the image fields on stacked pages will still display the 
3-4 Importing and Exporting



C R E A T I N G  N E W  S I T E S
image, but if you move the template to another computer and create a new site from 

it, the image fields will be empty.

To create a new site based on an AutoSite or other template: 

1. If your preferences are set to display the Welcome dialog when the 
program opens:

a. Open NetObjects Fusion.

The Welcome to NetObjects Fusion dialog appears.

b. Select From AutoSite or Template (*.nft) in the Create a New Site 
section of the dialog, and click OK.

If NetObjects Fusion is already running, select New Site, From Template 
from the File menu of any view.

The Select a Template File dialog appears with the AutoSites folder 
shown by default.
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2. Navigate to the folder containing the template you want. Select the 
appropriate TemplateName.nft file and click Open.

The Save Site As dialog appears. 

3. Enter a site name in the File name field. To ensure cross-platform 
compatibility, limit your site name to a maximum of 26 characters.

The site name is the file name for the NetObjects Fusion site (.nod) file 
and the name of the parent folder for the site’s assets and content folders.

4. Select the location where you want your site saved. By default 
NetObjects Fusion saves your site in the NetObjects Fusion 3.0\User 
Sites folder, but you can store it in the location of your choice. 

5. Click OK.

NetObjects Fusion creates the \Sitename folder, which contains a 
Sitename.nod file and a Sitename\Assets subfolder.

NetObjects Fusion opens in Site view and displays the page icons of the site you 

created. You can now modify the site structure as described in “Adding, Deleting, 

and Moving Pages” on page 2-12.

The first time you work with an AutoSite or page template, explore the individual 

pages in Page view before you delete or rearrange them. These pages include helpful 

content that can save you significant development time.

Type a site name 
here.

Click here to store 
the site in 
another location.
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Importing an Existing Site
You can create a new site by importing and converting an existing site that was 

created using a different site or page development tool. When you import and 

convert an existing site, NetObjects Fusion:

● Analyzes and duplicates the structure of the source site

● Analyzes and duplicates the content of each page

● Arranges source content into objects in a layout design as close as possible to the 
original

● Duplicates navigation and content links

● Assigns the default Plain SiteStyle and the default MasterBorder, if you select one

You can use this import and conversion function to bring previously created sites 

into NetObjects Fusion format. Then you can use NetObjects Fusion for updates, 

revisions, and maintenance. 

When you create a new site by importing and converting an existing site, follow 

these guidelines:

● When you begin to import and convert a source site, you can select one 
MasterBorder from the currently displayed site to apply to the new site. If you 
have an existing site with a MasterBorder similar to what you want the newly 
created site to have, open that site first, then create the new site. NetObjects 
Fusion applies the selected MasterBorder to the new site as it is created. 

● Be aware that importing a complex site might take more processing time than 
you expect. If the source site was created in NetObjects Fusion, it is more efficient 
to import it as a template than to import the published HTML pages.

● You can import an existing site from a local or networked drive, or from a remote 
location such as an intranet server or the World Wide Web.

– To import from a local drive, you must know the drive and folder where the 

site’s Home page, usually named index.htm or index.html, is stored. 

– To import from a remote location, you must know the URL of the main site 

file, such as index.htm.
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– You can limit the number of pages and the number of levels that NetObjects 

Fusion captures from either a local or remote site. Levels are based on the 

hierarchy of pages in the source site, defined by the site’s navigation; the first 

level is always the site’s Home page. The second level of the source site consists 

of pages that are linked from the Home page. Third-level pages are those 

linked from second-level pages, and so on.

– You must be connected to the Internet when you’re ready to activate the 

remote capture. 

● When NetObjects Fusion imports a site, it starts with the page you specify and 
stops importing when it hits the page number limit, the site level limit, or the end 
of the site. If you don’t define import limits, NetObjects Fusion imports to the 
end of the site—no matter how long that takes or how much it requires in system 
resources.

● In determining the number of levels, NetObjects Fusion counts the designated 
top-level page as level 1, then works down the site’s structure, stopping when it 
reaches the limit you set. NetObjects Fusion imports as many pages as possible at 
a higher level before going to a lower level.

● HTML coding practices vary, so the contents of the source site pages are 
unpredictable. Not all HTML coding syntax translates identically into 
NetObjects Fusion format, particularly incomplete or nonstandard tags. Some 
pages will convert more accurately than others. Spaces in .html file names might 
cause problems importing a site.

● NetObjects Fusion imports assets such as Java applets, Shockwave, and other 
media. It does not import server-side imagemaps or manage server-side 
resources. If the imported site originally used server resources such as a CGI 
script or Server-Side Includes, you must manually recreate these on your server. 

● NetObjects Fusion imports and converts HTML tables. If the source table has a 
visible border, no row or column spans, and a maximum size of 20 x 20 cells, 
then NetObjects Fusion converts it as a table. This works for regular and nested 
tables that meet the criteria. Otherwise, NetObjects Fusion converts the table into 
a series of text boxes and positions them on the page to represent the table 
structure. NetObjects Fusion tables do not support vertical alignment attributes.
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● NetObjects Fusion’s import feature supports the HTML 3.2 specification. 
Cascading Style Sheet (CSS) coding is removed from pages during import. 
Content with no other alignment formatting is placed flush left on its respective 
page.

● When you import a site that was built using HTML frames, NetObjects Fusion 
imports the frameset’s content pages as regular pages, and references the original 
frameset page as an external HTML page.

● Be prepared to perform some cleanup on an imported and converted site. Adjust 
font size and style if needed, and add NetObjects Fusion navigation bars and 
banners as appropriate to your design. If a page does not import the way you 
expect, check the original source file for incorrect HTML code or data. 

Creating a New Site from an Existing Site

1. To use an existing site’s MasterBorder when building the new site, open 
the existing site first.

2. From the File menu, choose New Site, From Local Import or From 
Remote Import.

● Select From Local Import to import a site located on your hard disk 

or network drive. 

The Import Local Web Site dialog appears.

● Select From Remote Import to import a site stored in a remote 

location such as an intranet server or the World Wide Web.
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The Import Remote Web Site dialog appears.

3. Enter the exact file location and path to the top-level page you want to 
import: 

● To specify a local site, enter the full drive and path to the local site’s 

top-level source page in the Home page field, or click Browse.

A file Open dialog appears. Navigate to and select the appropriate 
top-level page and click OK.

● To specify a remote site, enter the full URL to the site’s top-level 

source page in the Home Page URL field. To ensure accuracy, 

navigate to the site or page using your browser, then cut and paste 

the URL from the browser.

The starting page of your site import does not have to be the source site’s 
Home page, usually named index.htm or index.html; it can be any page 
of any accessible Web or intranet site.

4. From the Assign MasterBorder drop-down list, select the MasterBorder 
you want to apply to the imported site or section.

NetObjects Fusion displays the list of MasterBorders available in the 
current site; if there is no site currently open, the MasterBorder Import 
is applied by default.

5. Set the limits for the number of pages and number of levels you want to 
apply to the import process.
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6. If you are importing and converting a local site, enter the domain name 
for the site’s Home page in the Domain name field. If the local site was 
ever published on the Web, use the domain name that was used to access 
it; if not, leave the placeholder www.domain.com in the field. 

When it imports a local site, NetObjects Fusion needs to know the 
“home base” domain of that site, so it can tell whether to convert the 
links it finds into external or internal links. It does that by comparing the 
targeted domain, if there is one, to the domain name you entered.

7. If you are importing and converting a remote site, make sure your 
system is connected to the Internet or intranet so NetObjects Fusion can 
link to and import the site.

8. Click OK. 

NetObjects Fusion imports the site and converts its content, structure, 
and links into NetObjects Fusion format. It stores the site’s assets in the 
Sitename\Import folder, and assigns the MasterBorder you selected 
earlier to each page in the new site.

9. Navigate to each page and make necessary adjustments.
Expanding Your Site
One of the most efficient ways to expand your site and add new content is to import 

structures and content from other sources:

● You can import NetObjects Fusion templates at selected locations in your site. 
See “Importing Templates” on page 3-11 for information.

● You can import and convert existing sites or parts of sites using Site view and 
attach them to selected locations in your site. You can also import existing pages 
using Page view. See “Importing Existing Sites” on page 3-14.

Importing Templates
One way to expand your site is to import NetObjects Fusion templates into a 

specific location in your site. Templates can be either pages or whole sites; you can 

use either to assemble the basic structure of your site very quickly.
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Importing templates is especially helpful if you have standard boilerplate sections or 

pages that you want to add to multiple sites, or share among multiple authors. You 

can save those sections or pages as templates, and then incorporate them anywhere 

in your site with a few mouse clicks. 

When you import templates, follow these guidelines:

● Before you import, select the location where you want to append the imported 
section. The imported site, page, or section becomes a child of the selected page. 
You can move pages as needed once they are imported. 

● When you import a site or multi-page template, you are in effect adding a section 
to your site. See “Working with Sections” on page 2-9 for information.

● All imported pages take on the SiteStyle of the current site. For example, if several 
authors separately develop parts of a site, export their work as templates, and 
import the templates into a single master site for publishing, the master site’s 
SiteStyle ensures that the compiled site has a consistent look and feel. See 
Chapter 12, “Using SiteStyles,” for more information.

● When NetObjects Fusion imports a template, it renames the template’s 
MasterBorders by prefixing them with Imported, and adds them to the current 
site’s library of MasterBorders. For example, if the template has a MasterBorder 
named NoFrames, it is renamed and stored with the current site as 
ImportedNoFrames.

You can rename, manipulate, or delete these extra MasterBorders as appropriate. 

See “Modifying and Creating MasterBorders” on page 6-3 for information.

● Every template begins with a single root page, which is helpful if you are adding 
the template to your site as a page or section. However, if you want the root page 
of your template to be the Home page of your site, you must create a new site 
based on the template, rather than importing it. See “Creating New Sites” on 
page 3-4 for information.

● Although this information refers to the templates provided with NetObjects 
Fusion, the procedure is the same for importing custom templates.

● You can also reference external HTML pages as a part of your NetObjects Fusion 
site. NetObjects Fusion attaches referenced pages to the site, but does not import 
or convert their contents to NetObjects Fusion format. See Chapter 19, 
“Referencing and Editing External HTML,” for information.
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● If a template contains a data object, NetObjects Fusion stores its image fields only 
as path names to the image files. Therefore, if you import a template created on 
your computer, the image fields on stacked pages will still display the image, but 
if you move the template to another computer and import it, the image fields will 
be empty.

● If you add custom actions to a site, save the site as a template, and then import 
the template into a new site, the custom actions will not display in the custom 
actions menu in the new site. 

To import a site or page template:

1. In Site view, right-click the page under which you want to import the 
template. This page becomes the parent of the imported page or pages.

2. Select Import Template from the shortcut menu. 

The Import Template dialog appears.

3. Select the template you want to import:

● To import an AutoSite template, open the \AutoSites folder and 

find the folder containing the template you want to use. Open the 

selected template folder and select the TemplateName.nft file 

within it.

● To import a page template, open the \Pages folder and find the 

folder containing the template you want to use. Open the selected 

template folder and select the TemplateName.nft file within it. 
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● To import a template located elsewhere on your system or network, 

use the Import Template dialog to find the folder containing the 

template you want to use. Open the folder and select the 

TemplateName.nft file within it. 

4. After you select the template, click Open.

NetObjects Fusion imports the template and appends it under the page 
you selected. The page data and all assets are stored in your current site 
folder. The original template is still available in the NetObjects Fusion 
3.0\Templates folder.

Importing Existing Sites
You can expand your current site by importing and converting an existing site that 

was built without NetObjects Fusion. The process is similar to creating a new site 

from an existing site, but you are appending the existing site to your current site 

structure, rather than building a new site from scratch with it.

Be aware that importing a complex site might take more processing time than you 

expect. If you created the site in NetObjects Fusion, it is far more efficient to import 

it as a template than to import the published HTML pages.

To expand your site by importing an existing site:

1. In Site view, select the page you want to serve as the parent of the 
imported and converted content.

2. From the File menu, choose Import Web Site, From Local Import or 
From Remote Import.

● Select From Local Import if you want to import a site located on 

your hard disk or network drive. 
3-14 Importing and Exporting



E X P A N D I N G  Y O U R  S I T E
The Import Local Web Site dialog appears.

● Select From Remote Import to import a site stored in a remote 

location such as an intranet server or the World Wide Web.

The Import Remote Web Site dialog appears.

3. Enter the exact file location and path to the top-level page you want to 
import:

● To specify a local site, enter the full drive and path to the local site’s 

top-level source page in the Home page field, or click Browse.

A file Open dialog appears. Navigate to and select the appropriate 
top-level page and click OK.
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● To specify a remote site, enter the full URL to the site’s top-level 

source page in the Home Page URL field. To ensure accuracy, 

navigate to the site or page using your browser, then cut and paste 

the URL from the browser.

The starting page of your site import does not have to be the source site’s 
Home page, usually named index.htm or index.html; it can be any page 
of any accessible Web or intranet site.

4. From the Assign MasterBorder drop-down list, select the MasterBorder 
you want to apply to the imported site or section.

NetObjects Fusion displays the list of MasterBorders available in the 
current site; if there is no site currently open, the MasterBorder Import 
is applied by default.

5. Set the limits for the number of pages and number of levels you want to 
apply to the import process.

6. If you are importing and converting a local site, enter the domain name 
for the site’s Home page in the Domain name field. If the local site was 
ever published on the Web, use the domain name that was used to access 
it; if not, leave the placeholder www.domain.com in the field. 

When it imports a local site, NetObjects Fusion needs to know the 
“home base” domain of that site, so it can tell whether to convert the 
links it finds into external or internal links. It does that by comparing the 
targeted domain, if there is one, to the domain name you entered.

7. If you are importing and converting a remote site, make sure your 
system is connected to the Internet or intranet so NetObjects Fusion can 
link to and import the site.

8. Click OK. 

NetObjects Fusion imports the site, converts its content, structure, and 
links, stores its assets in the Sitename\Assets folder, and assigns the 
MasterBorder you selected earlier to each page in the new site.

9. Navigate to each page and make necessary adjustments.
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Exporting a Site
You can export any site as a template to use its style or content in another site. When 

you export a site as a template, NetObjects Fusion copies all assets into the \Assets 

folder of the template and converts absolute paths to relative paths. NetObjects 

Fusion includes in the exported template the SiteStyle files and resources for any 

SiteStyle in use by the source site. Therefore, exporting a site as a template (.nft) is 

the only way to share sites with other NetObjects Fusion authors or to incorporate it 

into another site.

You cannot move or replicate your site by copying and distributing the 

Sitename.nod file and its \Assets folder because:

● Your site’s assets are not necessarily stored in the Sitename\Assets folder; they 
could be elsewhere on your disk, somewhere on the network, or out on the Web. 
The Sitename.nod file contains absolute paths to all asset locations, so it doesn’t 
need to move or copy your assets until you publish your site. 

● The new computer to which you move the Sitename.nod file might not have the 
same assets in the same locations. If it doesn’t, the site will be missing assets.

● A customized SiteStyle used for the site might not be available in the site’s new 
location. 

Export is only available from Site view.

Creating a Template
1. To export the template to a new folder, create the folder first, using the 

Windows Explorer or NT File Manager.

2. In Site view, from the File menu, choose Export Site.
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The Select Destination dialog appears.

3. Navigate to and select the folder where you want to store the template 
and click OK.

NetObjects Fusion creates the template and stores it in a subfolder of the 
folder you selected. The current site remains open.
Changing an Existing Template
You can change or customize any NetObjects Fusion template. For example:

● If you have a standard company template for department pages, you can 
customize your copy so it contains your department name, location, and 
personnel information.

● If your company develops sites for customers and other organizations, you can 
customize the templates you use most frequently with your company name, 
contact information, and default links.

● If you routinely create new pages or new sites, but need them to have a consistent 
look and feel, you can customize NetObjects Fusion’s Blank Site template to 
contain the standard objects you want.

To preserve the original template, copy the entire template folder, including the 

TemplateName\Assets subfolder, before you edit or modify a default template. If 

you need to undo changes to a default NetObjects Fusion template, you can 

re-install it.
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If your modified template includes a custom SiteStyle, see “Customizing a Template 

with a SiteStyle” on page 3-19.

Customizing a Template

1. In Site view, from the File menu, choose Open Site to display the file 
Open dialog.

2. Select NetObjects Fusion Template Files (*.nft) from the Files of Type 
drop-down list.

3. Navigate to and select the template, then click OK.

4. Identify new assets you want to add to the template and copy them to the 
template’s \Asset folder, using Windows Explorer or NT File Manager.

5. Modify the template page(s) as needed.

6. To record the changes as part of the original template, chose File, Save 
Site.

To rename or move the template to a different folder, choose File, Save 
Site As. Navigate to and select a new parent folder, or enter a new name 
for the site. 

7. Click OK.

You can now import the customized template as needed.

Customizing a Template with a SiteStyle

1. In Site view, from the File menu, choose New Site, From Template. 

The New Site from Template dialog appears.

2. Navigate to and select the template you want to customize and click 
Open. 

The Save Site As dialog appears.

3. Enter a new name for the template.

NetObjects Fusion creates a new site based on the selected template, and 
gives it your new name.

4. Make changes to the template’s content, structure, or properties. 
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5. Switch to Style view. From the Style menu, choose Add Style to List. 

The file Open dialog appears with a Files of Type setting of Style Sheet 
Files (*.ssf).

6. Navigate to and select the Stylename.ssf file of the SiteStyle you want to 
apply to the template, and click OK.

NetObjects Fusion adds the SiteStyle to the list and displays an alert box 
asking if you want to apply the new SiteStyle to the site.

7. Click Yes.

8. Switch to Site view and from the File menu, choose Export Site to display 
the Export Destination dialog.

9. To replace the original template:

a. To export the template to a new folder, create the folder first, 
using the Windows Explorer or NT File Manager.

b. In Site view, from the File menu, choose Export Site to display the 
Select Destination dialog.

c. Navigate to and select the folder under which you want to store 
the template and click OK.

NetObjects Fusion creates the template and stores it in a subfolder of the 
folder you selected. The current site remains open.

10. To create a new template, export the site to a new location.

You can now import the customized template as needed.
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Sharing NetObjects Fusion Site Files
Templates are the only effective way to share NetObjects Fusion site files among 

multiple authors or across operating platforms. You cannot simply copy a 

Sitename.nod file created by NetObjects Fusion to another computer and open it, 

because the Sitename.nod file refers to files and styles that are not contained in the 

Sitename.nod file itself.

Note: If most of your sites involve the efforts of three or more developers using 
NetObjects Fusion, you should consider NetObjects TeamFusion, which uses client-
server technology to manage, integrate, and safeguard the contributions of each 
team member. See www.netobjects.com for more information.

To distribute or move a NetObjects Fusion site:

1. Export the site as a template according to the information in “Creating a 
Template” on page 3-17.

2. Copy the new template folder to the target computer via network, 
diskette, or other storage media. Make sure the folder and file names are 
not truncated or changed in the process.

3. Start NetObjects Fusion on the destination computer.

4. From the File menu, choose New Site, From Template.

The New Site dialog appears.

5. Navigate to and open the template’s folder and select the 
TemplateName.nft file. 

6. Enter a name for the new site in the Site Name field and click OK.

The site that was created in NetObjects Fusion on the source computer is 
now the active site, with its own Sitename.nod file, on the destination 
computer.
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C H A P T E R  4
Page View Basics 4

NetObjects Fusion supports three ways to lay out your page: position-based, text-

based, and HTML-based. Once you select a layout method, you either place objects 

within a layout container or import an HTML page to construct your page. 

Tools, properties palettes, and layout aides, such as rulers, guides, and grids, help 

you arrange and align objects on the page. 

This chapter describes how to use Page view features, including:

● Displaying pages

● Working in the MasterBorder and Layout areas

● Moving between pages

● Placing objects

● Using tools

● Aligning and distributing objects

● Overlapping objects

● Rearranging layered objects

● Renaming objects
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Displaying a Page in Page View
From Site view, there are several ways to display a page in Page view:

◆ Double-click the page icon.

◆ Click the page icon, then click the Page view button on the control bar.

◆ Click the page icon, then from the Go menu, choose Page.

◆ Click the page icon, then press Ctrl+2. 

The page you selected appears in Page view. 

Pages consist of a Layout area and a MasterBorder area. The Layout area is the body 

of the page. It contains objects that are unique to a page. MasterBorders are optional 

margin sets. They contain objects, such as navigation bars, that appear on multiple 

pages. 

You can define multiple Layouts and MasterBorders, then assign one of each to a 

page. “Modifying and Creating MasterBorders” on page 6-3 describes how to create 

Layout area

MasterBorder area

MasterBorder area

Page name

Layout name

Docked toolbars

Properties palette

Grid

Rulers

Guides
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MasterBorders; “Creating and Selecting Layouts” on page 7-2 describes how to 

create Layouts.

The size of a NetObjects Fusion page is defined by the combined size of the 

MasterBorder and Layout. The Blank Site template sets the default page size at 

600x555 pixels, which is appropriate for the majority of site visitors. You can 

redefine the default page size setting in Preferences as described on page 1-15, or by 

adjusting the size of the MasterBorder area, the Layout area, or both. See “Adjusting 

the Size of the Layout and MasterBorder Areas” on page 4-3 for more information.
Adjusting the Size of the Layout and MasterBorder Areas
You can adjust the size of the MasterBorder and Layout areas. Resizing these areas 

also changes your page size.

MasterBorder 
handles

Layout handles

MasterBorder 
handles

Layout Width and 
Height fields
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To resize the Layout and MasterBorder areas, do one of the following:

◆ Click in the Layout area, then change the Layout width, height, or both 
in the Layout Width and Height fields on the General tab of the Layout 
Properties palette.

◆ With the rulers showing, click one of the Layout handles and drag it to 
change the Layout height and width.

◆ With the rulers showing, click the rightmost MasterBorder handle to 
increase the size of the right MasterBorder. Click the bottom 
MasterBorder handle to increase the size of the bottom MasterBorder.
Forcing Objects to Snap to Grids, Guides, and Each Other
When you select a Snap to command, NetObjects Fusion creates a “magnetic” 

attraction between the selected object and the grids, guides, or other objects. 

Forcing objects to snap to grids, guides, and each other helps create more efficient 

HTML code.

◆ To force objects to snap to grids, select Snap to Grids from the View 
menu. 

◆ To force objects to snap to guides, select Snap to Guides from the View 
menu.

◆ To force objects to snap to each other, select Snap to Object Outlines 
from the View menu.
Adding, Moving, and Deleting Guides
You can add as many guides as you want to either the MasterBorder area or the 

Layout area, move the guides, and delete them. 
4-4 Page View Basics



M O V I N G  B E T W E E N  P A G E S  I N  P A G E  V I E W
◆ Click in the area for which you want to add, move, or delete a guide, 
then do one of the following: 

● To add a vertical guide, click in the top ruler.

● To add a horizontal guide, click in the side ruler.

● To move a guide, click its arrow on the ruler and drag it.

● To delete a guide, click its arrow and drag it off the ruler.
Showing and Hiding Rulers, Guides, and Grids
Grids, rulers, and moveable guides help you place and align objects in the 

MasterBorder and Layout areas. Guides associated with a MasterBorder appear on 

all pages that use that MasterBorder. 

You can set the size of the grid in the Preferences dialog as described on page 12. To 

show and hide rulers, guides, and grids in Page view, do one of the following:

◆ Select Rulers & Guides from the View menu to show and hide rulers and 
guides.

◆ Select Grids from the View menu to show and hide grids.
Moving Between Pages In Page View
You can easily move between pages in Page view using the page navigation buttons, 

the Site Navigation window, or the Go To command on the Go menu. For 

information about the Go To command, see “Using the Go Menu” on page 1-8.

The Page Navigation buttons and button for displaying the Site Navigation window 

are at the bottom of the NetObjects Fusion window.

Parent page button

Previous page button

Next page button

Child page button

Site Navigation window button
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Using Page Navigation Buttons
To move between pages using the page navigation buttons, do one of the following:

◆ On a child page, click the Parent page button to display its parent page.

◆ On a parent page, click the Child page button to display its child page.

◆ Click the Previous page button to move to the preceding sibling page.

◆ Click the Next page button to move to the next sibling page.
Using the Site Navigation Window
1. In Page view, click the Site Navigation window button.

The Site Navigation window appears.

2. Double-click the page you want to open, or select the page and press 
Enter to open it.
Importing HTML Pages
In Page view, you can import an HTML page authored elsewhere and convert it to 

NetObjects Fusion format, so you can visually edit its contents as you would any 

other page. You can import HTML documents with .htm or .html extensions.

If you prefer not to convert the HTML page to NetObjects Fusion format, place it as 

an object as described in “Referencing HTML from Page View” on page 19-4.
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Note: Because of variations in HTML code, not all pages import exactly as you see 
them, especially if their content is not in defined tables. Unpredictable results can 
occur if the page contains incorrect HTML. Non-HTML, such as JavaScripts and 
CGI scripts, do not import.

1. In Page view, display the page on which you want to import the HTML 
page.

It is easiest to import an HTML file onto a Layout that contains no 
content, because objects from the HTML file overlay any existing 
objects.

2. From the File menu, choose Import HTML Page.

The Open dialog appears.

3. Select an .htm or .html file from your hard disk, CD-ROM, or LAN.

4. Click Open.

NetObjects Fusion places the contents of the .htm or .html file on the 
current page, beginning in the upper left corner of the Layout area.
Placing Objects
You can use the tools on the four toolbars, or drag and drop files onto the page to 

place objects. To place an object using a tool:

1. In Page view, select the tool you want to use. Double-click the tool if you 
want to place multiple objects of the same type.

2. Draw a box where you want to place the object on the page.

If you are placing a picture, select from the Picture File Open dialog and 
click Open. 
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The object appears on the page as well as the appropriate Properties 
palette. For example, if you place a picture, the following appears:

3. Set the properties of the object. 

The tabs and options displayed on the Properties palette vary depending 
on the object you are placing. See the appropriate chapter for 
information about setting properties for objects.
Dragging and Dropping Objects
You can drag and drop text or Rich Text Format (.rtf) files from Microsoft Explorer 

or a word processor.

1. Locate and select the text or text file you want to place. 

2. Drag the text or file into the NetObjects Fusion application window and 
drop it on the page.

3. Use the Properties palette to set the text’s properties.
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Selecting Objects
Use the Selection tool to select, then move, or resize objects. 

Selection tool

◆ Click the Selection tool on the Standard toolbar. Then:

● Click an object to select it. Click elsewhere to deselect it. 

● Drag an object to move it.

● Click an object and drag the selection handles to resize the object.

● Drag a marquee around multiple objects, or Shift+Click to select 

multiple objects.

● Shift+Click selected objects one-by-one to deselect them.
Zooming In and Out 

Zoom tools

Use the Zoom tools to zoom in and out on an object or area on your page. You can 

press Alt while using the tool to toggle between zooming in and out on an object, or 

you can use the Zoom command on the View menu to select a magnification. 
Moving and Copying Objects
◆ Click and drag an object to move it.

◆ To prevent an object from dropping into a container, such as a Layout 
Region or text box, select the object and press Alt while moving it over a 
container.

◆ Press Ctrl, then click and drag an object to copy it.
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Editing Objects
You can edit objects you place on your page by launching editing applications right 

from NetObjects Fusion. To learn how to link a file type to the application of your 

choice, see “To create or modify a file type” in Windows 95 or Windows NT online 

Help.

1. In Page view, select the object and choose Open Object from the Object 
menu.

2. The object appears in the application associated with it.
Adding and Modifying Alt Tags
To make pages load faster, some visitors set up their browsers so they do not display 

images. To ensure that your pages provide the information you want to convey 

regardless of how the site visitor’s browser is set up, use alt tags to provide 

descriptive text that appears when images are not displayed. Also, Microsoft 

Internet Explorer 3.x and 4.x can display alt tag text in a ToolTip when the site 

visitor points at an object, so make sure every alt tag is appropriate for a ToolTip.

NetObjects Fusion assigns a picture’s file name as the alt tag when you place picture 

objects. You can change the name to a more descriptive one in the Alt Tag field on 

the Picture Properties palette. You can add an alt tag to Java, drawn shape, hotspot, 

generic plugin, QuickTime™, Shockwave, audio, and video objects in the Alt Tag 

field of their Properties palette. 

Alt tag
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To add or modify an alt tag:

◆ In the object’s Properties palette, type a descriptive name in the Alt Tag 
field.
Embedding Objects in Containers
In NetObjects Fusion, a container is an object into which you can embed other 

objects. A container can be any size and can hold any kind of object. NetObjects 

Fusion provides four types of containers you can use to design and lay out your 

page: 

● The Layout is the body of the page, surrounded on all four sides by the 
MasterBorder. Each page has at least one Layout, although you can create 
additional layouts as needed.

● Text boxes are a special class of objects because you can embed other objects 
within them. You can also maximize a text box so it fills the entire Layout—in 
effect, using a single text box to lay out the entire page.

● Layout Regions are mini-layouts that you can use to subdivide the page. You can 
draw and place Layout Regions anywhere on the page, and place any kind of 
objects—including text boxes or other Layout Regions—within their borders.

● Tables serve as containers for objects. If your page design calls for a tabular 
design, you can create a table to fill the page, and lay out your content within the 
cells of the table. Each cell of a table is a text box, so you can embed any other 
objects in the cell.

Note: If your page design requires hand-coded HTML pages, you can incorporate 
them as-is into your NetObjects Fusion page by referencing them. See “Referencing 
HTML from Page View” on page 19-4 for information.

◆ To embed an object in a container, select it and drag it over the container 
into which you want to embed it. 

The object automatically drops into the container. For details, see 
Chapter 7, “Laying Out the Page.”
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Creating Overlapping Objects
NetObjects Fusion supports CSS and Layers, an advanced form of HTML output 

that lets you overlap objects. Site visitors who have newer browsers —Microsoft 

Internet Explorer 4.x or Netscape Communicator 4.x—can see an object 

superimposed on top of another one. 

When you choose the CSS and Layers output option, you can place overlapped 

objects anywhere in a Layout, or embed them in a Layout Region.

To overlap two or more objects:

1. In Page view, in the Layout Properties palette, if you have not selected 
CSS and Layers for your entire site, select CSS and Layers from the Use 
drop-down list.

2. Place two or more objects in the Layout or a Layout Region.

3. Determine the object you want to be on the bottom layer, then drag the 
object you want to be on the next layer on top of it.

4. Repeat step 3 to continue layering objects.

See “Selecting HTML Output” on page 5-3 for a complete discussion of the CSS and 

Layers output type. If you want to change the order by which objects are layered, see 

“Rearranging Layered Objects” on page 4-13.
Locating and Renaming Objects
The Object Tree provides a convenient way to locate and rename objects on a page. 

This is particularly useful when you are working with layered or hidden objects. If 

you added several of the same type of objects, NetObjects Fusion numbers each 

object in the order in which you placed it. 

1. In Page view, from the View menu, choose Palettes, Object Tree.
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The Object Tree appears. 

2. Click an object in the Object Tree to locate it on the page.

Selection handles appear around the object on the page.

3. To rename the object, select the name of the object and type a new 
name. 
Rearranging Layered Objects
You can rearrange the layering of objects using commands on the Object menu or 

by moving the object in the Object Tree.

1. In Page view, open the Object Tree, and click the object you want to move. 

Handles appear around the object on the page.

2. Click and drag the object up or down the tree to move it to a different 
layer, or from the Object menu, choose Arrange Objects and:

● Select Bring to Front to bring the object to the top of the layer.

● Select Bring Forward to bring the object up one layer.

● Select Send to Back to send the object to the bottom layer.

● Select Send Backward to send the object down one layer.
Page View Basics 4-13



A L I G N I N G  A N D  D I S T R I B U T I N G  O B J E C T S
Aligning and Distributing Objects
In a Layout or Layout Region, you can align two or more objects to each other and 

distribute three or more objects equidistant from each other. Or, you can align and 

distribute objects relative to the Layout or Layout Region.

1. In Page view, select the objects you want to align by Shift+Clicking each 
one.

The Multi-Object Palette appears.

2. If you want the objects to align or be distributed relative to the Layout or 
Layout Region in which the objects are placed, select Relative to Layout.

3. In the Align section, specify the horizontal and vertical alignment.

● Select an option from the Horizontally section to align objects’ left 

or right sides, or if you want them to be centered on top of each 

other. If you select Relative to Layout, the objects align to the right 

or left side of the layout, or are centered in the Layout, one on top of 

the other.

● Select an option from the Vertically section if you want to align 

objects’ top or bottom sides, or if you want them to be centered next 

to each other. If you select Relative to Layout, the objects align to the 

top or bottom of the layout, or are centered in the layout side-by-

side.
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● Select Horizontally from the Distribute section if you want three or 

more objects that are on top of each other to be equidistant. Select 

Vertically from the Distribute section if you want three or more 

objects that are next to each other to be equidistant. 

Note: Object alignment can have an impact on preserving your design. See 
“Optimizing Nested Tables Output” on page 5-7 for information.
Making Multiple Objects the Same Size
You can adjust objects so they are all the same size. 

1. In Page view, select the objects by Shift+Clicking each one or by drawing 
a selection box around them.

The selected objects size to match the largest object you select.

2. From the Objects menu, choose Size Objects, Width to make two objects 
the same width. From the Objects menu, choose Size Objects, Height to 
make two objects the same height. 
Using the Standard Toolbar
Standard objects—such as text, pictures, tables, forms, and so on—are the basic 

building blocks of any site. 

Text tool

Use the Text tool to add text to your pages. See Chapter 8, “Designing with Text” for 

information.

Picture tool

Use the Picture tool to add pictures to your pages. See Chapter 10, “Placing 

Pictures” for information.

Rectangle Hotspot tool

Use the tools in the Hotspot tools group to create imagemaps. See “Creating an 

Imagemap” on page 14-13 for information.
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Layout Region tool

Use the Layout Region tool to add Layout Regions to your pages. See “Using Layout 

Regions” on page 7-14 for information. 

Table tool

Use the Table tool to place tables on your pages. See Chapter 9, “Adding Tables” for 

information.

Form Area tool

Use the Form Area tool to add a form container to your page. See Chapter 17, 

“Designing and Implementing Forms” for information.

Navigation Bar tool

Use the Navigation Bar tool to add navigation bars to a page. See Chapter 13, 

“Creating Navigation Bars and Banners” for information.

Banner tool

Use the Banner tool to add a banner based on your SiteStyle to your page. See 

Chapter 13, “Creating Navigation Bars and Banners” for information.

Rectangle tool

Use the tools in the Draw Shape group to draw shapes. See Chapter 11, “Drawing 

Shapes and Lines” for information about drawing shapes.

HR tool

Use the tools in the Line tools group to draw rules, lines, and arrows. See 

Chapter 11, “Drawing Shapes and Lines” for information about drawing lines and 

arrows.
Using the Advanced Toolbar
The Advanced toolbar contains tools you use to add media that require plugins, 

such as Shockwave and QuickTime, Java applets and servlets, ActiveX controls, data 

objects, and external HTML. 

Plug-in tool

Use the tools in the Media tools group to add popular plugins, such as Shockwave 

for Director, Shockwave Flash, or QuickTime movies to your pages. See Chapter 15, 

“Placing Media” for information about adding these objects.

Java tool

Use the Java tool to place Java applets and servlets. See Chapter 16, “Adding Java and 

ActiveX” for information.
4-16 Page View Basics



U S I N G  T H E  C O M P O N E N T S  T O O L B A R
ActiveX Control tool

Use the ActiveX Control tool to place ActiveX (.ocx) files on your page. See 

Chapter 16, “Adding Java and ActiveX” for information.

Data List tool

Use a Data List tool to add data list objects. See Chapter 20, “Data Publishing” for 

information. 

Use the External HTML tool to reference an external HTML page. See Chapter 19, 

“Referencing and Editing External HTML” for information.

External HTML tool

Using the Components Toolbar
The Components toolbar contains tools you use to add components, such as a 

Ticker Tape or Message Board, to your pages.

DynaButton tool

Dynabuttons are buttons site visitors use to navigate to links, including pages or 

sites. See “Adding DynaButtons” on page 18-2 for information. 

Ticker Tape tool

Ticker Tape adds a scrolling LED message to your site. See “Using Ticker Tape” on 

page 18-5 for information.

Site Mapper tool

Site Mapper helps site visitors create a site map. See “Adding a Site Map Button” on 

page 18-6 for information.

Message Board tool

Message Board provides visitors with a means to post, read, and reply to messages. 

See “Adding a Message Board” on page 18-8 for information.

Form Handler tool

Use the Form Handler tool to add a Submit button to forms. See “Submitting 

Responses as Plain Text” on page 17-14 for information.

Picture Rollover tool

Picture Rollover displays different images when a site visitor moves the mouse 

pointer over an image. See “Loading Pictures onto Your Site” on page 18-15 for 

information.
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Time Based Picture 
tool

Time Based Picture displays an image for a specified period of time. See “Adding 

Time Based Pictures” on page 18-13 for information.

Picture Loader tool

Picture Loader loads an image dynamically at browser request from a URL. See 

“Loading Pictures onto Your Site” on page 18-15 for information.

Rotating Picture tool

Rotating Picture displays several images in a continuous loop. See “Adding Pictures 

That Roll Over” on page 18-11 for information. 

NetObjects Fusion 

Use the NetObjects Fusion Components tool to add components to your site. See 

“Adding Other NetObjects Fusion Components” on page 18-18 for information.
Components tool

Using the Form Toolbar
A form provides a way for you to collect information from site visitors and provides 

the visitor with a way to request information. You use the Form tools to design 

forms after you designate an area of the page as the form area. 

Forms Button tool

Use this tool to add a reset button or, if your form will use either your own or a third 

party’s CGI script, to add a submit button. See “Adding Submit, Reset, and Custom 

Buttons” on page 17-12 for information.

Check Box tool

Check boxes provide site visitors with a way to select one or more items from a 

group of items, or to toggle a single item on and off. See “Adding Check Boxes” on 

page 17-9 for information.

Radio Button tool

Radio buttons limit the site visitor to selecting one item at a time. See “Adding 

Radio Buttons” on page 17-8 for information.

Edit Field tool

Single-line text fields accept text input from site visitors. They can be any width but 

only one line high. See “Adding a Single-Line Text Field” on page 17-5 for 

information. 

Multi-line tool

Multiple-line text fields can hold more than one line of text. See “Adding a Multiple-

Line Text Field” on page 17-7 for information.
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Forms Combo Box tool

Combo boxes create drop-down lists to display multiple options. Combo boxes 

allow site visitors to select one or several items from a list. See “Adding a Combo 

Box” on page 17-10 for information.
Interpreting the Warning Icon
NetObjects Fusion displays a warning icon on an object when it detects a potential 

layout problem or other error condition.

 

Mouse over the warning icon to display a ToolTip that identifies the problem, which 

can be one of the following:

● A picture is not Web safe, because it is in an unsupported file format. To remove 
the icon, replace the picture with one in a supported format. See “Choosing an 
Image Format” on page 10-2 for information.

● A form object, such as a Submit button, is outside a form. To remove the icon, 
drag the form object inside a form. See “Adding Objects to a Form” on page 17-4 
for information.

● Two or more objects overlap and you have not selected CSS and Layers as your 
HTML output option. To remove the icon, drag objects apart so they don’t 
overlap or choose CSS and Layers as the output option. See “Creating 
Overlapping Objects” on page 4-12 for information.

 Warning icon
Page View Basics 4-19



4-20 Page View Basics

I N T E R P R E T I N G  T H E  W A R N I N G  I C O N



C H A P T E R  5
Planning Your Site 5

The default settings for NetObjects Fusion generate efficient HTML that faithfully 

reproduces your visual design on the published page. The design of your text 

content, however, is subject to the browser settings of each site visitor. “Preserving 

Your Design Intentions” on page 5-2 describes potential variations that can happen 

in the site visitor’s browser. 

NetObjects Fusion offers several ways to control published output: 

● You can manipulate the HTML output method used to generate your site. 
NetObjects Fusion supports three output methods, each of which provides 
unique benefits in selected circumstances. “Selecting HTML Output” on 
page 5-3 describes these methods and their use. 

● You can control the table formatting priority—horizontal or vertical—used to 
generate the page. This helps preserve your design intentions when a browser’s 
font settings change the size of your text. “Optimizing Nested Tables Output” on 
page 5-7 describes the table format setting.

● You can select from four different types of page containers, each with different 
characteristics, to serve as your page layout medium. Chapter 7, “Laying Out the 
Page,” describes these containers and their use.

This chapter describes these HTML output methods and text flow choices, 

including:

● NetObjects Fusion’s three publishing methods, their pros and 
cons, and their application to different parts of your site

● The difference between horizontal and vertical preference for 
page formatting

● Matching your design priorities with the appropriate HTML 

output method
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Preserving Your Design Intentions
When you place a text box on a page, it’s shown in the default display font. You then 

format the text, size the object, and position it relative to other objects on the 

page—basing your efforts on the effects of your default display font and the size of 

the text box it creates.

When you preview or publish the page and view it in your browser, the size of the 

text box—and its alignment with the objects around it—is controlled by the base 

font settings in your browser. If your NetObjects Fusion base font is 10-point Times 

Roman, and your browser base font is set to 14-point Arial, you’ll see an immediate 

difference in the arrangement and spacing of your objects, because your text boxes 

expand to accommodate the new font size.

This is why you are advised to set the display fonts in NetObjects Fusion to match 

those of your browser—so you are working in a WYSIWYG environment. See 

“Setting Preferences” on page 1-12 for information.

This font variation is not caused by NetObjects Fusion; it’s a consequence of site 

visitors controlling their browser environment. It might not be an issue when you 

preview, but when you publish your site, you should be aware of potential 

problems: 

Page view at 10-point Times Roman Browser view at 14-point Arial
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● If a site visitor has a different browser base font setting, the text boxes on your 
page change size and other objects are re-arranged around them. 

● Microsoft Internet Explorer places slightly more blank space between text lines 
than the Netscape browsers do. If you design your page using one browser as a 
preview tool, visitors using the other browser see different results. You can set 
WYSIWYG optimization for either Netscape or Microsoft Internet Explorer to 
account for the browser differences. See “Setting Preferences” on page 1-12 for 
information.

● There are differences in font display between operating systems: if your site 
visitor is using a Macintosh, for example, its “version” of 14-point Arial is 
physically smaller than yours.

Using the Nested Tables output method you can control this rearrangement of 

content. See “Publishing with Nested Tables” on page 5-4 for information. You can 

also specify the horizontal or vertical formatting priority, so resized text impacts 

your page design in predictable ways. See “Optimizing Nested Tables Output” on 

page 5-7 for information.
Selecting HTML Output
Ongoing advances in browser technology and HTML standards have created several 

possibilities for controlling the way your site presents content. NetObjects Fusion 

supports these advances by offering three HTML output methods:

● Nested Tables uses nested table tagging and other features of the 3.2 HTML 
specification to produce your site. This is NetObjects Fusion’s default output 
because it produces the most predictable and consistent results onscreen, 
regardless of the type, version, or font configuration of the browser. “Publishing 
with Nested Tables” on page 5-4 describes this output option in detail.

● Regular Tables uses basic, non-nested HTML table tagging to format your site 
pages. Regular Tables is the “lowest common denominator” output setting, 
generating basic HTML that is compatible with the widest range of browser 
versions. See “Publishing with Regular Tables” on page 5-5 for a description of 
Regular Tables output.

● CSS and Layers uses a combination of Cascading Style Sheets positioning code, 
JScript™, and the <LAYER>tag to control the placement and delivery of content. 
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Content published with CSS and Layers requires an advanced browser: site 
visitors must use Microsoft Internet Explorer 4.0 or higher or Netscape Navigator 
4.0 or higher to get the full effect of your design. “Publishing with CSS and 
Layers” on page 5-5 describes effective applications of CSS and Layers output. 
CSS and Layers is also the best output method to use for dynamic pages and 
objects with actions. See Chapter 21, “Building Dynamic Pages,” for more 
information.

NetObjects Fusion gives you several options for applying these HTML output 

methods. You can:

● Publish your entire site with any method.

● Override the site publishing method for a specific page.

● Override the site or page publishing method for a specific Layout Region.

The rest of this chapter describes the differences between these formatting options 

and the results they deliver. For additional information on setting output methods 

in specific situations, see:

● “Selecting Layout Output Options” on page 7-33 for the steps necessary to set a 
page-specific publishing method.

● “Selecting Region Output Options” on page 7-43 for the steps to set the 
publishing method for a Layout Region.

● “Setting the Site’s HTML Output” on page 26-7 for the steps to set the publishing 
method for the entire site.
Publishing with Nested Tables
When NetObjects Fusion publishes your site, Layout, or Layout Region using the 

Nested Tables method, it places all your content in nested table cells. This method 

has several advantages:

● You get relative placement of your content as you designed it in Page view, with 
relative spacing preserved regardless of the site visitor’s display configuration—
such as browser fonts, browser type and version, and operating system. 

● You can prioritize either the vertical or horizontal relationship between objects. 
As a result, site visitors are more likely to see the pages as you designed them, 
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regardless of their local browser, font, and display configurations. By default, 
NetObjects Fusion assumes vertical relationships are most important.

● Pages published using Nested Tables can be viewed in most browsers that support 
the 3.2 HTML specification. This includes Microsoft Internet Explorer 3.0 or 
higher and Netscape Navigator 3.0 or higher. 

Nested Tables is the default publishing method for NetObjects Fusion. 
Publishing with Regular Tables
When NetObjects Fusion publishes your site, Layout, or Layout Region using 

Regular Tables, it translates each page or Layout Region into an HTML table with 

rows and columns, and places your content into table cells. This table is the 

underlying structure of the page, not a visible table object.

This output method gives you relative placement of content on the page; your 

content maintains its position in the underlying table. If text content expands 

because of a browser font setting, its table row expands with it, and the content 

below it on the page is moved down.

Regular Tables is the recommended output method in the following circumstances:

● When you want your pages to display successfully in older versions of some 
browsers.

● When you have embedded form objects in the page’s Layout or Layout Region.

● When you have objects with actions on the page, and you choose not to use CSS 

and Layers as the output method.
Publishing with CSS and Layers
CSS and Layers is an application of CSS concepts that NetObjects Fusion uses to 

express the location of content in terms of absolute positioning. For example, 

instead of using HTML workarounds such as empty table rows and transparent 

.gifs to position a line of text a certain amount of space below the top of the page, 

the absolute positioning supported by CSS and Layers defines placement of the text 

box a specific distance from the top left corner of the page in a simple statement of 

x,y coordinates.
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CSS and Layers uses a combination of CSS positioning code, JScript, and browser-

specific codes such as Netscape’s <LAYER> tag to control the placement and 

delivery of content. Pages published using CSS and Layers can only be viewed 

accurately in Microsoft Internet Explorer 4.0 or higher or Netscape Communicator 

4.0 or higher. Older browsers can view the pages, but their results will be 

unpredictable; in most cases the page content is stacked flush left down the page.

When you select CSS and Layers as your output method, NetObjects Fusion 

generates Everywhere HTML—HTML code that produces the same results in either 

browser. You can use this to take advantage of the advanced capabilities built into 

newer versions of Microsoft Internet Explorer and Netscape Communicator, 

without worrying about browser compatibility issues. 

Like the other two HTML output methods, you can apply CSS and Layers as:

● The default output method for your site. Note that this makes a 4.0-level browser 
the minimum requirement for viewing your entire site, which can exclude site 
visitors who use older browsers.

● The HTML output method override for a specific Layout. When you publish 
selected pages in CSS and Layers—while publishing the rest of the site in one of 
the table-based formats—you can keep the bulk of your site accessible to most 
browsers, while providing specialized content to those with browsers that 
support it.

● The HTML output method override for a specific Layout Region. Publishing a 
selected Layout Region in CSS and Layers—while publishing the rest of the page 
and site in a table-based format—makes an even finer distinction between the 
content available in basic HTML format and specialized content for newer 
browsers.

CSS and Layers: Pros

● Pages published using CSS and Layers as the output method are typically more 
compact and download faster than table-based HTML pages.

● You can overlap objects on Layouts or Layout Regions that are published with 
CSS and Layers. Because CSS and Layers includes a way to express depth, 
NetObjects Fusion can generate code that designates one object to display in 
front of another. See “Creating Overlapping Objects” on page 4-12 for details.
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● CSS and Layers is the most efficient output method for dynamic pages containing 
objects that have actions. See Chapter 21, “Building Dynamic Pages,” for 
information on developing DHTML.

CSS and Layers: Cons

● If you publish using CSS and Layers, site visitors who have older browser versions 
see the content stacked vertically against the left margin of the browser—not laid 
out in your page design.

● Because of its use of absolute positioning, CSS and Layers is less suited for text-
rich pages. If a CSS and Layers page is viewed in a browser with large font 
settings, the text boxes expand without regard for other objects on the page; the 
result can be unintended overlapping of objects.
Optimizing Nested Tables Output
If you use Nested Tables to output HTML for a Layout or Layout Region, you can 

control the text flow for each container by setting the table formatting priority—

columns or rows—that NetObjects Fusion uses to generate the page. This helps 

preserve your design intentions when a browser’s font settings change the size of 

your text content. 

For example, a Columns or vertical priority keeps text together in a vertical 

orientation when text size changes rearrange the page.
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A Rows or horizontal priority keeps text together in a horizontal orientation when 

text size changes rearrange the page.

In addition to selecting the formatting priority that best supports your design, you 

can also make your pages more efficient and more predictable by optimizing the 

placement of objects—particularly text objects— within the site’s underlying table 

structure. There’s no fixed standard, but as a general rule it’s best to align objects to 

The page with a Columns setting in Page view (at left) adjusts vertically to changes in browser 
text size, as shown at right.

The page with a Rows setting in Page view (at left) adjusts horizontally to changes in 
browser text size as shown at right.
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each other, and to isolate text boxes in their own cells within the underlying table 

structure so they can resize themselves as necessary in response to browser font 

changes.

To help you determine the best alignment, you can preview the underlying table 

row and column structure to see if NetObjects Fusion can divide your Layout into 

cells efficiently or if you need to rearrange some objects. 

To preview NetObjects Fusion’s arrangement of underlying table cells on your page 

and set your table alignment setting: 

1. In Page view, select the Layout or Layout Region you want to preview.

The General tab of the appropriate Properties palette appears.

By staggering the text boxes and image objects, as shown in the diagram at left, you 
require NetObjects Fusion to create multiple tables with different sized columns. 
By aligning the page objects, as shown at right, you create a simpler underlying table 
structure for the page.
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2. Select Columns or Rows in the HTML Output section of the General tab 
to set the table alignment priority.

3. Click and hold the Show button.

NetObjects Fusion hides grid lines, guide lines, and object borders in the 
Layout and displays solid grey lines that show where it is dividing the 
Layout into rows and columns. 

4. Identify underlying table cells that contain multiple text or other objects.

5. Release the Show button. 

6. Move objects around as needed to improve the efficiency of your HTML 
output. If the row and column dividers are not separating objects the 
way you think they should, those objects might not be aligned to each 
other with pixel accuracy. 

Show Table 
Structure button
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To correct this, Shift + Click all the objects you want to align. The Multi-
Object palette appears.

Click the alignment setting that your design requires for the selected 
objects.

7. Repeat steps 3 through 6 as needed. 

8. Preview the site or page.

9. To test the results, reset your browser display fonts to a significantly 
larger size and preview the site again.

You can also preview table structure in the browser by holding down Shift when you 

click the Preview button.
Optimizing AutoFrames
You can control realignment of AutoFrame content by selecting, for each frame, the 

primary table alignment setting that best preserves your design intentions. When 

you press and hold the Show button to preview the Layout’s table row and column 

structure, the preview includes the table structure that NetObjects Fusion expects to 

use within AutoFrames.
Locking or Maximizing a Text Box
There are three text box properties you can apply to reduce the impact of variations 

in browser configurations: locking the minimize size of the text box, sizing the text 

box to fill the Layout, and wrapping the text box contents to the browser width.
Planning Your Site 5-11



O P T I M I Z I N G  N E S T E D  T A B L E S  O U T P U T
● Locking the minimum size of a text box prevents automatic resizing by the 
browser if the display font is smaller than anticipated. When you publish a page 
with a locked text box, NetObjects Fusion generates HTML code that “hard-
wires” the minimum size of the text box. If the display font is bigger than 
expected, the height of the text box expands as needed; it will not shrink to a size 
less than the locked size.

● You can set the text box to automatically maximize itself to the full size of the 
Layout that contains it. If you embed all the page’s objects into a text box, for 
example, then you might want to make sure the text box grows to fill the Layout 
so there’s no unexpected white space if your MasterBorders or page dimensions 
change. 

If you embed your page content in a maximized text box, NetObjects Fusion 

generates extremely efficient HTML when it publishes your site. See “Embedding 

Objects in a Text Box” on page 7-24 for details.

● If you size your text box to the Layout and you select the ZeroMargins 
MasterBorder, you can set the text box to wrap to the width of the browser 
window. Text and images embedded in the text box rewrap themselves to fit 
within the browser window. If the browser window is resized, then the text box 
contents rewrap themselves to the new size.

Note: If you wrap the page contents to the browser window, then 
NetObjects Fusion generates the page’s HTML without using tables.

For information on formatting text, see Chapter 8, “Designing with Text.” For 

information on designing layouts with text boxes, see “Using Text Boxes” on 

page 7-21.
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Locking or Maximizing the Text Box Size

1. In Page view, create or select the text box.

2. Select the Text Box tab on the Text Properties palette.

3. Select Lock height to lock the text box’s minimum height.

4. Select Size to Layout to maximize the text box to fill the Layout.

Setting the Text Box to Wrap to Browser Width

1. In Page view, click the MasterBorder or select it from the Object Tree.

2. On the General tab of the MasterBorder Properties palette, select the 
ZeroMargins MasterBorder.

3. Select the text box.

4. Select the Text Box tab of the Text Properties palette.

5. Select the Contents wrap to browsers width option.
Planning Your Site 5-13



S U P P O R T I N G  Y O U R  D E S I G N  W I T H  H T M L  O U T P U T
Supporting Your Design with HTML Output
To determine which HTML output method best supports your site’s design and 

delivery priorities, find the description that best matches your main priority, then 

note the suggested HTML output choices. 

See Chapter 7, “Laying Out the Page” for details about choosing the layout method 

that most effectively supports your HTML output method. “Design Priorities and 

Method Choices” on page 7-34 matches design priorities with appropriate HTML 

output and layout methods.
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Managing MasterBorders 
and AutoFrames 6

NetObjects Fusion divides a page into two areas: the Layout area and the 

MasterBorder area. The MasterBorder is the set of margins—top, bottom, left, and 

right—on your page. Although MasterBorders are especially suited to repeating 

objects such as navigation buttons and logos, you can place anything in a 

MasterBorder that you can place in the Layout, including banners, pictures, and 

text. You can set any or all of the margins as an AutoFrame, which permits site 

visitors to scroll the body of the page while objects in the AutoFrame, such as 

navigation buttons, remain in view.

You can create a MasterBorder and apply it to all the pages in your site or just to 

selected pages; a site can use more than one MasterBorder. When you modify a 

MasterBorder, NetObjects Fusion automatically makes that change on every page 

that shares the MasterBorder. 

This chapter describes:

● Editing, creating, applying, and importing MasterBorders

● Creating AutoFrames
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Looking at MasterBorders
The illustration below shows a typical page with a MasterBorder.

By default, the left, right, and bottom margins are separated from each other 

visually by an outline. The lack of an outline between the left margin and the top 

margin indicates that—as in the illustration above—objects can straddle that 

boundary. This is not the case if the top or left margin is set as an AutoFrame. For 

information, see “Adding an AutoFrame” on page 6-13. You can turn the outline 

display off by selecting Page Labels from the View menu.

All pages have a MasterBorder, including those with a ZeroMargins MasterBorder, 

where all margins are set to zero and the MasterBorder is not visible. You can change 

the size of any MasterBorder margin, even those set to zero. See “Modifying a 

MasterBorder” on page 6-4.

The MasterBorder margins use the unit of measure selected for the site in 

Preferences. See “Setting Preferences” on page 1-12.

Top margin

Left margin

Right margin

Bottom margin
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Working with MasterBorders
When you create a new site, NetObjects Fusion automatically creates a default 

MasterBorder. The default MasterBorder for a new blank site contains three 

navigation aids—a banner showing the page name at the top, a graphical navigation 

button bar on the left, and a text navigation bar on the bottom. These objects are 

included in the MasterBorder of the Blank Site template. For information on the 

Blank Site template, new sites, and how to use templates, see Chapter 2, “Creating 

and Managing Sites,” and Chapter 3, “Importing and Exporting.”

When you import a template or create a new site based on a template, the new pages 

bring their MasterBorders and names with them from the source site. The Edit 

MasterBorder List dialog identifies imported MasterBorders. You can rename or 

delete imported MasterBorders. To display the Edit MasterBorder List dialog, click 

Add/Edit in the Masterborder Properties palette.

When you create a new site based on the template Import.nft, the default 

MasterBorder has a zero top, left, and right margin, and the bottom margin is 50 

pixels. Unless you change the default MasterBorder, new pages you create in the site 

will also have these margin sizes.

These are the MasterBorders from the imported 
template.
Modifying and Creating MasterBorders
You can modify a site’s default MasterBorder, or you can create your own 

MasterBorders. When you modify the MasterBorder on one page, NetObjects 

Fusion updates all pages that use the same MasterBorder; any object you place in a 

border automatically appears on all pages with that MasterBorder. 
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Modifying a MasterBorder
1. In Page view, display the MasterBorder Properties palette by clicking 

inside the MasterBorder. If the page has a ZeroMargins MasterBorder, 
click outside the page.

The MasterBorder Properties palette appears. The Name field shows the 
name of the MasterBorder assigned to the current page. If you started 
with a new blank site and have not changed the MasterBorder, this name 
is DefaultMasterBorder.

This page has a visible 
MasterBorder. Click inside it.

This page has a ZeroMargins MasterBorder. 
Click outside the page.
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2. To change the size of the margins, you can do either of the following:

● In the Margins section of the MasterBorder Properties palette, type 

values into the fields or click the arrows.

● Drag the handles on the ruler.

Note: If an object is in the way—such as a banner occupying both the top 
and left margin—you cannot resize the MasterBorder until you move 
the object.

3. Use the Selection tool to arrange objects such as a banner or navigation 
buttons.

4. Delete unwanted objects.

5. Use the tools in Page view to insert additional text or objects.

This handle changes 
the MasterBorder 
size.

These handles 
change the 
MasterBorder size.

These handles 
change the Layout 
size.
Resizing a MasterBorder
You can easily make a MasterBorder fit the objects in it—buttons, banners, text, 

pictures, and so on.

1. In Page view, select one of the objects in the MasterBorder.
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2. From the Object menu, choose Size MasterBorder to Objects.

MasterBorder margins before and after being resized
Creating a New MasterBorder
1. In Page view, click in the MasterBorder area.

The MasterBorder Properties palette appears. The Name field shows the 
name of the MasterBorder assigned to the current page. If you have not 
created a new MasterBorder or selected a different MasterBorder from 
the MasterBorder list, this name is DefaultMasterBorder.

2. Click the Add/Edit button.

The Edit MasterBorder List dialog appears.

Click here to create a new MasterBorder.
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3. The dialog lists all the MasterBorders in your site, with the current 
MasterBorder selected. To add a MasterBorder, click Add.

The New MasterBorder dialog appears.

4. Type a name for the new MasterBorder, select an existing MasterBorder 
to base it on, and click OK.

NetObjects Fusion creates a new MasterBorder based on the selected 
MasterBorder. The new MasterBorder is applied to the current page, and 
its name is added to the drop-down Name list in the MasterBorder 
Properties palette.

5. From this point, create the MasterBorder by following the steps in 
“Modifying a MasterBorder” on page 6-4.

Type a name for the new MasterBorder.

Select a MasterBorder to base the new one on.
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Changing MasterBorders
1. In Site view or Page view, navigate to a page where you want to apply a 

different MasterBorder, and display the page in Page view.

2. Click inside the MasterBorder area.

The MasterBorder Properties palette appears.

3. Select the MasterBorder you want from the Name drop-down list.

The margins of the page now display the contents of the selected 
MasterBorder.
Applying a MasterBorder to a Section
You can apply a MasterBorder to a section of pages in Site view. A section is any page 

and all its children, their children, and so on. 

1. In Site view, select a section of pages.

● Hold down the Shift key as you click the parent page of the section.

● With the keyboard, select the parent page of the section and then 

press Shift-Enter.

The Properties palette displays the Section tab.

2. Select the MasterBorder you want from the MasterBorder drop-down 
list.

The MasterBorder is applied to all the pages in the section.
Renaming MasterBorders
1. In Page view, click inside the MasterBorder area to display the 

MasterBorder Properties palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want 
to rename and click Rename.

4. In the Rename MasterBorder dialog, type a new name and click OK.
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The new MasterBorder name now appears in the Edit MasterBorder List 
dialog and in the drop-down list in the MasterBorder Properties palette.
Deleting MasterBorders
1. In Page view, click inside the MasterBorder area to display the 

MasterBorder Properties palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want 
to delete and click Delete.

You see a warning that deleting a MasterBorder cannot be undone.

4. If you choose to continue, click OK.

Note: When you delete the MasterBorder that is currently in use, NetObjects Fusion 
resets the page to the ZeroMargins MasterBorder.
Using AutoFrames
An AutoFrame is a special instance of a MasterBorder margin that corresponds to an 

HTML frame. It subdivides the browser window into independent “panes,” each 

displaying its own content—including links, form objects, regions, or any text, 

graphic, or media objects you want. The combination of frames that completes the 

browser window is called a frameset. 

Frames can take on properties not available to standard MasterBorders.
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● The scrolling properties of a frame are independent of other areas of the page. If 
the site visitor scrolls the Layout, the frame doesn’t scroll with it. This makes it 
possible—among other things—to keep navigation buttons in view at all times, 
regardless of where the visitor is in the Layout. Conversely, you can make a frame 
scrollable, so the site visitor can scroll the frame without affecting the Layout.

● You can specify whether the site visitor can resize the frame, making it wider or 
narrower, taller or shorter. This enlarges the visible content area of the frame. It 
has nothing to do with scrolling, which brings another part of the frame into 
view.

● You can specify a background for the frame: the current SiteStyle background, a 
solid color, or even a picture.

● You can define targets for the links contained in one frame so they retrieve 
content into another frame.

NetObjects Fusion supports two ways of creating frames:

● AutoFrames

AutoFrames gives you a graphical interface to set frames and then to add 

navigation controls, banners, text, graphics, links, and scroll bars. This section 

focuses exclusively on AutoFrames.

● Custom frames

NetObjects Fusion gives you direct access to HTML so you can manually code 

frames using the HTML page description language. This method requires 

knowledge of HTML codes and the NetObjects Fusion HTML access interface. If 

you prefer the flexibility of creating frames yourself, refer to Chapter 23, 

“Creating Custom HTML Framesets and Frames.”

Links within a frame can display a page, or display information in the same frame or 

a different frame. Frames can also reduce the amount of refreshing your visitor’s 

browser must do. To learn how you can take advantage of these frame features using 

AutoFrames, see Chapter 24, “Working with AutoFrames.”

Within a frame, you can influence how variations in browser fonts affect your 

design using the Rows and Columns option on the Frame properties tab. These 

options work within a frame the same way they do within a Layout. For more 
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information about selecting a table structure, see “Preserving Your Design 

Intentions” on page 5-2 and “Optimizing Nested Tables Output” on page 5-7.

Note: Although Netscape Navigator and Microsoft Internet Explorer support 
frames, not all browsers do. If you use frames, you might want to consider creating 
an alternate site for visitors with browsers that do not support frames. 
Looking at AutoFrames
The following examples illustrate some characteristics and advantages of frames. 

Here is a generic MasterBorder applied to a site’s Home page.
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As an AutoFrame, the left border now has an outline separating it from the Layout 

and the rest of the border, and a picture appears in the background.

Design your frames so the browser only needs to redraw the content of the Layout 

area when a site visitor uses a link to a child page sharing the same MasterBorder 

and AutoFrame design. See Chapter 23, “Creating Custom HTML Framesets and 

Frames.”
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Adding an AutoFrame
Since NetObjects Fusion applies AutoFrames to the current MasterBorder—and all 

pages that use that MasterBorder—you might want to start by selecting or creating a 

designated “framed” MasterBorder that you can selectively apply to the appropriate 

pages in your site. See “Creating a New MasterBorder” on page 6-6 if you need help 

creating a new MasterBorder. If you want to apply different framesets to different 

pages, you’ll need one MasterBorder for each frameset.

Arrange the content and design of the MasterBorder as you want it to look, and 

apply that MasterBorder to the first page you want to turn into a frameset. As you 

develop this MasterBorder, follow these guidelines:

● Objects in frames can’t straddle frame boundaries, so check the corners of your 
page before you add AutoFrames. For example, if you have a banner across the 
top of the page that overlaps the left and top borders, resize it or move it before 
you turn on AutoFrames for either border.

● Frames have internal margins, so add a little extra room to margins you’re going 
to set as frames, so you don’t get scroll bars when you don’t need them.

● By default, frames are borderless. To add borders, see “Generating HTML Frame 
Borders” on page 6-15.

To set a MasterBorder margin as an AutoFrame:

1. In Page view, click an empty space inside one of the border areas, or in 
the grey area outside the page. 

The MasterBorder Properties palette displays the General tab.

2. Select the AutoFrames tab.

3. Click the button for each margin you want to set as a frame—Left, Right, 
Top, or Bottom.
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NetObjects Fusion indicates a frame is applied by adding a label—Left, Right, Top, 

or Bottom—to the new frame.

If you select more than one border to set as a frame, your selection sequence makes 

a difference. Multiple frames overlap each other in the order in which you select 

them. You can change the overlap sequence by deselecting AutoFrame areas and 

then reselecting them in a different sequence.

In the first example, the left frame was selected, followed by the bottom frame, as 

indicated by the numbers in the AutoFrames tab. As a result, the left frame extends 

the full height of the page.

The left margin is set as an 
AutoFrame.
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In the second example, the bottom frame was selected first, followed by the left 

frame, and the bottom frame extends the full width of the page.

If an object overlaps the frame border when you apply AutoFrames, you see a 

message asking if you want to modify the margins.

● If you click OK, the selected margin enlarges to include the overlapping object.

● If you click Cancel, the creation of AutoFrames is canceled so you can manually 
adjust the margins. You can then apply AutoFrames again.
Generating HTML Frame Borders
Frames have borders by default, and you must leave Generate HTML frame borders 

checked if you want visitors to be able to resize the frame.

You can easily set frames to be borderless in the site visitor’s browser. To do so, clear 

Generate HTML frame borders on the AutoFrames tab of the MasterBorders 

Properties palette. NetObjects Fusion turns off the borders for all frames in that 

MasterBorder.

Note: To combine frames with borders and frames without borders on the same 
page, you must script the frames. See Chapter 23, “Creating Custom HTML 
Framesets and Frames.”
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Setting Frame Properties
The Frame tab in the MasterBorder Properties palette contains visual and 

functional properties that you can set for each frame individually. To view and set 

the properties of a frame, select the frame, click the Frame tab in the MasterBorder 

Properties palette, and follow the appropriate procedure.

You can also assign actions to frames, just like other page objects. See Chapter 21, 

“Building Dynamic Pages,” for information.
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Adding Scroll Bars to Frames
With the User scrollable option on the Frame tab you can specify whether the site 

visitor’s browser displays scroll bars around a specific frame. 

1. In Page view, click the frame and select the Frame tab.

2. Select a User Scrollable option: 

● Yes: The browser always displays vertical and horizontal scroll bars 

in the frame, whether needed or not.

● No: The browser never displays scroll bars, even if needed to display 

all objects in the frame. If the page content is larger than the frame 

itself, site visitors won’t be able to see the entire page.

● Auto: The browser displays scroll bars if the size of the page content 

requires them. Auto is the default setting.

Note: Due to the nature of HTML, links to anchors on a frame will not work if User 
Scrollable is set to No.
Making Frames Resizable
If you want a site visitor to be able to drag the frame border, making the frame 

larger or smaller, you can set the User Resizable Frame option.

1. In Page view, click the frame and select the Frame tab.

2. Select User Resizable Frame if you want site visitors to be able to resize 
the frame.

Note: HTML frame borders must be visible so the site visitor can drag 
them to specify a new size. If User Resizable Frame is not available, 
return to the AutoFrames tab and check the Generate HTML frame 
borders option.
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Setting the Frame Background
You can set the frame’s background to the current SiteStyle background, a solid 

color, or a picture.

1. In Page view, click the frame and select the Frame tab.

2. In the Background section of the Frame properties tab, set the 
background options:

● To use the background color of the current SiteStyle, select SiteStyle 

Background.

● To set the frame background to a different color, select Solid Color. 

If the solid color shown is not the one you want, click the Color 

button, select a color from the Color Picker, and then click OK. The 

selected color fills the frame background.

● To use a picture in the frame background, select Picture. The 

Picture File Open dialog appears. Navigate to and select either an 

image asset already included in the site, or a new image file located 

elsewhere. If the picture is smaller than the frame, it is automatically 

tiled to fill the frame.
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Laying Out the Page 7

You have three options for designing pages and laying out your content:

● You can design your pages by positioning content with pixel-level precision. The 
position-based approach uses Layouts and Layout Regions as content containers 
and preserves your position-based layout by generating pages consisting of either 
HTML or CSS code. 

● You can lay out pages using a text-based approach. With text-based design you 
can preserve the flow of content by embedding objects in text boxes or table cells. 
Text-based page layout generates lean and efficient HTML code that responds 
effectively to variations in browser and font size. If your page design is based on 
rows of content—as in a spreadsheet or other tabular arrangement—you can lay 
out all or part of your page in tables. Each table cell functions as a text box, into 
which you can embed any kind of object.

● You can include hand-coded HTML pages in your NetObjects Fusion site. In the 
HTML-based approach, you incorporate external HTML pages as part of your 
site by referencing them as objects on a page, or the page itself. NetObjects 
Fusion can manage the assets required by the original page. See Chapter 19, 
“Referencing and Editing External HTML,” for information.

No matter which approach you take, you don’t have to worry about differences 

among browsers. NetObjects Fusion publishes your site using Everywhere HTML—

generated HTML that displays correctly in both Microsoft Internet Explorer and 

Netscape Navigator. 

This chapter describes how to use these techniques to lay out the body of your page:

● Creating Layouts, Layout Regions, and text boxes

● Modifying the appearance and properties of each container

● Determining which approach to use for page layout

● Using design priorities to determine page layout method and 

HTML output method
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Using Layouts
The Layout is the default container that makes up the body of the page. It is 

surrounded on all four sides by the MasterBorder. When you publish a page, a single 

HTML file containing all the objects and properties of the MasterBorder and the 

Layout is created. The dimensions of the published page are determined by the 

combined size of the Layout and the MasterBorder. 

When you create a new page, NetObjects Fusion automatically assigns it a default 

Layout. You can also create multiple Layouts, which are an effective way to 

prototype page designs and toggle between sets of content. When you preview or 

publish your site, NetObjects Fusion publishes each page according to the currently 

selected Layout. 
Controlling Layout Appearance
You can control various characteristics of the Layout’s appearance in Page view.

● You can show or hide the MasterBorder by selecting it from the View menu. 
NetObjects Fusion publishes each page with its MasterBorder, whether it is 
visible or not in Page view. See “Modifying and Creating MasterBorders” on 
page 6-3 for information.

● You can show or hide Page view’s visual aids: page labels, object icons and 
outlines, and rulers and guides. You can toggle these on or off by selecting the 
option you want to hide or show from the View menu. Hiding or showing the 
Layout’s visual aids does not have an impact on the published site.

● You can change the Layout margins by dragging the Layout handles. See 
“Changing Layout Size” on page 7-5 for information.
Creating and Selecting Layouts
Each page has a default Layout, defined by the Blank Site template. Each Layout is 

attached to a single page, unlike MasterBorders, which can be applied to any page in 

the site. There’s no connection between Layouts on separate pages. 
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By default, the new Layout is named PagenameLayout, based on the current name of 

the page. For example, when you first add a new page, its page name is Untitled; 

until you rename that page, the default Layout is named UntitledLayout.

You can add multiple Layouts to a page, each with its own properties, design, and 

content. For example, you might use several Layouts so you can prototype or 

publish several versions of the same page. You could also create separate Layouts for 

different versions of your site, such as English, French, media, and text-only. When 

you publish the site, NetObjects Fusion publishes each page using the Layout 

currently selected for that page. 

The name of the currently selected Layout appears in the Layout drop-down list in 

the lower-left corner of Page view. In the example below, BlueLayout is the current 

Layout; if you publish this page, NetObjects Fusion generates this page with that 

Layout’s content.

To create a new Layout for a page:

1. Go to the page in Page view.

2. Select Add from the Layout drop-down list. 

A new, blank Layout appears. Any content on the previous Layout is 
stored with that Layout. 

3. Change the Layout name as needed. See “Renaming a Layout” on 
page 7-4 for information.

4. Add objects to the Layout, and modify the Layout’s properties—such as 
size, background, or HTML output options—as needed. 

To display a different Layout for a page, select it from the Layout drop-down list.

Layout drop-down list
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Renaming a Layout
Each Layout you add to a page is given the name of PagenameLayout. NetObjects 

Fusion does not require Layout names to be unique, but you might find it easier to 

keep track of multiple Layouts if they have meaningful names. 

To rename a Layout:

1. If the Layout currently displayed in Page view is not the one you want to 
rename, select the correct Layout from the Layout drop-down list at the 
bottom left of the NetObjects Fusion window.

2. Click the Layout, or select it from the Object Tree. 

The General tab of the Layout Properties palette appears.

3. Enter a new Layout name in the Name field of the General tab. Use 
letters and numbers only; Layout names cannot have spaces, hyphens, 
underscores, or other special characters, and they cannot begin with a 
number. 

4. Press Enter or click elsewhere on the page.

The name of the Layout changes and the Layout drop-down list is 
updated.

You can also use the Object Tree window to change the name of the Layout. See 

“Locating and Renaming Objects” on page 4-12 for information.
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Changing Layout Size
There are four ways to change the size of a Layout. You can:

● Set its Width and Height properties to specific values on the Layout Properties 
palette.

● Show Rulers and Guides and drag the Layout handles into place at the width and 
height you want.

● Automatically limit the size of the Layout to be no larger than the size required by 
the objects it contains.

Regardless of the method you choose, there are a few guidelines for controlling 

Layout dimensions:

● The minimum allowable size of a Layout is controlled by two things: the location 
and size of any objects placed on the page, and the location and size of any 
objects in the MasterBorder. You can’t make a Layout smaller than the space 
required by its current contents in their current locations. You also can’t make a 
Layout smaller than the space required by the size and location of its 
MasterBorder contents.

● The unit of measurement for Layout dimensions is set on the Page tab of the 
Preferences dialog. To set the unit of measurement, select Preferences from the 
Edit menu. See “Setting Preferences” on page 1-12 for information.

Setting a Specific Layout Size

1. In Page view, click the Layout, or select it from the Object Tree. 

The General tab of the Layout Properties palette appears.

2. Set specific Layout dimensions by entering a number in the Width and 
Height fields. 
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If the number you want is lower than the minimum allowable size, 
NetObjects Fusion displays a message and offers to set the Layout size to 
the minimum allowable size.

Note: Page Width and Height are display-only fields that calculate the 
total dimensions of the page by adding the MasterBorder to the Layout. 
A standard page size is 600 pixels in width; any size over that might force 
site visitors to scroll their browsers left or right to see the entire page.

Sizing a Layout by Dragging

1. In Page view, if rulers are not visible, choose Rulers & Guides from the 
View menu.

2. Click the Layout width handle in the top ruler bar and drag it to the 
Layout width you want. 

NetObjects Fusion displays a tip that reports in pixels the distance of the 
handle from the top left corner of the page. It also adjusts the 
MasterBorder handle as needed to maintain the bottom border height.

3. Click the Layout height handle in the left ruler bar and drag it to the 
Layout height you want. 
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NetObjects Fusion displays a tip that reports in pixels the distance of the 
handle from the top left corner of the page. It also adjusts the 
MasterBorder handle as needed to maintain the bottom border height.

The Layout and MasterBorder maintain a complete rectangle. If you change the 

width of the Layout, the widths of the top and bottom borders expand or shrink as 

needed. If you change the height of the Layout, the heights of the left and right 

borders change as needed. 

Shrinking the Layout Automatically

◆ In Page view, from the Object menu, select Size Layout to Objects.

The Layout height and width are reduced to the minimum size required 
by the MasterBorders and the current size and placement of objects on 
the page.

Note: You can significantly reduce the size of the HTML file NetObjects Fusion 
generates for your page if you shrink the Layout. Your pages can also benefit from 
shrinking the size of the MasterBorder: see “Resizing a MasterBorder” on page 6-5 
for information.

Layout width handle

Layout height handle
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Adding Objects to the Layout
The Layout is the default container for the page, and can contain any object. To add 

objects to a Layout, you can either:

● Select the appropriate tool and create the object directly within the Layout.

● Paste the object into the Layout from the Clipboard.

● Drag and drop any object that you can place with a tool.

For information on adding a specific type of object to the Layout, see the 

appropriate section for that object.
Setting the Layout’s HTML Output Method
You can specify an HTML output method that determines what type of HTML code 

NetObjects Fusion produces for the current Layout. This Layout-specific HTML 

method overrides the method used to publish the site. The site publishing method 

is assigned in the Publish Setup dialog; see “Setting the Site’s HTML Output” on 

page 26-7 for information.

See “Selecting HTML Output” on page 5-3 for descriptions of the HTML output 

options and their effects.

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. In the HTML output section of the General tab, select the HTML output 
method you want from the Use drop-down list:

● Publish Setting generates the Layout using the output method 

specified for the entire site, as assigned in the Publish Setup dialog. 

This is the default output method for a Layout. 
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● Nested Tables uses nested table tagging and other features of the 

3.2 HTML specification. This is the default choice for the Publish 

Setting that controls the HTML output for the whole site.

● Regular Tables uses basic HTML table tagging to deliver your 

design and content for this Layout only. 

● CSS and Layers uses Cascading Style Sheet Positioning code, layers, 

and scripts to position and publish the content of this Layout only.
Setting the Table Formatting Preference for Layouts
If you are using Nested Tables HTML output for this Layout, you can set the table 

formatting preference NetObjects Fusion protects when it publishes the site. This 

setting determines whether the horizontal or vertical relationship between objects 

on this Layout is more important. 

To set the table formatting for the current Layout:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. In the HTML output section of the General tab, select:

● Columns to preserve the vertical relationship between the Layout’s 

objects. This is the default.

● Rows to preserve the horizontal relationship between the Layout’s 

objects.

See “Preserving Your Design Intentions” on page 5-2 for information on 
selecting the table formatting preference.
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3. To preview the impact of your selection on the current size and 
placement of your Layout’s objects, press and hold the Show button.

NetObjects Fusion hides any grid lines, guide lines, and object borders in 
the Layout and displays solid grey lines that show where it is dividing the 
Layout into rows and columns.
Defining the Layout as a Form
To make a page collect data and function as an HTML form, you can use the Form 

Area tool to place multiple forms on a single Layout or MasterBorder, or you can set 

the Layout itself to function as a single form. See “Creating a Form” on page 17-2 

for information on creating multiple forms on a page. 

To set the Layout to function as a single form:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Select Layout is a form.

Note: You cannot set the Layout to function as a form if it contains one 
or more Form Areas. If the Layout is a form option is selected, you 
cannot place another Form Area on the page.

3. To assign the form processing settings to the Layout, click Settings and 
enter your settings in the Form Settings dialog.

See Chapter 17, “Designing and Implementing Forms” for information 
on creating forms and determining form processing settings.
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Adding HTML and Scripts to a Layout
You can also add custom scripts or HTML code to a Layout. When NetObjects 

Fusion publishes the site, it can include your custom scripts or code in three places:

● Between the page’s <HEAD> and </HEAD> tags

● Inside the page’s <BODY> tag

● At the beginning of the page’s body section, before the rest of the page content

To add HTML code or scripts to a Layout:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Click the HTML button.

The Page HTML dialog appears.

3. Enter your HTML or scripts in the text box of the appropriate tab, then 
click OK.

See Chapter 22, “Working with HTML Directly” for a full explanation of custom 

scripting.
Setting Layout Background Properties
You can control the appearance of each Layout by setting its background properties. 

You can assign a background color, place an image in the background, or attach a 

background sound that plays when a visitor views the page. 

Setting the Layout Background Color

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.
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2. Select the Background tab.

3. Select a Background Color option:

SiteStyle sets this Layout background to the default background color 
specified by the current SiteStyle, which you selected in Style view.

Solid Color sets this Layout background to a solid color of your choice. 
The current color appears in the sample box. To select a different color, 
click Color, select a color from the Color Picker, and click OK.

Picture specifies the image file that displays as the background of the 
Layout. The current selection, if there is one, displays in the sample box. 
To select a new or different image, click Browse. In the Picture File Open 
dialog, select the image file you want to use for the background. If the 
picture is smaller than the Layout, the browser automatically tiles the 
image as needed. For more information on using the Picture File Open 
dialog, see “Using Image Assets” on page 10-13.

Adding or Changing a Layout Background Sound

You can assign a sound to play when a site visitor views the page. You can use sound 

files in .au, .aiff, .midi, or .wav formats. The sound can play once, or continuously.

1. In Page view, on the Background tab of the Layout Properties palette, 
select Sound. 

● If a sound file is already selected, its name appears in the sample 

box. To select a different sound file, click Browse.
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The Background Sound dialog appears.

● If there is no previous sound file selection, the Background Sound 

dialog appears.

2. Click Browse to find and select a sound file from your hard disk, 
CD-ROM, or LAN. 

3. To make the sound repeat while the page is open, select Continuous 
Loop.

4. Click OK.

The selected sound plays when you preview the page.

Note: Site visitors must have a sound board, speakers, and a browser that 
supports background sounds installed on their computers to hear 
background sound. To preview and test sounds, your system must also 
be appropriately configured. Some sound formats also require support 
from the Web server. For more information about using sound files on 
various platforms, see “Inserting a Sound File” on page 15-11.
Changing the MasterBorder Selection
Although the MasterBorder is not a property of the Layout, each Layout also records 

the MasterBorder currently applied to it. If you switch between Layouts on the same 

page, each Layout displays the MasterBorder that was last applied to it. 

You cannot change the MasterBorder from the Layout Properties palette; you can 

only change MasterBorders on the MasterBorder Properties palette. See “Changing 

MasterBorders” on page 6-8.
Making Layouts Dynamic
You can make Layouts dynamic by assigning actions to them. For example, you can 

make a Layout’s background change colors when the site visitor’s mouse pointer 

passes over it, or make an alert box display when the site visitor clicks in the Layout. 

You can also make a Layout the target of an action assigned to another object.
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See “Building Dynamic Pages” on page 21-1 for information about making pages 

and objects dynamic, and the procedures for adding actions to Layouts and objects.
Using Layout Regions
A Layout Region is a container that you use to group objects in a defined area on the 

page. Layout Regions are independent page segments that you can place, size, and 

control independently from the rest of the Layout. 

There are four key aspects to using Layout Regions:

● If your page design includes multiple objects, you can group those objects within 
a Layout Region. When you move a Layout Region on the page, all its embedded 
objects move with it and maintain their positions relative to each other and the 
Layout Region. This makes it easier to design, manipulate, and manage multiple 
objects or multiple groups of objects on a page.

You can also send cascading action messages to the Layout Region, and it will 

pass the message to all of objects embedded within it. This makes it easier to 

create and manage groups of objects with similar or related actions, and to use 

actions efficiently. See “Building Dynamic Pages” on page 21-1 for information 

on adding and cascading actions.

● You can embed a Layout Region within a text box. This gives you position-based 
placement of the objects within the Layout Region, while the rest of the page is 
arranged in a text-based layout. The embedded Layout Region can be aligned 
within the text box, just like any other embedded object. 

This combines precise positioning of key content with the efficient HTML output 

of a text-based layout—taking advantage of both alternatives. See “Embedding 

Objects in a Text Box” on page 7-24 for specific information.

● You can assign to a Layout Region a different HTML output method from that 
used for its parent Layout. For example, you can overlap objects within a Layout 
Region set for CSS and Layers output, while the rest of your page or site is 
formatted using Nested Tables. Site visitors with advanced browsers get the 
overlapped effect, without making the rest of your page or site incompatible with 
older browser versions.
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See “Selecting HTML Output” on page 5-3 for an explanation of these HTML 

output methods. See “Setting the Layout Region’s HTML Output” on page 7-17 

for information on assigning an HTML output method to a Layout Region. 

● You can designate a Layout Region as a form and embed form objects within it. 
You can create multiple forms on a single page by placing each form in its own 
Layout Region. See “Defining the Layout Region as a Form” on page 7-19 for 
more information.
Creating Layout Regions

Layout Region tool

1. In Page view, select the Layout Region tool from the Standard toolbar.

2. Draw the Layout Region at the place you want it on the Layout. Nudge 
or drag it into position as needed. To resize the Layout Region, select it, 
then drag its object handles as needed.

3. Embed objects in the Layout Region. 

A Layout Region is an object; you can manipulate it or set its properties like other 

objects. You can:

● Set background properties such as background color or transparency. See 
“Setting Layout Region Background Properties” on page 7-19.

● Align, distribute, arrange, and size Layout Regions in relation to other objects on 
the page. See “Aligning and Distributing Objects” on page 4-14.

● Add HTML scripts to a Layout Region. See “Accessing an Object’s HTML” on 
page 22-6.

If you move the Layout Region, all objects embedded inside move with it and 

maintain their positions within the Layout Region. You can group objects within a 

Layout Region to reposition groups of objects on the page.
Adding Objects to a Layout Region
Like a Layout, a Layout Region can contain any object: text, pictures, media, or even 

other Layout Regions. To add objects to a Layout Region, you can either:

● Select the appropriate tool and create the object directly within the Layout 
Region borders.
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● Drag objects into the Layout Region from elsewhere on the page: 

– To make the Layout Region expand as needed to contain the object, drag the 

top left corner of the object into the Layout Region. 

– When you place or create objects in a Layout Region, the Layout Region 

border changes to a thick outline, indicating the object is contained in the 

Layout Region. 

Embedded Object 
symbol

– When the pointer changes into the embedded object symbol, you can drop the 

object.

You cannot paste an object inside a Layout Region. Once you place objects in a 

Layout Region, you can replace, move, or modify them as needed, just as if they 

were on the Layout.
Displaying the Layout Region Grid and Guides
To make it easier to place objects precisely in the Layout Region, you can display an 

alignment grid that is independent from the grid displayed within the Layout. The 

Layout Region grid always displays in pixels. You can set it to any scale; the default is 

50 percent of the grid for the page. See “Setting Preferences” on page 1-12 for 

information on setting the page grid.

To display and modify the Layout Region grid:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. Select LocalGrid.

3. Set the width and height of the local grid.
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Setting the Layout Region’s HTML Output
You can specify what type of HTML code NetObjects Fusion produces for the 

current Layout Region. The HTML output setting overrides the method NetObjects 

Fusion uses to publish the parent container for the Layout Region.

For example, if the Layout Region is placed on a page’s Layout, you can set its 

HTML output method to override the method used for that Layout, which, in turn, 

can be set to override the site’s publishing method. If you embed Layout Region 

inside another Layout Region, the embedded Layout Region can have an HTML 

output setting that overrides the HTML output produced for the parent Layout 

Region.

See “Selecting HTML Output” on page 5-3 for descriptions of the HTML output 

options and their effects.

To specify the HTML output method that NetObjects Fusion uses to produce this 

Layout Region:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. In the HTML output section of the General tab, select the HTML output 
method you want from the Use drop-down list:

● Parent Setting generates the Layout Region using the output 

method specified for the parent container in which the Layout 

Region is embedded. 

● Nested Tables uses nested table tagging and other features of the 

3.2 HTML specification. Nested Tables is the default choice for the 

Publish Setting that controls the HTML output for the whole site.
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● Regular Tables uses basic HTML table tagging to deliver your 

design and content for this Layout Region only. 

● CSS and Layers uses Cascading Style Sheet Positioning code, layers, 

and scripts to position and publish the content of this Layout 

Region only. 

See “Selecting HTML Output” on page 5-3 for more information on these HTML 

output choices. See “Setting the Site’s HTML Output” on page 26-7 for information 

on setting the Publish Setting property.
Setting the Table Formatting Preference for Layout Regions
If you use Nested Tables as the HTML output method for this Layout Region, you 

can set the table formatting preference NetObjects Fusion protects when it 

publishes the site. This setting determines whether the horizontal or vertical 

relationship between objects in this Layout Region is more important. 

To set the table formatting for the current Layout Region:

1. In Page view, select the Layout Region. 

The General tab of the Layout Region Properties palette appears.

2. In the HTML output section of the General tab, select:

● Columns to preserve the vertical relationship between the Layout 

Region’s objects. This is the default.

● Rows to preserve the horizontal relationship between the Layout 

Region’s objects.

See “Preserving Your Design Intentions” on page 5-2 for information on selecting 

the table formatting preference.
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Defining the Layout Region as a Form
You can define a Layout Region as a form in two ways:

● You can create a new form area and set its container to be a Layout Region. See 
“Creating a Form” on page 17-2 for information on creating new form areas.

● You can set any existing Layout Region to function as a form area.

Using either method, you can place multiple Layout Regions on the same page, and 

have each Layout Region contain its own form objects and function as an 

independent form. To publish forms that are compatible with the broadest range of 

browser versions, use Regular Tables as the HTML output method for Layout 

Regions you define as forms.

To define an existing Layout Region as a form:

1. In Page view, select the Layout Region. 

The General tab of the Layout Region Properties palette appears.

2. Set the HTML output option to Regular Tables in the Use drop-down 
list.

3. Check the Layout Region is a form option.

4. Click Settings to enter your form processing settings for this Layout 
Region in the Form Settings dialog. See Chapter 17, “Designing and 
Implementing Forms” for information on creating forms and 
determining form processing settings.
Setting Layout Region Background Properties
You can control the appearance of each Layout Region by setting the background 

color or placing an image in the background: 

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.
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2. Select the Background tab.

3. Select a Background Color option:

● Transparent makes this Layout Region transparent, so the 

background color or image assigned to the Layout underneath 

shows through.

● Solid Color sets this Layout Region background to a solid color. The 

current color appears in the sample box. To select a different color, 

click Color, select a color from the Color Picker, and click OK.

● Picture specifies the image file that displays as the background of 

the Layout Region. The current selection, if there is one, displays in 

the sample box. To select a new or different image, click Browse to 

display the Picture File Open dialog, and select the image file you 

want for the background. If the picture is smaller than the Layout 

Region, the browser automatically tiles the image as needed. For 

more information on using the Picture File Open dialog, see “Using 

Image Assets” on page 10-13.
Making Layout Regions Dynamic
You can make Layout Regions dynamic by assigning actions to them. For example, 

you can make a Layout Region’s background change colors when the site visitor’s 

mouse pointer passes over it, or make a Layout Region “fly in” to its proper location 

when the page finishes loading in the visitor’s browser.
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You can also make a Layout the target of an action assigned to another object.

See “Building Dynamic Pages” on page 21-1 for a discussion of making pages and 

objects dynamic, and the procedures for adding actions to Layout Regions and 

other objects.
Using Text Boxes
The text box not only serves the basic purpose of holding the words and sentences 

of your text: it also works as a container for other kinds of objects. You can type or 

paste text into a text box—and you can also embed pictures, sound objects, tables, 

and any other object into that text box. When you do so, you are using the text box 

as a layout container for your page’s content.

When you use a text box as a layout container, you do not have pixel-level control 

over embedded objects. For example, you do not insert a picture object in a text 

box, and then drag it to the location you want. Instead, you embed the object at a 

selected point in the text and then adjust its placement using HTML alignment, 

positioning, and text-wrapping choices.

The resulting pages that NetObjects Fusion publishes, however, have extremely lean 

HTML code and load relatively quickly in the site visitor’s browser. 

Additional text box functions not directly related to your use of the text box as a 

page layout method— such as creating and applying styles, formatting text, and 

inserting custom HTML tags — are discussed in Chapter 8, “Designing with Text.”
Sizing a Text Box
When you create or select a text box, you can control four aspects of its size: the 

width and internal margins, the minimum height, and the scaling of the text box to 

the full width of the Layout or the browser window. To size a text box:

Text tool

1. In Page view, either select an existing text box or draw a new text box 
using the Text tool from the Standard toolbar.

The Text Properties palette appears.
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2. Select the Text Box tab if it’s not already shown.

3. To set the margins inside the text box, enter a Text Inset value.

4. To set the width of the text box, select it and drag its object handles to 
stretch or shrink the text box as needed. The text box is always the width 
you set for it, unless you size it to the layout, as described in “Scaling a 
Text Box to the Layout” on page 7-23.

Setting the Text Box Minimum Height

You can set the minimum height of a text box, so no matter how much or how little 

you put into it, the text box will always be at least the specified height. This also 

means the text box never shrinks to a smaller size than specified; that is, it doesn’t 

adjust its height based on the size of the browser display font. 

For example, text displayed on a Macintosh is smaller than text displayed on 

Windows 95 or Windows NT. When a locked text box is viewed in a Macintosh-

based browser, the text takes up less room—but because the text box has a locked-in 

minimum size, the browser has to leave blank space at the bottom of the text box.

The maximum height of the text box—as displayed in the site visitor’s browser—is 

determined by the amount of content within it, and by the browser font size used to 

display any text it contains.

To set the minimum height for a text box:

1. In Page view, select an existing text box, or create a new text box using 
the Text tool from the Standard toolbar.
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2. Select the Text Box tab on the Text Properties palette.

3. Select Lock height on the Text Box tab. 

4. Select the text box and drag its object handles to the minimum height 
you always want the text box to require.

Scaling a Text Box to the Layout

To use a text box as the only layout container on the page:

Text tool

1. In Page view, select an existing text box, or create a new text box using 
the Text tool from the Standard toolbar.

2. Embed all Layout objects in the text box or place them in the 
MasterBorder.

Note: Layout objects left outside the text box will be overlapped by the 
text box when you size it to the Layout. Unless you want this overlap—
and use CSS and Layers HTML output to support it—you must clear the 
Size to Layout option, resize the text box, and embed, move, or remove 
the objects. Then you can reselect the Size to Layout option.

3. Select the text box. 

The Text Properties palette appears.

4. Select the Text Box tab if it’s not already shown.

5. Select Size to Layout. 

The text box expands to fill the Layout. 

Scaling Text Box Contents to the Browser Window

To make your text-based layout as flexible as possible, you can also configure 

NetObjects Fusion to format the content of a text box so it maximizes itself within 

the site visitor’s browser window. To scale a text box’s content to the browser 

window:

1. In Page view, click any visible MasterBorder, or select the MasterBorder 
from the Object Tree.
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The General tab of the MasterBorder Properties palette appears.

2. Using the MasterBorder name drop-down list, select the ZeroMargins 
Master Border. 

This MasterBorder is provided by default with NetObjects Fusion; if it 
has been deleted, you must create a new MasterBorder of your own 
name with no margins. See “Creating a New MasterBorder” on page 6-6 
for information.

3. Select an existing text box, or create a new text box using the Text tool 
from the Standard toolbar.

4. Embed all objects on the Layout into the text box.

5. On the Text Box tab of the Text Properties palette, select both Size to 
Layout and Contents wrap to browser width. 

When you publish this page, NetObjects Fusion generates HTML that 
makes the contents of the text box adjust to the size of the browser 
window.
Embedding Objects in a Text Box
There are three ways to embed objects into a text box. You can:

● Drag-and-drop existing objects into the text box from elsewhere on the page. 

● Create new objects using any object creation tool except the Text tool by drawing 
the new object inside the text box. The Text tool defaults to an insertion point 
inside a text box. To embed a text box within a text box, you must drag-and-drop 
it.

● Insert new objects at the current insertion point, either by pasting or using the 
Insert Object command from the Text menu. 
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No matter which embedding method you use, the insertion point appears within 

the text as a grey vertical bar.

When you embed an object, NetObjects Fusion positions the object in a default 

location within the text box, according to its type:

● Pictures are placed inline at the insertion point.

● Text, tables, sound, video, and other objects are placed one line below the 
insertion point, flush left. 

You can then use the options on the object’s Align tab to arrange that object within 

the text box. If your object is not inline on the text line, NetObjects Fusion displays 

an insertion marker to show the insertion point.

Text box with wide border

Insertion point

Picture Object Draw pointer

Insertion marker

Embedded Image aligned 
with Left Wrap setting
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You can move an embedded object by dragging its insertion point into place. When 

you select the object, the insertion point is displayed, and you can manipulate its 

location as needed. For example, to place the embedded object on the top line of the 

text box, place or move its insertion point before the first character of text. 

Embedding Existing Objects with Drag and Drop

1. In Page view, select the Text tool from the Standard toolbar and create a 
text box.

2. Select an object elsewhere on the page and drag it into the text box.

The text box boundary indicates the object will be embedded.

3. Position the drag-and-drop insertion point at the place in the text where 
you want to insert the object.

4. Drop the object.

5. Position the object within the text box where you want it. See “Aligning 
Objects in a Text Box” on page 7-28 for information.

Insertion Point moved to 
position before the first 
character of text

Embedded Image aligned 
with Left Wrap setting
7-26 Laying Out the Page



U S I N G  T E X T  B O X E S
Creating New Embedded Objects

1. In Page view, select the Text tool from the Standard toolbar and create a 
text box.

2. Select the tool for the object you want to create and embed. 

Note: Because the Text tool defaults to edit mode when you select it and 
click within a text box, you can’t draw a text box inside another text box. 
If you want to embed a text box within a text box, you have to either 
insert the text box using the Object menu, or create it outside the text 
box and then drag it into place.

3. Position the starting point of the object at the position in the text where 
you want to insert the object, then draw its outline.

The Open file dialog appropriate for that type of object appears.

4. Select the object source file that you want to embed and click OK.

5. Position the object within the text box where you want it. See “Aligning 
Objects in a Text Box” on page 7-28 for more information.

Inserting Objects into Text Boxes

1. In Page view, select the Text tool from the Standard toolbar and create a 
text box.

2. To insert a new object, click the insertion point at the position in the text 
where you want to insert the object. 

3. From the Text menu, select Insert, then select the type of object you 
want to insert.

The Open file dialog appropriate for that type of object appears.

4. Select the object source file you want to embed, and click OK.

NetObjects Fusion embeds that object.

5. Position the object within the text box where you want it. See “Aligning 
Objects in a Text Box” on page 7-28 for more information.

You can also use this method to embed an object by pasting:
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6. Copy or cut the object from another page or location.

7. Right-click the insertion point at the position in the text box where you 
want to insert the object. 

8. Select Paste from the shortcut menu.

NetObjects Fusion inserts the object.

9. Position the object within the text box where you want it. See “Aligning 
Objects in a Text Box”  for information.
Aligning Objects in a Text Box
Once you embed an object in a text box, you can position it as needed using the 

options on the Align tab of the Properties palette for the object. The options shown 

for each type of object reflect the alignment attributes supported by HTML.

For example, in HTML coding you can create a horizontal or vertical margin 

around an image: on the Align tab of the Picture Properties palette, you can set a 

horizontal or vertical space around a picture object.

Depending on the type of object you selected, NetObjects Fusion displays some 

combination of the following alignment options. Each option’s icon shows:

● Vertical alignment of the object to the text line: top, middle, or bottom.

● Horizontal alignment of the object to the text box, without text wrapping: left, 
center, or right.

● Horizontal alignment of the object to the text box, with text wrapping: left align 
plus text wrap, and right align plus text wrap. The name refers to the placement 
of the object, not the location of the text wrap. If you want the object to be 
embedded at the top left of the container, move the pointer to the absolute 
beginning of the text in the text box.

● Blank space around the object, in horizontal, vertical, or both dimensions.

Aligning Embedded Objects

1. In a text box in Page view, select an embedded object.

The General tab of the object’s Properties palette appears.
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2. Select the Align tab of the palette. The figure below shows the Align tab 
for a picture object.

3. Select a vertical alignment option as appropriate for the object type.

4. Select a horizontal alignment option that is either wrapped or not 
wrapped, as appropriate for the object type.

5. Enter a spacing value for the object, if appropriate.
Defining the Text Box as a Form
You can set any text box that contains form objects to function as an HTML form, If 

you have form objects in a text box that is not defined as a form, the red exclamation 

point error signal appears in the corner of the form objects.

To define a text box as a form:

1. In Page view, select the text box. 

The General tab of the text box Properties palette appears.

2. Select Text box is a form.

3. Click Settings to enter your form processing settings for this text box in 
the Form Settings dialog.
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See Chapter 17, “Designing and Implementing Forms” for information on creating 

forms and determining form processing settings.

Making Text Boxes Dynamic
You can make text boxes dynamic by adding actions to them. For example, you can 

make a text box display a transition effect such as Wipe or Peek when the site 

visitor’s mouse pointer passes over it, or make the text box “fly in” to its proper 

location when the page finishes loading in the visitor’s browser. You can also make a 

text box the target of an action assigned to another object.

See “Building Dynamic Pages” on page 21-1 for a discussion on making pages and 

objects dynamic, and the procedures for adding actions to text boxes.

You can also add actions to a text link contained within a text box. See “Assigning an 

Action to a Text Link” on page 21-17 for information.
Using Tables for Page Layout
If your page design or page content is tabular, you can use a NetObjects Fusion table 

to control the layout of the entire page. Each cell within the table is a text box, with 

all the attributes and controls of a text box outside the table. You can embed any 

objects within the cell, arrange them using each object’s alignment properties, and 

wrap text around other objects. 

To use a table for your page layout: add a table object, size it by hand to fill the 

Layout, and add content as needed. See “Laying Out the Page” on page 7-1 for 

detailed information on creating and modifying tables.
Using External HTML for Page Layout
You can also lay out your page using hand-coded HTML. You can incorporate 

external HTML pages as part of your site by referencing them as objects on a page, 

or the page itself. NetObjects Fusion makes no changes to the original HTML, but it 

will manage the assets required by the original page if told to do so. See 

“Referencing HTML from Page View” on page 19-4 for information on 

incorporating external HTML pages.
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Selecting Layout Method
There’s no single “best way” to lay out your pages; your circumstances will 

determine which method works best for selected pages. The pros and cons of each 

method are highlighted below.

Text Box Considerations
If efficient, lean HTML pages are more critical to your site visitors than precise 

placement of your content, use a text box for your page layout.

Text Box Advantages

● NetObjects Fusion generates extremely efficient HTML code for your site. HTML 
files are much smaller, which means they load faster, and your site visitors 
experience a more responsive site.

● Text within the text box flows around other embedded objects automatically, so 
you don’t have to create multiple text boxes to achieve a text-wrap effect.

● If the text box is the size of the Layout and you have chosen the ZeroMargins 
MasterBorder, you can set the text box to resize itself to the size of the browser 
window. When your site visitor views the page, it rewraps itself as necessary to fit 
within and fill the browser window.

● You can use any of NetObjects Fusion’s HTML output types: nested tables, 
regular tables, or CSS and Layers.

● You can present tabular or columnar data in a NetObjects Fusion table, each cell 
of which consists of a text box.

Text Box Limitations

● You give up pixel-level control of the layout and design of your page, and use 
alignment choices to control the placement of objects.
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Layout Considerations
If precise placement of your content is more critical to your site visitors than 

efficient, lean pages—or if you have individual pages that you want to publish using 

a specific HTML output method, different from the rest of the site— then use the 

Layout as the container for your page layout.

Layout Advantages

● You have pixel-level control of the layout and design of your page.

● You can drag-and-drop objects into their proper locations with ease.

● You can specify the HTML output type for any individual Layout; this lets you 
isolate any advanced content—which can exclude site visitors who are using 
lower-version browsers—from the rest of your site.

● Layouts support the column or row priority for page formatting; this means your 
pages will adjust more predictably to your site visitor’s font and display 
configuration.

Layout Limitations

Using the Layout as your page container has the following limitations:

● Position-based pages require more HTML code to achieve pixel-level placement 
of content, so your HTML files will be larger.

● Text cannot flow around other objects unless they are embedded in a text box. If 
you want to create the text wrap effect you have to create multiple text boxes.

● You can size the Layout as you see fit, but you cannot set the Layout to wrap to 
the width of your site visitor’s browser. If the browser window is wider than your 
page, the page’s background will fill in; if the window is smaller than your page 
width, your site visitor has to scroll right or left.
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Layout Region Considerations
In some respects, Layout Regions represent a “best of both worlds” option for laying 

out your page. Like Layouts, Layout Regions offer pixel-precise placement and a 

choice of HTML output methods—but they can be embedded in text boxes. So, if 

you need precise placement or specific output for some content, but want 

NetObjects Fusion to generate efficient, lean pages, you can use text boxes as your 

main layout container, and embed Layout Regions for selected content.

Layout Region Advantages

● You have pixel-level control of the layout and design of content within the Layout 
Region.

● You can embed the Layout Region within a text box, which combines the benefits 
of both containers.

● You can specify the HTML output type for any individual Layout Region, so you 
can isolate advanced content that can exclude site visitors who are using lower-
version browsers.

● Layout Regions support the column or row priority for page formatting; this 
means that selected sections of your page, when contained in a Layout Region, 
can adjust more predictably to your site visitor’s font and display configuration.

Layout Region Limitations

● NetObjects Fusion has to generate much more HTML code to achieve pixel-level 
placement of content. Your page files are significantly larger, and download more 
slowly to site visitors.

● Text cannot flow around other objects unless they are embedded in a text box. If 
you want to create the text wrap effect, you have to create multiple text boxes 
within the Layout Region.

● You can size the Layout Region, as you see fit, but you cannot maximize it to the 
full Layout size, nor can you set the Layout Region to wrap to the width of your 
site visitor’s browser. 
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Design Priorities and Method Choices
Use the table to determine which combination of layout methods and HTML 

output methods best supports your site design priorities.

If your priority is... Suggested page layout method Suggested HTML 
output method

Lean, efficient HTML and fast 

browser load time

Text box or page-sized table Nested Tables

Precise placement control for objects Layout and/or Layout Region(s) Nested Tables

Maximizing usability for site visitors 

with older browsers

Text box sized to Layout Regular Tables

Absolute control over minimum text 

box height 

Text box with size locked Nested Tables

Precise placement control for selected 

content, but lean HTML otherwise

Text box for page with embedded 

Layout Region for selected content

Nested Tables

Wrapping text around images and 

other objects

Text box and/or table Nested Tables

Overlapping selected objects Text box for page; overlapped objects in 

Layout Region embedded in the text box

Nested Tables for site; CSS 

and Layers for Layout 

Region containing 

overlapped objects

Wrapping page to varying browser 

sizes

Text box sized to Layout with content 

wrapped to browser

Nested Tables

Drag-and-drop placement of objects 

while designing the page

Layout and/or Layout Region Nested Tables

Horizontal or row-based content 

flow such as spreadsheets or other 

tabular data

Table sized to page Nested Tables

Delivering objects with actions 

or other DHTML effects only to

advanced browsers

Text box and/or table CSS and Layers
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Delivering objects with actions 

or other DHTML effects to greatest 

number of browser versions

Text box for page; objects with actions in 

Layout Region embedded in the text box

Nested Tables for site; 

Regular Tables for Layout 

Region containing objects 

with actions

Using cascading actions Text box for page; embedded Layout 

Regions containing objects with actions, 

grouped for cascading messages

Nested Tables

If your priority is... Suggested page layout method Suggested HTML 
output method
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C H A P T E R  8
Designing with Text 8

When you want to add text to a NetObjects Fusion page, you create a text box, then 

add, edit, and format the text within the box. You can also place objects in a text box 

and wrap text around the objects. Any object you can place on a page you can also 

add to a text box, including sounds, videos, plugins and Java applets, as well as 

pictures and lines.

Using a text box as a container can help reduce the size of your HTML code. See 

Chapter 7, “Laying Out the Page,” for information.

This chapter describes how to design with text. It includes:

● Working with text boxes

● Adding text and symbols

● Applying, creating, and modifying text styles 

● Formatting text

● Wrapping text around objects

● Inserting HTML tags and importing HTML pages

● Creating and editing fields

● Checking spelling

● Finding and replacing text

● Counting words, lines, paragraphs, and characters 
Designing with Text 8-1



W O R K I N G  W I T H  T E X T  B O X E S
Working with Text Boxes
In NetObjects Fusion, a text box is a container into which you can add text and 

embed other types of objects. How you select a text box determines what you can do 

with it.

To select a text box for text editing:

Text and Selection 
tools

◆ Choose the Text tool from the Standard toolbar, then double-click in the 
text box. Or, using the Selection tool, either select the text box and press 
Enter, or double-click in the text box.

To select a text box as an object:

◆ Using the Selection tool, click inside the text box.
Working with a Text Box as a Text Editor
When a text box is a text editor, the handles around the text box are hollow, and 

NetObjects Fusion displays the Format tab, as well as the Text Box and Actions tabs, 

on the Text Properties palette.

Hollow handle
8-2 Designing with Text



W O R K I N G  W I T H  T E X T  B O X E S
When a text box is a text editor, you can:

● Add, edit, and format text.

● Add, edit, and format paragraphs, including creating simple and multi-level 
bulleted and numbered lists.

● Change the appearance of text by selecting font, font size, and font style and 
assigning a color to the text.

● Create text styles so you can replicate and update paragraph formatting easily.

● Insert HTML tags. See “Inserting HTML in a Text Box” on page 22-10 for 
information.

● Import an HTML page.

● Link text to images or other text. See Chapter 14, “Creating Links and Anchors.”
Working With a Text Box as an Object
When the text box is selected as an object, the handles are solid and NetObjects 

Fusion only displays the Text Box and Actions tabs on the Text Properties palette.

Solid handles
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When the text box is an object, you can:

● Cut, copy, and move the text box.

● Place objects in the text box.

● Delete the text box and all its contents.
Adding Text
You add text to a page in one of three ways:

● Using the Text tool

● Dragging and dropping a text file

● Pasting text from the Clipboard

Using the Text Tool

Text tool

1. In Page view, select the Text tool from the Standard toolbar, then draw a 
box on the page.

The text box appears on the page in text edit mode and the Format tab of 
the Text Properties palette appears.

2. Type or paste text in the text box.

Text wraps to the width of the text box. 
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Dragging and Dropping a Text File
◆ In Windows Explorer, locate the text file, select it, then drag and drop it 

onto the page.

The text appears on the page in a text box. The text box is a text editor 
and the Format tab of the Text Properties palette appears. 

Pasting Text from the Clipboard
1. Cut or copy the text from its original source, such as a word processing 

file.

2. In Page view, click where you want to place the text on the page.

3. From the Edit menu, choose Paste.

The text appears on the page in a text box. The text box is a text editor 
and the Format tab of the Text Properties palette appears.
Setting Text Box Properties
1. In Page view double-click in the text box, then click the Text Box tab.

2. Select None to eliminate text box background color, or click Color and 
select a background color from the Color Picker. See “Choosing Colors” 
on page 1-9 for information.

3. If you added a background color to the text box, specify the number of 
units you want to inset the text within the text box. 

Note: Insetting text from the text box boundaries creates a new table in 
HTML.
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4. Select Lock height to keep the text box from contracting to fit with the 
text. This is the recommended setting. Locking the height of a text box 
helps preserve object location when browser-related font changes occur.

5. Select Size to Layout to make the text box the page’s Layout. See “Using 
Text Boxes” on page 7-21.

6. Select Text box is a form and click Settings to make the text box a form. 
See Chapter 17, “Designing and Implementing Forms.”
Applying Text Styles
Text styles are predefined sets of font and paragraph formats. Text styles are a 

convenient way to specify, replicate, and update paragraph formatting. 

1. In Page view, if the text box in which you want to apply Text styles is not 
a text editor, choose the Selection tool and double-click in the text box.

2. Click anywhere in the paragraph you want to format. 

Select multiple consecutive paragraphs if you want to apply the style to 
multiple paragraphs.

3. In the Paragraph section on the Text Properties palette, select the 
appropriate text style from the Style drop-down list.
Formatting Text and Paragraphs
Text normally assumes the font assigned to it by a browser, but NetObjects Fusion 

lets you assign unique fonts to your text. If the specified font is installed on the site 

visitor’s system, HTML 3.x-compatible browsers display it. If the font is not 

installed, the browser checks a substitution table before using its default font. You 

can find the substitution table in NetObjects System\fontmap.txt, and edit it with 

any text editor.

The Text Properties palette contains the options you can use for formatting selected 

characters and whole paragraphs when you want specific formatting for one-time 

use. For repeated formatting of paragraphs, use a text style as explained in 

“Applying Text Styles” on page 8-6. 
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Note: You can format selected characters only in text boxes or table cells. On a 
stacked page, you can format selected characters in formatted text fields, but in 
simple text fields, all characters have the same format. For more information on 
data fields, see Chapter 20, “Data Publishing.”

To format text properties, in Page view, select the Text tool, then double-click in the 

text box in which you want to format text or paragraphs to put the text box in text 

edit mode. 
Formatting Text 
1. In Page view, select the text you want to format.

2. Select a font from the Font drop-down list on the Text Properties palette.

Font style buttons

3. Click a font style button to assign characteristics—bold, italic, 
underline, and strikethrough—to the text. 

Font effects buttons

Click a font effects button to superscript or subscript the text.

4. Select the size you want to assign to the font from the Size drop-down 
list.

5. To assign a color other than the SiteStyle color to the text, click Color 
and select a color from the Color Picker. See “Choosing Colors” on 

page 1-9 for information. 
Formatting Paragraphs
Using the Text Properties palette, you can select left, right, or centered paragraph 

alignment, indent a whole paragraph, or create a simple bulleted or numbered list. 

See “Creating Multi-Leveled Numbered and Bulleted Lists” on page 8-8 for more 

information.
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Note: Due to limitations in HTML standards, you cannot insert a Tab character in a 
text box—for example, to indent the first line of a paragraph. You can only indent a 
whole paragraph. While you are editing a paragraph, Tab and Shift-Tab are 
keyboard shortcuts for indenting and unindenting the paragraph.

To format a paragraph:

1. In Page view, click in the paragraph you want to format. 

2. In the Paragraph section of the Text Properties palette, click the 
appropriate alignment button to align the paragraph.

3. To indent the paragraph, click one of the indent buttons.

4. To use a color other than the SiteStyle color for the paragraph, click 
Color and select a color from the Color Picker.

5. To create a simple numbered or bulleted list, select an option from the 
Bullet drop-down list. 

6. To start a numbered list with a value other than 1 or A, click Start Value, 
enter a number in the Start value field in the Start Value of Numbered 
List dialog, then click OK.
Creating Multi-Leveled Numbered and Bulleted Lists
You can create a bulleted or numbered list with multiple levels. For example, you 

can create a bulleted list that contains subordinate bullets.

● This is an example of a level 1 bullet.

– This is an example of a level 2 bullet.

– This is an example of a level 3 bullet.

You can also create a numbered list that has subordinate paragraphs within the list:

● This is an example of the first level in a multi-level numbered list.

– This is an example of the second level in a multi-level numbered list.

● This an example of the first level in a multi-level numbered list.
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To create a multi-leveled numbered or bulleted list:

1. In Page view, double-click in the text box, then type the text you want to 
include in the list. Make each item in the list a separate paragraph.

2. Click in the first paragraph of the list, then select a list type from the 
Bullet drop-down list. If you select a numbered list and want to start the 
list with a value other than 1 or A, click Start Value and enter a number 
in the Start Value of Numbered List dialog. Then click OK.

3. If you want this paragraph to be indented, click the right indent arrow.

4. Select the paragraph or paragraphs you want to make subordinate to the 
one you selected in the previous step. 

5. Use the right indent arrow to indent the subordinate paragraph so it is to 
the right of the superior paragraph. Then select a list type from the 
Bullet drop-down list.

6. Select the next paragraph you want to be a superior paragraph. Indent it 
to the same level as the paragraph you formatted in step 2. 

The paragraph adapts the list style you selected in step 2 to the current 
paragraph. If you selected a numbered list style, the paragraph is 
numbered sequentially. For example, if you selected a roman numeral 
list style starting at 1 in step 2, the current paragraph is numbered “II.”
Creating and Modifying Text Styles
You can create your own text styles and add them to the Styles list or modify the 

default text styles included with NetObjects Fusion. 

Text styles can be based on other text styles. For example, if you create text styles for 

headings, you could specify the formatting for the H1 style, then create an H2 text 

style that is based on H1. You would only have to specify formatting that differs 

from H1; for example, the font size or style.

Creating a Text Style
1. In Page view, from the Text menu, choose Edit Text Styles.
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The Text Styles dialog appears.

2. Click New.

The New Style dialog appears.

3. Enter a name for the new text style and if you like, select a text style on 
which to base this new style from the Based on drop-down list. 

4. From the Following Paragraph drop-down list, select the text style you 
want to appear automatically after the style you are creating. Leave it 
blank if you want the following paragraph to be the same style as the one 
you are creating. 

5. Click Paragraph to modify paragraph settings. 
8-10 Designing with Text



C R E A T I N G  A N D  M O D I F Y I N G  T E X T  S T Y L E S
The Paragraph dialog appears. Set the options you want:

● Specify the number of units you want to indent the paragraph in the 

Indent Level section.

● If you are creating a text style for a list, either select a bullet type or a 

numbered list option from the Bullet list.

● To start a numbered list with a value other than 1 or A, click Start 

Value and enter a number in the Start value field in the Start Value 

of Numbered List dialog. Then click OK.

● Specify how you want the paragraph to be aligned by selecting an 

option in the Alignment section.

Click OK in the Paragraph dialog. 

6. In the New Style dialog, click Font to select another font or modify the 
size, style, effect, or color of the font. If you don’t want to modify the 
font, skip to step 8.

The Font - [style name] dialog appears.

● Select the font, font style, and size you want to specify for the text 

style. The font size numbers represent size relative to your site 

visitor’s default browser font size. 

● In the Effects section, click the check box for the effect or effects you 

want to specify for the style. 

● To assign a color other than the SiteStyle color to the text, click 

Color, select a color from the Color Picker, and click OK.

Click OK in the Font dialog.

The changes appear in the Preview and Description sections of the New 
Style - [style name] dialog.

7. In the New Style dialog, click OK.

The new style is added to the Styles list of the Text Styles dialog.

8. Click Close.
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Modifying Styles
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Select the style you want to modify, then click Change. 

The Change Style - [format name] dialog appears.

3. In the Change Style dialog, you can change any of the options assigned 
to the paragraph. 

For information on this dialog, see “Creating a Text Style” on page 8-9. 

4. When you are finished, click OK in the Change Style dialog.

5. In the Text Styles dialog, click Close.

NetObjects Fusion updates any paragraph to which you applied the style 
with the new description.
Modifying Styles by Example
You can also modify a text style by formatting a paragraph then reapplying the style. 

1. In Page view, select a paragraph that is in the style you want to modify, 
so the style name is selected in the Style list on the Text Properties 
palette.

2. Select the text and use the Properties palette to change it to the font, size, 
style, color, and alignment you want.

3. Now select the style again from the Style list.

The Reapply Style dialog appears, showing the name of the selected style.

4. Select Redefine the style using the selection as an example and click OK.
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Note: If you select Reapply the formatting of the style to the paragraph, you lose all 
your changes and the paragraph returns to its original settings for that style.

The selected style now has the changed format, and all paragraphs with that style 

are updated.
Inserting Symbols
You can insert special symbols, such as an em dash, copyright symbol, registered 

trademark symbol, and so on.

1. In Page view, if necessary, double-click inside a text box to put it in text 
edit mode.

2. Click where you want to insert the symbol. 

3. Select Insert Symbol from the Text menu.

4. Select the symbol you want to insert from the Insert Symbol dialog, then 
click Insert.

The symbol appears in the text. 
Wrapping Text around Objects
You can wrap text around objects by embedding the object in a text box. 

Text tool

1. In Page view, select the Text tool from the Standard toolbar and draw a 
box on the page.

2. Select the appropriate tool from the Standard toolbar and embed the 
object in a text box.

See “Embedding Objects in a Text Box” on page 7-24 for information. 
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The Picture Properties palette appears.

3. Click Align.

The Align tab appears.

4. Set the wrap options you want.

● In the Alignment section, select the appropriate wrap option. If you 

select Left wrap, the text wraps around the right side of the object; if 

you select Right wrap, the text wraps around the left side of the 

object.

● In the Space around object section, specify the amount of space you 

want to leave between the image and the text.

5. Enter the text. 
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The text wraps around the object according to your specifications. For 
example:
Setting Paragraphs to Clear Wrapped Objects
You can force the paragraph that follows a wrapped paragraph to clear the wrapped 

object.

Text tool

1. In Page view, select the Text tool from the Standard toolbar and draw a 
box on the page.

2. Select the appropriate tool from the Standard toolbar and embed the 
object in a text box. Specify how you want the text to wrap around the 
object in the Align tab on the Picture Properties palette.

3. Enter the text and press Enter. 

To embed another object, continue to step 4. Otherwise, skip to step 5. 

4. If you want, embed another object and specify how you want the text to 
wrap around it. Enter the text, and then press Enter.

5. In the Paragraph section of the Format tab of the Text Properties tab, do 
one of the following:

● Select the Left check box to restart the text at the first left margin 

that is clear of a picture. 

● Select the Right check box to restart the text at the first right margin 

that is clear of a picture.

● Select both check boxes to restart the text when both the left and 

right margins are clear of a picture.
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The following is an example of how a paragraph following a 
wrapped paragraph looks when it is set to appear when the left 
and right margins are clear of pictures.
Creating and Editing Fields
NetObjects Fusion provides a list of fields you can include on your pages, such as 

the date and time the site was created or last modified, the site name and author, 

and so on. You can also define your own fields to include on your pages.

Inserting a NetObjects Fusion Defined Field
1. In Page view, double-click in the text box, then put the pointer where 

you want to insert the field.

2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select the type of field you want to insert from the Type drop-down list.

If you select Date & Time, select a date format by clicking Date Format. 
Then select a format from the list displayed in the Date Format dialog. 
Click OK.

4. Click OK in the Insert Field dialog.

Creating a User-Defined Variable
A user-defined variable is text or a phrase that is subject to change. For example, 

you might refer to a product in development that has only a code name. The name 

appears on many pages in your site. By creating a user-defined variable, you can 
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insert the product name as a field. When the product name changes, you can edit 

the field as described in “Editing a Variable” on page 25-13. Then NetObjects 

Fusion automatically updates all the instances of the name in your site. 

1. In Page view, double-click in the text box where you want to insert a 
user-defined variable.
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2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select User defined Variable from the Type drop-down list.

4. Click New.

The New Variable dialog appears.

5. Type a name and value for the field and click OK.

The field appears highlighted in the Field list of the Insert Field dialog. 

6. Click OK.

Formatting a Date & Time Field
1. In Page view, click the Date & Time field.

2. From the Text menu, choose Edit Field.

The Edit Field dialog appears.

3. Click Date Format on the Edit Field dialog, then select a new format 
from the Select format list. Click OK in the Date Format dialog. 

4. Click OK in the Edit Field dialog.
Checking Spelling
You can check the spelling of English language words using the spelling checker that 

is included with NetObjects Fusion. You can add words to a personal dictionary so 

they will no longer be flagged as misspelled. Your personal dictionary is a simple 

text file, so you can use any text editor to add or delete words.

The spelling checker checks one page at a time. 

1. In Page view, choose the text you want to check.

● To check all text boxes and tables on the page, select nothing.

● To check a particular block of text or an individual word, select it.

2. From the Edit menu, choose Spell Check.
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If NetObjects Fusion does not recognize the word, it displays the word in 
the Change To field of the Spelling dialog.

3. Choose to correct the selected word, ignore it, or add it to your 
dictionary. Click:

● Ignore to skip this instance of the word.

● Ignore All to skip all instances on this page.

● Change to replace this instance.

● Change All to replace all instances on this page.

● Add to put the word in your personal dictionary. 

● Suggest to see alternate spellings for the word in the Change to field. 

You can replace a misspelled word with a suggestion by double-

clicking the suggestion.

● Options to choose U.S. or UK English, and to choose a location for 

your personal dictionary.

● Close to cancel the spelling check.

Finding Text
1. In Page view, choose Find from the Edit menu.

2. In the Find what field on the Find dialog, type the word, letters, or 
phrase you want to find and select any options you want to use to 
narrow your search.

3. Click Find Next.
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Replacing Text
1. In Page view, from the Edit menu, choose Replace.

2. In the Find what field on the Replace dialog, type the text you want to 
replace.

3. In the Replace with field on the Replace dialog, type the replacement 
text.

4. Select any options you want to use to narrow your search.

5. Click Find Next to find the next instance of the text you want to replace, 
then click Replace to replace it, or click Replace All to replace all 
instances of the found text with the replacement text.
Counting Words, Lines, and Paragraphs
◆ To get a word count for the current page, in Page view, choose Word 

Count from the Edit menu. 

◆ To get a word count for a section of text, highlight the text, then choose 
Word Count from the Edit menu.

The Page Word Count dialog appears displaying a list of word, line, 
paragraph and character counts. If your text box includes embedded 
objects, the line count is incremented for each embedded object.
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Adding Tables 9

When you want to add a table to a page, place the table, define its appearance, then 

add text in table cells, which are text boxes. You can embed objects in table cells as 

you would in text boxes.

This chapter includes information about:

● Adding tables to your pages

● Selecting a table, a table cell, and a text box in a table cell

● Adding text and pictures to tables

● Modifying a table’s appearance
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Working with Tables
Presenting information in tabular form is often an effective way to convey complex 

concepts and ideas. NetObjects Fusion makes it easy to add tables to a site. 

Table cells are text boxes in which you can add text and embed objects. In table cells 

you can:

● Add text by typing or pasting it.

● Format text using text styles or by selecting individual paragraphs and words and 
specifying paragraph alignment, font, font size, and font style and effect.

● Embed objects in a table cell. See “Embedding Objects in a Text Box” on 
page 7-24 for information. 

● Wrap text around objects. See “Wrapping Text around Objects” on page 8-13 for 
information.

● Create a form. See Chapter 17, “Designing and Implementing Forms,” for 
information. 

The following is an example of a table with text and embedded objects.

.
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Adding a Table
When you add a table to a page, you place it, specify the number of rows and 

columns, and define its appearance. 

Table tool

1. In Page view, choose the Table tool from the Standard toolbar, then draw 
a box where you want the table to appear on the page.

The Table dialog appears.

2. Select the number of columns and rows you want, then click OK.

The table appears on the page and NetObjects Fusion displays the Table 
Properties palette.

3. In the Cell section of the General tab, define the appearance of the table. 
Specify:

● The size of the border surrounding the table. 

● The padding: the amount of space you want to leave between the 

contents of a table cell and the cell boundaries.

● The distance between cells.
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4. To modify the cell’s background color, click the Background tab, then 
click Color, select a color from the Color Picker, and click OK.

Borders

Cell spacing

Cell padding
Selecting a Table

Selection tool

◆ In Page view, select the Selection tool from the Standard toolbar, then 
click the table.

Solid handles appear around the table. With the table selected you can:

● Move the table on the page.

● Delete the table.

● Insert a row at the bottom of the table or delete the last row.

● Add a rightmost column to the table or delete the rightmost 

column.

● Resize columns and rows.
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Selecting a Table Cell
◆ In Page view, select the Selection tool from the Standard toolbar, then 

double-click the table cell.

Cross-hatching appears around the selected cell and dotted lines appear 
around the text box. 

With the table cell selected, you can:

● Add and format text.

● Specify text box properties.

● Insert objects.

● Wrap text around objects.

● Insert a row beneath the currently selected cell or delete the selected 

row.

● Insert a column to the right of the currently selected cell or delete 

the selected column.

Cross hatching 
indicates the 
cell is selected.

Dotted line defines 
the boundary of 
text box.
Selecting a Text Box in a Cell
1. In Page view, select the table cell.

2. Click the boundary of the text box.

Solid handles appear around the text box. With the text box selected you 
can:

● Delete its contents.

● Specify text box properties.
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Making a Table Cell a Form
1. In Page view, double-click in the table cell.

The Text Properties palette appears.

2. On the Text Box tab, select the Text box is a form option. 

See Chapter 17, “Designing and Implementing Forms,” for instructions.
Adding Text and Objects to a Table Cell
1. In Page view, select the cell.

2. Type or paste text in the cell and format the text.

The Text Properties palette appears. Text automatically wraps to fit the 
column size of the cell; the cell expands vertically to accommodate the 
text. See “Formatting Text and Paragraphs” on page 8-6 for information.

3. Embed objects and align them in the cell.

For example, center a picture using options on its Align tab. See 
“Embedding Objects in a Text Box” on page 7-24 for information. 
Modifying a Table
You can modify a table by changing the cell properties, adding and removing rows 

and columns, and resizing rows and columns.

Modifying Cell Properties
1. In Page view, select the table.

The Table Properties palette appears.

2. In the Cell section of the General tab, adjust the border size, padding 
between the cell boundary and cell contents, and spacing between cells.

3. To modify the cell’s background color, select the Background tab, then 
click Color, select a color from the Color Picker, and click OK. 
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Modifying a Cell’s Text Box Properties
1. In Page view, select the cell.

The Text Properties palette appears. 

2. Click the text box boundary.

Solid handles appear around the text box and the Text Properties palette 
displays the Text Box tab and the Action tab.

3. Modify Text Box properties. See “Working With a Text Box as an Object” 
on page 8-3.
Resizing Columns and Rows
1. In Page view, select the table. 

2. Point to the column or row you want to resize.

The pointer changes to a horizontal arrow.

3. Click and drag the cell boundary to the new size.
Inserting a Row
1. In Page view, select the item above where you want the row to be 

inserted.

● To insert a row at the bottom of the table, select the table. 

● To insert a row between two existing rows, select a cell in the row 

you want to be on top of the row you’re inserting. 

2. From the Object menu, choose Table, Add Row.
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Removing a Row
1. In Page view, select where you want to delete the row.

● To remove the last row in a table, select the table.

● To remove a row from between two existing rows, double-click a cell 

in the row that you want to remove. 

2. From the Object menu, choose Table, Remove Row.
Inserting a Column 
1. In Page view, select where you want to insert the column.

● To insert a rightmost column to your table, select the table. 

● To insert a column between two existing columns, double-click a 

cell in the column to the left of where you want to add the new 

column.

2. From the Object menu, choose Table, Add Column.
Removing a Column
1. In Page view, select the column you want to remove.

● To remove the rightmost column, select the table.

● To remove a column from between two columns, double-click a cell 

in the column you want to remove. 

2. From the Object menu, choose Table, Remove Column.
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Placing Pictures 10

Pictures are essential building blocks for any page design. This chapter describes 

how to add pictures to your site, then modify them. It includes:

● Adding a picture

● Resizing a picture

● Cropping a picture

● Tiling a picture

● Rotating a picture

● Creating a border around a picture

● Creating a transparent GIF

● Moving and copying pictures

● Adding text to a picture

● Using image assets
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Choosing an Image Format
To display a picture, most browsers require that the picture is stored in a Web-

standard format. When you place an image on a page, NetObjects Fusion offers the 

following standard formats:

● Joint Photographic Experts Group (.jpeg, .jpg) supports 24-bit true color.

● Graphics Interchange Format (.gif) supports 8-bit, 256-color images. NetObjects 
Fusion also supports GIF 89, a format for transparency, interlacing, and 
animation. If your .gif is interlaced or transparent, NetObjects Fusion parses this 
information.

NetObjects Fusion also supports animated .gifs. An animated .gif file contains 

multiple images that a browser plays in sequence. It adds movement to your 

pages without requiring browser plugins. You use a .gif animation program to 

create an animated .gif image and place it as you would any .gif.

● Portable Network Graphics (.png) supports any color-depth image. Web 
browsers require a plugin called PNGLive to view the image.

NetObjects Fusion includes sample pictures in the NetObjects Fusion 

3.0\Samples\Content\Images folder. When you place a picture, NetObjects 

Fusion offers to convert image files that are not in a Web-standard format, such as 

Photoshop, .bmp, and so on, to either .png or .jpg format. 

Use the Picture tool to place Flashpix (.fpx) images in a Layout in Windows NT 

only. Use the Media Plug-in tool, as described in “Inserting Other Types of Files” on 

page 15-14, to place an .fpx image in either Windows 95 or Windows NT.
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Adding Pictures

Picture tool

1. In Page view, choose the Picture tool from the Standard toolbar, and 
draw a box where you want to place the picture. 

The Picture File Open dialog appears.

2. Select the image file you want from your hard disk, CD-ROM, or LAN. 

NetObjects Fusion provides filters so you can view only the type of file 
you want to place. The filters are listed in the File of type drop-down list. 
You can select:

● Web images, to view all image files that can be viewed using a Web 

browser, including .gif, .jpeg, .jpg, and .png.

● All images, to view all files that are image files.

● Unique images, to view image files by a single file type, such as all 

.gifs or all .jpegs.

You can also drag and drop an image file directly onto a NetObjects 
Fusion page from your desktop or the Windows Explorer.

3. Select the Show thumbnail image option to preview your image before 
you add it to the page. 

A thumbnail preview of the selected picture appears on the right side of 
the dialog.

4. Click Open to place the image in the box.

Show thumbnail 
image check box
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If you select a non-standard Web format, the following dialog appears. 

● If you convert to .gif, NetObjects Fusion reduces the image to 256 

colors.

● If you convert to .jpeg, NetObjects Fusion retains the color 

information of the original file.

● If you choose not to convert, NetObjects Fusion positions the image 

in HTML using the <EMBED> tag. This means only those browsers 

that have the appropriate plugin installed can view the image.

5. Choose the appropriate conversion format and click OK.

If you choose an image in Web-standard format, the picture appears 
where you drew the box. The box snaps to fit the placed picture. The 
Picture Properties palette also appears.
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6. Type a description of the picture in the AltTag field.

Note: The alt tag is not linked if the picture is an image map. See 
“Creating an Imagemap” on page 14-13 for information.

For information on how to manipulate the picture, see “Modifying a Picture.” To 

place additional instances of a picture, see “Using Image Assets” on page 10-13.

You can also place an image by dragging and dropping it from the desktop or the 

Windows Explorer.

Note: When you use drag-and-drop to place a picture that is not in .gif or .jpeg 
format, NetObjects Fusion positions it in HTML using the <EMBED> tag instead 
of the <IMAGE> tag. 
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Modifying a Picture
Once you place a picture you can:

● Resize, crop, tile, or rotate it

● Add a border around it

● Change its transparency (.gif files only)

● Move or copy it

● Add text to it
Resizing a Picture
1. In Page view, select the picture you want to resize.

The Picture Properties palette appears.

2. Set the picture’s Display property to Stretch.

3. Drag any handle until the picture is the size you want.

To size the picture proportionally, hold down the Ctrl key as you drag. 

4. To return the picture to its original size, do either of the following: 

● From the Object or shortcut menu, choose Restore Original Size.

● Select Normal in the Picture Properties palette.
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Cropping a Picture
You can crop a picture to make only a part of it visible. When you crop a picture, 

NetObjects Fusion creates a new image file that contains just the visible portion of 

the image. It does not change your original image file.

1. In Page view, select the picture you want to crop.

The Picture Properties palette appears.

2. In the Display area on the Picture Properties palette, select Normal.

When Normal is selected, you cannot make a picture larger than its 
original size.

3. Drag the lower-right handle, reducing the size of the box to crop the 
picture. To crop proportionally, hold down Ctrl as you drag.
Tiling a Picture
You can create multiple instances of the picture within the box by tiling it. When 

you tile a picture, NetObjects Fusion creates a new image file that contains the tiled 

image. It does not change your original image file.

1. In Page view, select the picture you want to tile.

The Picture Properties palette appears.
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2. In the Display section of the Picture Properties palette, select Tile.

NetObjects Fusion displays multiple images of the picture in the box. 
The images are the size of the picture as it is in the source file.

3. Drag any handle to display more or fewer tiled images.
Rotating a Picture
After you place a picture, you can rotate it in 90-degree increments. When you 

rotate a picture, NetObjects Fusion creates a new image file that contains the rotated 

image. It does not change your original image file.

1. In Page view, select the picture you want to rotate.

The Picture Properties palette appears.

2. Select the Effects tab.
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3. In the Rotate field, select the desired rotation.
Creating a Border Around a Picture
You can add a border of a specified thickness around a picture. 

1. In Page view, select the picture for which you want to create a border.

The Picture Properties palette appears.

2. Select the Effects tab.

3. Use the Border field to specify the thickness of the border.
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Creating a Transparent GIF
When you place a .gif image on a page, you can select one of its colors and make 

every pixel of that color transparent. Browsers display all pixels in the image except 

pixels marked transparent. Although only part of the image becomes transparent, a 

.gif with a transparent color is called a transparent .gif. You can use transparent .gifs 

to achieve a natural image shape rather than a rectangular one, or to silhouette an 

image against the page background.

Only pixels of exactly the same color can be transparent. If the image background 

color is dithered, it might contain a mixture of different shades to approximate a 

color. An image without dithering in the background works best.

Note: Transparency only works with .gifs. You cannot set a transparency for a .jpeg 
or other image file format.

To create a transparent .gif:

1. In Page view, select the picture for which you want to create a 
transparent .gif.

The Picture Properties palette appears.

2. Select the Effects tab.
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3. Click the Transparency dropper, then click the color in the picture that 
you want to make transparent.

The Use Color check box is selected, and NetObjects Fusion displays the 
color you selected in the box next to it. 

4. To make a transparent color opaque, clear the Use Color check box.

Transparency dropper
Moving or Copying Pictures
You can move or copy pictures from layout to layout in Page view using the Cut, 

Copy, and Paste commands on the Edit menu, or by using the shortcut menu. You 

can also copy a picture by holding down Ctrl while you drag.

To move or copy a picture onto a different layout:

1. In Page view, select the picture you want to move or copy.

2. From the Edit menu, choose Cut or Copy.

3. Locate the target layout.

The target layout can be on another page or it can be a different layout 
on the same page.

4. From the Edit menu, choose Paste.

NetObjects Fusion pastes the picture into the new layout. 

5. Reposition the picture, as necessary.
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Note: o specify the position of an object before you paste it, cut or copy the object, 
click the page, and then paste the object. The upper-left corner of the pasted object 
appears at the point where you clicked the page.
Adding Text to a Picture
You can add text to a picture and format its font, size, and alignment. The text you 

add becomes part of a new image file when you publish the page containing the 

picture. Your original file is unchanged.

1. In Page view, select the picture to which you want to add text.

The Picture Properties palette appears.

2. Select the Effects tab.

3. In the Text in element section of the Effects tab, select Enable, and click 
Settings.

The Text in Element Settings dialog appears.

4. Replace the highlighted text with the text you want to add. Press Enter to 
type additional lines of text.
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5. Click Set for the Font to open the Font dialog.

6. Select the font, its style and size, and then click OK.

7. Click Set for the colors in the Text in Element Settings dialog to open the 
Color Picker.

8. Select the color you want to apply to the text.

See “Choosing Colors” on page 1-9 for information. 

9. In the Text in Element Settings dialog, select the Relative Alignment, 
Horizontal Position, and Vertical Position for the text.

The Relative Alignment left-aligns, centers, or right-aligns two or more 
lines of text. It has no effect on single lines of text.

The Horizontal Position and Vertical Position settings place the text 
block within the picture box.

For example, if you set the Relative Alignment to Left, the Horizontal 
Position to Center, and the Vertical Position to Bottom, NetObjects 
Fusion left-aligns the block of text and places it in the bottom center of 
the box.

10. In the Orientation area, move the slider to rotate the text.

Select Right angles to limit the text rotation to 90-degree increments.

11. Click Close to apply the text settings to the picture’s text.
Using Image Assets
By treating image files as assets, NetObjects Fusion provides you with a convenient 

way to replace or update multiple instances of an image. Using Image Assets can 

also reduce the number of image files included in your site. Instead of adding 

multiple copies of an image file in several locations, you add the image asset once 

and then select from the list of existing image assets when you want to place another 

instance of the picture.

When you export a template, NetObjects Fusion copies your image file assets from 

wherever they are located on your hard disk to an Assets folder within your 

template folder.
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Whenever you place a picture on the page, as described on page 10-3, you add a file 

asset. You can also add image file assets in Assets view. See “Adding File Assets” on 

page 25-4. 

To place an image asset:

Picture tool

1. In Page view, choose the Picture tool from the Standard toolbar and 
draw a box to specify where you want to place the picture on the page.

The Picture File Open dialog appears with the Folder tab on top.

2. Click the Image Assets tab to see a list of current assets.

3. Select the Show thumbnail image option to preview the picture before 
adding it to the page. 

4. Select the asset you want to place and click Open.

NetObjects Fusion places the image in its box and opens the Picture Properties 

palette. You can replace all instances of this picture in your site using a single 

command in Assets view, as described in “Replacing File Assets” on page 25-6.

Show thumbnail 
image check box

Image Assets tab 
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Editing a Picture
In Page view or Asset view, you can open a picture in the editor you have set up for 

the image’s file type. For information on how to set up this feature, see “Editing 

Objects and Assets” on page 1-18.

1. In Page view, select the picture and, from the Object menu, choose Open 
Object.

NetObjects Fusion opens the picture in the editor you specified for the 
file type. Edit and save the picture according to the editor’s features.

2. To see the changes in Page view, right-click the picture and choose 
Restore Original Size from the shortcut menu.
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Drawing Shapes and Lines 11

In addition to pictures, shapes and lines are essential building blocks for any page 

design. You can draw rectangles, rounded rectangles, ellipses, and polygons, as well 

as HTML horizontal rules, lines, or SiteStyle lines. You can select colors for a shape’s 

fill and border, add text to shapes, select a color for lines, or place a line picture from 

the SiteStyle you use for your site.

This chapter describes how to add drawn shapes and lines to your site and then 

modify them. It includes:

● Drawing shapes

● Adding text to a shape

● Adding lines

● Drawing horizontal rules 

● Drawing lines and arrows

● Editing lines and arrows
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Drawing Shapes
To draw an ellipse, rectangle, rounded rectangle, or polygon:

Rectangle tool

1. In Page view, select the Draw tool on the Standard toolbar, and select the 
shape you want to add from the flyout.

2. Draw the shape on the page.

● To draw a polygon, click to set the start point, click to set each 

subsequent point, and double-click to complete the shape.

● When you draw a rounded rectangle, NetObjects Fusion supplies 

one extra handle inside the object. Use this handle to edit the degree 

of curve on the corners.

The Properties palette for the shape you selected appears. For example:

3. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 4-10 for information.

Extra handle to modify curve
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4. In the Line width box, set the shape outline thickness.

To make the outline invisible, set it to zero.

5. In the Color section of the Properties palette, click the Color button for 
Fill.

6. In the Color Picker, choose the color you want to use for the shape fill 
color and click OK. 

See “Choosing Colors” on page 1-9 for information. 

7. Click the Color button for Line, select the color you want to assign to the 
shape border in the Color Picker, and click OK.

8. To adjust the shape or size of the drawing, drag its handles.

● To change the shape proportionally, drag a handle while holding 

down Ctrl.

● To vary the curve of a rounded rectangle, select it, place the pointer 

over the inside corner handle until it changes to a four-headed 

arrow, then drag toward the inside or outside until you have the 

desired curve.

● To edit the lines of a polygon, select it, place the pointer over any 

handle until you see the four-headed arrow, then drag the handle to 

adjust the shape.

● To create hotspots, see “Creating an Imagemap” on page 14-13.

When you publish a page with shapes, NetObjects Fusion generates each shape as a 

.gif file.
Adding Text to a Shape
You can add text to a shape and format its font, size, and alignment. The text you 

add becomes part of a new image file when the page containing the shape is 

published. Because the text is part of the image, your site visitor’s browser can 

display it even if the font you chose is not installed.
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To add text to a shape:

1. In Page view, select the shape to which you want to add text.

The shape’s Properties palette appears.

2. On the General tab, under Text in element, select Enable and click 
Settings.

The Text in Element Settings dialog appears

3. Replace the highlighted text with the text you want to add.

.
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4. Click the Set button for fonts to open the Font dialog.

5. Select the font, its style and size, and click OK.

6. In the Text in Element Settings box, click the Set button for colors.

7. In the Color Picker, select the color you want to apply to the text, and 
click OK.

See “Choosing Colors” on page 1-9 for information. 

8. In the Text in Element Settings dialog, select the Relative Alignment, 
Horizontal Position, and Vertical Position for the text.

The Relative Alignment left-aligns, centers, or right-aligns two or more 
lines of text. It has no effect on single lines of text.

The Horizontal Position and Vertical Position settings place the text 
block within the shape’s rectangular frame.

For example, if you set the Relative Alignment to Left, the Horizontal 
Position to Center, and the Vertical Position to Bottom, NetObjects 
Fusion left-aligns the block of text and places it in the bottom center of 
the frame.

9. In the Orientation section, move the slider to rotate the text.

Select Right angles to limit the text rotation to 90-degree increments.

10. Click Close to apply the text settings to the text.
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Adding HTML Horizontal Rules
HTML rules are horizontal only and can appear to have beveled edges when 

displayed by a browser. When you add an HTML rule, NetObjects Fusion positions 

it using an <HR> tag in the HTML for your page. When you embed an HTML rule 

in a text box, you can set its width as a percentage of the text box width.

To draw an HTML horizontal rule:

HR Rule tool

1. In Page view, select the Line tool on the Standard toolbar, and choose the 
HR Rule tool from the flyout. 

2. Draw the horizontal rule on the page.

The HR Rule Properties palette appears.

3. In the Thickness box, set the thickness of the rule.

4. Select Shaded to create a bevel effect.

The standard HR rule is a shaded, 2-pixel thick line.

5. Click the HTML button to open the Object HTML dialog.

In the bottom of this dialog, you can see the HTML code for the rule and 
its pixel length. In the top of the dialog, you can write JavaScript for the 
line, or your own HTML code. See Chapter 22, “Working with HTML 
Directly,” for information.
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Adding a SiteStyle Line
Use SiteStyle lines to embellish your page or divide it into sections. The line is a part 

of the current SiteStyle. See Chapter 12, “Using SiteStyles,” for information.

To place a SiteStyle line:

SiteStyle Line tool

1. In Page view, select the Line tool on the Standard toolbar, and choose the 
SiteStyle Line tool from the flyout. 

2. Draw a box starting where you want to position the upper-left corner of 
the line.

The SiteStyle line appears. 

You can drag the line to reposition it, and add HTML and Actions to it. When you 

change SiteStyles, NetObjects Fusion automatically updates the line with the line 

picture for the new SiteStyle.

In your published site, a SiteStyle line is a .gif file.
Drawing Lines and Arrows
You can draw a line on your page and specify its attributes, such as width, color, and 

the style of the head and tail. An arrow is simply a line that uses the Arrow or Point 

head/tail style.

Line Draw tool

1. In Page view, select the Line tool on the Standard toolbar, and choose the 
Draw tool from the flyout.

2. Drag from one point to another to set the position, length, and 
orientation of the line.

The point where you start dragging is the head of the line. The point 
where you finish is the tail of the line, regardless of the direction you 
drag.

To constrain the line to vertical or horizontal, hold down the Shift key 
while dragging.
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The Line Properties palette appears.

3. In the Line width box, set the width of the line.

4. In the Color section, click the Color button for the line, head, and tail, 
choose a color, and click OK. To set all three to the same color—the Line 
setting—select All parts use one color.

See “Choosing Colors” on page 1-9 for information. 

5. In the Style section, select a style for the head and tail from the 
appropriate drop-down list. 

If you want the head and tail to share the same style, select the style from 
one of the drop-down lists, then select Head/Tail same style. 

Select Outline so the head and tail have the line color for their outlines, 
regardless of their fill colors.

6. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 4-10 for information. 

When you publish a page with drawn lines, NetObjects Fusion generates each one as 

a .gif file.
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Editing Lines and Arrows
By dragging, you can change the length and width of a line or change the shape and 

size of the line’s head and tail. 

1. In Page view, select the line. 

Selection handles appear. 

Place the pointer over a selection handle—the pointer changes to a 
crosshair—and do any of the following:

● To make the line longer or shorter, drag an end handle. 

● To make the line thicker or thinner, drag a side handle.

● To change the shape of the end, drag one of its handles.

2. In the Style section, select a style from the Head or Tail drop-down lists 
to change the head or tail style. 
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Using SiteStyles 12

SiteStyles are sets of thematic elements you can apply to your site. Some style 

elements are graphical and others affect the text colors on your pages. In Style view, 

you use SiteStyles to create the look and feel of your entire site. NetObjects Fusion 

comes with a gallery of professionally designed SiteStyles. 55 SiteStyles are installed 

with NetObjects Fusion 3.0, and you can find the SiteStyles from all versions of 

NetObjects Fusion in the Extras folder on your installation CD-ROM. You can use 

these SiteStyles as they are, edit them, or create styles using your own artwork to 

give your site a distinctive look.

This chapter describes SiteStyles and how to use them, including:

● Applying SiteStyles

● Editing SiteStyles

● Creating SiteStyles

● Adding and removing SiteStyles

● Styles folder structure
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What Is a SiteStyle?
A SiteStyle is a collection of graphical and typographical elements that NetObjects 

Fusion applies to every page in your site. Your site’s SiteStyle gives it a consistent 

look that survives variations introduced by your site visitor’s browser. When you 

change the SiteStyle, NetObjects Fusion automatically updates every page in your 

site with the new look.

If you do not find a pre-built style that is appropriate for your site, you can create 

your own custom SiteStyle. Or, if a SiteStyle works for most, but not all, pages in 

your site, you can customize it for the exceptional pages, as described in “Setting the 

Navigation Bar Style” on page 13-7. For even more flexibility—for example, to use 

more than one banner image in your site or to use a different image for each button 

in a navigation bar—you can use the Navigation Bar and Banner properties palettes 

in Page view as described in “Customizing Banners and Buttons” on page 13-11. 
Style View
When you click the Style button on the control bar, NetObjects Fusion displays 

Style view. Style view shows:

● A list of available SiteStyles for this site

● Elements of the selected SiteStyle
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List of 
SiteStyles

Current SiteStyle

Click to set the 
selected SiteStyle.

Click to create a 
new SiteStyle.

Selected SiteStyle

Element area, 
displaying elements 
of the selected style
About Style Elements
NetObjects Fusion SiteStyles consist of two kinds of elements: 

● Images for buttons, banners, data list icons, SiteStyle lines, and page 
backgrounds. Button styles contain images for highlighted and non-highlighted 
buttons. The highlighted button image appears when a visitor is on the page 
represented by that button.

● Text attributes for banner and button text, and colors for normal text and regular 
and visited text links. The text on the navigation buttons and banners appears in 
the font style, size, color, alignment, and orientation assigned to the element in 
Style view.
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Each NetObjects Fusion SiteStyle is composed of nine style elements:

● Background: Color or image used as a background of the page

● Banner: Image containing the banner text

● Primary Navigation Bar: Images for highlighted and non-highlighted navigation 
buttons

● Secondary Navigation Bar: A second set of images for highlighted and non-
highlighted navigation buttons

● Data List Icons: Bullets next to items when you use a data object to create a data 
list

● Normal Text Color: Color of text on the page

● Regular Link Color: Color of linked text on the page

● Visited Link Color: Color of linked text already explored by visitor

● SiteStyle Line: Image for lines drawn with SiteStyle Line tool
Applying SiteStyles
By default, navigation banners and buttons obtain their images and text attributes 

from the SiteStyle assigned to the site. When you apply a SiteStyle, NetObjects 

Fusion automatically applies style elements throughout your site. For example, it 

replaces all the buttons in your navigation bars with images from the style you 

specified, while maintaining the relevant links. 

To apply a SiteStyle:

1. In Style view, select a SiteStyle from the style list.

The elements of the selected style appear.

2. Click the Set Style button on the control bar or choose Set Style from the 
Style menu. 

NetObjects Fusion applies the style to your site. The more pages in your 
site, the longer this takes. When complete, a message confirms that the 
style was applied and the name above the style list changes to the one 
you selected. 
12-4 Using SiteStyles



E D I T I N G  S I T E S T Y L E S
3. Click OK to acknowledge the message.

The next time you go to Page view, you see the new style elements and new font 

colors on each page.

You can also select a different style from the list and then navigate to another view. 

When a message asks if you want to set the currently selected style, click Yes to set 

the new style. 
Editing SiteStyles
You can edit any element of an existing style to customize it. For instance, you might 

like every element of a style except the banner. You can change just the banner 

image of a SiteStyle. The image for every banner in your site changes to the new 

image. 

To customize SiteStyle elements for some, but not all, pages, you do not edit the 

SiteStyle, you customize it just for those pages. See “Customizing Banners and 

Buttons” on page 13-11 for more information.

Note: When you edit a SiteStyle, every site that uses the SiteStyle is affected. Your 
Styles folder stores only one copy of a SiteStyle. When you change it, the change 
appears in all sites that use that SiteStyle. If the style you want to change is used in 
other sites and you don’t want them to be affected, create a new style from the 
original style’s graphic elements and customize the new style. See “Creating a 
SiteStyle” on page 12-12. Backups of all your style folders are located in the \Extras 
folder on your NetObjects Fusion CD-ROM.
Editing a Style Background
1. In Style view, select the style you want to change and double-click 

anywhere in the background. 
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The Background Style dialog appears.

2. Select a background option.

● Select None to use the default background color set in the browser’s 

preferences. 

● Select Color if you want a solid-color background such as white, the 

default. To choose a different color, click the Color button and select 

from the Color Picker. See “Choosing Colors” on page 1-9.

● Select Picture to use an image file as a background. Browsers tile the 

image across the page. Click Browse to choose an image file from 

your hard disk, CD-ROM, or LAN. See “Adding Pictures” on 

page 10-3.

3. Click OK.

Editing a Style Banner
1. In Style view, select the style you want to change and double-click the 

banner.

The Banner dialog appears.
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2. To change the banner’s image, click Browse to choose an image file from 
your hard disk, CD-ROM, or LAN. For information on choosing 
images, see “Adding Pictures” on page 10-3.

3. To change the appearance of text, click Text Settings and set text options 
as described in “Editing Text Settings for Buttons and Banners.” 

4. Click OK.
Editing Text Settings for Buttons and Banners
With SiteStyles, you can choose any font on your system for banner and button text. 

NetObjects Fusion dynamically generates image files for these banners and buttons 

using the font you specified for each element. This means that on buttons and 

banners, your site visitors see the fonts you select regardless of their browser or the 

fonts installed on their systems. 

To set how text appears on navigation buttons and banners:

1. In Style view, from the Banner, Primary Button, or Secondary Button 
dialog, click the Text Settings button.

The Text Settings dialog appears.
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● Select the left, center, or right Relative Alignment icon to align 

multiple lines of text in relation to each other. 

This option applies only if you used Custom Names to specify a 
banner or button label of more than one line of text. See “Using 
Custom Page Names and Extensions” on page 2-15 for more 
information. 

● To change the font, click the Set button next to the Font field. 

The Font dialog appears. Select the font, its style and size, and 
script style. The Script drop-down list shows the available 
language scripts for the specified font. Choose the appropriate 
script for the language you are using.

● Change the font color by clicking the Set button next to the Color 

field and choosing from the Color Picker, as described in “Choosing 

Colors” on page 1-9.

● In Horizontal Position, select Left, Center, or Right. In Vertical 

Position, select Top, Center, or Bottom.

Horizontal Position and Vertical Position specify where text 
appears on the button, while Relative Alignment specifies how 
lines of text appear in relation to each other.
In the illustration below, the first button’s Relative Alignment is 
set to left, and its Horizontal Position and Vertical Position are set 
to Center. The second button’s Relative Alignment is set to center, 
its Horizontal Position set to Left, and its Vertical Position set to 
Center. 

● In the Orientation section, drag the slider to set the rotation angle 

of the text. Zero degrees represents no rotation.

● Select Right angles to limit the text to right angles only; clear it to 

permit rotation to any angle. 
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2. When you finish adjusting the text, click OK.

After you close the banner or button dialog, the banner or button text 
appears with its new options in Site view.
Editing a Navigation Bar
Each SiteStyle includes a primary navigation bar and a secondary navigation bar. 

The two navigation bars differ only in the style of the button images. You can set the 

navigation bars in your site to display either style of navigation bar. For example, 

top-level pages can display the primary button set while lower-level pages display 

the secondary set. For more information, see “Using Navigation Bars” on page 13-3.

Each navigation bar contains two button images: regular and highlighted. 

Highlighted buttons are used in button navigation bars to show which page a visitor 

is currently viewing. You can turn highlighting on and off in the Navigation Bar 

Properties palette in Page view, as described in “Setting the Navigation Bar Style” on 

page 13-7. Highlighting is turned on by default. 

Note: If you are using AutoFrames, highlighting can affect how the browser refreshes 
your page. See “AutoFrames and Browser Refresh” on page 24-10 for information.

To edit a navigation bar:

1. In Style view, select the style you want to change and double-click the 
Primary or Secondary Navigation Bar.

The Primary or Secondary Button dialog appears, depending on which 
navigation bar you are editing.
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2. To select a different button image:

● Choose a regular button image by clicking the first Browse button 

and choosing an image file from your hard disk, CD-ROM, or LAN.

● Choose a highlighted button image by clicking the second Browse 

button and choosing an image file from your hard disk, CD-ROM, 

or LAN.

For information on choosing images, see “Adding Pictures” on 
page 10-3.

3. To set different text options:

● Choose options for regular button text by clicking the first Text 

Settings button. 

● Choose options for highlighted button text by clicking the second 

Text Settings button.

The Text Settings dialog appears, where you can set text options as 
described in “Editing Text Settings for Buttons and Banners” on 
page 12-7.

4. When finished, click OK in the Text Settings dialog and then click OK in 
the Primary Button dialog.
Editing a Data List Icon
Data list icons appear when you use the Data List tool to create a data list in 

Page view. For information on working with data lists and data objects, see 

Chapter 20, “Data Publishing.”

To edit a data list icon:

1. In Style view, select the style you want to change and double-click a Data 
List icon.

The Picture File Open dialog appears.

For information on choosing images, see “Adding Pictures” on 
page 10-3.
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2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.
Editing the SiteStyle Line
A variety of horizontal page-wide images can serve as lines to separate pages into 

sections. A number of line picture images are included in NetObjects Fusion styles. 

You insert line pictures in Page view using the SiteStyle Line tool, as described in 

“Adding a SiteStyle Line” on page 11-7.

To edit a SiteStyle line element:

1. In Site view, select the style you want to change and double-click the 
SiteStyle Line.

The Picture File Open dialog appears. 

2. Select an image file from your hard disk, CD-ROM, or LAN.

For information on choosing images, see “Adding Pictures” on 
page 10-3.

3. Click Open.
Editing Text Colors
You can set the colors for normal text, links, and visited links with NetObjects 

Fusion. These colors apply only to text created with the Text tool in Page view and 

text navigation bars. They do not apply to text on buttons, banners, or other images. 

To edit the default font, font size, and other font attributes, set the browser font, as 

described in “Setting Preferences” on page 1-12.

The normal text color is automatically applied to all text you add to text boxes in 

Page view. You can override the default color by formatting text in Page view.

The regular link color is applied to all text you link; the visited link color appears 

after your site visitor follows the link. You do not see this color in Page view. Link 

colors show site visitors where links are located, and browsers keep track of which 

links have been followed. Set a regular link color that is different from the color you 

plan to use for ordinary text. By assigning visited links a different color than that of 

the regular links, you let site visitors know at a glance that they have visited the link. 
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If color consistency is more important than this detail, assign identical colors to 

regular and visited links. 

To edit a text color:

1. In Style view, select the style you want to change and double-click the 
text label you want to change. 

● Double-click the words Normal Text Color to change the default 

color for text in the site. 

● Double-click the words Regular Link Color to change the color for 

links in the site. 

● Double-click the words Visited Link Color to change the color for 

visited links in the site.

The Color Picker appears. See “Choosing Colors” on page 1-9 for 
information on choosing colors.

2. Select a color and click OK.
Creating a SiteStyle
You can create original styles to give your site a unique look. Simply collect or create 

image files for your banner, buttons, line, icon, and background, and select them in 

Style view. When you create a new SiteStyle, each element is saved into its own 

subfolder in the style’s folder inside the NetObjects Fusion 3.0\Styles folder. See 

“Styles Folder Structure” on page 12-16 for information on style folders.

When you create your own SiteStyle, keep these points in mind:

● When you use an animated .gif for a style image, only the first frame of the 
animation displays on the image.

● Text labels for buttons and banners are placed on top of images. If you want the 
label to appear below the image, leave space above or below the image when you 
create it in your image editing application.
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● If you plan to use your SiteStyle on a page with a background color or image, and 
you want the background to show through your image, use your image editing 
application to set transparency in your image.

You can check the NetObjects Web site at www.netobjects.com for more 

guidelines on creating SiteStyles.

To create your own SiteStyle:

1. Create or collect images for your banner, buttons, lines, icons, and 
background. 

Use an image creation application to create the images. To be included in 
a published site they must be in .gif or .jpeg format. If you use an image 
in .bmp, .pcx, .pct, .png, or .psd format, a message asks you if you want 
to convert the image to .gif or .jpg format. If you choose to convert, 
NetObjects Fusion converts a copy of the image for you.

2. In Style view, on the control bar, click the New button, or choose New 
Style from the Style menu.

The New Style dialog appears.

3. Enter a name for your new SiteStyle and click OK.

NetObjects Fusion displays rectangular placeholders to indicate where 
you click to define the graphic images. It also displays the default text 
colors.

4. Define each style element by double-clicking it as described in “Editing 
SiteStyles” on page 12-5.

As you define each element, its image appears in Style view.

5. Click Set Style to apply the new style to your site.
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Your custom SiteStyle images and settings are applied to your site. 
NetObjects Fusion creates a new folder in the Styles folder to contain 
your style elements. See “Styles Folder Structure” on page 12-16 for 
information about the location of style folders.
Managing SiteStyles
You can add new styles to the list of available styles, such as those you obtain from 

your colleagues or those you create on your own. You can also remove styles from 

the list and synchronize the list with the style folders currently in your Styles folder. 

SiteStyles are stored in folders labeled with the style name. Because NetObjects 

Fusion stores a list of SiteStyles with each site file, you must add new styles you 

obtain to your site’s style list before you can use them. 

If you create a new site from a template, your new site contains the same style list as 

the site from which the template was made. If you import a template into your 

current site, style names that were in the template’s style list are added to your site’s 

style list. Templates created in NetObjects Fusion 3.0 also include the style folder for 

the template’s style. Templates created in earlier versions of NetObjects Fusion do 

not include the style and you must manually copy the style to your Styles folder to 

use it. For more information on transferring SiteStyles, see Chapter 10, “Upgrading 

From a Previous Version of NetObjects Fusion,” in Getting Started.
Adding a SiteStyle
You can add a style from any NetObjects Fusion style folder on your hard drive, 

CD-ROM, or LAN. The Add Style to List command on the Style menu makes a 

complete copy of the added style’s folder in the Styles folder in your NetObjects 

Fusion 3.0 folder. For information about these folders, see “Styles Folder Structure” 

on page 12-16.

Note: When you add a style, it appears in the list of styles for the current site only. If 
you want that style to appear in the style list of every new site you create, see 
“Changing an Existing Template” on page 3-18.
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To add a SiteStyle to the style list:

1. In Style view, from the Style menu, choose Add Style to List.

The Open dialog appears.

2. Navigate to the style folder of the style you want to import and select its 
.ssf file.

3. Click Open.

NetObjects Fusion adds the style name to the style list.
Adding All Available SiteStyles
To synchronize your style list with the styles in your Styles folder:

◆ In Style view, from the Style menu, choose Update Styles List.

NetObjects Fusion updates the Style list of the active site to match the 
current contents of the Styles folder. This process also removes styles 
from the style list that are not included in the Styles folder.
Removing SiteStyles
You can remove a style from the list of styles in the current site. You cannot remove 

the currently applied style. 

When you remove a SiteStyle, its name is removed from the current site only. Its 

style folder and the associated image files are not deleted, and it is not removed 

from any other sites. 

To remove a style from the list:

1. In Style view, select the style you want to remove.

2. From the Style menu, choose Remove Style from List.

3. Click Yes in the warning dialog.

The style disappears from the style list of the open site. It remains in the 
NetObjects Fusion 3.0\Styles folder.
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Styles Folder Structure
Each SiteStyle stores the images it uses in a special folder structure in the 

NetObjects Fusion 3.0\Styles folder.

NetObjects Fusion uses this folder structure to organize and label SiteStyle elements 

so you can easily locate parts of a style. When you assign an image to a SiteStyle 

element in Style view, NetObjects Fusion automatically copies the file to the 

appropriate folder within the Styles folder. You can give a style element any name 

you want, but NetObjects Fusion style images generally have the name of the style 

and element, such as BasicButton.gif, or BasicLine.gif.

When you select a new image for a style element, NetObjects Fusion automatically 

copies it into the appropriate folder for the SiteStyle. If you’re editing an existing 

SiteStyle, the new image file replaces the one previously assigned to that element in 

Style view. It copies the new image to the folder, but doesn’t overwrite the old image 

file unless the new and old files have identical names. 

For example, suppose you want to modify the SiteStyle BlackBook to change the 

color of the highlighted button from black to red. First you must use an image 

editing application to open the file BlackBookButtonOn.gif and change the 

button’s color. You can give the new image file any name you like. Then, in Style 
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view, you edit the highlighted button of the Primary Navigation Bar and choose the 

image file you edited. The image file you select is copied to the Primary Buttons 

Highlighted folder in the NetObjects Fusion 3.0\Styles\BlackBook folder. If the 

new image file has the same name as the original file, the original is overwritten. 

Thereafter, every site created or opened on your machine that uses BlackBook uses 

this file for all highlighted primary buttons.

This applies to all style elements that can be based on images: Background, Banner, 

Primary Navigation Bar, Secondary Navigation Bar, SiteStyle Line, and Data List 

Icon. This also occurs when you replace the image for a single instance of a button 

or banner as described in “Customizing Banners and Buttons” on page 13-11.
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Creating Navigation Bars
and Banners 13

NetObjects Fusion includes tools you can use to create banners and navigation bars 

that help site visitors understand and navigate the structure of your site. A new 

blank site includes a navigation bar and banner in the MasterBorder. You can create 

your own banners and navigation bars and place them in any MasterBorder or 

Layout area. You save time using banners and navigation bars because NetObjects 

Fusion automatically places page names on the banner and navigation bar pictures, 

and automatically links buttons to pages in your site.

New banners and navigation bars you create use picture elements of the currently 

selected SiteStyle. However, you can customize the banners and buttons after you 

create them by assigning other styles or labels or by replacing their pictures with 

your own pictures. 

This chapter tells you how to use navigation bars and banners, including:

● Creating navigation bars

● Setting navigation bar options

● Creating banners

● Customizing banners and navigation bars
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Working with Banners and Navigation Bars
NetObjects Fusion makes it easy to create different kinds of navigation tools to aid 

site visitors, including banners that show the page names and button and text 

navigation bars that link to pages in your site. 

You can easily place banners and navigation bars anywhere on the page, including 

MasterBorders, Layouts, and inside text boxes, table cells and Layout Regions. 

Banner titles and button names are determined by the page names in Site view or 

the settings in the Custom Names dialog. Buttons are linked according to your site’s 

structure. Whenever you change your site’s structure in Site view or change the 

name of a page, NetObjects Fusion automatically updates the buttons and banners.

When you preview or publish your site, NetObjects Fusion creates a new .gif image 

file with the picture and text for each button and banner. It gives the text the font 

style, size, and color you assigned to the element in Style view. It combines this text 

with the image file for that element of the SiteStyle to ensure that the font style you 

choose appears despite differences in the browsers used by your site visitors. 

In each new site you create, NetObjects Fusion places a banner in the top margin, a 

button navigation bar in the left margin, and a text navigation bar in the bottom 

margin. If you do not want the default banner and navigation bars to appear in 

every new site you create, edit the Blank Site template to remove them, as described 

in “Changing an Existing Template” on page 3-18. The only way you can 

permanently remove banners and navigation bars from your newly created sites is 

to edit the Blank Site template. 

Navigation bar

Text navigation bar

Banner

Button 
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Using Navigation Bars
Navigation bars are rows or columns of buttons or text that are automatically linked 

to other pages in your site. NetObjects Fusion provides two types of navigation bars: 

button navigation bars and text navigation bars. Text navigation bars provide 

navigation for visitors whose browsers do not display navigation pictures. Use the 

Navigation Bar tool to add navigation bars to MasterBorders or page layouts.

By default, button names are the same as the page name unless you specify a custom 

name, as described in “Using Custom Page Names and Extensions” on page 2-15. 

You can also split the button text into two lines by customizing the button name.

The style for buttons is determined by the SiteStyle you set in Style view, described 

in Chapter 12, “Using SiteStyles.” The SiteStyle button picture is automatically 

applied to buttons throughout your site. You can change the button style for an 

individual navigation bar or even an individual button without changing the overall 

SiteStyle. 

You create navigation bars using the default settings, but you can customize the way 

they look. You can choose buttons or text for navigation, include borders around 

the navigation bar, modify the spacing within the navigation bar, and change the 

background color. 

You can assign an action to any navigation bar using the Actions tab of the 

Navigation Bar Properties palette. For example, you might want a navigation bar to 

fly in from the top when the site visitor opens the page. To make the navigation bar 

do this, you assign it an action that executes when the page is loaded. For 

information on creating actions and assigning them to objects, see Chapter 21, 

“Building Dynamic Pages.”

Adding Button Navigation Bars
You can add a horizontal or vertical button navigation bar to a page. 

Buttons are 
linked to other 
pages in your 
site.

Choose pictures 
for buttons in 
Style view.
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1. In Page view, go to the page on which you want to place the navigation 
bar.

Navigation Bar tool

2. Select the Navigation Bar tool from the Standard toolbar. 

3. Drag a box in the MasterBorder or Layout area where you want to place 
the navigation bar.

● Drag in a horizontal direction to create a horizontal navigation bar.

● Drag in a vertical direction to create a vertical navigation bar.

A new button navigation bar appears, and the Properties palette displays 
settings for the navigation bar. The bar contains buttons linked to the 
pages indicated by the setting in the Display field of the Navigation Bar 
Properties palette. 

Highlighted 
button

Button 
navigation 
bar
Setting the Display Options
You set the display level to specify the relationship between the current page and the 

pages represented by the navigation bar. You also use it to change the navigation bar 

orientation. Illustrations in the Nav Bar Display dialog help you visualize the 

relationship of pages in the site’s structure. You can add as many navigation bars as 

you need and set each one to a different display level. 

If a navigation bar appears in a MasterBorder assigned to pages at several different 

levels of the site, the display level you select might not make sense at all levels. To 
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make sure your site visitors have access to all levels of your site, you can create new 

MasterBorders and place navigation bars with different display level settings in 

them. 

To set the display options:

1. In Page view, select the navigation bar.

The General tab appears on the Navigation Bar Properties palette.

2. In the Display section of the General tab, click the Options button.

The Nav Bar Display dialog appears.

3. In the Show section, set the navigation option for this bar:

● First Level generates buttons linked to the children of your 

Home page.

● Parent Level includes links to all pages in the level above the 

current page in the site’s structure.

● Current Level links the buttons to this page and all other pages on 

the same level with the same parent page.

● Child Level generates links to the children of the current page.
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Open Site view or the Site Navigation window if you are unsure about 
which level of the site you want to link.

4. To include your Home page as a link in this button bar, select Include 
Home Page. 

By default, Include Home Page is selected to provide quick access to the 
hub of your site.

5. To change the orientation of the bar, select Horizontal or Vertical in the 
Display section. 
Setting the Navigation Bar Type
On the Properties palette for navigation bars, you can choose whether the selected 

navigation bar displays text or picture buttons. Text navigation bars provide 

navigation for visitors whose browsers cannot display picture buttons. 

Primary and secondary navigation bars offer different sets of button pictures. Other 

than the pictures displayed, primary and secondary navigation bars function the 

same way. Because secondary button pictures are typically different in size, shape, or 

color, you can use a secondary navigation bar to visually distinguish links to 

different parts of your site. For example, to help your site visitor understand your 

site’s structure, you might use the secondary navigation bar for the lower levels of 

your site. To see the difference between primary and secondary navigation bars, go 

to Style view.

To set the navigation bar type:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Button Type section of the General tab, select the button type.

● To apply the primary button style for the current SiteStyle, select 

Primary Buttons. 

● To apply the secondary button style, select Secondary Buttons.

● For a text navigation bar, select Text. 
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Text navigation bars use the SiteStyle’s linked text color and the 
Normal text style. For information on editing text styles, see 
“Creating and Modifying Text Styles” on page 8-9. To set the link 
color, see “Editing Text Colors” on page 12-11.
Setting the Button Spacing
You can set the pixel size of a button navigation bar’s border, as well as the spacing 

between buttons. By default, the spacing between buttons is zero pixels, but you can 

increase this to let a background show through or to add visual breaks around 

buttons. The border and spacing are measured in pixels regardless of the 

measurement you set in Preferences.

To set button spacing:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Display (in pixels) section of the General tab, set display options.

● To increase or decrease the navigation bar border, enter a new 

number in the Border field.

● To increase or decrease the spacing between buttons, enter a new 

number in the Spacing field.
Setting the Navigation Bar Style
By default, new navigation bars take on the style of the currently applied SiteStyle, 

but you can set individual navigation bars to any available SiteStyle. If a SiteStyle 

works for most, but not all, pages in your site, use a different SiteStyle for the 

exceptional pages.

You can also choose whether the button for the current page will be highlighted or 

not. Use button highlighting to show site visitors which page they are on. The 

highlighted button picture is different from the regular button, so a glance at the 

buttons quickly indicates the current page. If you are using AutoFrames, be aware 

that highlighting can affect the way the browser refreshes your page. See 

“AutoFrames and Browser Refresh” on page 24-10 for more information.
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To set a button style:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Button Style section of the General tab, select Other, and choose a 
different style from the drop-down list.

3. To turn off highlighting, clear the Use Highlighting checkbox.

A highlighted 
button indicates 
the current page.
Setting the Navigation Bar Background
You can set a background color for a text or button navigation bar. A background 

color can visually unify a navigation bar if buttons are widely spaced; it can also help 

site visitors distinguish the navigation bar from the background of the page.

To set navigation bar background:

1. In Page view, select the navigation bar, then click the Background tab of 
the Properties palette.

2. In the Background Color section, set a background color.

● To use a background color, click the Color button, select a color 

from the Color Picker, then click OK. See “Choosing Colors” on 

page 1-9 for information.

● To use no background color, select None. 

The background color appears around buttons in a navigation 
bar or behind text in a text navigation bar.
Using Banners
Banners are picture title bars that display the name of the page, helping site visitors 

understand where they are in your site. You use the Banner tool to add new banners. 
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Banners are just like pictures, except they contain text to identify the page. By 

default, banner text is the page name, but you can specify a custom name or no 

name for the banner, as described in “Using Custom Page Names and Extensions” 

on page 2-15. You can also split the banner text into two lines by customizing the 

banner name. The style of a banner is determined by the SiteStyle you choose in 

Style view.

You can assign an action to any banner using the Actions tab of the Banner 

Properties palette. For example, you can make a banner “grow” into existence when 

the site visitor goes to the page by assigning this action to it: On Page Loaded do 

Transition with the transition type set to Iris. For information on assigning actions 

to objects, see Chapter 21, “Building Dynamic Pages.”

Set the 
Banner style 
in Style view.

Set the Page name in 
Site view or in the 
Custom Name dialog.
Adding a Banner 
1. In Page view, go to the page on which you want to place the banner.

Banner tool

2. Choose the Banner tool from the Standard toolbar. 

3. Drag a box in the MasterBorder or Layout area where you want to place 
the banner.

● Drag in a horizontal direction to create a horizontal banner.

● Drag in a vertical direction to create a vertical banner.
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A new horizontal or vertical banner appears in the current SiteStyle and 
contains the page name or the text specified in the Custom Name dialog. 
The Banner Properties palette displays options for the banner.

4. To change the banner orientation, select Horizontal or Vertical in the 
Display section of the General tab.
Setting the Banner Style and Orientation
By default, new banners take on the style of the currently applied style, but you can 

set individual banners to any available style. If you change the style of a banner in a 

MasterBorder, it changes on every page using that MasterBorder.

1. In Page view, select the banner.

The General tab of the Banner Properties palette appears.

2. In the Style section of the General tab, select Other, and choose a 
different style from the drop-down list.
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Customizing Banners and Buttons
You might want to take advantage of the automatic page linking of a navigation bar, 

but still want to design the entire button—including special text effects not available 

in NetObjects Fusion—in an image editing application. Or, you might want to 

replace a banner on just one page with a picture that is not included in SiteStyles, 

without affecting all the other pages that use the same MasterBorder. 

If necessary, you can substitute navigation pictures with other images for special 

pages. The customized picture appears only when you assign the SiteStyle that was 

selected when you chose the picture. The advantage to using customization instead 

of simply placing your own images as pictures is that NetObjects Fusion manages 

page links for you. 
Changing the Image for One Banner
You can change the picture for a selected banner in Page view. When you assign a 

new picture to a banner, NetObjects Fusion does not display the page or custom 

banner name. If you want text to appear on the banner, you must include the text in 

your banner graphic. If you change a banner in a MasterBorder, the change does not 

affect the banner on all the other pages that use that MasterBorder. You do not 

change the SiteStyle when you customize a banner picture.

To change the picture for one banner:

1. In Page view, navigate to the page containing the banner you want to 
change.

2. Select the banner.
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The General tab appears on the Banner Properties palette.

3. Double-click the banner, or click Custom Image on the General tab.

The Picture File Open dialog appears.

4. Select the image you want to use for the selected banner.

● To use an image that is not already an asset in your site, click the 

Folder tab, navigate to the appropriate folder, and select the image.

● To use an image that is already an asset in your site, click the Image 

Assets tab and select the image from the name column.

For more information on choosing images, see “Adding Pictures” on 
page 10-3.

The selected banner displays the new picture. The picture does not 
include the text style attributes or name that NetObjects Fusion usually 
assigns to the banner. Note that the banner picture changes for the 
current page only. The original image for the banner is unchanged. If 
you change the style assigned to the site, the banner no longer displays 
the custom picture. 

For information about changing the banner back to its original SiteStyle, see 

“Removing Banner or Button Image Customization” on page 13-15.
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Changing the Picture for One Button
You can change the picture on each individual button in a navigation bar in Page 

view. When you assign a new picture to a button, NetObjects Fusion does not 

display the page or custom name on the button. If you want text to appear on the 

button, you must include the text in your button picture. You do not change the 

current SiteStyle when you customize a button picture.

Changing a button picture affects every instance of the button for that page, even if 

the button is on different MasterBorders and on different pages. For example, if you 

change the picture for a regular button named “Download” in a primary navigation 

bar, every instance of the regular Download button in all primary navigation bars in 

your site will change. However, the highlighted button for Download will not 

change, nor will the Download buttons in secondary navigation bars. The 

Download page itself, which contains the highlighted button picture for the 

Download button, remains unchanged. To change both the regular and highlighted 

button you must customize both.

To change the picture for one button:

1. In Page view, navigate to the page containing the navigation button you 
want to change.

2. Double-click the button to select it.

A wide border surrounds the button to show it is selected.
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The General tab appears in the Navigation Button Properties palette.

3. Double-click the selected button, or click Custom Image on the General 
tab.

The Picture File Open dialog appears.

4. Select the image you want to use for the selected button.

● To use an image that is not already an asset in your site, click the 

Folders tab, navigate to the appropriate folder, and select the image.

● To use an image that is already an asset in your site, click the Image 

Assets tab and select the image from the name column.

For more information on choosing images, see “Adding Pictures” on 
page 10-3.

The selected button displays the new picture. The picture does not 
include the text style attributes or name that NetObjects Fusion usually 
assigns to the button. The original picture for the button is unchanged. 
If you change the style assigned to the site, the button no longer displays 
the custom picture. 

For information about changing the button back to its original SiteStyle, see 

“Removing Banner or Button Image Customization.”
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Removing Banner or Button Image Customization
If you change a banner or button picture, and want to revert back to using the 

selected SiteStyle, you can remove the customization.

1. In Page view, click the banner or double-click the button to select it.

The General tab appears in the Properties palette. 

2. Select Remove Customization. 
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Creating Links
and Anchors 14

In addition to navigation bars and banners, NetObjects Fusion makes it easy to 

create any kind of navigation aid you might want using links. You can link page 

objects to any other point on the Web, including points within your site. For 

example, you can make any text, image, draw object, or area of an image into a 

navigation aid by adding a link. You can also create anchors—markers at a specific 

location on a page—to aid navigation in long pages.

NetObjects Fusion offers several types of links. You use internal links to link to 

pages within the site. Smart links are based on the site’s structure. NetObjects 

Fusion manages both internal and smart links for you, updating them as you change 

your site structure and page names. Use external links to link to other sites on your 

intranet or on the Internet. File links let you link to a file.

This chapter tells you how to create:

● Internal links

● Anchors

● Smart links

● External links

● File links

● Links with added HTML

● Imagemaps

● Links with actions 
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Working with Links
You can use the linking techniques described in this chapter to manually link 

objects such as text, pictures, and drawn shapes, both within your site and outside 

it. As you organize your site, you’re likely to create multiple links to the same 

location. You can update these links efficiently in Assets view, as described in 

“Managing Links” on page 25-9.

You can use NetObjects Fusion’s HTML access button to insert your own HTML 

and JavaScript code before, inside, and after links. For more information on adding 

HTML, see Chapter 22, “Working with HTML Directly.” You can also use a link to 

trigger an action instead of jumping to a new page by using the Blank link, as 

described in “Assigning an Action to a Text Link” on page 21-17.

The properties palette for all linkable objects contains a Link button in the lower left 

corner. The Link button opens the Link dialog, where you specify the destination of 

a link. There are four types of links; each has its own tab in the Link dialog:

● Internal link, which links to a page or anchor inside the site.

● Smart link, which links to a relative position in the site, such as previous page or 
next page. Sometimes these are called structural links. The Blank link, which you 
can use to trigger an action without going to a new page, is also a smart link.

● External link, which links to a page in another site via a URL, using a protocol 
such as ftp, mailto, http, JavaScript, or other method.

● File link, which links to a file that will be published with the rest of the site. 

Link — Anchor 

If Object Icons is checked in the View menu, NetObjects Fusion displays the Link or 

Anchor icon wherever you create a link or an anchor.

In Page view, you can follow an existing link to its target page or anchor:

● Right-click a linked object and select Follow Link from the shortcut menu, or 
select the object and from the Go menu, choose Follow Link. 

● To follow a text link, click in the text so it includes the blinking insertion point, 
then right-click the linked text and select Follow Link from the shortcut menu.

● To follow a button link, double-click the button, then right-click the button and 
select Follow Link from the shortcut menu.
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To edit a link, select the linked text or object, click the Link button on the properties 

palette, then change the link in the Link dialog. 

To remove a link, select it, click Link on the Properties palette, and click Unlink in 

the Link dialog.

If your page includes AutoFrames, you might want the target of a link to appear in a 

specific frame. For more information, see “Targeting Links in AutoFrames” on 

page 24-2.
Creating an Internal Link
Internal links lead to pages or anchors within your site. If you move the page to a 

different place in your site’s structure or change the page’s name, NetObjects Fusion 

automatically updates the link. Assets view lists the internal links in your site so you 

can track them.

You can either link to a page name or to the current page when you make a link to 

an anchor. When you link to an anchor and the link is later present on another page, 

the ability to link to the current page is useful. Linking to an anchor on the current 

page ensures intelligent treatment of anchors by the browser. 

For example, suppose your layout contains a very long text box. At the top and 

bottom of the text box you place anchors, and in the MasterBorder, you link the 

words To Top to the top anchor and the words To Bottom to the bottom anchor. In 

the Link dialog, instead of choosing the current page name in the Page Name 

section, you choose the Current Page option. Then you decide to copy that text box 

to another page with the same MasterBorder and replace its content with different 

subject matter. Because you used the Current Page option, the To Top and To 

Bottom links still work, jumping to locations on the current page instead of the 

page where you made the links. When you copy an anchor link from one page to 

another, or when an anchor link is in a MasterBorder or AutoFrame, you can make 

sure the link always points to an anchor on the current page by using the Current 

Page option in the Link dialog. 

If you want an anchor link to always lead to a specific page, select a page name and 

then select an anchor.
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To create an internal link:

1. In Page view, select an object to link.

● If you are linking text, select the text you want the browser to 

display as linked.

● If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears. 

● If you are linking to a page, select Page Name and choose a page 

name.

● If you are linking to an anchor and want the link to always link to a 

specific page, select Page Name and the name of a page. 

● If you are linking to an anchor and want to always link to an anchor 

on the browser’s current page, select Current Page.

The Anchor section lists all the anchors on the page selected in the Page 
section. To learn how to create and link to an anchor, see “Adding an 
Anchor” on page 14-5.
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3. If you are linking to an anchor, choose the name of the anchor from the 
Select Anchor drop-down list.

The Select Frame Target field appears only when the current page 
contains an AutoFrame. For more information about link targets, see 
“Targeting Links in AutoFrames” on page 24-2. The Actions button 
appears only if you are linking text. For information on adding an 
Action to a text link, see “Assigning an Action to a Text Link” on 
page 21-17.

4. If the current page contains an AutoFrame, select the name of a frame 
from the Select Frame Target drop-down list.

The destination page for the link appears only in the frame you select.

5. Click Link.

NetObjects Fusion creates the link. When your site visitor clicks the 
linked item, the browser displays the destination page or the selected 
anchor.

Name of page to link to 

List of all pages in the site

Click to display anchors on 
the current page

Anchors on the selected or 
current page

See “Targeting Links in 
AutoFrames” on page 24-2
Adding an Anchor
An anchor marks a specific location on a page. Anchors are useful on long pages so 

site visitors can go directly to a particular part of the page, instead of scrolling and 

searching for information. 
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You can place an anchor anywhere in a text object or table, or on a picture or drawn 

shape. You can link to an anchor from anywhere; for more information, see 

“Creating an Internal Link” on page 14-3. When a site visitor clicks the link, the 

browser displays the page containing the anchor, beginning at the location of the 

anchor.

To add an anchor:

1. In Page view, click to place the insertion point within a line of text, or 
select an image or drawn shape. 

Make sure you place the insertion point within the text, rather than 
selecting text. If you select text, the Anchor button is not accessible.

2. In the Properties palette for the selected object, click the Anchor button.

The Add Anchor dialog appears. The Anchors on Page section shows 
existing anchors on the selected page.

3. Type a name for the anchor in the Name field. The name cannot contain 
spaces. Choose an appropriate name because you reference this anchor 
by name later, and the name appears in the browser when the pointer 
passes over it.

4. Click OK.

Anchor icon

If Object Icons is checked in the View menu, the Anchor icon appears at 
the anchor location on the page.
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To edit an anchor, click the Anchor icon and change its name in the Change Anchor 

dialog. 

To delete an anchor, click the Anchor icon and click Remove in the Change Anchor 

dialog.

Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the structure, 

rather than its name. These links automatically adjust when you change your site 

structure. For example, if your smart link leads to the parent of the current page, 

and you later move the current page to a different parent, NetObjects Fusion 

updates the link to point to the new parent. Sometimes a smart link is called a 

structural link.

To create a smart link:

1. In Page view, select an object to link.

● If you are linking text, select the text you want the browser to 

display as linked.

● If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.
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3. Select the Smart Link tab.

The Select Frame Target control appears only when the current page 
contains an AutoFrame. For more information about link targets, see 
“Targeting Links in AutoFrames” on page 24-2.

4. Select the type of link you want.

● Home links to your Home page.

● Up links to the parent of the current page.

● Next Stacked Page links to the next page in a stack.

● Previous Stacked Page links to the previous page in a stack.

● Next Page links to the sibling to the right of this page in your site 

structure.

● Previous Page links the sibling to the left of the current page in your 

site structure.

● First Child Page links to the first page below the current page.
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● Blank creates an empty link on the page. You can use the Blank link 

to assign an action or to create a custom <HREF> tag. If you want a 

link to trigger an action, but you don’t want it to lead to another 

page, use the Blank link. For more information on adding actions, 

see “Assigning an Action to a Text Link” on page 21-17.

5. Click Link.

For information about stacked pages, see Chapter 20, “Data Publishing.” For 

information about link targets, see “Targeting Links in AutoFrames” on page 24-2.
Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages and 

items in other sites on the Web. A valid URL can include the protocol, host name or 

DNS, path name, and sometimes a file name, such as http://www.netobjects.com/

products/fusion.html. Each external link you create becomes an asset of the site 

that you can easily update in Assets view.

To create an external link:

1. In Page view, select an object to link.

● If you are linking text, select the text you want the browser to 

display as linked.

● If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.
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3. Select the External Link tab.

The Select Frame Target control appears only when the current page 
contains an AutoFrame. For more information about link targets, see 
“Targeting Links in AutoFrames” on page 24-2.

The External Link tab shows a list of external links you previously 
entered in the current site.

4. Select a protocol from the URL drop-down list.

If you’re creating a link that does not require a protocol, select the 
existing protocol and press Delete. If you want to use a protocol that is 
not in the drop-down list, simply type it.

5. Either enter a new URL or, if you already created a link asset for this 
URL, select it from the list. 

When the site visitor clicks the selected object, this link target is 
displayed.

If you select a link target from the list of assets, its URL and name appear 
in the URL and Asset Name fields. You can modify the name and URL.

URL drop-down list with protocol 
selected

URL field
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6. If you’re creating a new external link asset, enter a name for this link 
target in the Asset Name field. 

This name is for your reference. It appears in the list of links in Assets 
view so you can quickly identify and sort link destinations. It is not 
added to the HTML generated when your site is published. 

7. Click Link.
Creating a File Link
You use file links to link to a file. The file referred to by the file link becomes an asset 

of the site and is uploaded to the server when the site is published. You might use a 

file link to link to a file that your site visitors want to download. 

1. In Page view, select an object to link.

● If you are linking text, select the text you want the browser to 

display as linked.

● If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the File Link tab.

Location of file

File name
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The Select Frame Target control appears only when the current page 
contains an AutoFrame. For more information about link targets, see 
“Targeting Links in AutoFrames” on page 24-2.

The File Link tab shows the path to the file and the name that appears in 
Assets view.

4. Click Browse and select a file in the Open dialog.

5. If necessary, enter or edit the Asset Name.

This name is for your reference. It appears in the list of links in Assets 
view so you can quickly identify and sort link destinations. It is not 
added to the HTML generated when your site is published. 

6. Click Link.
Adding HTML to a Link
You can add your own HTML or JavaScript to a link to extend its capabilities. For 

example, you might want to add HTML that directs the browser to open the link in 

a new window, or JavaScript that displays a dialog. The steps below show you how 

to add HTML that directs the browser to open the link in a new window.

1. In Page view, select the object you want to link.

● If you are linking text, select the text you want the browser to 

display as linked.

● If you are linking a picture or other object, click to select it.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select a link in one of the link tabs.

4. Click the HTML button on the Link dialog.

The Object HTML dialog appears. For detailed information on this 
dialog, see “Accessing an Object’s HTML” on page 22-6.

5. Click the Inside Tag tab to indicate where you want to enter HTML or 
JavaScript. 
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6. Enter target=NewWindow.

As you type, the bottom panel of the dialog displays your code as it will 
appear in the HTML NetObjects Fusion generates.

7. Click OK in the Object HTML dialog.

8. Click Link in the Link dialog. 

When you preview or publish the site, the link opens in a new browser window. 
Creating an Imagemap
An imagemap contains several links in a single picture. You create an imagemap by 

drawing hotspots on a picture. You can link as many hotspots as you like in a single 

image, but the hotspots cannot overlap or extend beyond the edge of the picture. 

Because the imagemaps you create with the following procedure do not require a 

CGI script running on the server, they are called client-side imagemaps. Server-side 

imagemaps require setup on a Web server to run properly.

To create a client-side imagemap:

1. In Page view, select a picture.

Hotspot tool

2. Press the Hotspot tool in the Standard toolbar, and select the 
appropriate tool to create a rectangular, circular, or polygon hotspot.

3. Draw a hotspot on the image.

If you are using the Polygon Hotspot tool, you must click to establish 
each vertex of the polygon, then double-click to complete the hotspot 
shape.

The Link dialog appears.

4. In the Link dialog, select the type of link by clicking a tab.

5. Select a destination for the link or type a URL. For more information 
about creating links, refer to one of the following sections.

● For information about internal links, see “Creating an Internal 

Link” on page 14-3.
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● For information about smart links, see “Creating a Smart Link” on 

page 14-7. 

● For information about external links, see “Creating an External 

Link” on page 14-9. 

● For information about file links, see “Creating a File Link” on 

page 14-11.

● For information about custom links, see “Assigning an Action to a 

Text Link” on page 21-17.

6. Create more hotspots, if you like, using the same tools and the Link 
dialog.

Once a picture has imagemaps, you can move it anywhere on the page and even 

copy and paste it elsewhere in the site.
Editing an ImageMap
To edit an existing hotspot, select it. The General tab appears in the Properties 

palette.

● To edit the link, click Link. The Link dialog appears, displaying the tab for the 
type of link. Change the link destination or click Unlink to remove the link.

● To make the hotspot an anchor, click Anchor and type a name in the Add Anchor 
dialog. 

● To add HTML to an anchor, click HTML and follow the procedure for adding 
HTML to a link as described in “Adding HTML to a Link” on page 14-12.

● To assign an action to a hotspot, click its Actions tab on the Properties palette and 
follow the procedure described in“Adding Actions to Objects” on page 21-5.

● To resize a hotspot, select it and drag its handles.

● To create an alt tag for the hotspot, type in the AltTag field. The alt tag appears 
when the browser does not display the image.
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Placing Media 15

Media such as sound and video give a site impact. The tools in NetObjects Fusion 

make it easy to add various media files to your pages. This chapter tells how to add:

● Sound files

● Video

● QuickTime movies

● Shockwave files

● Plugins

NetObjects Fusion contains sample sound, video, and other media files that you can 

add to your pages. These files are available in the NetObjects Fusion 3.0\Samples 

folder. 
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Media Tools
The Media flyout contains five tools for placing different types of media on your 

pages. Each tool and the types of files it helps you insert are discussed in this 

chapter. 

Sound tool

Video tool

QuickTime tool

Shockwave tool

Plug-in tool
Inserting Shockwave Files
With Shockwave from Macromedia™, you can create multimedia, graphics, and 

audio that downloads quickly over a network. NetObjects Fusion supports various 

Shockwave file formats, including: 

● Shockwave for Director 4.0 and 5.0 (.dcr)

● Director (.dir)

● Protected Director (.dxr)

● Flash (.swf) and Splash (.spl) 

To view these files, site visitors must install the Shockwave plugin for their browser 

and platform. These plugins are available from the Macromedia Web site at 

www.macromedia.com.

You cannot directly add a Shockwave Audio (.swa) file to a page. Instead, embed it 

in a Director movie by passing it as a parameter to the movie, and add the movie to 

your page. Then in Assets view, add the Shockwave audio file as a file asset.

The NetObjects Fusion 3.0\Samples\Content\Shockwave Movies folder 

contains some ready-to-use Shockwave files. Any Shockwave files you embed appear 

inline on the page itself. When you insert a Shockwave or Director file, Page view 

displays the Macromedia Shockwave placeholder. 
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To get WYSIWYG height and width parameters for Macromedia Director movies, 

you must have the Macromedia Director ActiveX control (version 6.0.1 or later) or 

the Macromedia Director Netscape plugin (version 6.0.1 or later) installed on your 

system. If you have an earlier version of the ActiveX control installed, you must 

update it for this feature to work. To obtain the ActiveX control, create a site with 

NetObjects Fusion that contains a Director movie, then preview the site with 

Microsoft Internet Explorer. The ActiveX control is automatically downloaded and 

installed. If you don’t have Internet Explorer, you can download the current 

Macromedia Director plugin at www.macromedia.com/shockwave/download.

To insert a Shockwave file:

Shockwave tool

1. In Page view, select the Shockwave tool from the Media flyout on the 
Advanced toolbar.

2. Draw a box to indicate the file’s location.

The WYSIWYG feature in NetObjects sizes the Shockwave box so it is 
the appropriate size for the stage, which is the space in which the 
animation appears. If this doesn’t happen, you might not have the right 
browser plugin or ActiveX control installed. 

The Open dialog appears. 

3. Select a Shockwave file from your hard disk, CD-ROM, or LAN. 

4. Click Open.
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The Macromedia Shockwave placeholder appears on your page, and the 
Shockwave Director Properties palette appears. The Properties title 
changes depending on which type of file you selected. The name of the 
file you selected appears in the File field on the General tab. 

5. To provide text for the browser to display if it cannot play the Shockwave 
file, enter a description in the AltTag field.

6. Click the HTML button to insert HTML tags and scripts. For 
information about HTML in NetObjects Fusion, see Chapter 22, 
“Working with HTML Directly.” 

7. Select the Controls tab. 

The options on the Controls tab vary depending on the type of 
Macromedia file you selected. To set the options on the Controls tab, see 
the appropriate procedure.
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Setting the Properties for Shockwave Director

◆ In Page view, after adding a Shockwave Director file, on the Controls tab 
of the Properties palette, click the option you want, enter the parameter, 
and click the check mark.

If you have worked with Director files, you should be familiar with these 
options. For detailed information on the Controls tab options, see the 
Shockwave or Director user guide. 

Setting the Properties for Shockwave Flash or Splash

1. In Page view, after adding a Shockwave Flash file, select the Controls tab 
on the Properties palette.

The Controls options for the Flash or Splash file appear.
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2. To control the display when using anti-aliasing, select a Quality option. 

● AutoLow sets the default to normal quality. The host computer uses 

high quality if it has the capacity.

● AutoHigh starts the movie in high quality. The host computer uses 

low quality if it cannot display the movie in high quality.

● High anti-aliases the movie on any computer.

● Low uses a normal quality so the movie displays quickly. 

3. To determine how the movie fits in the frame, select the Scale option. 

● ShowAll displays the movie within the frame but maintains the 

image proportions.

● NoBorder fits the movie within the frame so it fills the frame but 

maintains the ratio of the animation. Some edges of the animation 

might be trimmed.

● ExactFit displays the movie exactly within the frame. 

4. To specify the movie’s alignment within the frame, select an Alignment 
option, such as Left, Right, or Top. 

5. To play the movie automatically when the site visitor opens the page, 
select Auto Start.

6. To replay the movie when it ends, select Loop. 
Inserting a QuickTime Movie
QuickTime, developed by Apple Computer, is a multimedia software architecture 

used to create and deliver graphics, sound, video, text, music, and 3D media. You 

can use the QuickTime tool to place QuickTime movies. 

To view QuickTime movies, site visitors must have the QuickTime plugin installed 

in their browsers. For more information on QuickTime, visit Apple Computer’s site 

at www.quicktime.apple.com. 
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To insert a QuickTime movie:

QuickTime tool

1. In Page view, select the QuickTime tool from the Media flyout on the 
Advanced toolbar.

2. Draw a box where you want to locate the QuickTime movie.

An Open dialog appears.

3. Select the QuickTime file from your hard disk, CD-ROM, or LAN.

QuickTime media has a .mov extension. 

4. Click Open.

The QuickTime placeholder appears on the page, and the QuickTime 
Properties palette appears. 

:

The name of the file you selected appears in the File field on the General 
tab. To select a different movie file, click the Browse button. 

5. To provide text for the browser to display when it cannot play a movie, 
enter a description in the AltTag field.

6. In the Display section, select the option you want:

● To play the movie in your site, select Play Inline. 

● To open a new browser window in which to play the movie, select 

Play in new browser window. 
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By default, NetObjects Fusion represents the movie on the page with the 
QuickTime icon. If you want to use a different icon, you can click the 
Browse button and select another image file to represent the movie. The 
name of the image file appears in the Launch from picture field.

7. Click the HTML button to insert HTML tags and scripts. For 
information about HTML in NetObjects Fusion, see Chapter 22, 
“Working with HTML Directly.” 

8. On the Controls tab, set the sound volume for the movie. You can enter a 
number from 0 to 256. 

9. In the Display options section, select the options you want:

● If you don’t want to show the movie but want to use it only as 

background sound, select Hide all. 

● To display a control bar that the site visitor can use to start or stop 

the movie, select Controller. This option is not available when Hide 

all is selected.

● To automatically start playing the movie when the page loads, select 

Auto start. 

● To replay the movie when it comes to the end, select Loop. You can 

replay the movie from the end to the beginning by selecting Back 

and forth. 
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10. To store the movie in the cache on the site visitor’s system, select Keep 
movie in user’s cache. If the visitor leaves the page and comes back, the 
movie doesn’t have to be downloaded again because it is already in the 
system cache. 

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”
Inserting a Video File
You can add video, such as an animation or a movie, to a site. For example, if you 

are creating a site for a video rental store, you might include video clips from the 

latest releases on the site. Site visitors could preview the video clips before they rent 

or buy the movie. 

The latest browsers often have video players built in; however, other browsers might 

require a helper application or plugin. For example, Netscape Navigator includes 

Live Video. To ensure that site visitors can view the video, you should provide a link 

to a site from which site visitors can download a plugin that can play the video files.

Using NetObjects Fusion, you can display video files two ways on a page:

● Use a placeholder icon to represent the video file. When site visitors click the 
icon, a separate browser window opens and plays the video.

● Play the video on the page when the page is displayed. 

You set how video is displayed on the Video Properties palette. 

NetObjects Fusion supports these popular video file formats:

● Moving Pictures Experts Group (.mpg, .mpeg, .mpe, .mpv), supported by 
Windows and the Macintosh with browser plugins

● Microsoft Audio Video Interleaved (.avi), supported by Windows 

● Vivo Active Producer (.viv), supported by Windows and the Macintosh with 
browser plugins

● Rapid Prototyping Module (.rpm)
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To insert a video file:

Video tool

1. In Page view, select the Video tool from the Media flyout on the 
Advanced toolbar.

2. Click where you want to position the video placeholder. 

A box with handles appears on the page, and the Open dialog appears. 

3. Select a video file from your hard disk, CD-ROM, or LAN. 

4. Click Open.

The video icon appears on the page, and the Video Properties palette 
appears. The selected file name appears in the File field on the General 
tab. 

5. To provide text that the browser displays if it cannot display the video, 
enter the text in the AltTag field.

6. In the Display section, select the display option for this video:

● To display the first frame of the video inside the browser window, 

click Inline. The image is the placeholder for the movie. The site 

visitor can start the movie by clicking the image. 

● To select a different NetObjects Fusion image to represent the video 

on the page, select Icon, then click the image you want.
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● To use another image file you previously created, such as a .gif or 

.jpeg file, to represent the video, select File. Click Browse and 

choose the image file to use. 

7. Click the HTML button to insert HTML tags and scripts. For 
information about HTML in NetObjects Fusion, see Chapter 22, 
“Working with HTML Directly.” 

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”
Inserting a Sound File
Sounds are either digital or synthesized audio files that a browser with a built-in 

player or helper application can play. To play sounds, a system must have a sound 

card and speakers. 

On any system, the visitor’s browser must be capable of playing sounds, either 

through a built-in player or helper application. Typically, site visitors must 

download and install these applications, but most popular browsers have sound file 

players built in. For example, Live Audio technology is built into Netscape 

Navigator. Visitors can also download helper applications from sound technology 

developers and install them in their browsers. Some sound formats also require 

support from the Web server. 

NetObjects Fusion supports the following popular audio file formats:

● Windows Wave (.wav) format sound files that play on Windows and Macintosh. 
For Macintosh, site visitors must have Netscape 3.x or later. 

● Audio Interchange File Format (.aiff) with browser plugins can play on Windows 
95 and Macintosh.

● Musical Instrument Digital Interface (.midi, .mid) can play on almost all types of 
operating systems.

● .AU, the most common sound format found on the Web, is used in Java applets 
and can play on Sun Microsystems and NeXT systems.
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● RealAudio™ (.ra, .ram) can play streaming audio on all systems, requires 
RealAudio Web server-resident software, and sometimes includes video. Site 
visitors must install the RealAudio player browser plugin. 

● Rich Music Format (.rmf) is a sound file format that enhances the use of music 
and sound in interactive environments, such as the Web. 

You can also add any of these formats as a background sound that plays when a 

visitor views your page. For more information, see “Setting Layout Background 

Properties” on page 7-11.

Because an audio file has no visual object, NetObjects Fusion represents the audio 

file with a graphic, usually an icon or an inline player control bar the browser 

recognizes. When a site visitor clicks the icon or the play button on the inline player 

control bar, the browser either plays the sound file or opens a helper application to 

play it. 

To insert a sound file:

Sound tool

1. In Page view, select the Sound tool from the Media flyout on the 
Advanced toolbar.

2. Draw a box on the page to indicate the location of the sound file.

The Open dialog appears.

3. Select a sound file from your hard disk, CD-ROM, or LAN. 

4. Click Open.
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The default sound icon appears on the page, and the Sound Properties 
palette appears. The name of the file you selected appears in the File field 
on the General tab. You can use the Browse button to select a different 
sound file. 

5. To provide text that the browser displays if it cannot play the sound, type 
a description in the AltTag field.

6. In the Display section, set the display options for this sound:

● To use the audio player for your browser, select Inline. If site visitors 

have Headspace Beatnik installed on their system, the browser will 

use that player to play the sound. 

● To change the sound icon, select Icon and click one of the three 

images. The selected image represents a link to the sound on the 

page. 

● To use another image file as an icon linking to the sound, select File, 

click Browse, and select an image file. 

7. Click the HTML button to insert HTML tags and scripts. For 
information about HTML in NetObjects Fusion, see Chapter 22, 
“Working with HTML Directly.” 

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”
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Inserting Other Types of Files
Although NetObjects Fusion supports a wide variety of media files, you might have 

other formats, such as Adobe Acrobat PDF files, that you want to include on your 

site. You can place other files on your site, including an Adobe Acrobat, VRML, 

RealSpace FlashPix files, and Headspace Beatnik files. 

When a site visitor clicks the document’s icon, the file displays it in the visitor’s 

browser or downloads to the visitor’s system. When you insert a file using the Plug-

in tool, site visitors need the appropriate plugin for their browser and platform to 

use the file. 

To insert a file using the Plug-in tool:

Plug-in tool

1. In Page view, select the Plug-in tool from the Media flyout on the 
Advanced toolbar.

2. Draw a box where you want to place the plugin.

The Open dialog appears. 

3. Select a file from your hard disk, CD-ROM, or LAN. 

To display the various file types that NetObjects supports, use the Files 
of type drop-down list. 

To insert a plugin that is not explicitly supported by NetObjects Fusion, 
choose All Files in the Files of type drop-down list, then select the plug-
in file. 

4. Click Open.
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The plug-in placeholder image appears on your page, and the Plug-In 
Properties palette appears. The name of the file you selected appears in 
the File field on the General tab.

5. To provide text for the browser to display if it cannot display the file, 
enter a description in the AltTag field.

6. In the Display section, select the option you want:

● To display the file on your site, select Play inline. 

● To open a new browser window in which to display the file, select 

Play in new browser window. NetObjects Fusion launches the file 

when the site visitor clicks the plug-in icon. By default, the 

Plugin.gif icon represents the file on your page. If you want to use a 

different image, you can click the Browse button and select another 

image file.

7. Click the HTML button to insert HTML tags and scripts. For 
information about HTML in NetObjects Fusion, see Chapter 22, 
“Working with HTML Directly.” 

8. Select the Advanced tab.

The Advanced options appear.
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9. Set the parameters. Because you can add different parameters for 
different files, see the associated user guide. 

● To edit parameters that appear in the Parameters section, double-

click the parameter. Enter the value in the Add Plug-In Parameter 

dialog.

● To add a parameter, click the plus (+) button and enter the 

parameter name and value in the Add Plug-In Parameter dialog.

● To remove a parameter, select it and click the minus (–) button.

● To change the order of the parameters, click the Up or Down arrow 

buttons. The selected parameter moves up or down in the 

parameters list.

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”

Use the Parameters section to add custom 
settings to the plugin. You cannot change 
the plugin’s standard parameters, such as 
height and width. 
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Replacing a Media File
Sites are constantly changing and evolving. As you build your site or after using it 

for some time, you might want to change a media file that you used in a specific 

location. You can replace one file with another.

To replace a media file with a new file:

1. In Page view or Assets view, double-click the media placeholder on your 
page.

The Open dialog appears.

2. Select the new file and click Open. 
Editing a Media File’s Properties
When you place a media file on your page, you can set the properties for that file in 

the Properties palette. The properties determine how the media file looks and works 

on your page. After previewing a page or from site visitors’ feedback, you might 

want to change the properties for a particular file. 

To edit a media file’s properties:

1. In Page view, click the media file’s placeholder.

The Properties palette for that file appears. 

2. Change the options you want. 

3. Save the site. 
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Adding Java and ActiveX 16

You can make your site more interesting and interactive by adding special 

applications, such as Java applets or ActiveX controls. The tools in NetObjects 

Fusion make it easy to insert a Java applet, Java servlet, or ActiveX control and set its 

properties. To choose appropriate properties settings, you should be familiar with 

Java or ActiveX before you add these types of application files to your site.

This chapter describes how to add the following files to your site:

● Java applets and servlets

● ActiveX controls
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Inserting a Java Applet or Servlet
Java applets and servlets are an efficient way to add sound and animation, such as 

scrolling messages and color cycling buttons, to a page. Java applets and servlets are 

platform-independent applications with compact file sizes. Usually, Java applets and 

servlets run on the client platform, which means site visitors download and run 

them from a Web browser. Most browsers are Java-compatible, so site visitors don’t 

need special plugins to run a Java application.

When you embed a Java applet or servlet file on a page, NetObjects Fusion displays 

the file’s parameters on the Java Properties palette if the file conforms to certain 

standards. If the Java applets and servlets meet the appropriate standards, you can 

edit their parameters without leaving NetObjects Fusion. 

Visit the NetObjects Fusion site (www.netobjects.com) to learn the details of 

using Java applets and servlets, and the standards that NetObjects Fusion uses to 

display the applet or servlet’s parameters. 

To insert a Java applet or servlet:

Java tool

1. In Page view, select the Java tool from the Advanced toolbar.

2. Draw a box to indicate the position of the Java applet or servlet. 

The Open dialog appears.

3. Select the appropriate Java file from your hard disk, CD-ROM, or LAN.

The extension for a Java file is .class. A sample Java applet is available in 
the NetObjects Fusion 3.0\Samples\Content\Java Applets folder. 

4. Click Open.
16-2 Adding Java and ActiveX

http://www.netobjects.com/


I N S E R T I N G  A  J A V A  A P P L E T  O R  S E R V L E T
The Java placeholder image appears on the page, and the Java Properties 
palette appears. The name of the file you selected appears in the Class 
field on the General tab.

5. Select Applet or Servlet depending on the type of file you are inserting.

6. To provide text for the browser to display if it cannot display the file, 
enter a description in the AltTag field.

7. Set the parameters. 

This guide assumes you are familiar with Java and know how to set these 
parameters. In some cases, Java developers do provide documentation 
that explains the parameters. 

● To edit parameters that appear in the Parameters section on the 

General tab, double-click the parameter. Enter a value in the Enter 

Value dialog.

For servlets, you can specify that the value is an initialization 
value for the parameter by checking the Value is an initialization 
option in the Enter Value dialog. 

● To learn more about each parameter, check the Parameter info 

section on the General tab.

● To remove a parameter, select it and click the minus (–) button.

● To add a parameter, click the plus (+) button and enter a name and 

value in the Enter Value dialog.
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Typically, you can add more instances of a parameter than already 
exists. For example, if text1 and text2 already exist, an applet will 
probably recognize a text3 parameter you create. If you add a 
parameter the applet doesn’t recognize, the parameter is ignored.

● To change the order of the parameters, click the Up or Down arrow 

buttons. The selected parameter moves up or down in the 

parameters’ list.

8. To provide text that the browser displays if it cannot launch the applet or 
servlet, enter the text in the AltTag field.

9. If your applet or servlet uses more than one .class file and you need to 
add others, click the List button, then click Add in the Java Applet Files 
dialog. 

10. Select another .class file from the Java Applet Files dialog, and click 
Open. Click OK to add the selected file. 

To delete a .class file from the Class list, click the List button and select 
the appropriate applet in the Java Applet Files dialog. Click Delete, then 
click OK.

You can drag a Java .class file from a folder onto your page. The Java placeholder 

appears on the page, and you can set the Java properties for that file. 

Note: After you place a Java object, you cannot change the applet or servlet it 
embeds. If you want to replace one object with another, you must delete the original 
Java object. 

This list shows all the .class 
files that NetObjects 
Fusion detects in the 
chosen .class file. 
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Inserting an ActiveX Control
ActiveX controls are small applications designed with a specific purpose, such as 

playing an animation. Microsoft Internet Explorer 3.x or later supports ActiveX 

controls with which you can add custom capabilities such as audio and movie 

players, calendars, custom buttons, and forms to your pages. You can view 

documents such as Microsoft Office files in Internet Explorer without launching the 

associated program. Site visitors must use Internet Explorer 3.x or later to view 

content created with ActiveX controls. To view the content in Netscape Navigator, 

site visitors must install special plugins. 

If you use an ActiveX control that references an external file, such as a .pdf file, you 

must type in the relative path of the file as it will be in the final published Web site. 

First you must add the file as an asset of the site and set it to always publish; see 

“Adding File Assets” on page 25-4 for information. Then you can determine the 

file’s relative path in the final Web site by looking at the publish directory structure 

listed in Publish view. 

Because ActiveX requires that you install Microsoft ActiveX controls on your 

system, you can get ActiveX controls from the Microsoft site. You can also check at 

www.netobjects.com and www.microsoft.com for links to archives of free, 

ready-to-use ActiveX controls.

To insert an ActiveX control:

ActiveX Control tool

1. In Page view, select the ActiveX Control tool from the Advanced toolbar.

2. Draw a box to indicate the position of the ActiveX control.
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The Insert ActiveX Control dialog appears, listing the ActiveX controls 
currently installed on your system. The bottom section shows the 
selected ActiveX control, which has an .ocx extension.

3. To display the file name of the control in the Codebase field of the 
ActiveX Properties palette, select Set Codebase. 

4. Select the control you want and click OK.

The ActiveX placeholder appears on your page, and the ActiveX Control 
Properties palette appears.

The General tab displays the options for the selected control. If you 
selected Set Codebase, the path name and file name of the ActiveX 
Control appear in the Codebase field. 
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Because the options vary depending on which ActiveX control is 
selected, this guide does not describe all the options. Step 6 explains how 
to change them. 

5. To provide text that the browser displays if it cannot launch the ActiveX 
control, enter the text in the AltTag field.

6. To change an option, select it, then edit the text field at the top.

● To accept any text you enter, click the check mark. 

● To cancel the change, click the X.

● To change the native property page for the ActiveX control, click the 

Properties button. You can change the control’s settings using the 

native property page instead of in the NetObjects Fusion properties. 

● To insert HTML tags and scripts, click the HTML button. For 

information about HTML in NetObjects Fusion, see Chapter 22, 

“Working with HTML Directly.” 
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Designing and 
Implementing Forms 17

You can add forms to your site to collect information from site visitors, for example, 

to survey potential customers, conduct credit-card transactions, have customers 

register products, or otherwise process information visitors submit. 

Using forms, visitors can type in text fields, and select options in check boxes, radio 

buttons, and combo boxes. You can use NetObjects Fusion’s Form Handler 

component to have responses posted in an email or copied to a text file on your Web 

server. Or, you can assign a Common Gateway Interface (CGI) script to further 

process responses, for example, by summarizing them on a confirmation page.

Creating forms involves:

● Creating one or more forms on a page

● Adding text fields, check boxes, radio buttons, and combo boxes

● Adding Submit, Reset, and custom buttons

● Submitting data via email or to a text file

● Processing data with a CGI script

● Adding hidden fields for client-side parameters 

You can also use JavaScripts or Visual Basic routines with forms, for example to do 

client-side processing before sending data to the server. For information on 

attaching script to forms, see Chapter 22, “Working with HTML Directly.”

Note: Don’t publish pages containing forms using the CSS and Layers HTML output 
option, or the forms won’t display properly.
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Creating a Form
With NetObjects Fusion, you can create one or more forms on a page. Devote an 

entire Layout area to a detailed survey, or create one or more forms in a Layout 

Region, table, or text box. One form might log product registrations, for example, 

while another emails customer comments to a product manager. You can also add a 

form to the MasterBorder to appear on each of several pages.

Form Area tool

1. In Page view, select the Form Area tool from the Standard toolbar, and 
draw a rectangle in the Layout area or MasterBorder.

The Create Form dialog appears. 

2. Select a type of form.

● Create position-based form. Use this option to create a form in a 

Layout Region that you can resize and drag anywhere on the page. 

When you add form objects, text boxes, and other objects to the 

region, you can freely position and align them, just as you do 

objects in a Layout area.

● Create text-based form. Use this option to create a form in a text 

box. Text you type and form objects you add appear sequentially 

inline, just as when you type. This is a good choice for forms that 

have a lot of text, where objects appear inline, or that have a simple 

layout, like a row of check boxes or single column of fields. 

A text box form usually generates less HTML when you publish 
than a Layout Region form.

Provides flexibility in arranging form objects

Good for forms that include a lot of text or 
have a simple layout

Useful for forms with a rigid tabular layout

Use if this is the only form on the page. Option 
not available when you create a form in a 
MasterBorder.
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● Create form in a table. This option creates a table where you can 

line up form objects by inserting them in table cells. Each cell acts 

like a text box, where you type and add objects just as you add other 

objects to a table.

● Define Layout as a form. Use this option to fill your entire Layout 

area with a form. You can’t use this option if there’s a form in the 

page’s MasterBorder. You’ll also notice it’s not available in the Create 

Forms dialog when you use the Form Area tool in a MasterBorder.

3. Click OK.

4. Add fields, check boxes, and other objects to your form, along with 
images and other content, as described in “Adding Objects to a Form.”

You can also turn an existing Layout or object into a form. Click the Layout area, 

Layout Region, text box, or table, and select the form option on the Properties 

palette; for example, Text box is a form.

Form in a table

Another form in a 
Layout Region
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Adding Objects to a Form
You can add any standard form objects to a form, including single- and multiple-

line text fields, check boxes, radio buttons, scrolling lists, and drop-down lists. 

You add objects to a form using the Form toolbar. This toolbar appears when you 

first create the form, or you can open the toolbar from the View menu by choosing 

Toolbars, Form Tools.

Arrange and align the fields, check boxes, and other objects in a form, just as you 

would objects in a Layout area, table, or text box. You must place form objects inside 

a form to make them work as part of the form.

To minimize the amount of HTML generated by a Layout Region form, align its 

objects by selecting them and using the Multi-Object Palette.

Browsers display form objects differently, so test your form on all the browsers and 

platforms you plan to support. 

Edit fields

Radio buttons

Multi-line text field

Form buttons

Check boxes

Drop-down list

The Form toolbar appears when you 
create a form.
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Naming Form Objects
When you add objects to a form, you provide a name or argument for each object 

that’s passed to the Form Handler component or CGI script processing responses. 

These names can then be used to output or otherwise process the text typed in each 

field or the state of each check box, radio button, or combo box. 

If you’re using the Form Handler to output responses, you must name each form 

object with a sequential number, beginning with 1, and continuing with 2, 3, and so 

on. Don’t use text characters or punctuation, as in 1-RadioButton.

In addition to names, you might also provide a value to be sent when a site visitor 

selects a check box, radio button, or item in a combo box. For example, a check box 

named Yellow with a value of Yes might be sent to a CGI script as Yellow=Yes, 

depending on the script.

Actions you add with NetObjects Fusion can also use form object values to 

manipulate a site visitor’s response. For information on using actions with values, 

see “Scripting JavaScript Expressions” on page 21-23.

Note: Avoid associating an action with an object that’s inside a form. Problems with 
some browsers can keep the form from displaying. You can, however, use an action 
with an object that’s outside the form.

If you’re using a CGI script, you might need to coordinate the names and values you 

enter with those used in the script. Also, each CGI script has its own naming 

conventions, but in general, names can’t include spaces or punctuation. Check with 

your Web administrator or ISP for more information.
Adding a Single-Line Text Field
A single-line text field can accommodate just a few words, such as a name or phone 

number. 
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After creating the form as described on page 17-2:

Edit Field tool

1. In Page view, select the Forms Edit Field tool from the Form toolbar.

2. Draw a rectangle on the form.

3. On the Forms Edit Field Properties palette, define the field’s size, 
content, and name passed to the script processing the form.

● Name. Type the argument for this field that’s passed to the CGI 

script processing the form. Ask your Web administrator or ISP if 

you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the 
object’s order in the output text. For example, a field with the 
name 2, where a visitor has typed St. Louis, might appear as 2=St. 
Louis.

● Text. Type text to appear in the field by default. This text is 

submitted as the response if the site visitor doesn’t replace it.

● Password field. Select this option if the field is for sensitive 

information like a password or credit card number. Characters site 

visitors type are submitted to the script, but depending on the 

browser, visitors see asterisks, bullets, or nothing at all as they type. 

● Visible length. Enter a number defining the text field’s width in 

characters.

Text field width, measured in characters

Maximum number of characters that can be entered 
in the field

Select to hide the site visitor’s typing.

Type text to appear in the field by default.

Argument passed to the script processing the form
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● Max length. Enter a number defining how many characters can be 

entered in the field. When typing exceeds the field’s width, text 

scrolls up to this number of characters.

4. To label the field, use the Text tool on the Standard toolbar to insert text 
next to it.
Adding a Multiple-Line Text Field
To provide a place for long comments or descriptions, you can add a multiple-line 

text field. Site visitors can type as much as they want, and text scrolls as necessary.

After creating the form as described on page 17-2:

Multi-Line tool

1. In Page view, select the Forms Multi-Line tool from the Form toolbar.

2. Draw a rectangle on the form.

3. On the Forms Multi-Line Properties palette, define the field’s height, 
content, and name passed to the script processing the form.

● Name. Type the argument for this field that’s passed to the CGI 

script processing the form. Ask your Web administrator or ISP if 

you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the 
object’s order in the output text. For example, a field with the 
name 4 that a visitor has typed in might appear as 4=Your Web 
site is really great.

Type text to appear in the field by default.

Argument passed to the script processing the form
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● Text. Type text to appear in the field by default. This text is 

submitted as the response if the site visitor doesn’t replace it.

● Visible length. Enter a number defining the text field’s width in 

characters.

● Visible height. Enter a number defining the field’s height in lines, 

up to 16. When typing exceeds this height, the text scrolls.

4. To label the field, use the Text tool to insert text next to it.
Adding Radio Buttons
Use radio buttons when you want site visitors to choose one option from a group. 

Clicking one radio button deselects all others in its group. 

After creating the form as described on page 17-2:

Radio Button tool

1. In Page view, select the Radio Button tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. On the Forms Radio Button Properties palette, define the button and 
group names passed to the script processing the form.

Value passed if this button is selected

Argument passed for the group to the script 
processing the form. This should be the same for all 
buttons in the group.
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● Group name. Type the argument for this group of buttons that’s 

passed to the CGI script processing the form. Ask your Web 

administrator or ISP if you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the 
button’s order in the output text. 

● Value sent. Type the argument passed for the button if the site 

visitor selects it. 

If you’re using the Form Handler, and a visitor selects a button 
named Large in a group named 4, the output text might appear as 
4=Large. 

● Default. Choose either Selected or Not selected to set the button’s 

initial status, which is returned as the response if the site visitor 

doesn’t change it. Remember that only one radio button in a group 

can be selected at a time.

4. To label each radio button, use the Text tool to insert text next to it.
Adding Check Boxes
You can provide check boxes for making one or more selections from a group of 

options, or to turn a single option on or off. Unlike radio buttons, any number of 

boxes in a group can be selected at the same time, or site visitors can leave them all 

unselected.

After creating the form as described on page 17-2:

Checkbox tool

1. In Page view, select the Forms Checkbox tool from the Form toolbar. 

2. Draw a rectangle on the form.
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3. On the Forms Checkbox Properties palette, define the name for this box 
that’s passed to the script processing the form.

● Name. Type the argument for this box that’s passed to the script 

processing the form. Ask your Web administrator or ISP if you’re 

not sure what’s required here.

If you’re using the Form Handler, use a number indicating the 
box’s order in the output text. 

● Value. Type the argument passed for the box if the site visitor 

checks it. 

If you’re using the Form Handler, and a visitor checks a button 
named 6 that has the value Email, the output text might appear as 
6=Email. 

● Default. Select either Checked or Unchecked to set the box’s initial 

status, which is returned as the response if the site visitor doesn’t 

change it.

4. To label each check box, use the Text tool to insert text next to it.

Value that’s passed if this box is checked

Argument passed to the script processing the form
Adding a Combo Box
If a long list of check boxes or radio buttons takes up too much space in your form, 

you can list options in a combo box, instead. Use a scrolling list if you want site 

visitors to be able to select more than one option, which is a space-saving alternative 
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to a group of check boxes. Or use a drop-down list for selecting only one option, 

which is an alternative to radio buttons.

After creating the form as described on page 17-2:

Combo Box tool

1. In Page view, select the Forms Combo Box tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. On the Forms Combo Box Properties palette, define the type of list, its 
options, and names that are passed to the script processing the form.

● Name. Type the argument for this combo box that’s passed to the 

script processing the form. Ask your Web administrator or ISP if 

you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the 
combo box’s order in the output text. 

● Type. Select whether you want a drop-down list that displays one 

item at a time, or a list box that can display several items in a 

scrolling list.

● Visible Height. For a list box, enter a number defining the list’s 

height, in lines.

● Allow Multiple Selections. For a list box, select this option if you 

want site visitors to be able to select more than one item in the list.

Argument passed to the script for the combo box

Names and values passed for each item in the list
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4. For each item in the list, click the plus (+) button and, in the Enter 
Values dialog, type a name and the value passed to the script for the 
item. 

● Name. Type the name passed for this item, which is also the name 

that appears in the list.

● Value. Type the value passed if the item is selected.

● Selected by Default. Check this option if you want this item 

initially selected. Unless you’re creating a list box and you select 

Allow Multiple Selections, only one item in the list can be selected.

5. To give the list a label, use the Text tool to insert text next to it.

Name that appears in the list

Value passed if this item is selected
Adding Submit, Reset, and Custom Buttons
After adding objects for collecting data from site visitors, you need to add a Submit 

button to send the data to your Web server. You can also supply a Reset button so 

visitors can clear the form, if they want to enter responses from scratch. And you 

can add a custom button that runs a script on the visitor’s browser, for example, to 

calculate shipping for a purchase or to validate that the right information is entered 

in a field.

Note: If you’re using the Form Handler component to send form responses in an 
email or to a text file, create your Submit button as described in “Submitting Data to 
a Text File” on page 17-14.

After creating the form as described on page 17-2:
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Button tool

1. In Page view, select the Forms Button tool from the Form toolbar. 

2. Draw a rectangle on the form.

3. On the Forms Button Properties palette, choose the type of button you 
want to create and give it a label.

● Name. Use the name your CGI script references.

● Text. If you want a different text label, select Text and type the label 

in the field.

● Image. To use a picture as a label, select Image, click Browse, and 

choose an image file from the Open dialog.

● Type. Choose the type of button you want to create from this drop-

down list.

Choosing Submit creates a button that sends the site visitor’s 
responses to the Form Handler or CGI script on the Web server. 
Choosing Reset creates a button that reverts to the form’s initial 
settings. And choosing Button creates a custom button that runs 
the script you add using the HTML button.

● HTML. Click here to open the Object HTML dialog and add a script 

that runs on site visitors’ browsers when they click the button you’re 

creating. Do this for a custom button to define what it does.

For more information, see “Accessing an Object’s HTML” on 
page 22-6.

The button’s label can be text or a picture.

Selecting Button creates a custom button.

Click here to attach a script defining what 
your custom button does.
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Submitting Responses as Plain Text
You can have responses submitted as plain text in an email or to a file on the Web 

server using the NetObjects Fusion Form Handler component. When you use the 

Form Handler, you don’t have to provide your own CGI script. 

Note: Using the Form Handler component might require configuration of your Web 
server, which some administrators or ISPs might not support. To find out what’s 
required, see the usage note at www.netobjects.com/support.
Submitting Data to a Text File
To use the Form Handler component to copy site visitors’ responses to a text file on 

your server, use the component’s tool to create the form’s Submit button.

After creating the form as described on page 17-2:

Form Handler tool

1. In Page view, select the Form Handler tool from the Component toolbar, 
and draw a rectangle on the form for the Submit button.

2. On the Form Handler Properties palette, identify the type of server, and 
rename the Submit button if you want.

Click each row in the palette and enter information as follows:

● Button Name. Type another name for the button’s label, or use the 

one that’s there. 

Click a Form Handler property here...

... to enter its value in this field.
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● Publish to. From the drop-down list, choose the type of Web server 

you’re publishing to: Windows, Mac, or UNIX.

● Success URL. Double-click this row and, in the Link dialog, select 

the page to display when a site visitor accurately completes the 

form. Click the Link button when you’re done. 

● Error URL. Double-click this row and, in the Link dialog, select the 

page to display when the submission fails, for example, if the site 

visitor doesn’t fill in a required field. 

● Output File. Type a name for the file you want responses copied to. 

Don’t specify a path. 

● Required Fields. For each field, choose whether a response is 

required (True) or not (False) for a submission to be successful. If 

you mark a field True, and a site visitor doesn’t fill it in, they see the 

error URL when they submit the form.

Note: If any object in your form isn’t listed in the Form Handler 
Properties palette, you might have named it incorrectly. For 
information, see “Naming Form Objects” on page 17-5.

3. If you’re publishing to a UNIX server, enter the following. You might 
need to consult your Web administrator or ISP for this information.

● Perl Path for UNIX. Type the path to the Perl application on the 

server. Note that Perl 5 is required on the server.

● CGI Bin Directory. Type the path to the directory on the Web server 

where CGI scripts should be copied.

● Storage Directory. Type the path to the directory on the Web 

server where you want NetObjects Fusion to put the Output file.
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Submitting Data in an Email
You can also use the NetObjects Fusion Form Handler component to copy site 

visitors’ responses into an email to any address you specify.

Form Handler tool

1. In Page view, select the Form Handler tool from the Component toolbar, 
and draw a rectangle on the form for the Submit button.

2. Enter the email address, and relabel the button if you want.

● Button Name. To change the button’s label, click in the Button 

Name row and type a name in the Form Handler text field. 

● Publish to. Click this option and choose Email from the drop-down 

list.

● Email. Click this option and type the email address to which 

responses will be sent.

● Required Fields. For each field, choose whether a response is 

required (True) or not (False) for a submission to be successful. If 

you mark a field True, and a site visitor doesn’t fill it in, they see the 

error URL when they submit the form.

Note: If any object in your form isn’t listed in the Form Handler 
Properties palette, you might have named it incorrectly. See “Naming 
Form Objects” on page 17-5.

Click a Form Handler property here...

... to enter its value in this field.
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Processing Data with a CGI Script 

To process form responses other than by outputting text, use a CGI script. A CGI 

script is a program that controls a program on your Web server. Using a CGI script, 

you can format responses for a particular application, summarize them on a page 

that’s returned to the site visitor, or do practically anything else with the data. For 

more information about the benefits of CGI scripts, talk to your Web administrator 

or ISP.

Note: Not all Web administrators let you install CGI scripts on their servers. Some 
provide standard CGI scripts for you to use, and a few don’t support CGI at all. For 
information on CGI support for your Web server, consult your server administrator 
or ISP. 

1. In Page view, click anywhere in the form except on a form object.

2. On the form’s Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For 
other forms, look on the General tab.

The Form Settings dialog appears.

3. In the top half of the dialog, specify the CGI script.

● Form Name. Type an arbitrary name for the form. This is required 

by some browsers. 

● Action. If the CGI script is already on the server, enter its URL here; 

for example:
Designing and Implementing Forms 17-17



P R O C E S S I N G  D A T A  W I T H  A  C G I  S C R I P T
http://www.host.com/myaccount/fusionproject/assets/cgi-bin/

mtscript.cgi

Note: Normally, NetObjects Fusion publishes CGI scripts to the cgi-bin 
folder on the Web server. If your server’s configuration requires 
publishing scripts somewhere else, you must use the Advanced Settings 
dialog to specify that location in the CGI script field. See “Creating 
Aliased Folders and Setting the CGI-Bin Directory” on page 26-17.

If the CGI script isn’t already on the Web server but needs to be published 

along with your site’s assets, click Browse and select the script file to be 

published from the Open dialog. This file appears in the Action field.

When visitors click Submit, their Web server executes the CGI script at this 

URL. 

Note: If the URL isn’t to your server’s cgi-bin folder, you also have to 
customize your site’s published directory structure by renaming cgi-bin 
appropriately. See “Customizing Your Directory Structure” on 
page 26-21.

● Method. Select the method for sending form data to the Web server. 

Select Post, which is the preferred method, to send data as a 
standard stream of name=value pairs, separated by an ampersand 
(&).

Select Get to send data using environment variables. Use Get with 
care, as some Web servers truncate data sent via this method.

● Encoding Type. If your Web server requires data to be encoded in a 

particular format, such as MIME or BinHex, type the format here.

4. Click OK.
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Adding Hidden Fields
If a CGI script is processing your form, you probably need to use hidden fields to 

pass additional information to it, such as which fields must be filled out to display 

the success page or where to return data once it’s been processed; for example, to 

your email address. Site visitors don’t see these fields, but their values are submitted 

to the script along with form responses.

Note: If you’re not sure what hidden fields a CGI script requires, ask the script 
author, or your Web administrator or ISP.

1. In Page view, click anywhere in the form except on a form object.

2. On the Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For 
other forms, look on the General tab.

The Form Settings dialog appears.

3. Add names and values for each hidden field in the bottom of the dialog.

● To add a field, click the plus (+) button, then enter a name and 

value for the field in the Enter Value dialog.

● To remove a field, select it and click the minus (–) button.

● To reorder fields in the list and define their order in the submitted 

data, select a field and click the up or down arrow.
Designing and Implementing Forms 17-19



A D D I N G  H I D D E N  F I E L D S
4. Click OK.

Note: If you’re using the Form Handler component to process a form, don’t enter 
hidden fields yourself. The Form Handler enters the fields it needs for you.
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Using NetObjects Fusion 
Components 18

NetObjects Fusion Components are pre-built mini-applications that add 

sophisticated interactivity to your site with no custom programming or scripting 

required on your part. For example, you can use the Site Mapper component to add 

a button that site visitors can click to display a full navigational map of the site. 

NetObjects Fusion includes nine pre-built components and one tool for adding new 

components. You place components on your pages using the tools on the 

Component toolbar. 

Some NetObjects Fusion Components require set up on the server side. You can 

find information about server-side setup in usage notes at www.netobjects.com/

support. 

If you are a software developer and want to create your own NetObjects Fusion 

components, sometimes called NFXes, you can use the NetObjects Component 

Development Kit (CDK), available for free from NetObjects. You can download the 

CDK from the NetObjects site at www.netobjects.com. 

This chapter explains how to work with NetObjects components on your pages, 

including:

● Learning about each NetObjects Fusion Component

● Adding NetObjects Fusion Components to a page

● Setting component properties for the client site

● Adding new components to NetObjects Fusion
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Adding DynaButtons
DynaButtons are Java buttons that link to another page on your site, other sites, or a 

specific file. You can place DynaButtons anywhere on your pages and assign up to 20 

buttons to a DynaButton bar. In addition, you can assign up to 20 sub-buttons to 

each DynaButton. You can create sub-buttons for navigating from a main page to 

pages at a lower level. 

When you publish the site, each button appears in the browser in the primary 

button style selected for the site and displays the name of the page to which it is 

linked. You cannot assign custom images to DynaButtons. The buttons style is 

determined by your SiteStyle. To use custom images for buttons, use the Picture 

Rollover tool. 

Because a DynaButton is an active link, the button appears active when a site visitor 

moves the mouse pointer over the DynaButton or clicks the button. The site visitor 

can click the DynaButton to go to the appropriate link. 

Note: Because of the security features in some browsers, NetObjects Fusion cannot 
display DynaButtons in Preview. To see how your DynaButtons work, you must 
publish the site locally or remotely and browse it via http: protocol. 
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To add DynaButtons and set properties:

DynaButtons tool

1. In Page view, select the DynaButtons tool from the Component toolbar.

2. Draw a box on the page to indicate the DynaButtons’ location. 

A button placeholder labeled DynaButtons appears on the page, along 
with the DynaButtons Properties palette. 

3. Select the buttons’ orientation—vertical or horizontal—from the drop-
down list.

4. Double-click the Number of Buttons row, specify how many buttons you 
want, and click the check mark. 

5. Double-click the number row, such as Button 1. 

The Link dialog appears. You can link this button to another page, file, 
smart link, or external link. For information about adding links, see 
“Working with Links” on page 14-2. 

6. Create the link for the button and click Link. 

The details of the link appear in the right column of the button row. 

You can add an action to an object using the Actions tab. For information about 

adding actions, see Chapter 21, “Building Dynamic Pages.”
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Adding Sub-Buttons
If a DynaButton contains sub-buttons, the sub-buttons appear when a site visitor 

clicks the DynaButton. The sub-button shows information about the link associated 

with the button. For example, if the sub-button is linked to an external link, the 

sub-button displays the asset name for the external link. 

To add sub-buttons and set the properties:

1. In Page view, create a DynaButton as described in “Adding 
DynaButtons” on page 18-2. 

2. Double-click a Use Sub-Buttons row, and Yes appears in the right 
column. 

NetObjects Fusion adds a Number Sub-Buttons row under the Use 
Sub-Buttons row.

3. To specify the number of sub-buttons, select the Number Sub-Buttons 
row, enter the number of buttons, and click the check mark. 

The limit is 20 sub-buttons. The appropriate number of sub-button 
rows appear, numbered in sequential order. 

4. To define the link for each sub-button, double-click the appropriate 
sub-button row, such as Sub-Button 1,2. The first number, in this case 
the 1, identifies the button for which the sub-button was created, and 
the second number is number of the current sub-button. 
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The Link dialog appears. For information about adding links, see 
“Working with Links” on page 14-2.

5. Create the link for the sub-button and click Link. 

6. Repeat steps 3 through 5 to create and define each sub-button. 
Using Ticker Tape 
Often, you want to announce a special promotion or event on your site. You can use 

the Ticker Tape component to add a scrolling message to a page and set the colors 

and speed that are used to display the message.

To add a Ticker Tape display and set its properties:

Ticker Tape tool

1. In Page view, select the Ticker Tape tool from the Component toolbar.

2. Draw a rectangle to indicate the location of the Ticker Tape display. 
Make the rectangle the size you want for the message background.

The Ticker Tape placeholder appears on the page, and the Ticker Tape 
Properties palette appears.

3. To display multiple messages in the Ticker Tape display, double-click the 
Number of Messages row, specify the number, and click the check mark.

You can specify up to 50 messages. A new Text for Message and URL for 
Message row appears for each message you specified. 

4. Double-click the Text for Message row, and type the message in the 
Ticker Tape text entry field. Click the check mark. 
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5. Double-click the URL for Message row.

The Link dialog appears. For information about creating links, see 
“Working with Links” on page 14-2. 

6. Create the link for this message and click Link. 

7. Repeat steps 4 through 6 for each message in the Ticker Tape display. 

8. Click the Speed row, and specify the scrolling speed (1 to 50) of the 
message. 

Specify a higher number to make the message scroll faster; a lower 
number to make the message scroll slower.

9. To set the frame, background, and LED colors, click the appropriate row, 
then select the color you want from the drop-down list. 

● Frame Color determines the border color of the Ticker Tape display. 

The default is grey. 

● Background Color determines the background color of the Ticker 

Tape display. The default is black. 

● LED Color determines the color of the message text. The default is 

green. 

You can add an action to an object using the Actions tab. For information about 

adding actions, see Chapter 21, “Building Dynamic Pages.”
Adding a Site Map Button
Site Mapper is a Java navigation applet that site visitors can use to create an 

interactive map of a site. If your site is large, Site Mapper simplifies navigation by 

providing a detailed view of the site’s levels. Using the site map, visitors can jump 

directly from page to page without using the page navigation controls. You cannot 

place Site Mapper inside a frame.

The Site Map button provides three ways for visitors to view the site:

● By structure, similar to the Site view in NetObjects Fusion
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● In an outline view 

● By searching for certain words

Note: Because of the security features in some browsers, you cannot click a page in 
the Site Mapper to display the page in Preview. You must publish the site before you 
can display a page from the Site Mapper. 

To add a Site Map button and set its properties:

1. In Page view, display the page of your site where you want to include the 
Site Mapper component.

Site Mapper tool

2. Select the Site Mapper tool from the Component toolbar.

3. Draw a box on the page to indicate the location of the Site Map button.

This site map shows a site 
by structure. 

The site visitor can use these 
buttons to view the site three 
different ways. 

Display two, three, or all levels of 
the site. 
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The Site Map button appears on the page, and the Site Mapper 
Properties palette appears. 

4. To change the image displayed for the Site Map button, double-click the 
Image row, then select the image file you want from the Picture File 
Open dialog. For information about placing an image, see “Adding 
Pictures” on page 10-3. 

The selected image appears on the page.

You can add an action to a NetObjects Fusion object using the Actions tab. For 

information about adding actions, see Chapter 21, “Building Dynamic Pages.”
Adding a Message Board
You can create a Message Board on your site by adding the NetObjects Fusion 

Message Board component to a page. The Message Board component is also called 

the BBS or BBS component. 

When site visitors click the Message Board button, the browser opens a new browser 

window displaying the Message Board. Visitors can use this message board to read 

messages organized by thread, subject, author, or time; expand or collapse the view; 

post new messages; and reply to messages. 
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You can have only one Message Board per site. For the Message Board to run 

properly, your Web server must be able to run CGI scripts, and the site visitor’s 

browser must support the Netscape JavaScript standard. Before you can view the 

Message Board, you must complete the server-side setup described in usage notes 

available at www.netobjects.com/support.

Note: You cannot view your Message Board in Preview because the Message Board 
uses CGI. 

Some components, such as the Message Board and Form Handler, generate files 

when they are used by the client. When you publish your site, NetObjects Fusion 

attempts to set up the proper file and directory permissions using the CHMOD 

command. Some servers do not allow this permission change. The Message Board 

will not work if it cannot write to certain files and directories. This situation is more 

common with Unix servers. You can contact your Internet service provider to find 

out if CHMOD is implemented on the server. 

To add a Message Board and set its properties:

Site visitors can 
select how to display 
messages. 
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Message Board tool

1. In Page view, select the Message Board tool from the Component 
toolbar.

2. Draw a box on the page to indicate where you want to place the Message 
Board.

The Message Board button appears on the page, and the Message Board 
Properties palette appears. 

3. To specify where Message Board files are stored, double-click the 
Subdirectory row, type the new location in the Message Board field, and 
click the check mark. 

The default is BBS. NetObjects Fusion creates the directory in your site’s 
base directory, which is the directory where you want to publish the site. 

4. To specify the title that appears in the title bar of the Message Board 
window, double-click the Page Title row, type the title, and click the 
check mark.

The Page Title cannot include a single quote. 

5. To select the operating system platform on which the server is running, 
click the Publish to row, then select the platform from the drop-down 
list. 

This option determines if the Perl5 CGI script or NT CGI binaries are 
uploaded to the server. 
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Note: If you are publishing your site to a Macintosh Web server, Message 
Board Macintosh CGI requires a Webstar 2.0 Web server, running on a 
PowerPC computer with Mac Perl5 installed.

6. If you are publishing to a Unix server, Perl5 must be installed on the 
server. Click the PerlPath for Unix row, then type the path name to the 
Perl 5 interpreter.

The path name is relative to the base publishing directory. You can 
obtain the path name from your Internet service provider. Or, if you 
want to get the Perl5 path yourself, you can type which perl or which 
perl5 at the Unix command-line prompt.

7. To specify the CGI-bin directory where the BBS CGIs are to reside, 
double-click the CGI-bin Directory row, type the path name for the 
directory, and click the check mark.

You can obtain the path from your Internet service provider. 

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”
Adding Pictures That Roll Over
You can use the Picture Rollover component to create JavaScript rollovers for any 

image on your site. Because this component uses JavaScript, the colors of your 

images are not compromised in any image. 

To view a rollover picture, site visitors must use Netscape Navigator 3.x or 4.x or 

Microsoft Internet Explorer 3.x or 4.x. You can also create rollovers for any image by 

using NetObjects Fusion actions; however, this only works in Netscape Navigator 

4.x or Microsoft Internet Explorer 4.x. 

Note: Because of the security features in some browsers, NetObjects Fusion cannot 
display a rollover picture in Preview. You must publish the site locally or remotely to 
see how this component works. 
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To add pictures that roll over:

Rollover Picture tool

1. In Page view, select the Rollover Picture tool from the Component 
toolbar.

2. Draw a box on the page where you want to locate the pictures.

A picture placeholder appears on your page, and the Picture Rollover 
Properties palette appears.

3. To specify the first image to display, double-click the Initial image row, 
select the image from the Picture File Open dialog, and click Open. 

The Picture Rollover Properties dialog changes and displays two new 
rows—Mouse over image and Mouse out image. 

4. To specify the image to display when the mouse pointer moves over the 
image, double-click the Mouse over image row, select the image from the 
Picture File Open dialog, and click Open.
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5. To specify which image to display when the site visitor moves the mouse 
pointer off the picture, double-click the Mouse out image row, select the 
image from the Picture File Open dialog, and click Open. 

6. To link the image to a specific URL, double-click the Link URL row. 

The Link dialog appears. Because the entire image is treated as one 
object, you can link it to another page, file, smart link, or external link, 
such as another site. For information about adding links, see “Working 
with Links” on page 14-2.

7. Create the link for the image and click Link. 

The details of the link appear in the right column of the button row. 
Adding Time Based Pictures
You can use the Time Based Picture component to display different pictures at the 

same location on your page at different times. You select the image to display and 

specify the hour at which to display it. The browser automatically displays the 

picture at the specified time. The picture remains on the page until it is time for the 

next picture to be displayed. 

NetObjects Fusion supports the most popular graphics formats used on the Web, 

including .gif and .jpeg. For information about these formats, see “Adding 

Pictures” on page 10-3. 

Note: Because of the security features in certain browsers, NetObjects Fusion cannot 
display the Time Based Picture component in Preview. You must publish the site to 
see how this component works. 

To add time based pictures and set the properties:

Time Based Picture 
tool

1. In Page view, select the Time Based Picture tool from the Component 
toolbar.

2. Draw a box on the page where you want to locate the picture.
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A picture placeholder appears on your page, and the Time Based Picture 
Properties palette appears.

3. Double-click the Number of Images row and specify the number of 
images you want to rotate.

You can use up to 24 images. NetObjects Fusions adds an Image, Start 
Time for Image, and URL for Image row for each image.

4. To select an image, double-click the Image row, select the image from the 
Picture File Open dialog, and click Open. 

For information about adding an image to your site, see “Adding 
Pictures” on page 10-3.

5. Double-click the URL for Image row, then select the type of link.

For information about creating links, see “Working with Links” on 
page 14-2.

6. Specify the link information and click Link. 

7. Double-click the Start Time for Image row and select a starting time 
from the drop-down list.

The start time determines when the image is displayed on your site. You 
can select one-hour increments from 12 a.m. to 12 p.m. The image is 
displayed until the next image’s starting time. 

8. Repeat steps 4 through 7 for each image you add. 

The number of 
images is 3 by 
default. 
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Loading Pictures onto Your Site
Use the NetObjects Picture Loader Component to load an image from a site other 

than your own. You can use this to place advertising banners if the banners are 

located on a server other than your Web server. 

To load a picture from an external source:

Picture Loader tool

1. In Page view, select the Picture Loader tool from the Component 
toolbar.

2. Draw a box on the page to indicate where you want to place the picture.

A picture placeholder appears on your page, and the Picture Loader 
Properties palette appears.

3. Double-click the Image URL row and type the URL where the picture is 
located.

Type the complete URL. For example: http://www.netobjects.com/
announcements/assets/images/homepagemainart.gif.

4. Click the check mark. 
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Adding Rotating Pictures
You can use the NetObjects Fusion Rotating Picture component to display different 

pictures in succession in the same place on the page. For example, you could rotate 

among several images that advertise new products or current sale items. 

To add a rotating picture, you specify the image to display and the number of 

seconds to pause before displaying the next picture in the sequence. You can also 

assign a link to each picture.

NetObjects Fusion supports the most popular graphics formats used on the Web, 

including .gif and .jpeg. For more information about these formats, see “Choosing 

an Image Format” on page 10-2. Note that if you want to use animated .gif files, you 

can create an animated .gif file outside NetObjects Fusion in several popular image-

editing applications. After creating the animated .gif file, use the Picture tool to 

place the file. 

Note: Because of the security features in certain browsers, NetObjects Fusion cannot 
display a rotating picture in Preview. You must publish the site locally or remotely to 
view rotating pictures. 

To add pictures that rotate and set their properties: 

Rotating Picture tool

1. In Page view, select the Rotating Picture tool from the Component 
toolbar.

2. Draw a box on the page to indicate where you want to place the picture.
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A rotating picture placeholder appears on the page, and the Rotating 
Picture Properties palette appears.

3. To set the number of seconds each picture is displayed before moving to 
the next one, double-click the Pause Time (Seconds) row, specify the 
number of seconds, and click the check mark.

4. To set how many different images to display in the rotating picture, 
double-click the Number of Images row, specify the number of images, 
and click the check mark. 

You can display up to 50 images for your rotating pictures. An Image 
row and URL for Image row for each image you specified appears. 

5. Double-click an Image row, select an image file from the Picture File 
Open dialog, and click Open. 

For information about placing images, see “Adding Pictures” on 
page 10-3.

6. To create a link for this image, double-click the image’s URL for Image 
row, then select the type of link. For information about creating links, 
see “Working with Links” on page 14-2.

7. Specify the appropriate information for the link and click Link. 

8. Repeat steps 5 through 7 for each image. 

You can add an action to an object using the Actions tab. For more information 

about adding actions, see Chapter 21, “Building Dynamic Pages.”
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Adding Other NetObjects Fusion Components
NetObjects Fusion components extend a site’s functionality. Many third-party 

developers create components that make external database connectivity, electronic 

commerce, and dynamic data publishing possible. 

Dynamic data publishing, for example, refreshes data each time a visitor goes to the 

site. You can publish data dynamically on your site by adding a third-party 

component, such as:

● Allaire Cold Fusion and Fusion2Fusion components, available at 
www.allaire.com

● Selective Server from Fundere, available at www.fundere.com

● Lotus Domino and NetObjects Fusion Connector, available at www.lotus.com

For information about static data publishing, see “Static and Dynamic Data 

Publishing” on page 20-2. 

Other third-party developers, such as Coolmaps, provide many useful components. 

You can purchase components from Coolmaps to create special rollover buttons, 

add pull-down menus of links, or put a vicinity map on your page. Visit the 

Coolmaps site at www.coolmaps.com for information. 

Because the number of NetObjects Fusion components is constantly growing, the 

NetObjects Web site at www.netobjects.com is a valuable resource for learning:

● When new components become available

● The many ways to enhance your site with NetObjects Fusion components 

● How to develop your own NetObjects Fusion components using the CDK.

You can add a component to your site by:

● Dragging the component file (.nfx extension) and any associated files and folders 
into the Components folder in the NetObjects Fusion folder. 

● Using the NetObjects Fusion Components tool from the Component toolbar. 
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To add a new or third-party NetObjects Fusion component:

NetObjects Fusion 
Components tool

1. In Page view, select the NetObjects Fusion Components tool from the 
Component toolbar.

2. Draw a box on the page where you want to place the component. 

The Installed Components dialog appears and displays a list of installed 
NetObjects Fusion Components. 

3. Click Add.

The Install Components dialog appears.
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4. Select the component to add and click Open.

Components have the extension .nfx or .class. You cannot add 
components that come with NetObjects Fusion, such as DynaButtons or 
the Message Board. Any other components appear in the list in the 
Installed Components dialog.

5. To add the component to your page, select the component in the 
Installed Components dialog and click OK.

The new component appears on your page, and the component’s 
properties palette appears. 

6. Specify the properties for the component. 

Because each component has different properties, check the information 
included with the component for help. 
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Referencing and Editing 
External HTML 19

In addition to content you create and maintain in Page view, your site might also 

include pages that require special, hand-coded HTML. Instead of importing and 

converting this HTML, you can reference HTML files externally and place them 

anywhere in your site. NetObjects Fusion doesn’t parse the HTML when it publishes 

your site, ensuring that your HTML is kept pure.

You can edit referenced files externally using any HTML editor, such as Allaire 

HomeSite 3.0, which is included with NetObjects Fusion. Plus, you can manage 

external assets in Assets view, and apply a consistent look to the published pages by 

assigning a MasterBorder.

This chapter describes how to work with external HTML by:

● Referencing HTML from Site view

● Referencing HTML from Page view

● Referencing HTML as an object

● Managing referenced assets

● Publishing native HTML

● Previewing and publishing unmanaged assets 

● Editing referenced HTML

Note: You can reference files located on a hard disk, CD-ROM, or LAN, but not from 
a remote Web server. Also, <A HREF> links in the original HTML files should point 
to other HTML files, and anchors within those files, using relative rather than 
absolute path names. See “Managing Referenced Assets” on page 19-9 for 
information.
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Referencing HTML from Site View
You can reference an entire site or section of a site from Site view. For example, you 

might reference an existing site you want to manage with NetObjects Fusion now 

and import later. Or, reference files you prefer to maintain in their native code, such 

as files containing the HTML tags ROWSPAN or COLSPAN.

Note: For links to work between the HTML files you reference, use relative path 
names in the original <A HREF> tags, and publish files using the same directory 
structure as the original site. See “Managing Referenced Assets” on page 19-9 for 
information.

When you reference HTML from Site view, NetObjects Fusion publishes the 

<HEAD> content from the original files, along with <HEAD> content it generates.

1. In Site view, select the page to be the parent of the pages you reference.

2. From the File menu, choose Reference HTML, or right-click the page 
icon and select Reference HTML from the shortcut menu.

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the top-level HTML file you want to reference, and click Open to 
return to the Reference HTML dialog. 

5. Choose which files to reference, and assign a MasterBorder.

NetObjects Fusion adds the top level 
page you’re referencing here, and its 
children below.

Select an existing page and 
choose the Reference HTML 
command.
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● Assign MasterBorder. Choose a MasterBorder from this drop-

down list. Each HTML file you reference occupies the Layout area of 

a page, while the MasterBorder gives pages the consistent look of 

your site. To display external content with its original look, choose 

ZeroMargins.

Note: If any external HTML you’re referencing contains frames, you must 
choose the ZeroMargins MasterBorder.

● Limit number of pages to. You can select this option to enter a 

number of files to reference. NetObjects Fusion begins with the 

Home page you select and stops referencing when it reaches the end 

of the site or the number of pages entered here.

● Down to structural level. Select this option to enter how many 

levels of your site structure to reference. NetObjects Fusion 

references as many pages as possible at a higher level before going to 

a lower level.

● Do not manage or move assets. If you select this option, 

NetObjects Fusion doesn’t copy external assets into Assets view. Do 

this if you prefer that path names in the published HTML not be 

edited from your native code. However, you then have to manage 

images and other assets yourself. See “Publishing Unmanaged 

Assets” on page 19-13.

NetObjects Fusion references 
this file and child files in the 
domain you specify.

Display referenced HTML on 
pages with your site’s 
MasterBorder, or choose 
ZeroMargins to publish external 
content with its original look.

If you check here, NetObjects 
Fusion doesn’t edit path names 
in the published HTML, but you 
have to manage images and 
other assets yourself.

You can limit how many files 
to reference...

... or how deep into your 
external site to reference.
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● Domain Name. Enter the domain name of the site containing the 

HTML files you’re referencing. Be sure to include the entire name, 

as in www.netobjects.com.

6. Click OK.

Preview your site to see the referenced pages.

You can rename referenced pages in Site view, just like you do other pages. To keep 

track of what part of your site is externally referenced, you might want to use the 

View tab on the Properties palette to assign a different color background to the 

icons of referenced pages.
Referencing HTML from Page View
You can reference an external HTML file as the Layout area of a page from Page 

view, and incorporate the file’s <HEAD> content—for example, to include existing 

Meta tag keywords or JavaScript definitions.

1. Create a page in Site view.

2. In Page view, from the File menu, choose Reference HTML. 

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the external file you want to reference, and click Open to return to 
the Reference HTML dialog.

5. Choose whether to import the referenced file’s <HEAD> content and 
manage external assets.
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● Import <HEAD>. Select this option to publish the external HTML 

file’s <HEAD> content. Choose Append to Current <HEAD> to 

add external <HEAD> content to what NetObjects Fusion 

generates, or choose Replace Current <HEAD> to publish only the 

external file’s <HEAD> content.

Caution: Don’t select Replace Current <HEAD> if the page contains actions or is 

being published using the CSS and Layers HTML output option. NetObjects 

Fusion generates <HEAD> content these options require. 

● Do not manage or move assets. If you select this option, 

NetObjects Fusion doesn’t copy any external assets into Assets view. 

Do this if you prefer that path names in the published HTML not be 

edited from your native code. However, you then have to manage 

images and other assets yourself. See “Publishing Unmanaged 

Assets” on page 19-13.

6. Click OK.

NetObjects Fusion places this 
file’s <BODY> in the Layout area 
of your new page.

Check here to also publish the 
file’s <HEAD> content...

...either in addition to, or instead 
of, the <HEAD> NetObjects 
Fusion generates.

If you check here, NetObjects 
Fusion doesn’t edit path names 
in the published HTML, but you 
have to manage images and 
other assets yourself.
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In Page view, the referenced HTML fills the Layout area:

Information about the 
referenced file

You can double-click the 
Layout area to open the 
file and edit its HTML. 
See “Editing Referenced 
HTML” on page 19-13.
Referencing HTML as an Object
You can reference an external file as an individual object on a page. Reference an ad 

banner, for example, an applet created by a Java generator such as Lotus Bean 

machine, or any other object requiring special code. 

You can even put several external files on a page. For example, you might construct 

a front page for a company newsletter that includes a slot for each of several 

externally maintained story leads; and add pictures, actions, or media created with 

NetObjects Fusion. 

As when you reference HTML as a Layout area, you can incorporate each file’s 

<HEAD> tags and script definitions to include existing Meta tag and script 

definitions.
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To reference HTML as an object:

External HTML tool

1. In Page view, select the External HTML tool from the Advanced toolbar. 

2. Draw a box where you want the referenced content to appear. 

Put the box in the Layout area to publish the content on one page, or in 
the MasterBorder to publish it in the border of several pages.

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the external file you want to reference, and click Open to return to 
the Reference HTML dialog.

5. Choose whether to import the referenced file’s <HEAD> content and 
manage external assets.

● Import <HEAD>. Select this to publish the external HTML file’s 

<HEAD> content. Choose Append to Current <HEAD> to add 

external <HEAD> content to what NetObjects Fusion generates 

and what you import from other external objects on the page. Or 

choose Replace Current <HEAD> to publish only this external file’s 

<HEAD> content.

Caution: Don’t select Replace Current <HEAD> if the page contains actions or is 

being published using the CSS and Layers HTML output option. NetObjects 

Fusion generates <HEAD> content these options require. 

This file’s <BODY> is published 
in the table cell NetObjects 
Fusion generates for the object.

Select this to also publish the 
file’s <HEAD> content...

...either in addition to, or 
instead of, any <HEAD> 
contents NetObjects Fusion 
generates.

If you select this, NetObjects 
Fusion doesn’t edit path names 
in the published HTML, but you 
have to manage images and 
other assets yourself.
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● Do not manage or move assets. If you select this, NetObjects 

Fusion doesn’t copy any external assets into Assets view. Do this if 

you prefer that path names in the published HTML not be edited 

from your native code. However, you then have to manage images 

and other assets yourself. See “Publishing Unmanaged Assets” on 

page 19-13.

Preview the page to see the object. If necessary, go back and adjust the box’s position 

in Page view to get the actual spacing you want. As with other objects, you can drag 

a referenced object around the page, drag it inside other objects, or even layer it. 

Add other referenced 
objects as well as pictures, 
media, and objects created 
in NetObjects Fusion.

Double-click an external 
object to edit the HTML. 
See “Editing Referenced 
HTML” on page 19-13.
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Toggling Referenced Layouts and Objects
You can convert a referenced layout into an object, for example, to add other objects 

to the Layout area. Or conversely, size a referenced object to fill the Layout area. Use 

the Lock to Layout option on the External HTML Properties palette.

1. In Page view, click in the referenced Layout area or object you want to 
resize.

2. Click the General tab on the External HTML Properties palette.

3. Select or clear Size to Layout.

Clearing this option adds resize handles to a referenced Layout area, so 
you can resize it, move it, and add other objects to the Layout area. 
Selecting the option removes resize handles from an object, which snaps 
to fill the Layout.

Note: Avoid locking a referenced object to a Layout if there are other 
objects in the Layout area. You might get unexpected results in some 
browsers.

Adds or removes resize handles 
from referenced HTML
Managing Referenced Assets
When you reference an external HTML file, NetObjects Fusion lists the HTML file 

in Assets view. Unless you choose otherwise, it imports into Assets view pictures, 

applets, media, and most other external assets the file references. 
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You can move external assets around in your directory structure in Publish view 

while maintaining paths. When you publish, NetObjects Fusion edits paths to the 

assets so they can be found. For example, depending on your original and published 

directory structures, NetObjects Fusion might change the original HTML’s 

<IMG SRC="Images/Logo.gif"> to <IMG SRC="../Index/Logo.gif"> in the 

published HTML.

However, NetObjects Fusion doesn’t edit paths to other HTML files, or to 

<TARGET=> anchors within a file. For these links to be maintained, the path 

names in the original files must work as-is when you publish. The original <A 

HREF> tags must use relative rather than absolute path names; that is, use 

<A HREF=".Index.html"> rather than <A HREF="HTTP://

www.your_original_domain.com/Index.html">. And you must position external 

HTML files in your NetObjects Fusion directory structure so these original paths 

work. See “Customizing Your Directory Structure” on page 26-21.

In particular, NetObjects Fusion manages external assets referenced by these tags:

● <IMG SRC=>

● <A HREF=> to non-HTML assets, such as sound files

● <BODY BACKGROUND=>

Referenced HTML files are 
listed in Assets view.

Unless you choose 
otherwise, pictures and 
other assets are listed, 
too. Rename them, 
double-click them to see 
them in Page view, and so 
on.
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● <EMBED SRC=>

● <BGSOUND SRC=>

● <SCRIPT SRC=>

● <INPUT SRC=>

● <APPLET CODE=>

Although NetObjects Fusion manages external applets that are assets of referenced 

HTML, it doesn’t manage classes referenced by the applets. See “Publishing 

Unmanaged Assets” on page 19-13 for information on getting these classes and 

other unmanaged assets to the Preview folder or Web server.

Note: Once an external asset is imported into Assets view, you can use it anywhere 
throughout your site. Deleting referenced HTML from your site removes its assets 
from Assets view unless they’re in use elsewhere. 
Publishing Native HTML
When you preview or publish referenced HTML, NetObjects Fusion copies the 

HTML from the original files to .html files it creates in the Preview or publish 

folder. If it’s managing external assets or including MasterBorders, NetObjects 

Fusion also adds its own code to the published HTML. Of course it never modifies 

your original files.
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If you don’t want NetObjects Fusion to add HTML to the original code when it 

publishes, you can choose these options in the Reference HTML dialog.

● When you reference from Site view, choose the ZeroMargins MasterBorder. 
NetObjects Fusion doesn’t add MasterBorder information to the published 
HTML or impose a table structure.

● When you reference from Page view, you can choose Replace Current <HEAD> 
from the Import <HEAD> drop-down list. NetObjects Fusion publishes the 
original <HEAD> as-is, without adding HTML of its own. 

Don’t do this if you’re using actions on the page or publishing using the CSS and 

Layers HTML output option.

● In either case, check Do not manage or move assets. NetObjects Fusion doesn’t 
copy external assets into Assets view, so it doesn’t edit path names in the 
published HTML. However, you have to publish images and other assets yourself. 
See “Publishing Unmanaged Assets” for information.

● Be sure Lock to Layout is selected on the External HTML Properties palette.

When you reference HTML 
from Page view, choose 
Replace current <HEAD>.

In either case, check this 
option.

When you reference HTML 
from Site view, choose the 
ZeroMargins MasterBorder.
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Publishing Unmanaged Assets 
If you choose not to manage assets when you reference external HTML files, you 

have to get external pictures, media files, applets, and other assets to the Web server 

yourself. 

You can upload the files to the server with an FTP utility. Or, copy assets manually 

into Assets view, and they are published when you publish the rest of the site.

1. In Assets view, from the Assets menu, choose New File Asset.

The New File Asset dialog appears.

2. Click Browse in the dialog to open an external asset you want to publish, 
and type a name for the asset.

For more information on this dialog, see “Adding File Assets” on 
page 25-4.

3. Select Always publish file in the dialog.

This causes NetObjects Fusion to publish the file, even though it’s not 
listed as being in use.

4. In Publish view, position the asset in your directory structure so when 
it’s published, it can be found by any HTML referencing it.

Because NetObjects Fusion doesn’t edit paths to unmanaged assets in 
the published HTML, you must position assets so the original paths will 
work. See “Customizing Your Directory Structure” on page 26-21.
Editing Referenced HTML
To update referenced HTML, edit the original files using any HTML editor, such as 

Allaire HomeSite 3.0, which is included with NetObjects Fusion. To add or modify 

assets, do so in the original site folder, as well. When you preview or publish the site, 

NetObjects Fusion copies the original HTML to your site’s Preview folder or Web 

server. If it’s managing assets, it copies asset files you add or modify, too.
Referencing and Editing External HTML 19-13



E D I T I N G  R E F E R E N C E D  H T M L
1. In Page view, select the referenced Layout area or object, and click the 
Edit HTML File button on the External HTML Properties palette. Or, 
just double-click the referenced page or object.

Your default HTML editor opens. You choose this editor using the 
Preferences command on the Edit menu.

2. Edit the HTML.

3. Save your changes and close the file.

Click here in the Preferences dialog 
to select your default HTML editor, 
such as Allaire HomeSite 3.0.
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Or double-click the external 
HTML.

Click Edit HTML File on the 
Properties palette.

Your default editor opens for 
you to edit the original HTML.
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Data Publishing 20

NetObjects Fusion makes it easy to publish information such as employee 

directories, product and service catalogs, and event schedules. You can enter, 

manage, and store this information as records either in your NetObjects Fusion site, 

or in an external application such as a database or spreadsheet.

To publish the data, you specify its source and create a layout for the pages that will 

display it. NetObjects Fusion uses your Layout to create a separate page for each 

record, and can automatically provide your site visitor with buttons to navigate 

between them.

This chapter describes how to publish data using NetObjects Fusion, including:

● Static and dynamic data publishing

● Creating a data object

● Storing data internally

● Using data stored externally

● Creating a data list

● Creating stacked pages
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Static and Dynamic Data Publishing
NetObjects Fusion supports two kinds of data publishing: static and dynamic.

● Static data publishing takes any kind of data—text, pictures, multimedia files, 
and so on—from a database or spreadsheet. NetObjects Fusion publishes the 
data on your site, where it remains unchanged—static—until the source data is 
changed and the site is re-published. Static data publishing, which is the focus of 
this chapter, uses data objects that can derive their data from internal or external 
sources.

● Dynamic data publishing makes it possible to refresh the data each time a visitor 
goes to the site. When the browser requests the data, it is assembled on the spot; it 
does not depend on re-publishing the site.

Dynamic data publishing requires third-party components such as:

– Allaire’s Cold Fusion and Fusion2Fusion components 

(http://www.allaire.com)

– Selective Server from Fundere (http://www.fundere.com)

– Lotus Domino and NetObjects Fusion Connector (http://www.lotus.com)

For information on additional third-party components, see “Adding Other 

NetObjects Fusion Components” on page 18-18, or visit the NetObjects Fusion 

Web site at www.netobjects.com.
Storing Data with NetObjects Fusion
Using the data publishing capabilities of NetObjects Fusion, you can store text and 

pictures in a database internal to your site, or import data from external sources 

such as Microsoft Excel, Access, and ODBC databases. In both cases, NetObjects 

Fusion publishes your data in standard HTML pages. This makes it easy to add 

listings, such as product and service catalogs, employee directories, and event 

schedules to your site.
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Data publishing in NetObjects Fusion uses the following objects:

● data objects

A data object is a collection of data fields, the definition of what data will be 

published. Creating a data object is the essential first step in adding internal or 

external data to your site. The data object becomes an asset of your site. When 

you store records internally, you must specify the data fields you want to store. 

When you store records from external data, NetObjects Fusion includes all fields 

available in the source.

● data fields

Defined in the data object, data fields appear in the stacked pages and are the 

containers for the data in your site. You can arrange and label the data fields, and 

this arrangement appears in all stacked pages.

● data lists

The data list appears on the parent page of the stacked pages that contain the 

actual data. The data list functions as a table of contents for the internal or 

external data in your site. You select the fields you want to display as column 

headers in the list. The field data from either the internal or external source 

populates the data list when you publish.

● stacked pages

Each record in your database appears on a separate stacked page below the page 

containing the data list. Stacked pages are not siblings of each other, but instead 

are iterations of the same page, containing the fields defined in your data object.

The following illustration shows the relationship of these objects for internal and 

external databases.
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For example, you could publish a backpack catalog on your site, with a record for 

each backpack. Each row in the data list lets the site visitor navigate to the stacked 

page that describes the corresponding backpack with a description, photo, and 

price.

To create your backpack catalog, your first step is to create a backpack data object. 

You can define a data object once and use it in different filtered data lists. For 

example, you can create one data list of all the backpacks in your database. With the 

same data object, you can create additional data lists of internal frame backpacks, 

external frame backpacks, frameless backpacks, and so on.

If you create a data object from an external source—for example, from a Microsoft 

Access database—and then update or change the external source, you must use 

Assets view to update the data in your site. For example, suppose your backpack 

data object references 50 records originally and the external database is increased 

Data object with internal data source Data object with external data source
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with 25 new records. After you update your site, the data object references 75 

records, the backpack data list contains 75 rows, and there are 75 stacked pages.

After you create a data list on a page, NetObjects Fusion generates a stacked page as 

its child. When you create the Layout of the first stacked page, the remaining stacked 

pages automatically inherit the same Layout. The following illustration shows how 

the data list page and its child stacked pages appear in Site view.

Data list page

Stacked pages
Publishing Data
In general, when you work with data publishing, you follow this three-step process:

1. Create a data object.

2. Create a data list.

3. Create a set of stacked pages.

When you create a data list, NetObjects Fusion automatically creates the first of 

your stacked pages, where you create the Layout to be used for all the pages in the 

stack.

When you design a stacked page, you create or identify the field data you want to 

display on the page.

● If you are storing data internally, you enter the field data on the stacked page 
itself.

● If you are using an external source, the field data is drawn from the external 
database, spreadsheet, or ASCII text file.
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When you use the Data List tool in Page view, you can perform all three tasks within 

the Data Publishing dialog.

Create or select a data 
object.

Choose options for the data list.

Choose options for stacked pages.

Click OK to create the data list and 
stacked pages.
Creating a Data Object
You can create two types of data objects:

● Internal data objects: These objects reference simple text, formatted text, and 
picture data fields stored within your site.

● External data objects: These objects import simple text fields from a data field 
created in a program other than NetObjects Fusion. External data sources 
include external databases, spreadsheets, and ASCII text files.

Use external data if your database is maintained by others who do not have 

NetObjects Fusion, if you have large quantities of data, or if the data is frequently 

updated.

Note: Importing external data takes a single table from a database or a 
single worksheet from a program such as Microsoft Excel; it does not 
import the entire database.
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The two data tools appear on the Advanced Tools toolbar.

Use the New External Data Source tool to create a data object for external data; use 

the Data List tool to create a data object for internal data. The currently selected tool 

appears on the toolbar.

New External Data Source tool

Data List tool
Creating a Data Object for Internal Data
Internal data is records and fields stored within your site. You enter internal data 

directly into a stacked page by typing text or numbers and by placing pictures.

You can create a data object in Page view or in Assets view. If you create a data object 

in Page view, you can immediately create stacked pages to contain the data. If you 

create a data object in Assets view, you must return to Page view to create a data list 

and stacked pages.

To create a new internal data object:

1. Do either of the following:

Data List tool

● In Page view, select the Data List tool from the Advanced toolbar, 

and draw a rectangle on the page. The Data Publishing dialog 

appears—see page 20-6. Click the New button to display the Data 

Object dialog.
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● In Assets view, click the Data Objects tab and then click the New 

button on the control bar. The Data Object dialog appears.

2. Select Internal and enter a name for the data object and comments 
about it.

NetObjects Fusion uses the data object name to identify your data object 
when it lists all data objects in the Data Publishing dialog and in Assets 
view.

3. Click the plus (+) button to add a field. Fields define the kind of data 
you can enter.
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The Data Field dialog appears.

4. Type the field name, select the data type for the field, and click OK.

Internal data fields can store formatted text, plain text, and image files:

● Simple text fields: All characters in these fields share the same 

formatting characteristics. Simple text fields cannot contain 

paragraph breaks or line breaks and cannot exceed 255 characters. 

You can sort on simple text fields.

● Formatted text fields: Characters in these fields can be formatted 

individually. Formatted text fields can contain paragraph breaks 

and line breaks and can exceed 255 characters. You cannot sort on 

formatted text fields.

● Image file fields: These fields can contain an image in one of these 

formats: .bmp, .gif (animated, embedded, interlaced), .jpg, .jpeg, 

.pct, .pcx, .pict, .png, .psd, .tga, or .tiff. You can sort on image file 

fields.

Note: Take special care as you define fields. Once you click OK in the 
Data Field dialog, you cannot delete the field from the data object. 

5. Repeat steps 3 and 4 to add fields.

6. When you are done, click OK in the Data Object dialog.
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The data object is now an asset of your site, and you can continue as follows:

● If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 20-18, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 20-22.

● If you’re in Assets view, take these additional steps:

a. Switch to Page view.

Data List tool

b. Select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.

You can now select fields and format the data list as described in 
“Creating a Data List” on page 20-18, and lay out your stacked pages as 
described in “Creating Stacked Pages” on page 20-22.
Changing an Internal Data Field Name
1. Switch to Assets view.

2. Click the Data Objects tab.

3. Double-click the data object name. 

The Data Object dialog appears.

4. Double-click the name of the object you want to rename. 

The Data Field dialog appears.

5. Type a new name in the Name field and click OK.

You can also change a Simple text field to an Image field and vice versa, but you 

cannot change the type of a Formatted text field.
Creating a Data Object for External Data
External data exists in local desktop databases or in ODBC data sources. To make 

this data available to your site, you must choose an appropriate driver. NetObjects 

Fusion uses two types of drivers to access external data:
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● Indexed Sequential Access Method (ISAM) drivers: These draw data from 
desktop databases, such as Microsoft Access, Paradox®, dBASE®, Microsoft 
FoxPro®, Microsoft Excel, or delimited text files. 

● Open Data Base Connectivity (ODBC) drivers: These draw data from 
Structured Query Language (SQL) data sources, such as Oracle and Sybase data 
files.

A data source is either of the following:

● an ISAM driver plus a source data file

● an ODBC data source, which is an ODBC driver bound to a database

If your system includes both types of drivers for your application, use the ISAM 

driver, which is faster. In addition, selecting an ISAM driver takes fewer steps.

NetObjects Fusion automatically imports all the fields available in the external 

database file. By default, it imports all external fields as simple text or formatted 

text. To import pictures referenced in an external file’s field as image file paths, 

change that field’s type to Image.

Note: NetObjects Fusion components that support dynamic data publishing are 
available. Visit www.netobjects.com for information.
Creating an External Data Object from a Desktop Database
This section describes how you draw data from desktop databases such as Microsoft 

Access, Paradox, dBASE, Microsoft Pro, Microsoft Excel, or from delimited text 

files. Your system must include an ISAM driver appropriate for your source. ISAM 

drivers are automatically installed with most desktop databases.

To create an external data object from a desktop database:

1. Do any of the following:
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New External Data 
Source tool

● In Page view, select the New External Data Source tool from the 

Advanced toolbar, and draw a rectangle on the page.

Data List tool

● In Page view, select the Data List tool from the Advanced toolbar, 

and draw a rectangle on the page. The Data Publishing dialog 

appears. Click the New button. The Data Object dialog appears. 

Select External and then click the Source button.

● In Assets view, click the Data Objects tab, and then click New on the 

control bar. The Data Object dialog appears. Select External and 

then click the Source button.

The Data Source Type dialog appears.

2. Select the data file type from the drop-down list.

NetObjects Fusion always lists Access 3.0. Additional data types are 
available if ISAM drivers are installed. ISAM drivers are automatically 
installed when you install Microsoft FoxPro, Microsoft Visual FoxPro®, 
Paradox, Microsoft Excel, or dBASE.

Note: If the data is in Microsoft Excel 97 Workbook format, use an 
ODBC driver. See “Creating an External Data Object from a SQL Data 
Source” on page 20-14.

3. Click the Browse button, locate the database, and open it.
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If the file is a multiple-file database or a spreadsheet with multiple tabs, 
the Select dialog appears.

4. Select the file or tab you want to use and click OK.

NetObjects Fusion creates the data object and makes it an asset of your 
site. The data object contains all fields in the external source, and takes 
the name of the selected file or tab. All fields are Simple text fields, 
regardless of their type in the source.

The data object is now an asset of your site, and you can continue as follows:

● If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 20-18, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 20-22.

● If you’re in Assets view, take these additional steps:

a. Switch to Page view.

Data List tool

b. Select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.

You can now select fields and format the data list as described in 
“Creating a Data List” on page 20-18, and lay out your stacked pages as 
described in “Creating Stacked Pages” on page 20-22.
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Creating an External Data Object 
from a SQL Data Source
This section describes how you use an Open Data Base Connectivity (ODBC) driver 

to draw data from a Structured Query Language (SQL) data source, such as an 

Oracle data file.

Before you can choose an ODBC data source, you must specifically create the data 

source by binding your data file to a driver. You can do this in the Windows ODBC 

Data Source Administrator, found in the Control Panel as 32bit ODBC, or from 

within NetObjects Fusion, as described below.

If you use MS Office or MS Office Professional for Windows 95, you might already 

have a set of ODBC drivers installed on your system. If you do not use those 

products, you must obtain the drivers elsewhere. Contact Microsoft for 

information.

To create a data object from a SQL data source:

1. Create an external data object by doing any of the following:

New External Data 
Source tool

● In Page view, select the New External Data Source tool from the 

Advanced Tools toolbar, and draw a rectangle on the page.

Data List tool

● In Page view, select the Data List tool from the Advanced toolbar, 

and draw a rectangle on the page. The Data Publishing dialog 

appears. Click the New button. The Data Object dialog appears. 

Select External and then click the Source button.

● In Assets view, click the Data Objects tab, and then click New on the 

control bar. The Data Object dialog appears. Select External and 

then click the Source button.

The Data Source Type dialog appears.
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2. Click ODBC and then the Select button.

The Select Data Source dialog appears. It displays all the ODBC data 
sources stored on your computer. You can select an existing data source, 
or you can create a new data source.

To select an existing data source:

◆ To select an ODBC source on your system, you can use the File Data 
Source tab or the Machine Data Source tab.

● File Data Source: Select from the list of data sources and click OK.

● Machine Data Source: Select from the Data Source Name list and 

click OK. Depending on the data source type you choose, the Select 

Workbook or Select Database dialog appears. Follow these steps:
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- Select a file in the dialog and click OK.

- If the source refers to a multiple-file database or a spreadsheet 

with multiple tabs, the Select dialog appears. Select the file or 

tab and click OK.

NetObjects Fusion creates the data object, gives it the name of the 
selected file or tab, and imports its fields as simple text fields.

The data object is now an asset of your site, and you can continue as follows:

● If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 20-18, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 20-22.

● If you’re in Assets view, take these additional steps:

a. Switch to Page view.

Data List tool

b. Select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.

You can now select fields and format the data list as described in 
“Creating a Data List” on page 20-18, and lay out your stacked pages as 
described in “Creating Stacked Pages” on page 20-22.

To create a new data source:

◆ Click New in the Select Data Source dialog.

The Windows Add Data Source wizard takes over. Follow the steps in the wizard, or 

refer to the online Help for information.

Once the data object becomes an asset of your site, you can continue as follows:

● If you’re working in Page view, the Data Publishing dialog is still open. You can 
select fields and format the data list as described in “Creating a Data List” on 
page 20-18, and lay out your stacked pages as described in “Creating Stacked 
Pages” on page 20-22.

● If you’re in Assets view, take these additional steps:
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a. Switch to Page view.

Data List tool

b. Select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.

You can now select fields and format the data list as described in 
“Creating a Data List” on page 20-18, and lay out your stacked pages as 
described in “Creating Stacked Pages” on page 20-22.
Importing Images from an External Data Source
NetObjects Fusion can import images referenced in an external data source. A field 

in the external data source must provide paths for the location of each image.

1. In your database application, such as Microsoft Excel or Access, create a 
simple text field. In each record enter the full path to each image—for 
example c:\my documents\images\photo.gif. 

2. In NetObjects Fusion, create an external data object as described in 
“Creating an External Data Object from a Desktop Database” on 
page 20-11 or “Creating an External Data Object from a SQL Data 
Source” on page 20-14. Link it to the table that contains your image 
field.

3. Switch to Assets view and click the Data Objects button.

4. Open the data object for editing by double-clicking it.

5. In the Data Objects dialog that appears, double-click the name of the 
field that contains your images.

6. In the Data Field dialog that appears, select the Image File option.

7. Close both dialogs and switch to Page view.

● If you have not created the data list and stacked pages, see “Creating 

a Data Object for External Data” on page 20-10.

● If you have created the data list and placed the image field on your 

stacked pages manually or by selecting the Display All Fields option 

in the Data Publishing dialog when you created the data list, go to a 
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stacked page, delete the placed image field, then place it again using 

the Data Field tool as described in “Adding Stacked Pages for 

Internal Data” on page 20-25.

Each image from the external data file appears on the appropriate 
stacked page.
Creating a Data List 
Once you create a data object, you can create a data list on any page. You create a 

data list and one or more stacked pages at the same time. NetObjects Fusion 

automatically includes linked data list icons in the first column in the data list. The 

data list thus acts as a table of contents—each row contains data for, and is linked to, 

a single stacked page.

To create a data list:

1. In Page view, display the page on which you want to place the data list. 

Data List tool

2. Select the Data List tool from the Advanced toolbar. 

3. Draw a rectangle in the page body.

The Data Publishing dialog appears. Select the data object you want to 
use for this data list.
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The Fields list displays the fields in the selected data object.

4. Choose a field to sort the list. You can sort on simple text fields or image 
file fields.

The records are sorted in ascending order.

5. To filter the data, click Set next to Filter.

By default, all available records in the data list and on stacked pages 
appear. A filter selects a subset of the available records to display. You can 
create selection criteria that isolate exactly the records you want to 
appear in your data list.

This box identifies the current 
data object.

This box lists the fields in the table or 
worksheet in the current data object.
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The Query dialog appears.

6. Enter your selection criteria and click OK.

If you do not use all three lines, choose “end” from the drop-down list at 
the end of the last line you use.

You return to the Data Publishing dialog.

7. In the Data List area, enter a name for the data list.

8. In the Fields list, select fields to include in the data list by clicking the 
check boxes to the left of the fields.

As a shortcut, you can click the Add All button, which marks all fields for 
display. Typically, however, you display only a subset of fields in the data 
list and display all fields on stacked pages.

9. To link a field to its stacked page, select the field in the Data Publishing 
dialog and click the Link/Unlink button.

A data list automatically includes at the left of each row a navigation 
button that links to the record’s stacked page. When you link a field, 
your site visitor can click either the button or the linked field to jump to 
the record’s stacked page.

10. To change the order in which fields appear left to right in the data list, 
click a field and then click the up and down arrow buttons.

Continue to select fields and press the up and down arrow buttons until 
the list is in the order you want. 

11. Set the following options for creating stacked pages:
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● Display all fields: Places all fields available in the data object in a 

simple Layout when NetObjects Fusion creates the first stacked 

page. This shortcut can save you the effort of placing fields 

individually as described in “Designing the Stacked Page Layout” on 

page 20-22.

● Add navigation buttons: Places relative navigation buttons in a 

simple Layout when NetObjects Fusion creates the first stacked 

page. This shortcut can save you the effort of creating these buttons 

as described in “Adding Navigation Buttons for Stacked Pages” on 

page 20-25.

12. Click OK.

The data list placeholder appears. Its column heads are the names of the 
fields you selected for display, and a data list button appears at the left of 
the first row.

This is enough information for you to use the Properties palette to 
specify the appearance of your data list.

NetObjects Fusion populates the data list only when you preview or 
publish the page. Data never appears in the data list in Page view.

13. Click the data list to see the General tab on the Data List Properties 
palette.

Adjust the settings to change the bullet type, background color, border 
size, and spacing of data. You can also mouse over the column heading 
borders and drag them to set column width.

Field names identify 
columns of data.

This bullet is the 
Data List icon from 
the current SiteStyle.
Data Publishing 20-21



D E L E T I N G  A  D A T A  O B J E C T
When you are satisfied with the appearance of the data list, create a 
Layout for your stacked pages as described in “Designing the Stacked 
Page Layout” on page 20-22.
Deleting a Data Object
1. If you created stacked pages for the data object, you must delete the 

stacked pages and any data lists before you can delete the data object.

Switch to Site view and select the stacked pages.

2. Press Delete, and click OK in the warning message that appears.

3. Switch to Assets view.

4. Click the Data Objects tab.

5. Select the data object and press Delete.

You see a warning that the deletion cannot be undone.

6. To continue with the deletion, click OK.
Creating Stacked Pages
Stacked pages correspond to records in a database. When you store information 

internally in NetObjects Fusion, each stacked page lets you enter data for one 

record. If you are drawing information from an external data file, each stacked page 

automatically displays information from a record.

Note: You can add or delete stacked pages for internal data as described in “Adding 
Stacked Pages for Internal Data” on page 20-25. To add or delete records for external 
data, you must make the changes in your external database or spreadsheet 
application and then republish your site.
Designing the Stacked Page Layout
The stacked page Layout determines the appearance of all the stacked pages. Data 

fields and non-data objects (text, pictures, or other assets) added to the stacked page 
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Layout are repeated across all the stacked pages. In addition, Layout changes made 

to any stacked page are automatically applied to all pages in the stack.

Unless you selected the Display All Fields option when you created your data list, 

your stacked page Layout is blank. You can add text and graphic objects to this page, 

just like any other page. The key items to be added, however, are the data fields you 

defined in the data object.

To design stacked pages:

1. Switch to Site view, or use the Site Navigation window in Page view to 
navigate to the first stacked page.

If you are working with external data, the stacked page navigation 
button bar indicates this is “1 of” as many records as were imported 
from the external source. If you are working with an internal data object, 
the stacked page navigation button bar indicates this is “0 of 0” because 
you have not created any records yet.

Data Field tool

2. In Page view, select the Data Field tool from the Advanced toolbar, and 
draw a rectangle in the body of the stacked page.

Drawing a data field.
Data Publishing 20-23



C R E A T I N G  S T A C K E D  P A G E S
The Data Field dialog appears, so you can choose which field you want 
to display in the area you drew. The fields available are those in the data 
object you selected in the Data Publishing dialog when you created the 
stacked pages.

3. Select a field and click OK.

● If you are using external data, NetObjects Fusion displays simple 

text field data from the first record in the data file. To import 

images, see “Importing Images from an External Data Source” on 

page 20-17. 

● If you are using internal data and selected an image file field, the 

field area is marked with an X. Double-click the X to open the 

Picture File Open dialog. Select the file, and then click OK. 

● If you are using internal data and selected a simple or formatted 

internal text field, NetObjects Fusion displays a blank field. See 

“Adding Stacked Pages for Internal Data” on page 20-25 to learn 

how to enter text in these fields.

4. Place additional data fields, until you have as many as you want. Add text 
blocks to label your fields, lines, and other graphics until you are 
satisfied with your Layout.
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5. If you are using external data, your stacked pages are already created. You 
can use the Next and Previous buttons on the control bar to scroll 
though all pages in the stack.

6. If you are using internal data, add records as described in “Adding 
Stacked Pages for Internal Data.” You cannot enter data until you add a 
record to contain it.
Adding Navigation Buttons for Stacked Pages
Next and Previous buttons simplify navigation between stacked pages. You can 

automatically add navigation buttons when creating your data list as described in 

“Creating a Data List” on page 20-18, or you can create custom navigation aids by 

drawing or importing buttons, as described here.

To add navigation buttons for stacked pages:

1. In Page view, on one of the stacked pages, add an object to serve as a 
button. 

You can place text, draw a button using the Draw tool, or import an 
image using the Picture tool. If you installed the Extras folder, you’ll find 
it contains pictures specially designed for page navigation buttons.

2. Select the object.

3. Click Link in the object’s Properties palette.

4. In the Link dialog, click the Smart Link tab.

5. Select Next Stacked Page or Previous Stacked Page, and then click Link.
Adding Stacked Pages for Internal Data
To add a new record to internal data, you create a new stacked page. Each new 

stacked page has the same layout of data fields and non-data objects as all the others 

in the stack.

You can create as many new stacked pages as you want. For each new stacked page, 

NetObjects Fusion adds a row to the data list on the data list page. You can delete 

stacked pages for internal data whenever you want.
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Note: You cannot add or delete stacked pages associated with an external data object. 
To add or delete records when data is stored externally, you must update your 
external database or spreadsheet application and re-publish your site.

To add internal data stacked pages:

◆ In Page view, on the first stacked page, click the Add button on the 
control bar.

A stacked page with blank data fields appears. The counter on the 
navigation bar indicates the new total of records in the stack.
Deleting Stacked Pages
To delete the current stacked page:

◆ In Page view, click the Delete button on the control bar.

Adding Text and Images for Stacked Pages
When a stacked page displays data from an internal data object, you can enter text 

and add pictures in fields on the stacked page. You cannot edit text on stacked pages 

that reference external data.

To enter text in a text field:

◆ Double-click the field. Or press Tab or Shift+Tab to move the selection 
from field to field. To edit a selected field, press Enter.

A dotted outline with hollow handles highlights the field, and an 
insertion point appears inside. Type the text you want, then click outside 
the field to deselect it.

To add an image in an image file field:

◆ Double-click the field and select the image you want in the dialog that 
appears.

When you add data to the stacked pages, the data list can display it. 
Preview the data list page to see how it will look in your browser.
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Building Dynamic Pages 21

Thanks to continuing advances in HTML specifications and browser development, 

you can now make pages dynamic—enlivening objects with movement and 

function, and using interaction to help deliver your site’s message and content.

Using NetObjects Fusion you can add animations, actions, messages, and behaviors 

to any object on the page, or to the page itself. There’s no programming required: 

NetObjects Fusion provides all the ingredients for a wide range of actions, 

presented in a standard selection dialog. 

If you prefer, you can script your own actions in NetObjects Fusion, using 

JavaScript or VBScript. Experienced programmers can customize the built-in menu 

of actions.

When you publish your site, NetObjects Fusion generates dynamic pages in 

Everywhere HTML—a combination of CSS positioning code, JavaScript, and 

browser-specific HTML code such as Netscape’s <LAYER> tag. Everywhere HTML 

makes dynamic pages work properly in both Microsoft Internet Explorer 4.0 and 

Netscape Communicator 4.0, with no further configuration or adjustment. 

This chapter contains:

● An overview and example of objects, actions, and messages 

● Design considerations and the dynamic page-building process

● The mechanics of assigning actions and parameters to objects

● Scripting custom actions
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The Basics of Dynamic Pages
Dynamic pages contain one or more objects that have actions. These actions can 

include:

● Animations that make the object move on, off, and around the screen, bounce off 
other objects, grow or shrink, or change places. 

● Direct manipulation of the object by the site visitor, typically by dragging or 
moving it with the mouse.

● Indirect manipulation of the object by the browser using JavaScript “collision 
detection” to prevent two objects from occupying the same space at the same 
time.

● Changes to the object’s properties, such as its color, location, visible/invisible 
condition, or some other state.

● Responses attached to form objects that cause other actions in response to the 
site visitor’s selection or entry.

The action mechanism is message-based; each action is triggered by a specific 

message, and it sends a specific message in response to that trigger. 

Because of their capability for animation or interaction, pages with dynamic objects 

are considered to be coded in dynamic HTML (DHTML). DHTML is not a new 

HTML standard of specific tags and attributes; it’s a general term to describe pages 

that use JavaScript or other supported scripting languages operating within the 

browser to provide animation and interactivity.

The templates provided with NetObjects Fusion include an example of a page 

written in DHTML that has objects on it with pre-built actions. See “Expanding 

Your Site” on page 3-11 for information.

Note: For reliable performance, actions should be viewed in Internet Explorer 4 or 
Netscape Navigator 4. The HTML tags that make actions possible are not always 
supported in earlier versions.
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Objects, Actions, and Messages
At their most basic level, actions are composed of a trigger event, an action message, 

and one or more message targets. 

● A trigger event causes an action to start. Trigger events are expressed as:

– Messages about site visitor actions, such as a mouse click or mouse-over

– Messages about conditions such as the page loading or a particular state of the 

server

– Messages sent from or by other objects

● An action message is the information that gets passed from the source object to 
the target object. An action message can be a statement or a conditional 
expression.

● A target is any object that receives the message and acts upon it.
Triggering Actions
There are a variety of ways that you can define the triggering event for an action. 

You can:

● Set the state of the browser as a triggering event, so actions are triggered when the 
page loads, or when the browser leaves the page. You might, for example, define 
one set of actions to occur when the page loads, and have another set of actions 
triggered to “reset” the objects or the page to their original state when the 
browser exits.

● Set actions to respond to various forms of onscreen interaction, including 
clicking, hovering over, or dragging objects on the page. For example, images are 
frequently used as buttons to launch actions when the site visitor clicks them.

● Define custom messages and then use them as the triggering event for other 
actions. This lets you link actions together that do not require onscreen 
interaction or changes to object states.

● Use completion messages from one action to trigger another action. For example, 
you can have one image fly in to your page from top right; its completion triggers 
the fly-in of the second image from the bottom left.
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● Send cascading messages to grouped or collected objects, so one message gets 
sent to multiple related objects.
An Active Objects Example
Suppose you are creating a site for a non-profit organization that is having its 

annual fund-raising drive. You want to provide a Click for Status button that 

displays a thermometer, indicating the progress of the fund-raising efforts. You can 

do this using a simple action that makes an image appear when you click on a 

button object. The example works like this:

1. When a site visitor clicks the object, the browser sends a Mouse Down 
message to the button object itself—that’s how the button “knows” it has 
been clicked.

2. When the button object receives the Mouse Down message, it triggers 
the object to send a message called Object Show to its target—an image 
that is currently on the page, but hidden.

3. When the hidden object receives the Object Show message, it triggers the 
action attached to the hidden object, which changes the image object’s 
visible property to “true.”
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In this example:

● The button object has an action whose trigger event is defined as a mouse click 
on that object:

When Mouse Down, send message Object Show to target 
Hidden_Object

● The hidden object has an initial setting

Don’t show when the page loads

and an action:

When Object Show (is received), send message Set Visible Property On to target 

Hidden_Object (myself).

The built-in behavior for Set Visible Property On is to display the specified object 

when the ObjectShow message is received.
The Dynamic Page-Building Process
To add dynamic content and actions to your pages, you follow this basic process:

1. Design the activity and effects for each page. Determine the sequence of 
actions, the possible groupings and arrangement of objects, and the 
most effective use of cascading actions.

Then, compare all the dynamic pages within your site to identify 
duplication, eliminate conflicts or clashes, and keep a “big picture” view 
of the site as a whole.

2. On each page with dynamic content, select the objects and assign the 
appropriate actions, targets, messages, and parameters. 

3. Script custom parameters or custom actions as needed.

4. Preview or publish, then test your results in both 4.0 browsers.

The specifics for each step are described in the remainder of this chapter. 
Adding Actions to Objects
1. In Page view, select the object to which you are adding an action.
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The object’s default Properties palette appears.

2. Select the Actions tab.

The Actions tab displays the Object ID for the current object.

3. By default, Object initially visible in browser is selected. If you want this 
object to be hidden when the page is loaded, clear the check box.

Add Action button

4. To add a new action, click the plus (+) button in the lower left corner.

The Set Action dialog appears.

Use this dialog to configure the action by specifying its trigger, target, 
message, and parameters.

5. To override the default action name, enter a descriptive name for the 
action in the Name field.
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6. Specify the triggering event for this action in the When field. See 
“Specifying a Trigger Event” on page 21-7 for information.

7. Specify the target for this action in the Target field. The default target is 
always the object itself. See “Specifying an Action Target” on page 21-9 
for details.

8. Specify the message you want this action to send to the target object in 
the Message field. See “Specifying an Action Message” on page 21-10 for 
information.

9. Specify the appropriate parameter for this message in the Parameter 
field. See “Specifying an Action Parameter Value” on page 21-12 for 
information.

10. If your target object is a text box, Layout Region, or Layout, you can send 
this message to all objects contained within the target object. To do so, 
select Cascade Action. See “Creating Cascading Actions” on page 21-15 
for details about cascading actions.

11. When you finish configuring your action, click OK. 

The new action appears in the list box of the Action tab of the object’s 
Properties palette.

12. Repeat steps 3 through 11 to assign additional actions to this object.

13. Preview or publish the site locally and view the results in your browser. 
To ensure the best experience for your site visitors, test your dynamic 
pages in both Microsoft Internet Explorer 4 and Netscape Navigator 4.
Specifying a Trigger Event
The first component of an action is its trigger event or condition: when the trigger 

event occurs, or the trigger condition is met, the action begins. The trigger event is 

defined by its subject and its condition: an action’s trigger might occur when the 

page is loaded or when a transition is started.

Your choices for trigger events and conditions vary, depending on the type of object 

to which you’re adding the action. For example, if you are adding an action to a 

picture object, there are five potential mouse-driven trigger events to choose from: 

clicked, down, up, over, and out.
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Keep in mind that the trigger event is itself expressed as a message: in a literal sense, 

the action is kicked off when the object receives the message that the trigger event 

occurred. The picture object in the example below won’t “know” that the mouse 

was clicked until it receives a message to that effect from the browser. 

This is what happens when you chain actions together in a sequence—you use a 

message from one action to trigger the next action.

Use the When message menus in the Set Action dialog to select the triggering 

message that kicks off this action.

When field menu 
button

1. In the Set Action dialog, open the When menu. 

A list of the event subjects that you can use to define the trigger event 
appears.

Mouse-driven events, for example, can be triggered when the site visitor 
clicks the mouse or moves the mouse pointer over the object. Object-
driven events can be triggered when the object is hidden, shown, 
generates an error, or is loaded on the page. Page-driven events can be 
triggered when the page finishes loading in the browser, or when the site 
visitor leaves the page.

2. Point to the trigger category, then click the event or condition you want. 
To select a custom message, point to Custom and select from the list 
displayed. See “Creating Custom Messages” on page 21-18.

The name of the trigger event appears in the When field.

The When menu displays 
trigger categories.

Choose an event or 
condition for a trigger.
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3. Continue setting the action target, message, and parameters as needed.

Specifying an Action Target
The target of an action is the recipient of the action’s message. An action can target 

any one of the other objects or containers on the current page. If you target a 

container, like a text box or a Layout Region, you can also cascade the action so the 

container passes it along to all the objects embedded within it. See “Creating 

Cascading Actions” on page 21-15 for more information. 

For example, you might add a “Fly Out to Top Right” action to one picture object 

and target it at another picture object. When the site visitor clicks the first object, 

the second object receives the action message, which triggers it to fly off the page.

NetObjects Fusion’s default setting is for an object’s actions to target itself. Unless 

you target another object, the action acts on or impacts the object to which it is 

attached.

If you add an action to an object in a MasterBorder or an AutoFrame, and it targets 

an object in the Layout, make sure the target object is always available in all Layouts 

to which the MasterBorder or AutoFrame is applied. MasterBorders and 

AutoFrames are often applied to several pages; if you add an action to an object in 

the MasterBorder and the target is in the Layout, the target might not always be 

available. For example, if you add an action in a MasterBorder on a page named 

Staff Photos, and the target is an object named CEOPicture in the Layout, the action 

will not work while site visitors are on the page named Phone Numbers if 

CEOPicture is not also in the Layout for Phone Numbers.
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Use the Target field’s Object Tree to select the target for an action:

Target Browse button

1. In the Set Action dialog, click the Target Browse button. 

The Object Tree shows the hierarchy of all the objects on the current 
page. 

The Object Tree shows the page’s containers—MasterBorder, Layouts, 
Layout Regions, and text boxes—with their objects listed below. You can 
expand or contract the Object Tree by clicking the plus or minus sign for 
each level. 

2. Select the object you want to designate as the target for this action and 
click OK. 

The name of the object is displayed in the Target field.

3. Continue setting the action message and parameters as needed.
Specifying an Action Message
The action message is the heart of the action—it defines what the action really does, 

what effect it has, and what conditions or behaviors it establishes. An action 

message is essentially an instruction to the target object, telling it to behave in a 

certain way: it might, for example, carry instructions for the target object to Fly In 

from Top Right when triggered. 
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Your choices for action messages vary, depending on the type of object you are 

targeting. For example, if you target an action at the Layout, there are three 

potential dialogs that you can display: alert, confirm, and prompt. 

Keep in mind that the action message is itself a trigger that kicks off the action when 

it is received by the targeted object. The picture object in the example above won’t 

“know” to fly off the screen until it receives the instruction to do so, which triggers 

the flying action within the object. 

Use the Message menu button to select the action message.

Message menu button

1. In the Set Action dialog, open the Message menu.

2. Point to a Message option, then click the condition you want. To select a 
custom message, point to Custom and select from the list. See “Creating 
Custom Messages” on page 21-18 for information.

The name of the selected action message appears in the Message field.

3. Continue setting the action parameter values, if appropriate to the 
message you selected.
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Specifying an Action Parameter Value
Some actions require or accept additional parameters that control some aspect of 

their activity. In some cases, you can select from a list of predefined parameter 

values. In others, you can enter a value of your choice. The parameter value you set 

is sent to the object as part of the Action Message. 

The range of choices is determined by the type of Action Message you assigned to 

this action. For example, the Fly message accepts directional parameters, with 

choices like In from Top or Out to Top Left. The Alert message, on the other hand, 

accepts a text string that it displays within the alert box.

Use the Parameters menu button to select the parameter values.

Parameter menu 
button

1. In the Set Action dialog, open the Parameters field menu. 

NetObjects Fusion displays the list of predefined parameter values, if any 
are defined for the selected action message.
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2. Set the value for this action message’s parameter by:

● Selecting a predefined value from the list.

● Selecting the Values option to set custom values. See “Customizing 

Parameter Values” on page 21-13 for details.

● Selecting the Expression option to create a JavaScript expression 

that generates or otherwise controls the value of the parameter. See 

“Scripting JavaScript Expressions” on page 21-23 for information. 

Once you select or set the parameter value, the name of the value 
appears in the Parameter field.

3. If you want this action to cascade within the hierarchy of the target 
object, select Cascade message. See “Creating Cascading Actions” on 
page 21-15 for information.

4. Click OK to complete this action and return to the Action tab of the 
selected object.

Customizing Parameter Values

When you select a predefined value from the Parameters list, you are only setting 

the value of the most important parameter for this action. For example, in the case 

of the action Fly, the most important parameter—the one available from the menu 

list—will define “where from, and where to?” The default value for this parameter in 

this instance is In from Top. 

However, the Fly message has other parameters as well, such as speed, duration, and 

action repeat. All these parameters have default values; you can also set new values.

1. Select Values from the Parameter drop-down list in the Set Action 
dialog.
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The Parameter Values dialog appears, listing all the parameters 
predefined for this message and their default values.

2. Select a parameter whose value you want to change. 

The value for that parameter appears in the edit field at the top of the 
dialog.

3. Set the parameter value:

● If the potential value choices for this parameter are predefined, the 

edit field might offer a means to select your choice—such as a drop-

down list, the Color Picker, a Picture File Open dialog, or a Link 

dialog. Select the parameter value you want from the available list or 

dialog.

● If the parameter accepts any values, enter one in the edit field.

4. Repeat steps 2 and 3 for other parameter values you want to set.

5. Click OK after you set all parameter values.

The Set Action dialog appears.
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Creating Cascading Actions
If you target an action at a container object, such as a Layout or a Layout Region, 

you can instruct the target to forward that action’s message to every object 

contained within it. When the site visitor or browser triggers the action, the message 

cascades down the target object’s hierarchy. 

In effect, the target object forwards the message in turn to each object contained 

within itself. For example, if you send a cascaded action to a Layout, the Layout 

forwards the action’s message to each object on the page. 

Be aware that messages your actions send to either the Layout or the MasterBorder 

will apply to the entire page, not just the Layout or MasterBorder. For example, if 

you make a button which, when clicked, sends a Hide Object message to all objects 

on the Layout, it actually sends the message to all items on the page, making 

everything invisible. If you want a cascading message to affect only a group of 

objects, put all the objects in a Layout Region container and send the message to the 

Layout Region instead of the Layout.

Cascading actions are particularly valuable when you want to apply actions to a 

changing collection of multiple objects. For example, assume you are preparing a 

site for your company. In the marketing information part of your site, you want to 

display a map showing the 10 locations of your company offices. The way you 

designed it, each office location includes a button that superimposes a text object on 

the page. That text object contains a profile of that location’s activities. When a site 

visitor clicks a location, you want to hide any currently visible profile and display 

the one linked to the selected location. 

Cascading messages make this manageable:

● Without cascading messages, you’d have to include 10 actions with each location 
button: 9 actions to hide other location profiles (Hide Profile1, Hide Profile2, and 
so forth) and 1 action to display that location’s profile object. 
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● Using cascading actions, each location button sends one Hide all profiles message 
to the Layout. That message is then forwarded by the Layout to each object 
within that Layout; in effect, the message cascades down the Layout’s object tree. 
In this case, Hide all profiles is a custom message that is not provided with 
NetObjects Fusion: see “Creating Custom Messages” on page 21-18 for more 
information.

Note that the Layout doesn’t command its objects to hide. It simply passes along 

the Hide all profiles message, and any object that understands that message—

because it has an action of its own that is triggered by a Hide all profiles 

message—acts on it. 

The selected location button then sends one Show message to its corresponding 

location profile, and that profile object displays itself. 

The net result: you assign 20 actions, not 100, and when a new office location opens 

in Quebec, all you add is one location button, one profile object, and two actions—

instead of having to add the hide Quebec profile message to all other office 

locations.

Configuring Cascading Actions

1. In Page view, create the objects that you want to act upon, and embed 
them in the container of your choice.

2. Add the object that will trigger the action.

The default Properties palette for the trigger object appears.

Add Action button

3. Select the Actions tab and click the Add Action button to add a new 
Action, and name the action if appropriate.

4. In the Target Object Tree, select the container—Layout, MasterBorder, 
Layout Region, or text box—in which you embedded the objects in step 
1. This is the container you want to target for the cascaded action.

5. Select the Cascade action option.

6. Complete the action configuration as needed, and click OK.

7. Preview or publish the site locally and test the cascading effect.
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Assigning an Action to a Text Link
1. In Page view, select text you want to link.

2. On the Format tab of the Properties palette, click Link.

The Link dialog appears.

3. Select a link in one of the four link tabs.

If you want the link to launch the action, but you don’t want the link to 
display a new page in the browser, choose the Blank link on the Smart 
Link tab.

4. Click the Actions button.

The Actions dialog appears.

5. Click the Add Action button and add an action as described in “Adding 
Actions to Objects” on page 21-5.

6. Click OK in the Actions dialog.

7. Click Link in the Link dialog.
Customizing Actions
The actions, messages, and values described in “Adding Actions to Objects” are 

predefined by and provided with NetObjects Fusion. They represent samples of the 

typical actions you will use to make your pages dynamic. However, you might also 

want to:

● Create custom messages to support specific combinations of actions.

● Script custom actions using JavaScript or VBScript to produce exactly the results 
you want.

● Script JavaScript expressions to create effects or perform functions.
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Creating Custom Messages
You can create custom messages and use them as trigger or action messages. Any 

custom message that you define and use will typically be used twice: once as the 

action Message, sent when triggered by some other event, and once as the When 

message, to trigger another event. 

For example, in the office locations example described in “Creating Cascading 

Actions” on page 21-15, the custom message Hide all profiles works like this:

1. When the site visitor clicks an office location, the custom message Hide 
all profiles is sent as a cascading action message to the Layout.

2. The Layout receives the custom message, but it doesn’t have any actions 
triggered by this message. The Layout cascades the message down to its 
embedded objects.

3. The custom message Hide all profiles is received by each object 
contained in the layout. Each profile object has an Object Hide action 
that is triggered by the message Hide all profiles. As a result, each profile 
object hides itself when it receives the custom message.

To create a custom message:

4. In the Set Action dialog, from the When or Message option menus, select 
Custom, Edit.

The Custom Messages list box appears.

5. Click the plus (+) button.
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The Add Message dialog appears.

6. Enter the message exactly as you want it to be used in other actions, and 
click OK.

The message is added to the Custom Message list box. The next time you 
select Custom from the When or Message option menus, NetObjects 
Fusion displays your custom message as one of the choices.
Deleting a Custom Message
1. In the Set Action dialog, select Custom, Edit from the When or Message 

option menus.

The Custom Messages list box appears.

2. Select the message you want to delete, then click the minus (-) button.

The custom message disappears from the Custom Messages list box.

3. Click OK.
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Scripting Custom Actions
The action events and messages you can choose from the Set Action dialog are 

defined by NetObjects Fusion in the default JavaScript Beans file: \NetObjects 

Fusion 3.0\NetObjects System\NetObjects Fusion.jsb. You can also use the Set 

Action dialog to script your own actions for any object. You can define these actions 

in any valid scripting language: JavaScript, JScript, VBScript, or CGI.

To add a scripted action to an object:

1. In Page view, select the object. 

The object’s default Properties palette appears.

2. Select the Actions tab.

The Action tab displays the Object ID for the current object. 

3. By default, the Object initially visible in browser option is checked. If 
you want this object to be hidden when the page is loaded, clear the 
check box.

Add Action button

4. Click the plus (+) button in the lower left corner to add an action.
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The Set Action dialog appears.

5. Check the Scripted action option in the bottom left corner.

NetObjects Fusion modifies the Set Action dialog to display the Action 
scripting text box.

6. Use the Action text entry field to enter your scripted action. NetObjects 
Fusion gives you three methods for building a custom script: 

● You can enter script or paste any valid JavaScript, JScript, or CGI 

coding directly into the text entry field. NetObjects Fusion does not 

validate or otherwise check the code you enter.
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● You can insert a predefined script from another file.

● You can insert any action you have already defined for this object. 

Use all three methods as needed to create a scripted action.

Inserting a Script in a Scripted Action

1. In the Set Action dialog, click the Scripted action option, and then click 
Insert Script to display a File Open dialog.

2. Use the dialog to navigate to and select the source file for your script. 
Change the Files of type setting to All Files (*.*) if necessary.

3. Click OK to insert the contents of the selected file.

NetObjects Fusion inserts the script from the selected file.

This is particularly helpful if you are sharing scripts with other 
developers, or if you are implementing a script that someone else 
developed.

Inserting an Existing Action

1. In the Set Action dialog, click the Scripted action option, and then click 
Insert Action.
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The list of the Actions assigned to the current object appears.

2. Select the Action you want to insert, and click OK.

NetObjects Fusion inserts a call to the selected action, in the form 
$Actionn where n is the number of the action as it was created, and 
places the statement in the text box. Actions are numbered when you 
create them.

3. Insert other scripts or actions, as needed.

4. Click OK when you finish scripting the action.

NetObjects Fusion adds the scripted action to the Action list box.
Scripting JavaScript Expressions
You can script your own JavaScript expressions to use as parameter values for any 

action. These JavaScript expressions can return individual values for specific 
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parameters. They can return objects with multiple values. They can obtain values 

from form objects and forward them as message parameters.

You can enter JavaScript expressions directly, or you can assemble an expression out 

of existing actions for that object.For example, you could define an expression that 

tests for a particular server condition—such as time of day—and then launches 

specific actions that you defined using the Set Actions dialog based on that 

condition. 

For more information about JavaScript and scripting expressions, consult the 

resources at http://www.developer.com/directories/pages/dir.javascript.html.
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To script an expression for the value of a message parameter:

1. In Page view, select the object and add any actions that you want to use 
as components of the scripted expression. See “Adding Actions to 
Objects” on page 21-5 for specific steps.

2. In the Action list box, select the action whose parameter value you want 
to set to the expression, and click OK.

3. In the Set Action dialog, set the other values of the action as appropriate.

4. Select Expression from the Parameter drop-down list. 

The JavaScript Expression edit dialog appears.

5. Enter in the text field the JavaScript expression you want to use to 
determine the value of this parameter. 

6. If you want to build your expression around or with existing actions, 
click the Insert Action button. 

NetObjects Fusion displays a list of actions you already defined for this 
object. Select the action you want to insert and click OK.

Note: Expressions must be written in valid JavaScript. NetObjects Fusion 
does not perform any error- or syntax-checking of your expression.

7. When the expression is completed, click OK. 

The parameter is set to the value generated by the expression, and the Set 
Action dialog appears.

8. Repeat steps 1 through 4 for other parameter values you want to set to 
expressions.
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Modifying Existing Actions
1. In Page view, select the object that has the action you want to modify.

The default tab of the object’s Properties palette appears.

2. Select the Actions tab. The actions you added to this object are listed: 

3. To change the sequence of actions for this object:

a. Select an action that’s out of sequence.

b. Press the up or down arrows in the bottom right corner to move 
the selected action.

c. Repeat as needed.

Actions are launched by their trigger events, or messages. If two or more 
actions share the same trigger action, they are run in the order in which 
they appear.

4. To suppress an action so NetObjects Fusion does not include it when the 
site is published, clear that action’s check box on the Actions tab. A 
suppressed action can, however, be inserted in a scripted action.

5. To change the properties of an action—the name, trigger, target, 
message, parameters, or cascade setting—double-click the action you 
want to modify. 

The Set Action dialog appears with the current action configuration 
shown. You can change any of these settings as needed.
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Customizing Action Choices
The Set Action dialog is dynamically built when NetObjects Fusion starts up, based 

on the contents of the NetObjects Fusion.jsb file located in the \NetObjects 

Fusion 3.0\NetObjects System folder. The NetObjects Fusion.jsb file, in turn, is 

based on the JavaScript Beans specification.

If you are experienced in JavaScript programming, you can edit this file to:

● Add, delete, or modify the choices available from the Set Action dialog.

● Change the default or potential values of parameters.

● Replace or supplement the .jsb file with your own files.
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Working with HTML Directly 22

In addition to adding content, links, and Dynamic Actions™ to your site using 

NetObjects Fusion’s tools, you can work directly with the code to insert HTML and 

script yourself. For example, you can add META tags to index your site for search 

engines, power content with JavaScript or Visual Basic routines, center pages 

throughout your site, or do whatever else you can when coding raw HTML. You 

can’t edit the HTML NetObjects Fusion generates, but you can add your own code 

virtually anywhere.

Before working with HTML directly, you should be familiar with HTML tags and 

page structure. There are many books and Web sites to learn from. If you’re not 

familiar with HTML, you can still complete the tasks in“Examples of Adding Page 

HTML” on page 22-4 and “Examples of Object HTML” on page 22-8.

This chapter tells you how to add HTML or scripts by:

● Accessing the page’s HTML

● Accessing an object’s HTML

● Inserting HTML in a text box

● Coding your own objects

You can also code custom frames and framesets, insert code within link tags, and 

add your own actions. See Chapter 23, “Creating Custom HTML Framesets and 

Frames,” “Adding HTML to a Link” on page 14-12, and “Customizing Actions” on 

page 21-17.

Note: NetObjects Fusion doesn’t verify HTML you add, so be sure to use valid 
syntax, enclosing scripts within <SCRIPT> and </SCRIPT> tags, and so on. Also, 
assets referenced in your HTML aren’t managed in Assets view. If you move the 
HTML or its assets in your directory structure, edit paths in the HTML accordingly.
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Accessing the Page’s HTML
You can add HTML or script to the <HEAD> or <BODY> of the HTML 

NetObjects Fusion generates. First, select the area of the page you want to access—

the Layout area to access the current page’s HTML, or a MasterBorder or 

AutoFrame to access the HTML of several pages. 

Note: If your site uses frames, access Master HTML to add code to the frameset 
NetObjects Fusion generates, and access Frame HTML to customize that frame.

Then use the Page HTML dialog to add code between the <HEAD> tags, inside the 

<BODY> tag, or at the beginning of the <BODY>.

1. In Page view, click in the Layout area, MasterBorder, or an AutoFrame.

To select a ZeroMargins MasterBorder, click outside the page. See 
“Modifying a MasterBorder” on page 6-4.

2. Click the HTML button on the Properties palette.

Click the Frame tab to locate the button for accessing AutoFrame HTML 
and adding code to a frame’s contents. 

To access frameset HTML, select the MasterBorder or AutoFrame; then 
click the HTML button on the General tab, or right-click in the Layout, 
MasterBorder, or AutoFrame, and select Layout HTML, Master HTML, 
or Frame HTML from the shortcut menu.

The Page HTML dialog appears.

3. Click a tab to indicate where in the HTML you want to add tags or 
script. 

● Between Head Tags. Adds code to the <HEAD> content, inserting 

it just before the </HEAD> tag.

● Inside Body Tag. Adds code inside the <BODY> tag, as in 

<BODY attribute=value>, where attribute=value is your code.

● Beginning of Body. Adds code just below the <BODY> tag.
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4. Enter your code in the white area of the dialog.

Your typing, shown in blue, appears in the dialog’s grey area, where you 
can preview its location in the HTML NetObjects Fusion generates.

You can click the Insert button to insert contents of an HTML, script, or 
other text file. Click the Field button to insert a field. For information on 
fields, see “Managing Variables” on page 25-12.

5. Click OK.

Preview the site to test your code, and view the source from your browser to see the 

resulting HTML.

To edit your code, open the Page HTML dialog again, click the tab containing the 

code, and make your changes. 

Note: If you convert an AutoFrame back to a MasterBorder, code added to the 
frame’s content HTML is deleted.

To add HTML or script 
between the <HEAD> and 
</HEAD>... 

...inside the <BODY> tag 
itself...

...or to the page's content, 
just below the <BODY> tag

Type or paste your HTML 
or script in the white part 
of the dialog.

Click to insert contents of 
an HTML, script, or other 
text file.

Click to insert a field.

Preview your code in 
placeholder HTML that 
NetObjects Fusion 
generates. 
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Examples of Adding Page HTML

Centering a Page’s Contents
NetObjects Fusion generates fixed-width pages by default. As a result, content 

doesn’t widen or narrow when site visitors resize their browsers. If your pages are 

narrow, you can center them to avoid an imbalance of white space by adding the 

<CENTER> tag at the beginning of each page’s <BODY>.

1. In Page view, click in the Layout area of the page you want to center, in a 
MasterBorder to center a set of pages, or in an AutoFrame to center just 
the contents of the frame. 

2. Click the Frame tab locate the HTML button for an AutoFrame.

The Page HTML dialog appears.

3. Click the Beginning of Body tab and type <CENTER>.

4. Click OK.

Preview the site and resize your browser to test the centered pages. 

You can’t use NetObjects Fusion to add a <\CENTER> tag at the end of the page’s 

<BODY>, which is considered standard HTML syntax. Although this breach of 

protocol might be noted by an HTML code-checking program, it doesn’t cause 

problems in your site.

For information on scaling page content, see “Changing Layout Size” on page 7-5.
Indexing Pages for Search Engines
To give your content the best chance of being found and ranked by search engines 

like AltaVista, you can add Meta tag descriptions and keywords to your pages’ 

<HEAD> content. Site visitors don’t see this information, but search engines 

require it to index your site.

Note: Search engines index frameset files, so if your site uses frames, be sure to access 
MasterBorder HTML so your tags are added to the frameset file. 
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1. In Page view, click in the Layout area of the page you want indexed, or in 
the MasterBorder or AutoFrame to index a set of pages.

2. Click the HTML button on the General tab of the Properties palette, or 
right-click and select Layout HTML or Master HTML from the shortcut 
menu. 

The Page HTML dialog appears.

3. Click the Between Head Tags tab and enter Meta tags that describe your 
content. For example, type:

<META NAME="DESCRIPTION" CONTENT="Large selection of valuable, 
high quality antiques and collectibles for any budget."> 

where the content is a one-sentence description containing the most 
important keywords site visitors might search for. Then type:

<META NAME="KEYWORDS" CONTENT="antiques, quality antiques, 
valuable antiques, low-cost antiques, collectibles, jewelry, furniture, 
novelties">

where the content lists all important keywords.

4. Click OK.

5. Register your site with search engines.

You must do this separately with each search engine for it to find your 
site. Visit AltaVista, Excite, Lycos®, Yahoo®, and so on, for information.

To see the resulting HTML, you must publish the site locally or on your Web server 

and view the source in your browser. To test the tags you added, publish on your 

Web server and search for keywords using the various search engines—be patient, as 

it can take days or weeks for indexers to find your site.

Search engines continually evolve how they use Meta tags and other content to 

index and rank pages, and many of them make this information available at their 

sites. Check there to find out about other techniques.
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Auto-Forwarding from a Transition Page
You can create a transition page that appears for a few seconds, for example, to 

display a product logo, and then forwards site visitors automatically to another 

page. You do this by inserting a Meta tag in the page’s <HEAD>.

1. In Page view, click in the Layout area of the transition page, and click the 
HTML button on the Layout Properties palette.

The Page HTML dialog appears.

2. Click the Between Head Tags tab and type:

<META HTTP-EQUIV="REFRESH" CONTENT="seconds; URL=http://
server.domain.com/page.htm">

where seconds is the number of seconds you want the transition page to 
appear, and http://server.domain.com/page.htm is the URL of the page 
you want to link to.

3. Click OK.

Preview the site to test the transition, and view the HTML source in your browser to 

see your code.
Accessing an Object’s HTML
You can add HTML or script to pictures, media, a text box, or any other object, to 

modify or control that object. You can enclose the object in HTML tags, or add 

HTML or script inside the object’s tag.

You can add code before and after a text box’s HTML as described here. For 

information on inserting code inside the contents of a text box, see “Inserting 

HTML in a Text Box” on page 22-10.

1. In Page view, select the object you want to add code to, and click the 
HTML button on the Properties palette.

You can also click HTML on the Object menu, or right-click the object 
and select Object HTML from the shortcut menu.

The Object HTML dialog appears.
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2. Click the tab to indicate where you want to insert HTML or script. 

● Before Tag. Adds code just before the object’s tag, as in 

your_code <IMG SRC=>, if the object is a picture.

● Inside Tag. Adds code inside the object’s tag, as in 

<BODY SRC=”Image.gif” attribute>, where attribute is your code.

● After Tag. Adds code just after the object’s tag; for example, to 

insert a closing HTML tag for any opening tag inserted before the 

object.

3. Enter your code in the white area of the dialog.

Your typing, shown in blue, appears in the dialog’s grey area, where you 
can preview its location in the object’s HTML.

You can click the Insert button to insert contents of an HTML, script, or 
other text file. Click the Field button to insert a field. For more 
information on fields, see “Managing Variables” on page 25-12.

4. Click OK.

To add HTML or script before 
the object’s HTML tag

To add code inside the object’s 
tag

To insert a closing HTML tag for 
any opening tag you inserted 
before the object

Type or paste your HTML or 
script in the white part of 
the dialog.

Click to insert contents of an 
HTML, script, or other text 
file.

Click to insert a field.

See the object’s HTML, and 
preview your code as you 
type. 
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HTML icon

Preview the site to test your code, and view the source from your browser to see the 

resulting HTML.

To edit your code, open the Object HTML dialog again, click the tab where you 

entered code, and make your changes.

This symbol in Page view marks an 
object with HTML or script attached.
Examples of Object HTML

Displaying a Message on Mouse Click
You can display a message when site visitors click an image or text link. One way to 

do this is by creating a Blank link and inserting an onClick JavaScript in the link’s 

opening <A HREF> tag. 

1. In Page view, select the image or exact text site visitors are to click, and 
click the Link button on the Properties palette.

The Link dialog appears.

2. Click the Smart Link tab and select a Blank link.

See “Creating a Smart Link” on page 14-7 for information.

3. Click the HTML button in the Link dialog.

The Object HTML dialog appears.

4. Click the Inside Tag tab and type:

onClick="alert('your message')"

where your message is the text of your message.

5. Click OK in the Object HTML dialog, then click Link in the Link dialog.

Preview the page and click the image or text to see the message. View the HTML 

source in your browser to see the resulting HTML.

Another way to add this JavaScript to a picture or text link is to create a custom link. 

In the Link dialog, click the External Link tab, choose javascript from the URL 
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drop-down list, and type the onClick script in the URL field. See “Linking to a New 

Window” for another example of creating a link this way.

Message that appears 
when site visitors click 
the link

Resulting HTML 
including your 
JavaScript

<A HREF="javascript:void(0)"  onClick="alert('To build your site 

with NetObjects Fusion, visit www.NetObjects.com today.')">
Linking to a New Window
You can have a link open a page in a new browser window rather than in the current 

window, for example, so site visitors can keep the current page around while 

exploring a new part of your site. To do this, define a window.open JavaScript in a 

page’s <HEAD>, and call the function from the link using the Link dialog.

1. In Page view, select the image or exact text to be the link, and click the 
Link button on the Properties palette.

The Link dialog appears.

2. In the Link dialog, click the External Link tab and create a custom link.

Choose javascript to 
indicate you’re linking, not 
to another page, but to a 
JavaScript.

Type the name or function call that 
you’ll use in the page’s <HEAD> to 
define the script’s function.

The name you type here identifies the 
link in Assets view.
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URL. Choose javascript from this drop-down list. In the field, type 
openMe().

Asset Name. In this field, type NewWindow, which identifies the link 
in Assets view.

3. Click the Link button to close the dialog.

4. On the same page, click in the Layout area or MasterBorder depending 
on where the link is, and click the HTML button on the Properties 
palette.

The Page HTML dialog appears.

5. Click the Between Heads tab and type:

<SCRIPT LANGUAGE="javascript">
function openMe() 
{
window.open("http://server.domain.com/filename.htm", 
"newwindow")
}
</SCRIPT>

where http://server.domain.com/filename.htm is the URL of the page 
you’re linking to.

6. Click OK.

Preview the page to test the link, and view the HTML source in your browser to see 

the resulting HTML.
Inserting HTML in a Text Box
You can insert HTML or script inside the contents of a text box at the insertion 

point; for example, to add text attributes or comments to the HTML.

1. In Page view, double-click in the text box to get an insertion point.

2. From the Text menu, select Insert HTML.

The Insert HTML dialog appears.
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3. Enter your HTML or script.

4. Click OK. 

HTML Tag icon

Preview the page to test your code, and view the source from your browser to see the 

resulting HTML. 

...is inserted where you 
clicked in the text box, in the 
published HTML.

What you type or paste here...

For <BLINK>SPECIAL DEALS</BLINK>, click here

This symbol in a text box marks inserted 
code. You can double-click it to reopen the 
Insert HTML dialog to view or edit the code.
Coding Your Own Objects
You can create an object, such as a Java applet or a table you want to code yourself, 

by entering HTML or script in an empty text box.

1. In Page view, draw a text box where you want the object to go.

The box marks the object’s position when you publish, but it can grow 
vertically or horizontally depending on the object. To approximate the 
published size in your Layout area, select Lock Size on the object’s 
Properties palette.

2. From the Text menu, select Insert HTML.

The Insert HTML dialog appears.

3. Enter the HTML or script.
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4. Click OK. 

Preview the page to test your code, and view the source from your browser to see the 

resulting HTML. If necessary, go back and adjust the box’s position in Page view to 

get the actual spacing you want. 

What you type or paste here is 
nested in a cell of the HTML 
table NetObjects Fusion 
generates.
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Creating Custom HTML 
Framesets and Frames 23

Chapter 22, “Working with HTML Directly,” described how to use NetObjects 

Fusion’s HTML access feature to add custom HTML and scripts to pages and 

objects. This chapter describes how to use the Page HTML dialog to create custom 

HTML frames entirely from scripts. 

Understanding the differences between custom HTML frames and AutoFrames can 

help you choose which to use. It’s easier to create frames using AutoFrames, and you 

can customize them with custom HTML or scripts. 

You can also create the frameset page in another HTML editor, such as Allaire’s 

HomeSite, and then reference the frameset page as an External HTML page. This 

way, NetObjects Fusion manages the frameset page as an asset, and you can create 

the frameset’s content pages as regular pages in NetObjects Fusion. See Chapter 19, 

“Referencing and Editing External HTML,” for information about referencing 

external pages.

Although these tools help you create framed pages to meet most of your needs, on 

some occasions you may want to create custom frames using NetObjects Fusion’s 

HTML access feature. This chapter starts with a brief summary of HTML frames 

components, and includes information on:

● Defining a custom frameset 

● Creating frame content and targeting frame links

● Adding content for browsers that don’t support frames
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Understanding Frames
Frames are an HTML mechanism you can use to subdivide a page Layout so it 

displays in the browser window as multiple independent areas. Each frame displays 

its own content, made up of a separate page or resource that can include links, form 

objects, regions, or any text, graphic, or media objects. 

A special type of page—called a frameset—establishes the combination of frames 

and frame properties that make up the complete Layout. The frameset sets the 

number of frames, defines their size and placement, and specifies the pages or 

resources that make up their original or default content.

Within a frameset, each frame has the characteristics of an individual page. Site 

visitors viewing a frameset can drag frame borders and scroll frame contents to 

display information. A link in a frame can display new information in any frame 

within the frameset, or load an entirely different page that replaces the frameset. 

You can target links to specify what happens within each frame when a site visitor 

clicks linked items.

In addition to the AutoFrames function, NetObjects Fusion provides HTML access 

capabilities necessary to create frames directly in HTML. If you know the HTML 

used to create frames, you can create custom frames in NetObjects Fusion just as 

you create frames in an HTML editor. 

This chapter describes how to script a simple frameset. For information on other 

uses of NetObjects Fusion’s HTML access feature, see Chapter 22, “Working with 

HTML Directly.”

Note: You must know HTML frame coding to script frames in NetObjects Fusion. If 
you need background information, see the resources at www.newbie.net/frames/. 
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The Frame Scripting Process
To script frames in NetObjects Fusion, follow this process:

1. Determine how and where you want to use frames in your site, as 
described in “Planning Your Use of Frames” on page 23-3.

2. Create a frameset page and define the appearance and function of the 
frames within it. See “Defining a Frameset” on page 23-4.

3. Add non-frame content for site visitors using older browsers that don’t 
support frames. See “Adding Content for Frameless Browsers” on 
page 23-10.

4. Create the content pages that will be displayed in the frames. See 
“Creating Frame Content” on page 23-6.

5. Define links and determine frame targeting. See “Scripting and 
Targeting Links” on page 23-7.

The rest of this section covers these tasks in more detail.
Planning Your Use of Frames
Begin your frame scripting efforts by planning the appearance and use of frames.

● Determine which pages within your site you want to display in frames. If you 
want the entire site framed, for example, then you create your frameset on the 
site’s Home page. If you only want certain sections—such as technical 
publications or references—displayed in frames, then you can create your 
frameset as the top page of that section, and arrange the content pages as child 
pages beneath it.

● If you apply frames only to a section of your site, decide how you want site 
visitors to navigate in and out of the framed section: 

– You can link to the frameset from other pages in the site with the normal 

methods, using either navigation bars or specific object links.

– To link from the frameset back to the non-framed parts of the site, you must 

include a properly targeted link on one or more of the content pages of the 

frameset. If you don’t create an exit link, you might leave your site visitor with 

no way to navigate out of your frameset.
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● Plan in which frame your links will display retrieved results. You might want to 
define default link targets for certain content pages, and specific target frames for 
selected links.
Defining a Frameset
1. In Site view, create and name a new page at the location where you want 

the frameset.

2. Go to the page in Page view and select the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

4. In the text field of the tab, enter the HTML code that defines the page as 
a frameset and defines the size, names, and configuration of the frames it 
contains. 

For example, the HTML code to create two horizontal frames–one body 
frame called “main” and one footer frame called “menu”–might look like 
this: 

5. You can include other HTML frame attributes as needed. For example, 
to set a frame to have zero margins enter this HTML between the 
frameset tags:

<frame name=”menu” src=”../html/menu.html” scrolling=”no” 
marginwidth=0 marginheight=0>

6. Click OK, and your frameset is established.
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Frameset Paths and File Names
The src attribute of a <FRAME> tag identifies the URL of the source file that first 

displays in that frame. This can be a relative path, like the one shown above, or an 

absolute URL. 

If the source file for your frame is an internal page, you must make sure the src 

attribute exactly matches the file name that NetObjects Fusion assigns when it 

creates the page. For example, if your source page name has spaces or special 

characters, NetObjects Fusion converts those special characters and spaces to 

underscores when it generates the page. When you script your frame to use that 

page as its source, you must also use an underscore in the source file name so the 

frame can find the file.

You also have to define the relative path to the source file correctly. NetObjects 

Fusion determines the relative path to an internal page at the time you are prepared 

to publish the site. The directory structure you select before you preview or publish 

your site defines the relative paths between the files.

NetObjects Fusion offers three predefined site structures, and you can also 

customize the structure yourself. “Customizing Your Directory Structure” on 

page 26-21 describes these choices in detail.
Relative Path Scenarios
If you use one of NetObjects Fusion’s directory structure choices, consider these 

relative path scenarios when you define your frameset.

For these examples, page.html stands for any content page, section_name refers 

to any site section, and index.html represents your Home page. Your own file 

names may be different.

● If you publish with a Flat directory structure, NetObjects Fusion puts all content 
files, including the Home page, in the same directory. Relative paths in a flat 
structure are always expressed as ./page.html or ./index.html.

● If you publish with By Asset Type directory structure, NetObjects Fusion puts the 
Home page in the top directory, and all content pages in the /html subdirectory 
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below it. Other types of assets have their own subdirectories. Relative paths in an 
asset type structure are expressed as follows:

– If the frameset is the Home page for your site, the relative path to your content 

pages is ./HTML/page.html.

– If the frameset is not your Home page, the relative path to your content pages 

is ./page.html.

– If the frameset is not your Home page, but you want to use the Home page as a 

source file for one of your frames, the relative path to the Home page is 

../index.html.

● If you publish with By Site Section directory structure, NetObjects Fusion puts 
the Home page in the top directory, creates a subdirectory named for each major 
section of the site, and puts the content pages into subdirectories for each section. 
Relative paths in a site section structure can be expressed as follows:

– If the frameset is the Home page for your site, the relative path to your content 

pages is ../section_name/page.html.

– If the frameset is in the same section as its content pages, the relative path to 

the content pages is ./page.html.

– If the frameset is in a different section than its content pages, the relative path 

to the content pages is ../section_name/page.html. 

– If the frameset is not your Home page, but you want to use the Home page as a 

source file for one of your frames, the relative path to the Home page is 

../index.html.
Creating Frame Content 
After you define your frameset, you add or refine the content pages or resources for 

each frame. You can use all NetObjects Fusion tools that you would normally use 

for page and content development, but consider these issues:

● The frames created by your frameset constrain the size of your content pages. For 
example, if you set frames to be unscrollable and then create a content page that’s 
too big for the frame, your site visitor won’t be able to see the entire page. Keep 
track of your frame dimensions and reset your Layout size to match.
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● Arrange the hierarchy of your site to support your framed content. For example, 
if you want the frameset to be the sole access point for the pages in the frames, 
organize the content pages as children of your frameset page.

This simplifies managing NetObjects Fusion’s automatic navigation links.

● Links within scripted frames have special targeting requirements, which are 
discussed in the next section.
Scripting and Targeting Links
Targeting is the technique of specifying which frame a link is supposed to use to 

display its retrieved content. When a site visitor clicks a link within a scripted frame, 

the retrieved content can appear in one of three targeted locations:

● The frame that contains the link itself. This is the default browser behavior, but 
it’s not usually the targeting behavior that you want.

● A default target frame that you define for a particular frame content page. If you 
set a default target for the page in left_frame, for example, all links on that page 
retrieve their content into the target frame, unless you define a different, specific 
target for individual links.

● A specific target defined only for that link. This target can be:

– Any other frame in the current frameset.

– A full browser window with no frames. This replaces the frameset with the 

retrieved content displayed in the full browser window.

– A new, additional browser window, also known as a browser instance. This 

leaves the original browser window open and the original frameset intact.
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Note: If you do not specify any default or specific targets, links within your frames 
follow the default browser behavior: the retrieved content displays in the same 
frame as the link, overwriting the page containing the original link. 
Scripting a Default Target Frame
You can set the default target frame for any content page, whether it’s the original 

content for that frame (the page entered as the value of src in the <FRAME> tag) or 

simply another content page. If, for example, you create a frame intended to provide 

site navigation, then you set its default target to be the body or main frame, so all 

links display their content in the proper frame.

To script a default target frame:

1. In Page view, open the content page to be targeted.

2. Click the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

4. In the text field on that tab, enter: 

<base target="framename">

using the actual name of your target frame. For example, you might use 
the following HTML for the source file for a navigation frame:

5. Click OK.

6. Add or select several objects in the Layout of this page and link them to 
appropriate pages or resources.
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7. Preview or publish your site and view the frameset page. Then test the 
default links. All retrieved resources should be displayed in the targeted 
frame.
Scripting Targeted Links
You can also define a specific target frame for each individual link. As noted 

previously, these targets can be another frame in the current frameset, a full browser 

window with no frames, or an additional browser instance.

1. In Page view, select an object or text to link.

2. In the Properties palette for that object, click Link.

The Link dialog appears. 

3. Select the tab for the type of link you want and select the page, resource, 
or anchor you are linking to.

4. Click the HTML button to display the Object HTML dialog.

5. Select the Inside Tag tab and enter the following HTML: 

< target="framename">

using the actual name of your target frame. For example, you might use 
the following HTML for a link to a secondary menu page. 

6. Click OK and the Link dialog appears. Click Link to complete the link.
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Adding Content for Frameless Browsers
Some site visitors may have browsers that don’t support frames, so you should 

include unframed content to give them some information when they access your 

site. Site visitors using browsers that do support frames do not see this content.

To define this alternate content for frameless browsers, you can use the HTML 

<NOFRAMES></NOFRAMES> tag to add text, pictures, and links to the frameset 

that you created by modifying the layout HTML and the contents of your frameset 

page:

1. In Page view, open the frameset page.

2. Click the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button to display the Between Head Tags tab of the 
Page HTML dialog.

4. Select the Beginning of Body tab. In the text field of this tab, enter:

<noframes>
...your message to frameless site visitors, using any valid HTML 
tagging
</noframes>
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For example, your message might look like the figure below.

5. Click OK to close the dialog.
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A site visitor with a browser that supports frames sees the framed site as you 

designed it. A site visitor with an older, frameless browser sees the <NOFRAMES> 

message, such as in the example. 
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Working with AutoFrames 24

When you use AutoFrames, you use the MasterBorder to create an HTML 

frameset—a multi-paned page that lets you deliver multiple content pages in one 

browser window. When you preview or publish the site, NetObjects Fusion converts 

all pages that use that framed MasterBorder into content pages for the frameset. The 

process of using AutoFrames to create a frameset is described in “Using 

AutoFrames” on page 6-9.

This chapter expands your use of AutoFrames to exercise greater control over 

framed pages. It explains how NetObjects Fusion generates HTML pages that 

contain AutoFrames, and describes how to add HTML or scripts to individual 

frames or the main frameset, so you can customize AutoFrame pages. 

For example, you can:

● Target links in your AutoFrames to specify where they display results.

● Include content within the <NOFRAMES> HTML tag, so site visitors using 
frameless browsers—older browser versions that don’t support frames—see some 
content or message.

● Add <META> tags and information to any frameset or frame content pages.

The combination of AutoFrames and custom scripting will probably meet your 

needs for frame-based pages. To create your frames completely from scratch, see 

“Creating Custom HTML Framesets and Frames” on page 23-1.

The chapter includes:

● Targeting links in AutoFrames

● Including content for frameless browsers

● Scripting other custom HTML for AutoFrames

● Browser refresh factors for AutoFrame pages 
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Targeting Links in AutoFrames
Before you customize AutoFrames, you should understand these basics about 

HTML frame targeting:

● HTML frames divide the browser window into multiple areas. When a site visitor 
clicks a link that’s placed within a frame—including the main or body frame—
the browser has to know where to display the results. 

● The frame that displays the retrieved content is considered the target of the link; 
when you specify which frame is to display the results of a link, you are targeting 
that frame. 

● In HTML, you can set a default target for a frame that targets all its links to a 
specific frame, or you can define targets for individual links. You can also do 
both; an individual link target overrides any default target set for that page.

When NetObjects Fusion generates AutoFrame pages, it inserts a 

<base target=”_parent”> statement into the HTML of each frame. This defines the 

frameset as the default target for any links within each frame. You can override this 

default by defining an individual link to target a specific frame. 

You cannot reset the default target in AutoFrames, however; if your page design 

requires that you set a specific default target, you have to script the frames yourself. 

See “Scripting a Default Target Frame” on page 23-8 for information.

When NetObjects Fusion generates the AutoFrames, it names the frames Left, 

Right, Header, Footer, and Body. The read-only Frame name field on the Frame tab 

of the MasterBorder Properties palette displays the name of the currently selected 

frame in grey text.
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If the framed MasterBorder contains a dynamic element such as a banner, 

highlighted navigation buttons, or a smart link, NetObjects Fusion names the 

source page for that frame one of the following: 

● Left_PageName.htm

● Right_PageName.htm

● Bottom_PageName.htm

● Top_PageName.htm

where PageName is the name of the page that forms the frameset.

The dynamic element, by definition, changes from page to page, so NetObjects 

Fusion has to create separate pages for each MasterBorder.

If the MasterBorder does not contain any dynamic elements, NetObjects Fusion 

names the source page for that frame one of the following:

● Left_MasterBorderName.htm

● Right_MasterBorderName.htm

● Bottom_MasterBorderName.htm

● Top_MasterBorderName.htm

This source page is then used by all the frameset pages that share that MasterBorder.
Targeting Specific Links 
When you add a link to an object located in an AutoFrame frameset, you can target 

the retrieved results to display in one of three places: 

● In a different frame on the same page within the same frameset. Use this to target 
content to display in any frame other than the body frame. 

● In the full browser window with no frames. This removes the current frameset 
and displays the retrieved content in the full browser window.

● In a new, additional browser window opened just for that purpose. This window 
is also known as a new browser instance. This leaves the original browser window 
open and the original frameset intact.
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When you create AutoFrames, you must also consider whether the browser refreshes 

all or part of the entire frameset when a site visitor clicks a link. Although this is not 

a linking issue, it has an impact on visitors to your site. For more information, see 

“AutoFrames and Browser Refresh” on page 24-10.
Targeting a Link to Internal Pages 

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. If you’re linking to an internal page, select the page to be linked from the 
Page Name list. To target a specific anchor on that page, select it from the 
Select Anchor drop-down list.

If you’re linking to an anchor location on the current page, select 
Current Page and choose an anchor from the Select Anchor drop-down 
list.

4. Choose the target frame in which you want to display the linked 
information from the Select Frame Target drop-down list.

5. Click Link to close the dialog and create the link.
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6. Preview or publish locally and test your targeted links.

See Chapter 22, “Working with HTML Directly,” for information on 
scripting techniques and requirements.

Targeting a Smart Link to Internal Pages 

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog is displayed.

3. Select the Smart Link tab.

4. Select the Smart Link you want from the Link Types list.

5. Select the targeted AutoFrame from the Select Frame Target drop-down 
list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.

Targeting a Link to External Pages 

1. In Page view, select the object or text that you want to link.
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The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the External Link tab.

4. If you are linking to a new external resource:

a. Select the correct protocol for this resource from the URL drop-
down list. http:// is the default for HTML pages. 

b. Enter the complete URL for the linked resource in the second 
URL field.

c. Enter a name for the external resource in the Asset Name field.

If you are linking to an existing external resource, select its name from 
the list of link assets.

5. Select the targeted AutoFrame from the Select Frame Target drop-down 
list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.
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Targeting a File Link

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the File Link tab.

4. If you are linking to a new file resource:

a. Enter the complete URL for the linked resource in the URL field, 
or click Browse to open a file dialog and find the resource.

b. Enter a name for the external file in the Asset Name field.

If you are linking to an existing file resource, select its name from the list 
of file assets in the dialog.

5. Select the targeted AutoFrame from the Select Frame Target drop-down 
list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.
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Targeting the Full Browser Window
To display the retrieved resource in the full browser window—regardless of the type 

of link you use—you can script the necessary targeting HTML yourself. 

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

NetObjects Fusion displays the Internal Link tab of the Link dialog.

3. Select the tab for the type of link you want—Internal, Smart Link, 
External, or File.

4. Select or enter the page or resource that you are linking to the selected 
object.

5. Make sure Select Frame Target drop-down list is set to (none).

6. Click the HTML button.

The Before Tag tab of the Page HTML dialog appears.

7. Select the Inside Tag tab. In the text field, enter:

target="_top"

This inserts your target statement inside the link tag that NetObjects 
Fusion creates for your object. The value “_top” is an HTML default that 
displays the retrieved resource in the full browser window.

8. Click OK to close the Page HTML dialog.

9. Click Link to create the targeted link.

10. Preview or publish locally and test your targeted links.
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See Chapter 22, “Working with HTML Directly,” for information on 
scripting techniques and requirements.

Targeting a New Browser Window
To display a linked resource in a new browser window, you can script the necessary 

targeting HTML. 

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the tab for the type of link you want—Internal, Smart Link, 
External, or File.

4. Select or enter the page or resource that you are linking to your selected 
object.

5. Make sure the Select Frame Target is set to (none).

6. Click the HTML button.

The Before Tag tab of the Page HTML dialog appears.

7. Select the Inside Tag tab. In the text field, enter:

target="_blank"

This inserts your target statement inside the link tag that NetObjects 
Fusion creates for your object. The value “_blank” is an HTML default 
that displays the retrieved resource in a new browser window.

8. Click OK to close the Page HTML dialog.
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9. Click Link to create the targeted link.

10. Preview or publish locally and test your targeted links.

See Chapter 22, “Working with HTML Directly,” for information on 
scripting techniques and requirements.
AutoFrames and Browser Refresh
When a site visitor clicks an untargeted link in a frame that you created with 

AutoFrames, the browser either refreshes the content of the body frame only, or it 

refreshes the entire page. Although this doesn’t affect the appearance of the page, for 

performance reasons you don’t want the browser to refresh the entire page 

unnecessarily. 

The HTML code that NetObjects Fusion generates for your AutoFrame pages 

controls this according to the factors listed below. In all cases this is based on 

untargeted links—links that depend on the default target of the frame. Use this 

information to plan your use of AutoFrames:

● The browser refreshes the entire window if any one of the framed MasterBorders 
contains a dynamic object, such as a banner, highlighted navigation buttons, or a 
smart link. The dynamic object, by definition, changes from page to page, so the 
browser has to load the new page.

● The browser exits the frameset and displays the retrieved resource in the full 
browser window if the link retrieves a page with a different MasterBorder, or an 
external HTML page. 

If neither of these conditions exist, the browser refreshes the body frame only.
Adding Content for Frameless Browsers
Some site visitors might have browsers that don’t support frames, so you should 

include unframed content. Site visitors using browsers that support frames do not 

see this content.

To define alternate content for frameless browsers, you can use the HTML 

<NOFRAMES></NOFRAMES> tag to add text, pictures, and links to the frameset 

that you created with AutoFrames.
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1. In Page view, click a border of the frameset page.

The General tab of the MasterBorder Properties palette appears.

2. Click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

3. Select the Beginning of Body tab. In the text field of this tab, enter:

<noframes>
...your message to frameless site visitors, using any valid HTML 
tagging
</noframes>

For example, your message might look like the figure below.

4. Click OK to close the dialog.
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A site visitor with a browser that supports frames sees the framed site as you 

designed it. A site visitor with an older, frameless browser sees the <NOFRAMES> 

message. 
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Adding Other Scripts to AutoFrames
You can use the Page HTML dialog to add custom HTML or scripts to any frame in 

the frameset, or to the frameset itself. 

1. In Page view, click a border of the frameset page.

The General tab of the MasterBorder Properties palette appears.

2. Click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

3. Select the tab that places your HTML or scripting in the proper location. 
In the text field of this tab, enter the HTML or script for the current 
frame.

4. Click OK to close the dialog

To add HTML or scripts to an individual frame:

5. In Page view, click the frame to which you want to add HTML or script. 

The General tab of the MasterBorder Properties palette appears.

6. Select the Frame tab and click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

7. Select the tab that places your HTML or scripting in the proper location. 
In the text field of this tab, enter the HTML or script for the current 
frame.

8. Click OK to close the dialog.

For example, you may want to help search engines categorize your site by adding a 

set of keywords to the frameset using the <META> HTML tag. See “Indexing Pages 

for Search Engines” on page 22-4 for an example of <META> tag scripting.
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Managing Assets 25

NetObjects Fusion can manage all the files, links, data objects, and variables used in 

your site. In Assets view, you can navigate to the pages on which these assets appear, 

delete unused assets, and verify the location of assets that are in use. Because 

NetObjects Fusion uses aliases for files and external links, you can globally replace 

an item that appears on several pages—such as a picture, an applet, or an external 

link—by replacing it once in Assets view. If you insert a variable in text boxes on 

different pages, you can edit the value of the variable in Assets view, and NetObjects 

Fusion updates all instances of the variable throughout your site automatically.

This chapter describes the features of Assets view, including:

● Managing files

● Managing links

● Managing data objects

● Managing variables
Managing Assets 25-1



W O R K I N G  I N  A S S E T S  V I E W
Working in Assets View
When you switch to Assets view, choose which kind of asset to view by clicking one 

of the four tabs below the control bar. You can sort a list by clicking a column 

heading, and you can change the width of any column by dragging the column 

divider to the left or right.

Depending on the selected asset type, Assets view lists:

Click a tab to see file assets, links, 
data objects, or user-defined 
variables.

Click a column heading 
to sort the table.

Drag the column divider to 
change column width.

Files Links Data Objects Variables

Name Name Name Name

Type Link To Contents

In Use Type

Location Target

Size Verify Status

Date

Verify Status
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Managing File Assets
When you click the Files tab, a list of the files associated with your site appears, 

including external files and those generated by NetObjects Fusion.

File types include:

● images

● audio 

● video

● applets/plugins

● Java scripts

● HTML

In Assets view you can add new assets and edit the names of assets. You can go 

directly to the page containing a selected asset. You can replace assets, delete selected 

assets, or delete all unused assets in a single action. You can verify the locations of 

assets in your site, and you can open an asset file for editing in the application that 

created it.
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The File dialog displays an asset’s name, location, and the pages on which it is used. 

To display the File dialog, double-click the asset’s name in the Assets Files view.

Note: Image files that you place on stacked pages to populate an internal data object 
are not listed in Assets view. You can manage such files directly on the stacked pages. 
For information about data objects and stacked pages, see Chapter 20, “Data 
Publishing.”

This is the asset’s location.

This is the name that appears in the 
Name list in the Assets File view.

These are the pages on which the 
asset is used.
Adding File Assets
1. In Assets view, from the Assets menu choose New File Asset, or click 

New on the control bar.

The File dialog appears.

2. In the Location field of the File dialog, type the path and file name of the 
asset you want to add, or click Browse and select a file.

3. If you want, edit the asset name and click OK. See “Editing Asset Names 
and Locations” on page 25-5.

4. To force publication of the file, even if it is not in use, you can select 
Always publish file.
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If the new asset is an image file, its name appears on the Image Assets tab of the 

Picture File Open dialog.

When you add an asset in this manner, it is available for use in your site, but it is not 

yet actually in use. For information about placing image assets, see “Using Image 

Assets” on page 10-13.
Editing Asset Names and Locations
Giving custom names to assets can make them easier to manage. For example, if you 

have an image file of an arrow that indicates the next page in the site, you could 

name this asset “Next Page” and place it on several pages. If you later decide to 

change the image to a pointing finger, you need only edit the file asset so Next Page 

uses the pointing finger image file. NetObjects Fusion automatically changes the 

image on all the pages that include the Next Page image asset.

To edit an asset’s name:

1. In Assets view, double-click the name in the Files list to display the File 
dialog.

2. Type a new name into the name in the Name field and click OK.

You can also edit the location directly in the File dialog. For example, you could 

enter a URL instead of a file path to point to a dynamic image on a server. Such 

images, however, are represented by an X in Page view, because the asset is not 

accessible.

This asset has been 
renamed.
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Displaying Pages Containing File Assets
1. In Assets view, double-click a file asset to open the File dialog.

2. Select the page you want to see from the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.
Replacing File Assets
You can change all occurrences of one asset file to another file. To replace an asset 

throughout the site:

1. In Assets File view, double-click the name of the asset you want to 
replace.

2. In the Location field of the File dialog, type the location of the 
replacement asset file, or click Browse and select the file from the dialog 
that is displayed.

3. If the asset is a picture, the Picture File Open dialog appears.

Select a new file from the Folders tab or an existing asset from the Image 
Assets tab and click Open.

4. Click OK in the File dialog to change all occurrences of this asset.

Note: If the asset is an image and the replacement image is not the same 
size as the original, you must go through the site and resize the new 
images accordingly.

Thumbnail of the 
selected picture.
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Deleting File Assets
To delete a file asset that is not in use:

◆ In Assets view, select the file you want to delete, and choose Delete File 
Asset from the Edit menu or press Delete. Click Yes to confirm the 
deletion.

If the asset is in use, you must first delete all occurrences of the file throughout the 

site. To delete a file asset that is in use:

1. In Assets view, double-click the asset you want to delete.

2. In the File dialog, select a page containing the asset and click Go To.

NetObjects Fusion switches to Page view, displaying the page that 
contains the asset you want to delete.

3. In Page view, select and delete the asset.

4. Repeat steps 1-3 until the object is deleted from all pages.

5. Return to Assets view and select the file you want to delete.

6. Choose Delete File Asset from the Edit menu or press Delete. Click Yes to 
confirm the deletion.

Note: You cannot undo this operation. You must use the New File Asset command to 
recreate the file asset.
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Deleting All Unused File Assets
1. In Assets view, from the Assets menu choose Delete All Unused File 

Assets.

2. Click Yes to confirm the deletion.

NetObjects Fusion removes all file assets for which the In Use indicator 
is not Yes.

Note: You cannot undo this operation. You must use the New File Asset 
command to recreate file assets.
Verifying File Assets
To determine whether all file assets are in their expected directories:

1. In Assets view, from the Assets menu choose Verify All File Assets.

NetObjects Fusion verifies and reports the path status of all files. 

● When a file’s path information is correct, NetObjects Fusion lists 

the date and time found in the Verify Status column.

● When a file’s path information is incorrect and the file or folder 

cannot be found, NetObjects Fusion displays this dialog:

2. Resolve the paths of any lost files or folders.
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● To specify a new path, click Browse and locate the file or folder. 

● To skip the lost item and continue verification, click Skip. 

NetObjects Fusion gives this file Not Found status and goes on to 

verify subsequent files or folders.

● To stop the verification process, click Cancel. The verification status 

of the current file or subsequent files is not updated.

3. When verification is complete, click OK in the confirmation dialog.
Managing Links
When you click the Links tab, a list of all the links used in your site appears, 

including external links, user-defined internal links, and smart (structural) links.

For information on links, see Chapter 14, “Creating Links and Anchors.”

Links between entries in a data list and their associated stacked pages do not appear 

in Assets view. You can manage such links directly on the data list pages. For 

complete information about data lists, see “Creating a Data List” on page 20-18.
Opening File Assets
You can open a file asset in the application with which it is associated. For example, 

you can open a .gif or .jpeg file in your paint program directly from NetObjects 

Fusion. To open a file asset:

1. In Assets view, select the asset.

2. From the Assets menu choose Open Asset.

For information on file types and applications, see “To create or modify a file type” 

in Windows 95 Help.
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Updating an External Link
1. In Assets Links view, double-click the external link you want to update.

The Links dialog appears.

2. Change the name in the Name field if desired.

3. Update the URL in the Link To field and click OK.

List of pages that use the link
Displaying the Page Containing a Link
1. Double-click the link in Assets Links view. The Links dialog appears.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.
Adding a Link
1. In Assets Links view, from the Assets menu choose New Link, or click the 

New button on the control bar. 

The Links dialog appears.

2. Enter a name and destination for your link and click OK.
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Deleting a Link
1. In Assets Links view, select the link you want to delete

2. From the Edit menu choose Delete Link, or press Delete.

3. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the Add Link 
command to recreate the link.
Verifying Links
To determine whether all link destinations can be located:

1. In Assets Links view, from the Assets menu choose Verify All Links.

NetObjects Fusion displays a progress bar as it verifies and reports the 
status of link destinations. It accesses the Internet to verify external link 
references.

● When a link’s destination is found, the date and time of validation 

appear in the Verify Status column.

● If a link’s destination is not found, the problem is described in the 

Verify Status column.

When verification is complete, the progress bar disappears.

2. Resolve the destinations of any broken links by double-clicking the link 
and editing it as described in the previous section.

Link verification takes place in the background, so you can switch to another view 

and continue working while the links are being verified.

To verify links through a proxy server:

● Open the Windows 95 Control Panel and double-click the Internet icon. In the 
Internet Properties dialog, click the Advanced tab, and configure your proxy 
settings.
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Note: NetObjects Fusion might not be able to verify destinations that are on the 
other side of a firewall. Also, after verification any mailto links display 
“Unsupported URL Type” because NetObjects Fusion cannot verify whether an 
email address is valid.
Managing Data Objects
Data objects are collections of fields of data. You can use a data object to publish 

data without using CGI scripts or database programming. For information about 

data objects, including how to create them in Assets view, see Chapter 20, “Data 

Publishing.”

When you click the Data Objects tab, NetObjects Fusion displays a list of all the data 

objects used in your site.

You can edit the name and field names of an internal data object and add new fields. 

See “Changing an Internal Data Field Name” on page 20-10.

For an external data object, you can change Simple fields to Image fields and vice 

versa, but you cannot edit field names or add new fields, because these items depend 

on data in the external data file.
Managing Variables
Text variables make it easy to update text that appears throughout your site. User-

defined variables are displayed in Assets Variables view so you can edit, create, or 

delete them. NetObjects Fusion also provides standard variables, such as the date 

and time the site was created or last modified, but these are not displayed in Assets 

Variables view.

Adding a Variable
1. In Assets Variables view, from the Assets menu choose New User Defined 

Variable, or click New in the control bar. 
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The New Variable dialog appears.

2. Enter a name and value for your variable and click OK.
Editing a Variable
1. Double-click the variable in Assets Variables view. 

The Edit Variable dialog appears.

2. Edit the name and value of the variable and click OK.

If you edit the value of the variable, NetObjects Fusion updates all text 
blocks containing that variable with the new value.
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Deleting a Variable
1. In Assets Variables view, select the variable you want to delete

2. From the Edit menu, choose Delete User Defined Variable, or press 
Delete.

3. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the New Variable 
command to recreate the variable. Do not delete a variable that is in use. 
If you do, it will be replaced with Undefined User variable: variable 
name in the text where it was used.
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Publishing Your Site 26

When you complete your site design and development, you’re ready to publish the 

results as a collection of HTML pages and associated assets. Publishing is similar to 

previewing your site, with one major difference: 

● When you preview your site, NetObjects Fusion automatically generates and 
stores your site in the Sitename\Preview folder and creates absolute paths to 
your site’s assets.

● When you publish, you can control the location of your published site, directing 
NetObjects Fusion to store your site on a local disk or a remote server. 

This chapter tells you about the publishing process, describes the functions and 

features of Publish view, and tells you how to publish your site by: 

● Selecting the default HTML output method

● Designing the server file and directory structure

● Defining local and remote server locations

● Publishing your site locally or remotely

Note: Sites published with NetObjects Fusion work with any Web server, on any 
operating platform. No special Web-server extensions are required. If your site 
contains server-side components—including NetObjects Fusion Message Board or 
Form Handler components, CGI scripts, or third-party components such as Allaire 
Fusion2Fusion—it will require additional server setup.
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The Publishing Process
When you publish your site, NetObjects Fusion generates HTML pages and 

associated assets from the information in the Sitename.nod file, which contains 

your site structure, page design, content, links, and assets. If you are publishing to a 

remote server, NetObjects Fusion opens an FTP session and connects to the remote 

server. Then the HTML pages and assets of your site are stored in the location of 

your choice, using the file and directory structure you specify.

To publish your site the first time:

1. Define your site’s publishing settings in the Setup Publish dialog by:

a. Defining the file and directory structure.

b. Selecting the HTML output method. 

c. Defining a server profile for each location where you want to 
publish your site. 

These publishing settings are saved in your Sitename.nod file for future 
use.

2. Customize your site’s directory structure, if needed, by:

a. Re-arranging and renaming site folders.

b. Creating custom folders.

c. Changing the publishing properties for folders, pages, and assets.

Your customized directory structure is saved in your Sitename.nod file 
for future use. The file and directory structure you use does not change 
the appearance, design, or content your site visitor sees; it only controls 
the way the pages and assets are stored on the server.

3. Publish your site to the selected server location. 

Once you successfully publish, you can re-publish at any time by clicking the 

Publish button on the control bar. You can also modify these settings at any time, 

and then re-publish.
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Using Publish View
When you click Publish on the control bar, Publish view opens. Publish view looks 

similar to the Microsoft Windows Explorer or the Windows NT File Manager. 

You must be in Publish view to publish your site.

The Directory pane on the left displays the file and directory structure of your site as 

it will be published on your server. You can delete, rearrange, or rename folders 

shown in the Directory pane, and you can create new subfolders at any level. 

Components and their related assets have a black lock image on their icons, 

signifying that they cannot be renamed or rearranged.

The Contents pane on the right displays the contents of the folder currently selected 

in the Directory pane. For each folder, page, or asset, the Contents pane displays its 

name, type, attributes, and the last date each page or asset file was published locally 

and remotely. You can sort the content files and folders by clicking a column 

heading, and you can resize the columns by dragging the column heading border to 

the left or right. The icons displayed for different file types are set in the File Types 

Registry of the Windows 95 options.
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Click a folder’s plus sign to expand the display to show the subfolders beneath it. 

Click a folder’s minus sign to collapse the display and hide the subfolders beneath it. 

You can also resize the Directory and Contents panes by dragging the divider bar in 

either direction.
Configuring Publish Setup
Before you can publish, you should configure three publishing settings: the 

directory structure, the type of HTML output, and the server locations where you 

want to store the published results.
Setting the Directory Structure
When you publish your site, you control the directory structure NetObjects Fusion 

uses to arrange your files and assets on the server. Setting the directory structure 

does not change the site structure that the site visitor sees, nor does it affect the 

relationships or links between pages and assets. It simply defines how your pages 

and assets are stored on the server, and what URL is required to access them.

For example, some servers require a one-level structure, with all pages, images, and 

other assets in the same directory; others let you set up your own directories. 

NetObjects Fusion supports three types of server directory structures:

● Flat directories for servers that require all resources and assets to be in a single 
directory. Many commercial Internet Service Providers (ISPs) require this kind of 
structure. 

● By Asset Type arranges your site contents into folders according to their asset 
type. This is the structure generated by earlier versions of NetObjects Fusion. For 
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example, if your site contains a typical mix of text and media, a structure set By 
Asset Type arranges your contents into the structure shown below.

● By Site Section arranges your site contents into a directory structure that looks 
like your site in Site view:

– Your Home page and its assets are stored in the site’s root directory.

– Each first-level page is stored in its own folder with its assets.

– Any child page is stored with its assets in a subfolder beneath the folder that 

contains its parent page. 

For example, a structure set By Site Section would have this directory structure 

on the server.

This setting creates the most efficient file structure, allowing your server to load 

your pages as quickly as possible in your site visitor’s browser. It is the default 

directory structure setting in NetObjects Fusion. It also provides the most 

effective directory structure for search engines, which may only index one page 

per folder.
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Note: If you apply the By Section directory structure, shared assets are 
stored in the deepest folder common to all pages that use that asset. This 
makes the shared access to those assets as efficient as possible.

To set the Directory Structure property for this site:

1. In Publish view, click the Setup button on the control bar, or choose 
Publish Setup from the Publish menu.

The Directory Structure tab of the Publish Setup dialog appears.

2. Select the server arrangement you want from the Directory Structure 
drop-down list. 

For each option, NetObjects Fusion displays a short description of that 
option’s effect.

3. If you customized your directory structure and want to reset your 
arrangement to the default directory structure, click the Clear All 
Customizations button. 

NetObjects Fusion removes any custom folders and changes all 
customized asset names back to their original, auto-generated names. 
See “Customizing Your Directory Structure” on page 26-21 for 
information.
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4. Click OK to apply the selected directory structure type. 

The directory structure is revised and displayed in Publish view.

Note: If you apply the By Section directory structure, shared assets are 
stored in the deepest folder common to all pages that use that asset. This 
makes the shared access to those assets as efficient as possible.
Setting the Site’s HTML Output 
The wide range of browser versions and capabilities makes it difficult to know 

exactly what kind of HTML tags and functions will display effectively to site visitors. 

Advances in HTML coding and browser abilities have also made it possible to create 

pages using less code and more efficient downloads—if your site visitor’s browser 

can support it. 

To address these concerns and take advantage of these improvements, NetObjects 

Fusion can generate any of three types of HTML output when publishing your site 

See “Optimizing Nested Tables Output” on page 5-7 for complete information on 

these publishing methods. 

● Nested Tables uses nested table tagging and other features of the 3.2 HTML 
specification. This is NetObjects Fusion’s default output because it produces the 
most predictable and consistent results onscreen, regardless of the type, version, 
or configuration of the site visitor’s system or browser fonts. Both Microsoft 
Internet Explorer 2.x and above and Netscape Navigator 2.x and above correctly 
display pages published in Nested Tables format.

● Regular Tables uses basic HTML table tagging to deliver your design and 
content. Both Microsoft Internet Explorer 2.x and above and Netscape Navigator 
2.x and above correctly display pages published in Regular Tables format, 
although site visitors’ results might vary according to their system and browser 
font settings. 
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Note: If you select either form of table-based output, be sure your pages 
do not have overlapping objects, or your published results will not be 
what you expected. See “Interpreting the Warning Icon” on page 4-19 
for information.

● CSS and Layers uses Cascading Style Sheet Positioning code, layers, and scripts 
to position and publish your layout and content. Both Microsoft Internet 
Explorer 4.x and Netscape Communicator 4.x correctly display pages published 
in CSS and Layers format, although the site visitors’ results might vary according 
to their system and browser font settings.

On the HTML Output tab of the Publish Configure dialog you designate which type 

of HTML output NetObjects Fusion generates. This setting determines the site 

preference for HTML output. You can override this site preference for individual 

Layouts and Layout Regions, so NetObjects Fusion generates their HTML using a 

different method. See “Setting the Layout’s HTML Output Method” on page 7-8 

and “Setting the Layout Region’s HTML Output” on page 7-17 for information.

To set the publishing method for your site:

1. In Publish view, click the Setup button on the control bar, or choose 
Publish Setup from the Publish menu.

The Publish Setup dialog appears.
26-8 Publishing Your Site



C O N F I G U R I N G  P U B L I S H  S E T U P
2. Select the HTML Output tab.

3. Select the publishing method you want to use from the Output Type 
drop-down list.

When you select an option, NetObjects Fusion displays a short 
description of that option’s effect. The selected output method becomes 
the default for all the pages in the site, unless overridden in a specific 
Layout or Layout Region.

4. In the Options section of the dialog:

● To include comments in the HTML file created for each page, select 

the Generate HTML comments option. The comments identify the 

beginning and ending of each page’s head and body, as well as 

objects.

● If you are working with special character sets, such as Japanese or 

Chinese, and are familiar with their related coding issues and trade-

offs, you can prevent NetObjects Fusion from converting high 

ASCII characters to their HTML equivalents. To do so, select Skip 

High ASCII character set conversion.

The default is to leave ASCII character set conversion turned on; 
this is the correct setting for most sites.
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● Use the Quote Type drop-down list to select one of the three types 

of quotation marks you can use in your site’s text objects

Curly Quotes is the default setting. The site visitor’s browser font 
settings control the appearance of these quotes in the browser.

5. Click OK to set the selected HTML output type and formatting options.

"These are Straight Quotes."

“These are Curly Quotes.”

“These are Newspaper Quotes."
Defining Server Profiles
The last task in configuring your publishing settings is to define the local or remote 

server locations where you want to store the completed site. You configure these 

locations by modifying or creating server profiles, which are stored with the rest of 

your publishing specifications in the Sitename.nod file. 

Each server profile has a name and a set of properties that define the local path 

name or the remote host connection settings that NetObjects Fusion uses to publish 

your site to that location and server. You can select a server profile or set its 

properties any time before you publish the site.

NetObjects Fusion includes two default server profiles: 

● Local Stage Server, which defaults to a local setting with the target directory of 
Sitename\Publish.

● Remote Publish Server, which defaults to a blank remote server profile that you 
must fill out before publishing.

You can modify these default profiles, create your own, or delete unneeded profiles. 

Defining a Server Profile for Local Publishing

1. In Publish view, click the Setup button on the control bar. 
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The Publish Setup dialog appears.

2. Select the Server Locations tab.

3. To modify an existing local server profile, select the profile from the list 
and click Edit. Continue with step 5.

4. To create a new server profile, click Add.

NetObjects Fusion displays the New Location dialog with the Server 
Name field blank and the Local publish setting selected by default.
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Enter a name for this profile in the Server Name field.

5. Fill in the Directory field using one of these methods:

● Enter the drive and directory path you want to use. This path can 

point to an existing directory or create a new directory.

● Click Browse to display the Select Destination file dialog, then select 

the local directory you want to use and click Open. To create a new 

directory, browse to and select the directory immediately above the 

location you want, then click Open. Enter the name of the new 

directory at the end of the path in the Directory field.

To prevent your published site files from getting mixed in with other 
files, enter or select a new or empty directory. Also, make sure the local 
drive has sufficient space for your published site files.

6. To set the file name for the Home page of your site, use the Rename the 
home page drop-down list. You can select:

● Index, which is the default page name automatically recognized by 

most current servers. This is the default.
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● Current Page Name, which is set by the value of the Name property 

for the Home page.

● Home

● Default, which literally uses the name default, as in default.html

7. Set the default file name extension applied to each page in your site by 
either:

● Selecting .htm, .html, or .shtml from the drop-down list.

● Entering an extension of your choice.

For local publishing, be sure to use a page extension that your browser 
recognizes, or it might not display the page properly. If you defined a file 
name extension for an individual page in the Custom Names dialog, that 
extension overrides the site default for that page.

8. To convert all spaces and most non-alphanumeric characters in asset file 
names to underscore characters (_), select Replace spaces and other 
special characters with underscores. NetObjects Fusion does not replace 
periods (.) or hyphens (-), because all servers understand those 
characters.

9. Click OK to complete the configuration of the local server profile.

Defining a Server Profile for Remote Publishing

The information needed to connect to a remote server is specific to your server. 

Contact your ISP or server administrator for the precise information to enter in 

these fields. For guidance on the questions you need to ask, see “Remote Server 

Access Checklist” on page 26-29.

To define a remote server profile:

1. In Publish view, click Setup on the control bar. 

The Publish Setup dialog appears.
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2. Select the Server Locations tab.

3. To modify an existing remote server profile, select the profile from the 
list and click Edit. Continue with step 5.

4. To create a new remote server profile, click Add.

NetObjects Fusion displays the New Location dialog with the Server 
Name field blank and the Local publish setting selected by default.
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Enter a name for this profile in the Server Name field.

5. In the Location Properties dialog, select Remote.

6. In the Remote Host field, enter the name or IP number used to connect 
to the remote server. This can be your site’s domain name, the name of 
an intranet server, or the name of your ISP’s server.

7. To specify a CGI FTP port number or custom port number, or establish 
aliases or virtual directories for some of your site content, click 
Advanced to display the Advanced Settings dialog. See “Creating Aliased 
Folders and Setting the CGI-Bin Directory” on page 26-17 for 
information.

8. Enter the Base Directory for your site that defines where on the server 
your content will be stored:

● If your site’s Home page should be stored in the root directory of the 

user ID or server account that you use for loading your site, leave 

this field blank.

● If you want your site’s Home page to be stored in a different 

directory than the root directory, enter the relative path to it here.
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For more information on the base directory setting, see “Remote Server 
Access Checklist” on page 26-29.

9. In the Name field, enter the user ID needed to log on to the remote 
server so you can transfer files to it.

10. In the Password field, enter the password that authorizes this ID to 
access the server. To effectively publish your site, you need server 
permissions that let you add files and create directories, so you can 
transfer scripts and other executable resources to a directory on the 
server that lets them run.

11. Select the Remember Password option unless you want to be prompted 
for your password every time you publish remotely to this server. 

12. To set the file name for the Home page of your site, use the Rename the 
home page drop-down list. You can select:

● Index, which is the default page name automatically recognized by 

most current servers. This is the default.

● Current Page Name, which is set by the value of the Name property 

for the Home page.

● Home

● Default, which literally uses the name default, as in default.html

Your server administrator can tell you whether to use Home or Default 
instead of Index. If you use Current Page Name, your site visitors must 
include the exact file name as part of the URL to reach your site.

13. Set the default file name extension applied to each page in your site by 
either:

● Selecting .htm, .html, or .shtml from the drop-down list.

● Entering an extension of your choice directly in the extension field.

Your server administrator can tell you which extension is the default for 
your server. 
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Note: If you define a file name extension for an individual page in the 
Custom Names dialog, that extension overrides the site default for that 
page.

14. To convert all spaces and most non-alphanumeric characters in asset file 
names to underscore characters (_), select Replace file name spaces with 
underscores. 

Your site might be hosted on a UNIX server that cannot handle spaces in 
file names, so it’s recommended that you select this option. NetObjects 
Fusion does not replace periods (.) or hyphens (-), because all servers 
understand those characters.

15. Click OK to complete the configuration of the remote server profile.
Creating Aliased Folders and Setting the CGI-Bin Directory

Sometimes you need to store certain assets of your site in a location separate from 

the rest of your site. For example:

● You can link to programs such as CGI scripts or other executables that have to be 
placed in a specific CGI directory so they run properly.

● You can place an order form or other pages in a secure location that requires 
authorized access, without restricting access to the rest of your site.

● You can link to images or other assets that are maintained or controlled by 
others, and stored in a protected location.

To do this, you create alias folders, using a process in which you define two 

locations: the actual physical location where you want to FTP the pages or assets, 

and the URL or logical address that you want NetObjects Fusion to use when 

referring to that object. On some servers, this is referred to as creating virtual 

folders.

Once the site is published, you or your server administrator must configure the 

server to look in the FTP location for assets that are described as being in the URL 

location. 
Publishing Your Site 26-17



C O N F I G U R I N G  P U B L I S H  S E T U P
For example, your site might include several stock images from your company’s 

marketing department, such as the company logo and other approved art work. 

When you create your site, you use copies of the art work that you stored on a local 

disk. When you publish and upload your site to the company server, however, you 

want to use the “official” images that have been approved and maintained by the 

marketing department.

Check with your server administrator to see if your site contents or remote server 

configuration requires a CGI directory or other aliases. 

To specify the CGI-BIN directory:

1. In Publish view, click Setup.

2. Select the Server Locations tab, select a remote server, and click Edit.

3. Click the Advanced button.

4. Enter the ftp path where CGI scripts are stored in the CGI field.
This establishes an alias to the executable directory on the server where 
CGI scripts are kept. 

You can also use the Advanced Settings dialog to define a specific server port or 

permissions setting—even if you are not defining aliases or virtual folders. 

Depending on your Web server configuration, you might need to set specific 

permissions so that your Web server software can access your published files. This 

section describes how to set a different permission string to override the default 

permissions normally set by NetObjects Fusion. If you simply want to define a 

specific server port or permissions setting for this server profile, proceed to step 10. 

To create other aliased folders:

1. In Publish view, arrange the directory structure for your site the way you 
want it to appear on your server. 

2. Isolate the pages or assets you want to store in an aliased location into 
one branch of the directory structure, under a common parent folder. If 
necessary, create a custom folder for each set of aliased content. 
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If your site requires more than one alias—such as one alias for secure 
pages and another alias for protected assets—you can create more than 
one custom folder. See “Creating Aliased Folders and Setting the CGI-
Bin Directory” on page 26-17 for information.

3. Drag pages and assets into the appropriate custom folder(s) as needed.

4. Click Setup on the control bar. 

The Publish Setup dialog appears.

5. Select the Server Locations tab.

6. Select the remote server profile that you want to change, and click Edit. 

The Location Properties dialog appears.

7. Enter remote server profile information, if needed.

8. Position the Locations Properties dialog so you have a clear view of the 
Directory pane of Publish view. Refer to the directory structure to make 
sure you type the URL correctly.

9. Click the Advanced button. 

The Advanced Settings dialog appears.

10. To specify a port or permissions setting to access this server, enter the 
port number or permissions flag in the fields shown. 

11. To add a new alias, click the Add button. To edit an existing alias, select it 
from the list, then click the Edit button.
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The New Alias dialog appears.

12. Enter the relative path from your site’s root folder to the custom folder 
containing the aliased pages and assets as the URL Path. Refer to the 
directory panel as needed to enter the path exactly as it appears, 
including the use of uppercase and lowercase names and spaces. 

For example, if you create a custom folder called companypix and 
placed it under your /assets folder, then the URL Path would be
/assets/companypix.

13. Enter the FTP path that you want to use to actually store that folder and 
its contents. This FTP location must be on the same server as the rest of 
the site because your server profile only logs on to one server at a time.

14. Click OK. 

The Location Properties dialog appears.

15. If you need to add additional aliases, return to step 11.

When you publish your site, NetObjects Fusion keeps all links and references to 

your aliased content pointing toward the URL path, but actually stores the pages 

and assets in the FTP location you specified.

Note: The server must be configured to support this alias. This is a system 
administrator task outside NetObjects Fusion’s responsibility, so you or your server 
administrator must define the alias on the server.
26-20 Publishing Your Site



C U S T O M I Z I N G  Y O U R  D I R E C T O R Y  S T R U C T U R E
Customizing Your Directory Structure
Although NetObjects Fusion offers three directory structures, you might need to 

customize your site’s directory structure further. You can do this in Publish view by 

renaming, rearranging, or deleting site folders, creating custom folders, or changing 

the publishing properties for folders, pages, and assets.

NetObjects Fusion’s database keeps track of all your name, path, and structure 

changes, and updates the site’s links and auto-generated objects as appropriate. 

When you re-publish the site in the future, NetObjects Fusion remembers your 

changes and keeps them in place.

Note: Customizing your site structure does not change the appearance, design, or 
content that your site visitor sees; it only controls how the pages and assets are 
stored on the server, and the URL necessary to access the site’s interior information.
Creating a Custom Folder
1. In either pane of Publish view, right-click the folder, page, or asset where 

you want to add a custom folder, and select Add Folder from the 
shortcut menu.

NetObjects Fusion adds a custom subfolder named \New Folder below 
the selected folder or file, and opens the folder’s name field.

2. Edit the existing folder name, or enter a new name. Press Enter or select 
another object to record your changes.

3. Drag other folders or files into the custom folder as needed. 
Renaming Folders and Files
1. In either pane of Publish view, right-click the object and select Rename 

from the shortcut menu.

The object’s name field opens.

2. Edit the existing object name, or enter a new name. Press Enter or select 
another object to record your changes.
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You can rename auto-generated folders and files; NetObjects Fusion remembers the 

new names the next time you generate your site. Any folder or file that you rename 

is considered customized. If you name a customized folder with a name used by an 

auto-generated folder, it is still treated as a customized folder. 

Aliased folders are also considered customized folders; NetObjects Fusion displays 

them in the directory structure, even if they are empty, and tracks their name and 

location in the event you change them. See “Creating Aliased Folders and Setting 

the CGI-Bin Directory” on page 26-17 for more information.

By definition, read-only assets, such as script files used by NetObjects Fusion 

components, can’t be changed. NetObjects Fusion ignores attempts to move or 

rename read-only files.
Deleting Folders
1. In either pane of Publish view, click the folder you want to delete, and 

make sure it is empty. You cannot delete a folder until it is empty, and 
you also cannot delete pages or assets in Publish view. 

2. Right-click the folder and select Delete Folder from the shortcut menu.

NetObjects Fusion deletes the folder.

After you delete a customized folder, the next time you publish the site, NetObjects 

Fusion recreates any auto-generated assets that it needs.
Rearranging the Directory Structure
◆ In either pane of Publish view, click the folder, page, or asset and drag it 

to its new location.

NetObjects Fusion moves the object and updates all references to it.

If you move pages, NetObjects Fusion remembers their new locations, but might 

continue to auto-generate folders needed to contain that page’s assets. Components 

and their related assets have a black lock image on their icons, signifying that they 

cannot be renamed or rearranged.
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Viewing and Setting Publication Properties
In addition to their other properties, your site’s folders, pages, and assets have 

publishing properties that indicate or control the way they are included in your 

published site. 

Three of these publication properties are indicators of the publishing status for that 

folder, page, or asset:

● Folders, pages, and assets that were renamed or moved from their default 
location have a customized publication property. Customized assets display a C 
in the Attributes column of the Contents pane, and a check in the Customized 
option of the publication Properties dialog.

● Some folders, pages, and assets are marked read-only:

– Assets created by NetObjects Fusion components, such as SiteMapper or 

MessageBoard.

– Dependent Java .class files that were added to the site’s assets. When you add a 

Java object and preview or publish your site, NetObjects Fusion analyzes the 

object’s .class file to see if it calls for other .class files; if so, those dependent 

.class files are added as read-only assets.

Read-only assets display an R in the Attributes column of the Contents pane, and 

a check in the Read-only option of the publication Properties dialog.

● Pages and assets have two published date properties that display the latest 
publication date in both the Last Remote Publish and Last Local Publish columns 
of the Contents pane. 

– The publish dates for pages are always displayed in red, because NetObjects 

Fusion always publishes all pages of your site, except those individually 

marked Don’t publish.

– If an asset was never published locally or remotely, it displays Never Published 

in red in the appropriate column, and has a check in the Needs Publishing 

option of the publication Properties dialog.

– If an asset was changed since the last time it was published, it displays the Last 

Published date in red, and has a check in the Needs Publishing option of the 
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Publication properties dialog. If you select Publish changed assets only when 

you publish this site, the assets with red dates are re-published to the server.
Suppressing a Page or Asset from the Published Site
You can also suppress publishing for a selected page or asset by setting its Don’t 

publish property. If you set this property, NetObjects Fusion:

● Overrides any Needs Publishing or Publish changed assets setting for this page or 
asset.

● Displays a diagonal red slash mark through the page or file icon in Publish view 
and adds a D to its attribute column.

● Publishes the site without that page or asset.

To suppress publishing for a page or asset:

1. In the Contents pane of Publish view, right-click the page or asset and 
select Properties from the shortcut menu.

The Publication properties dialog appears.

2. Select Don’t Publish, then click OK.

NetObjects Fusion displays a red slash through the page or asset icon 
and suppresses it from the site when published.

To re-enable publishing for a suppressed page or asset, repeat step 1, then clear 

Don’t Publish and click OK.
Publishing Your Site
When your publishing configuration settings are complete, you are ready to publish 

your site: 

1. In Publish view, click the Publish button on the control bar.
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The Publish dialog appears.

2. Use the Location drop-down list to select a server profile.

3. To confirm or change the server profile properties—such as the 
directory name for local publishing, or the target directory for remote 
publishing: 

a. Click Edit.

The Locations Properties dialog is displayed.

b. Make necessary changes to the server profile. 

See “Defining a Server Profile for Local Publishing” on 
page 26-10 or “Defining a Server Profile for Remote Publishing” 
on page 26-13 for information.

c. Click OK to close the Locations Properties dialog.

4. To publish only the assets that changed since the last time you published, 
select Publish changed assets only. 

NetObjects Fusion determines which assets have changed since the last 
time the site was published, then generates and transfers only those 
assets. This does not impact your site’s pages, which are always 
regenerated and reloaded when you publish your site.

Note: NetObjects Fusion does not query the server to see if it has all the 
unchanged assets needed by the site. If you publish changed assets only, 
be sure you publish to the same location you did previously, so 
unchanged assets are still available.

5. Click OK to publish your site.
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● If you publish your site locally, NetObjects Fusion creates the local 

directories if needed, and stores the formatted site as directed.

● If you publish your site remotely, NetObjects Fusion generates a 

temporary copy of the site, connects to the remote server using the 

settings in the server profile, and uses its internal FTP program to 

transfer the site files and directories to the remote server.

If you specify in Publish Setup a folder that doesn’t exist yet on 
the server, NetObjects Fusion alerts you that the target directory 
doesn’t exist, and asks for confirmation that you want it to be 
created.

6. While NetObjects Fusion is transferring the published site to the server, 
you can select a different view and continue working. You cannot open a 
different site, however.

7. When the transfer is complete and your site is in place, access it with 
your browser and examine your results. You can now make changes to 
your site file (Sitename.nod), and re-publish the site or its changed assets 
as needed.
Additional Publishing Guidelines
● Sites published with NetObjects Fusion work with any Web server, on any 

operating platform. No special Web server extensions are required. 

● When you re-publish your site, NetObjects Fusion overwrites existing files as 
needed. It does not, however remove old files or obsolete assets from your local 
or remote directories; you have to perform these housekeeping duties yourself.

● NetObjects does not publish through firewalls or to proxy servers. See 
“Publishing with Firewalls or Proxy Servers” on page 26-27 for the steps 
necessary to publish your site to a protected server.

● If NetObjects Fusion has difficulty storing your site on a remote server:

– Make sure your system is online and has a valid connection to your network or 

the Internet.

– Make sure the server is not down or offline.
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– Make sure your server profile settings are correct. Test the remote host, 

account name, and password settings displayed in the Location Properties 

dialog by using them to log onto the server using a separate FTP or telnet 

application.

– Make sure your account has the appropriate permissions, and that there is 

sufficient storage space for your site on the server.

● If you define publishing configuration settings for a site, and then export that site 
as a template, those settings travel with the template. If you are sharing a template 
with colleagues who can use the same publishing settings, you can save time by 
configuring the publishing settings in advance, exporting them with a template, 
and then distributing the template. 

● If your site has been published and revised several times, your publish location 
might contain files that are not needed in the current or final version of the site. 
Delete unused assets and clean out obsolete files from your published site folders 
before publishing a new version of a site. See Chapter 25, “Managing Assets” for 
information.
Publishing with Firewalls or Proxy Servers
If your remote server is behind a firewall or stored on a proxy server, NetObjects 

Fusion cannot publish directly to the server. If that’s the case, follow these steps:

1. Publish your site to a local folder other than the Sitename\Preview 
folder of your site. Use whatever directory structure and publishing 
method you would normally. The default setting, Local Stage Server, 
publishes to the folder Sitename\Stage. 

2. Consult with your server administrator for the preferred method of 
transferring content to the remote server. Potential methods include: 

● Transferring the entire site structure of the locally published site to a 

holding location on an unprotected server, so an authorized 

administrator can then transfer the site to the protected location.

● Using an FTP application such as WS-FTP™ or other means of 

access authorized by the server administrator to transfer the entire 

site structure of the locally published site to the protected server. 
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In either instance, be sure to transfer all files and to duplicate the local 
folder structure precisely.
Publishing Special Assets
When you publish your site, NetObjects Fusion transfers the entire site to your 

designated location, including special assets you told it to manage. These special 

assets include things like Java classes, images and assets contained on external 

HTML pages, and CGI scripts. The list of managed assets included in your 

published site is displayed in Assets view.

You can use one of three ways to ensure that these special assets are included in your 

site’s managed assets when you publish:

● Include the assets when you add the object that refers to them. For example:

– If you reference external HTML pages using the External HTML tool, 

NetObjects Fusion automatically analyzes the external pages and includes 

their assets in the Asset Manager—unless you select Do not manage or move 

assets. If you do not select this option, you have to add assets those pages need 

to the Asset Manager, using one of the two methods below. For information, 

see “Adding File Assets” on page 25-4.

– If you add Java objects to your pages using the Java tool, NetObjects Fusion 

analyzes their .class files and adds other .class files referenced there. If you 

listed special assets in the Java Object Properties palette, NetObjects Fusion 

includes them as managed assets. See “Inserting a Java Applet or Servlet” on 

page 16-2 for information.

● You can add a file link to a special asset, and NetObjects Fusion manages and 
publishes the asset. See “Creating a File Link” on page 14-11 for information.

● You can explicitly add any special asset to the Asset Manager and select Always 
publish file to ensure that NetObjects Fusion manages and publishes the asset. 
For information, see “Adding File Assets” on page 25-4.
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Managing Script Assets
NetObjects Fusion does not analyze custom scripts that you add to pages, 

MasterBorders, or other objects. If those scripts reference special assets, they are not 

automatically included in the site’s managed assets. To have NetObjects Fusion 

manage and publish assets called in custom scripts, you must create file links to 

those assets, or explicitly add them to the Asset Manager. Then right-click the asset 

and choose Properties from the shortcut menu, and select Always publish.
Remote Server Access Checklist
Before you create a remote server profile, answer these questions.

1. Who is your service provider? This is the ISP, organization, or department 
that is going to store your site on its server and provide your site visitors 
access to it. 

The technical support staff of your service provider should be able to 
provide the answers to the rest of these questions. (ISPs and other 
service providers often offer technical support pages on their own Web 
sites that answer these questions.)

2. What is the name of your remote host? This is the name of the server 
where you are going to store your site. It might be the same as your 
domain name, such as www.yourname.com; a name assigned by the 
service provider, such as inbox.isp.com; or a specific IP address, a series 
of four numbers separated by periods.

My Remote Host: 
___________________________________________

3. What is your base directory? When you log onto your remote host, you 
automatically begin in the home directory for your log-in account. This 
might not be the right place to put your site, however. For a variety of 
reasons, you might need to store your site in a subdirectory of your 
home directory, or in another directory altogether.

You must know the relative path from your account’s home directory to 
the base directory where your site should be stored. When NetObjects 
Fusion publishes your site and logs onto your service provider, it stores 
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your site’s pages and assets in this base directory. This path statement is 
the value you enter for Base Directory in the Location Properties palette 
for remote server publishing. 

However, the host and base directory might not look anything like the 
URL that your site visitors use to access your site. For security and other 
reasons, service providers frequently name their host machines and user 
directories according to their own needs.

My Base Directory or path to my site folder: 
_______________________________________________________

Note: If you have your own domain, such as www.mycompany.com, 
and are logging in directly to the account that owns that domain, you 
might not need to specify a base directory, because the home directory 
of that account might be the same location as the base directory.

4. What is the name and password for your account? You need these so 
NetObjects Fusion can log on to the server and store your site files.

My account name:______________ Password: _______________

5. What is the preferred name for the default Home page? Your service 
provider determines what file name the server displays by default for 
each directory on the server. Some servers are configured to display by 
default any file named index; others default to home or default. You 
must match this preferred name in the Location Properties dialog for 
remote server publishing.

My server’s default file name is: ____________________________

6. What HTML file name extension does your server support? Web page 
servers typically support .html, .htm, or .shtml as file name extensions. 
Some service providers map one to the other so the server recognizes all 
of them; others require you to use a specific one. You must set the 
Location Properties dialog so NetObjects Fusion publishes files with the 
correct extension. You can also enter a custom extension, if your server 
supports it.

My server’s preferred or required extension: __________________
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7. Is a specific port required for upload? The service provider might have 
designated a specific port on the server that it wants you to use to upload 
files. If so, you must specify this for NetObjects Fusion. See “Creating 
Aliased Folders and Setting the CGI-Bin Directory” on page 26-17 for 
information about setting a custom port address.

My server’s custom port number: __________________

8. Does your log-in account have the necessary permissions? Servers use 
permission configurations to control what users are allowed to do while 
logged on—whether they can delete files, for example, or create new 
directories. 

In Publish view, you can specify the server file and directory structure 
that you want NetObjects Fusion to create or use for your site. Your log-
in account—which NetObjects Fusion uses to store the files—must have 
the server permissions necessary to create the directory structure you 
defined. 

If your service provider does not let user accounts create directories, 
then you must use the Flat directory structure option to publish your 
site.

My account does / does not have permission to create server 
directories.

9. How much server space do you have? Before you publish, you should 
publish your site locally and check the size of the generated 
Sitename\Publish folder, including all its sub-folders. Confirm that it 
takes less space than the maximum allowed by your service provider. 

My account’s storage capacity: _________________________
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A P P E N D I X  A
Working Around Browser 
Problems A

There are a few circumstances when later versions of browsers don’t properly 

display or handle actions, forms, and other objects you create in NetObjects Fusion.

This appendix describes browser problems with:

● Actions

● Forms

● Sounds and Shockwave objects

You can work around many problems by changing the HTML output method used 

to publish the particular page or Layout Region. For more information, see 

“Selecting HTML Output” on page 5-3.

Also, see the usage notes at www.netobjects.com/support for the latest 

information on browser problems.
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Problems with Actions
If you publish a page using the Nested Tables or Regular Tables HTML output 

method, the following problems can occur.

● If you assign an action to an object, and then put the object in a table, text box, or 
Layout Region, sometimes the object doesn’t display in Netscape Navigator 4.0.

Solution: Removing any action assigned to the table, text box, or region itself 

might fix the problem. Or, you can change the HTML output method to CSS & 

Layers.

● If you assign the Set Src or Use Image action to an image, the action doesn’t work 
in Netscape Navigator 4.0. 

Solution: Change the HTML output method to CSS & Layers.

● If you assign a transition action to an object, the transition doesn’t display 
properly in Internet Explorer 4.0 for Windows.

Solution: Either change the HTML output method to CSS & Layers, or use a 

motion action instead of a transition. 

If you assigned transition actions to objects placed inside a table or text box, 

changing the HTML output method will not fix the problem. Either use a Layout 

Region instead of the table or text box, or use a motion action.

Note that transitions don’t display in Internet Explorer 4.0 for Macintosh, 

regardless of your output method. Usa a motion action.
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Problems with Forms
● If you assign an action to an object inside a form, the form might not be visible in 

Netscape Navigator 4.0.

Solution: Place the object outside the form. For example, create the form in a 

Layout Region, and place the object elsewhere in the Layout area.

● If you publish a form in a Layout Area or Layout Region using the CSS & Layers 
HTML output method, form elements display piled atop one another in the 
upper left corner of the page.

Solution: Either change the HTML output method to Regular Tables or Nested 

Tables, or recreate the form in a text box or a table.
Problems with Sounds and Shockwave
Sound or Shockwave objects published using Nested Tables or Regular Tables as the 

HTML output method can’t be started, stopped, or otherwise controlled in 

Netscape Navigator 4.0. 

To avoid this problem, change the HTML output method to CSS & Layers.
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Index

A
accessing HTML 22-2, 22-6
actions 21-2

action messages 21-3, 21-10
adding to objects 21-5~21-16
assigning to Layout Regions 7-20
assigning to Layouts 7-13
assigning to navigation bars 13-3
assigning to text boxes 7-30
assigning to text links 21-17
cascading 21-15~21-16
custom, importing 3-13
custom, scripting 21-20~21-25
customizing 21-17, 21-27
customizing parameters 21-13
illustrated 21-4
inserting in scripts 21-22
inserting scripts 21-22
JavaScript 21-23
MasterBorders/AutoFrames 21-9
modifying 21-26
Object Initially Visible in Browser 

option 21-20
objects in forms 17-5
parameters 21-12~21-14
specifying targets 21-9
specifying trigger events 21-7
suppressing 21-26
targeting MasterBorder or 

Layout 21-15
targets 21-3
trigger events 21-3

ActiveX controls 16-5, 16-7
Add navigation buttons (stacked 

pages) 20-21
adding

alt tags 4-10
anchors 14-5
AutoFrames 6-13
banners 13-9
button navigation bars 13-3
check boxes 17-9
combo boxes 17-10

custom HTML and scripts to 
AutoFrames 24-13

DynaButtons 
component 18-2~18-5

file assets 25-4
form objects 17-4
framesets 23-4
guides 4-4
hidden fields in forms 17-19
HTML 22-2
HTML horizontal rules 11-6
HTML to links 14-12
HTML to objects 22-6
HTML/scripts to Layout 7-11
JavaScript to links 14-12
links 25-10
Message Board 

component 18-8~18-11
NetObjects Fusion 

components 18-18~18-20
objects to Layout Regions 7-15
objects to table cells 10-6
pages 2-12
Picture Loader component 18-15
Picture Rollover 

component 18-11~18-13
pictures 10-3~10-5
radio buttons 17-8
Reset button, forms 17-12
Rotating Picture 

component 18-16~18-17
scripts 22-2
scroll bars to frames 6-17
server profiles 26-11, 26-14
Site Mapper 

component 18-6~18-8
SiteStyle lines 11-7
SiteStyles 12-14, 12-15
sounds to background 7-12
Submit button, forms 17-12
tables 10-3
text to pictures 10-12
text to shapes 11-4
text to table cells 10-6

text with drag-and-drop 8-5
text with Text tool 8-4
Ticker Tape 

component 18-5~18-6
Time Based Picture 

component 18-13~18-14
variables 25-12
see also creating, placing

Adobe Acrobat PDF files 15-14
Advanced toolbar 4-16
.AIFF files 15-11
aliased folders 26-17~26-20, 26-22
aligning

embedded objects 7-28
objects 4-14

Alignment options, Flash and Splash 
files 15-6

Allaire HomeSite 3.0 19-13
alt tags 4-10
Always publish file option 25-4
Anchor icon 14-2
anchors

adding 14-5
adding HTML 14-14
deleting 14-7
editing 14-7
from hotspots 14-14
see also links

animated .gif files 10-2, 18-16
SiteStyles 12-12

animation, see video files 15-9
anti-aliasing options, Flash and 

Splash files 15-6
applying

MasterBorders to sections 6-8
SiteStyles 12-4
text styles 8-6

arrows, see lines
assets 1-4

custom names 25-5
customized 26-23
data objects, managing 25-12
displaying pages containing file 

assets 25-6
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displaying pages containing 
links 25-10

file types 25-3
file, adding 25-4
file, deleting 25-7
file, deleting unused 25-8
file, managing 25-3~25-9
file, opening 25-9
file, replacing 25-6
file, verifying 25-8
importing, limitations 3-8
links, adding 25-10
links, deleting 25-11
links, managing 25-9~25-12
links, verifying 25-11
location, changing 25-5
referenced, 

managing 19-9~19-11
script, managing 26-29
special, publishing 26-28
types 25-2
unmanaged, publishing 19-13
variables, adding 25-12
variables, deleting 25-14
variables, editing 25-13
variables, managing 25-12

Assets folder 1-20
Assets view 1-4, 25-2
asset-type directory structure, 

publishing 26-4
assigning

actions to banners 13-9
actions to Layout Regions 7-20
actions to Layouts 7-13
actions to text boxes 7-30
MasterBorders to imported 

sites 3-10, 3-16
.au files 15-11
audio file formats 15-11
author name 2-17
Auto Save preference 1-13
auto-forwarding 22-6
AutoFrames 6-9~6-18

adding 6-13
adding custom HTML and 

scripts 24-13
browser refresh 24-10
converted to MasterBorders, effect 

on HTML 22-3

customizing 24-1
defined 6-9
dynamic elements 24-3
illustrated 6-12
optimizing 5-11
properties 6-9
selection sequence 6-14
targeting links in 24-2
targeting specific links 24-3
see also frames

AutoSite templates 3-3
importing 3-13

.avi files 15-9

B
background color

Site view 2-18
tables, modifying 10-4

background images 1-16
background sounds 7-12
background, SiteStyle 12-5
backing up sites 1-17, 2-21
Backups folder 1-20
Banner (Custom Names 

dialog) 2-16
banners 13-2

adding 13-9
assigning actions 13-9
changing pictures 13-11
default location 13-2
restoring SiteStyle 13-15
setting custom text 2-15
setting style of 13-9
setting style/orientation 13-10
SiteStyle, editing 12-6
text, SiteStyles 12-7
using 13-8~13-10

base directory 26-29
BBS, see Message Board
blank site 2-3

default MasterBorder 6-3
starting with 2-4

Blank Site template 2-5, 3-2, 3-18
.bmp files 10-2
borderless frames 6-15
borders 10-4
browser default display font 5-2
Browser Safe Palette 1-10
browsers

displaying forms 17-4
font settings 1-15
font substitution 8-6
fonts in AutoFrames 6-10
frame support 6-11
frameless, alternate 

content 23-10, 24-10
new instance 24-3
opening page in new 

window 22-9
Previewing sites 1-13
refreshing pages 24-10
targeting full window 24-8
targeting new window 24-9
transparent .gif files 10-10
using non-Web-standard image 

files 10-4
building dynamic pages 21-5
bulleted lists 8-8
Bulletin Board, see Message Board
button navigation bars 13-2, 13-3

adding 13-3
default location 13-2
display levels 13-5
setting style 13-7
see also navigation bars

buttons 13-2
changing picture on one 

button 13-13
default style 13-3
highlighted 12-9
restoring SiteStyle 13-15
setting custom text 2-15
text, SiteStyles 12-7

C
cascading actions

creating 21-15
Cascading Style Sheets, see CSS and 

Layers
cell padding 10-4
cell spacing 10-4
centering page content 22-4
CGI directory for publishing 26-18
CGI script

assigning to form 17-17
forms 17-17
processing data with 17-17

CGI script support 17-17
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CGI scripts
naming conventions 17-5
Perl5 18-10

CGI-BIN folder 17-18
changing

colors 1-9
Layout size 4-3, 7-5~7-7
MasterBorder margins 4-3, 6-5
MasterBorders 6-8
page properties 2-9
page size 4-3
templates 3-18~3-20
see also customizing, editing, 

modifying
character sets, special 26-9
check boxes 17-4

adding 17-9
checking spelling 8-18
checklist, remote server 

access 26-29~26-31
Child Page button 4-5
child pages 2-7
CHMOD command 18-9
.CLASS files 16-2
client-side imagemaps 14-13
coding

objects 22-11
Cold Fusion component 

(Allaire) 18-18, 20-2
collapsing site structure 2-18
color

font 12-8
text, SiteStyles 12-11

Color dialog 12-8
color palettes 1-11

creating/editing 1-11
loading custom 1-11

Color Picker 1-9
Color property (pages) 2-10
Color property (sections) 2-11
colors

changing 1-9
inserting in frame 

background 6-18
Web safe 1-10

Columns (HTML output 
option) 7-9, 7-18

columns, tables
inserting 10-8

removing 10-8
resizing 10-7

combo boxes
adding 17-10

Comments property 2-11
Common Gateway Interface, see 

CGI 17-1
compacting

files 1-18
Component Development Kit 18-1
Component Tools toolbar

Form Handler tool 17-14
components

adding third-party 
components 18-18~18-20

Components folder 1-19
Components toolbar 4-17
configuring publishing setup 26-4
constraining lines to horizontal/

vertical 11-7
control bar 1-5

illustrated 1-4
Last button 1-8
New button 1-4
Preview button 1-7

converting existing sites 3-7
Coolmaps components 18-18
copying

objects 4-9
pictures 10-11

copying sites
restrictions explained 3-17, 3-21

copyright symbol
inserting in text 8-13

creating
borders around pictures 10-9
cascading actions 21-15
color palettes 1-11
custom folders 26-21
custom HTML frames 23-1
custom messages 21-18
external data 

objects 20-10~20-18
external links 14-9
file links 14-11
form objects 17-4
forms 17-2
forms from table cells 10-6
imagemaps 14-13

internal data objects 20-7~20-10
internal links 14-3
Layout Regions 7-15
Layouts 7-2
MasterBorders 6-6
multiple images of a picture 10-7
new embedded objects 7-27
sites from existing sites 3-9
SiteStyles 12-12
smart links 14-7
templates from sites 3-17
text styles 8-9
transition pages 22-6
user-defined variables 8-16
see also adding, placing

cropping pictures 10-7
CSS and Layers 4-12, 5-3

advantages 5-6
browser requirements 5-6
disadvantages 5-7
forms 17-1
publishing 5-5

CSS and Layers (HTML output 
option) 7-9, 7-18, 26-8

curly quotes 26-10
Current Page option, links 14-3
custom actions

scripting 21-20~21-25
custom extensions 2-15
custom frames 6-10
custom messages

creating 21-18
deleting 21-19

custom names 2-15
Custom Names property 

(pages) 2-10
Custom Names property 

(sections) 2-11
custom page names

specifying 2-15
customization, navigation bars, 

removing 13-15
customized assets 26-23
customizing

actions 21-17, 21-27
AutoFrames 24-1
banners 13-11
buttons 13-11
navigation bars 13-11
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templates 3-18~3-20
templates, customizing with 

SiteStyles 3-19
see also changing, editing, 

modifying
customizing parameters 

(actions) 21-13

D
data

submitting in email 17-16
data fields

defined 20-3
formatted text 20-9
image file 20-9
internal 20-9
simple text 20-9

data list icons 12-10
Data List tool 20-7
data lists

creating 20-18~20-22
defined 20-3

data objects
defined 20-3
deleting 20-22
external 20-6
external, creating 20-10~20-18
internal 20-6
internal, creating 20-7~20-10
managing 25-12
with external data source 20-4
with internal data source 20-4

data publishing 20-1
data lists, creating 20-18~20-22
process 20-5
stacked pages 20-22~20-26

data sources
defined 20-11

Date & Time field 8-16
formatting 8-18

date property, published sites 26-23
.DCR files 15-2
default display font 5-2
default page size 4-3
DefaultMasterBorder 6-4, 6-6
defining

framesets 23-4
Layout Regions as forms 7-19
Layouts as forms 7-10

server profile for local 
publishing 26-10

server profile for remote 
publishing 26-13

text boxes as forms 7-29
deleting

anchors 14-7
custom messages 21-19
data objects 20-22
file assets 25-7
folders 26-22
guides 4-4
links 25-11
MasterBorders 6-9
unused file assets 25-8
variables 25-14

deleting pages 2-13
deleting stacked pages 20-26
Developer folder 1-19
DHTML 21-2
.DIR files 15-2
Director

ActiveX control 15-3
Netscape plug-in 15-3
setting properties 15-5
WYSIWYG height and width 

parameters 15-3
Director files 15-2
directory structure

customizing 26-21~26-24
publishing, setting 26-4~26-7

Display all fields (stacked 
pages) 20-21

display levels
button navigation bars 13-5

Display options
plug-in media files 15-15
QuickTime movies (Controls 

tab) 15-8
QuickTime movies (General 

tab) 15-7
sound files 15-13
video files 15-10

displaying
grids, rulers and guides 4-5
Layout Region grid and 

guides 7-16
message on mouse-click 22-8
pages containing file assets 25-6

pages containing links 25-10
pages in Page view 4-2
previous view/page 1-8

distributing objects 4-14
distributing sites 3-21
dithering in transparent GIF 

files 10-10
domain names in imported 

sites 3-11, 3-16
Domino component (Lotus) 18-18, 

20-2
drag-and-drop

embedding objects 7-26
objects 4-8

drawing
HTML horizontal rules 11-6
lines 11-7
shapes 11-2

drop-down lists 17-4, 17-11
.DXR files 15-2
DynaButtons 

component 18-2~18-5
restriction on Preview 18-2
sub-buttons 18-4

dynamic content, adding to 
pages 21-5

dynamic data publishing 18-18
dynamic HTML 21-2
dynamic pages 21-2

E
edit fields 17-5
editing

anchors 14-7
color palettes 1-11
data list icons 12-10
hotspots 14-14
HTML 1-18, 22-3
imagemaps 14-14
images 1-18
lines 11-9
links 14-3, 14-14
media files 15-17
navigation bars 12-9
objects 4-10
referenced HTML 19-13~19-15
SiteStyles 12-5~12-12, 12-16
variables 25-13
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see also changing, customizing, 
modifying

editing page names (Site view) 2-14
ellipses, see shapes
email, submitting data 17-16
embedded objects

aligning 7-28
embedding

existing objects with 
drag-and-drop 7-26

objects in containers 4-11
objects in text boxes 7-24

events
mouse/object/page-driven 21-8

Everywhere HTML 5-6, 7-1, 21-1
expanding

sites 3-11
expanding site structure 2-18
exporting

pages 3-1, 3-17~3-21
sites 3-1, 3-17~3-21

expressions
JavaScript 21-23

HTML
external, see external HTML

external data objects 20-6
creating from desktop 

database 20-11~20-13
creating from SQL data 

sources 20-14~20-17
filtering 20-19
importing images 20-17
importing pictures 20-17
ISAM drivers 20-11
ODBC drivers 20-11

external HTML
as layout or object 19-9
publishing 19-11
referenced, editing 19-13~19-15
referencing 19-1
referencing as object 19-6~19-8
referencing from Page view 19-4
referencing in Site 

View 19-2~19-4
using for page layout 7-30

external links 14-2
creating 14-9
updating 25-10

F
file assets

adding 25-4
deleting 25-7
managing 25-3~25-9
opening 25-9
replacing 25-6
types 25-3
unused, deleting 25-8
verifying 25-8

File Data Source, external data 
objects 20-15

File Extension (Custom Names 
dialog) 2-16

file extensions
.nft 3-2
.nod 2-2
SHTML 2-16

file formats
audio 15-11
images 10-2
Shockwave 15-2

file links 14-2
creating 14-11
targeting 24-7

file names
framesets 23-5
HTML 2-14, 23-5

files
compacting 1-18
moving 3-21
renaming 26-21

filtering external data 20-19
finding

text 8-19
finding objects 1-7
firewalls, publishing with 26-27
Flash files 15-2

properties 15-5
Flashpix files 10-2
flat directory structure, 

publishing 26-4
flyouts 1-6

selecting tools 1-6
folders 1-19

aliased 26-17~26-20, 26-22
custom, creating 26-21
deleting 26-22
renaming 26-21

font substitution 8-6
fonts

banners and buttons, 
SiteStyles 12-7

browser fonts in 
AutoFrames 6-10

browsers 1-15
color 12-8
default display in browser 5-2

Form Handler tool 17-14
form objects

adding 17-4
creating 17-4
naming 17-5

form responses
processing 17-17

form templates, provided 3-3
Form toolbar 4-18, 17-4
formatted text fields

defined 20-9
formatting

date field 8-18
paragraphs 8-6~8-9
text 8-6~8-9
time field 8-18

forms
actions, browser problems 17-5
adding objects 17-4
assigning CGI script 17-17
CGI scripts 17-17
check boxes, adding 17-9
creating 17-2
creating from table cells 10-6
CSS and Layers 17-1
defining Layout as 7-10
defining Layout Region as 7-19
defining text boxes as 7-29
displaying in browsers 17-4
edit fields 17-5
hidden fields 17-19
multiple 7-10
multiple-line text fields 17-7
passwords 17-6
radio buttons, adding 17-8
Reset button 17-12
Submit button 17-12
submitting data in email 17-16
submitting data to text files 17-14
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submitting responses as plain 
text 17-14

types 17-2
Forms Button tool 17-13
Forms Checkbox tool 17-9
Forms Combo Box tool 17-11
Forms Edit Field tool 17-6
Forms Multi-Line tool 17-7
FPX picture files 10-2
frameless browsers

alternate content 23-10, 24-10
frames

adding content 23-6
adding custom HTML and 

scripts 24-13
adding scroll bars 6-17
borderless 6-15
custom (HTML) 6-10
defined 23-2
generating visible borders 6-15
inserting colors in 

background 6-18
inserting pictures in 

background 6-18
links to anchors 6-17
links within 6-10
planning 23-3
relative paths 23-5
resizing 6-17
scripting default target 23-8
scripting, overview 23-3~23-4
setting background 6-18
setting properties 6-16
support in browsers 6-11
User Resizable Frame 6-17
User scrollable 6-17
see also AutoFrames

framesets 6-9, 23-2
adding 23-4
defining 23-4
HTML 24-1
linking to/from 23-3
paths and file names 23-5

Fusion, see NetObjects Fusion
Fusion2 Fusion component 

(Allaire) 18-18
Fusion2Fusion component 

(Allaire) 20-2

G
General tab, Preferences dialog 1-12
Generate HTML comments 26-9
generating

HTML frame borders 6-15
GIF files 10-2

transparent 10-10
transparent, dithered 

colors 10-10
.gif files

animated 10-2
Go menu 1-8
Go To button 1-7
Graphics Interchange Format, see 

GIF files
grid

object snap 4-4
unit of measurement 1-15

grids
showing/hiding 4-5

guidelines for publishing 26-26
guides

adding/moving/deleting 4-4
hiding 7-2
object snap 4-4
showing/hiding 4-5

H
Headspace Beatnik files 15-14
help

What’s This? popup 1-9
help system

online xviii
hidden fields in forms 17-19
Hide all profiles 21-18
hiding toolbars 1-6
highlighted buttons 12-9
Home page, setting published file 

name 26-12
Horizontal Position 10-13, 11-5, 

12-8
horizontal rules, HTML 11-6
hotspots 14-13

converting to anchors 14-14
editing 14-14

HTML
accessing 22-2
adding to anchors 14-14
adding to Layouts 7-11

adding to links 14-12
centering page content 22-4
custom, adding to frames 24-13
displaying message on 

mouse-click 22-8
dynamic 21-2
editing 1-18, 22-3
editor, choosing 1-14
file extensions 4-6
file extensions, custom 2-15
frames, targeting 24-2
generating comments 26-9
indexing pages for search 

engines 22-4
inserting in text boxes 22-10
keywords 22-4
linking to new window 22-9
Meta tags 22-4
not verified by NetObjects 

Fusion 22-1
object, examples 22-8
page, examples 22-4

HTML access for custom 
frames 6-10

HTML file names 2-14
character conversion 2-14, 23-5

HTML files
minimizing file size 17-4

HTML frame borders, 
generating 6-15

HTML frames
creating custom 23-1

HTML frameset 24-1
HTML horizontal rules 11-6
HTML output

advantages of CSS and Layers 5-6
browser requirements for CSS and 

Layers 5-6
CSS and Layers 5-3
CSS and Layers format 7-9, 26-8
disadvantages of CSS and 

Layers 5-7
JScript 5-3
Layout Regions 7-17
Layouts 7-8
nested tables 5-3
Nested Tables format 7-9, 26-7
nested tables, 

optimizing 5-7~5-13
Index-6



I N D E X
publishing, setting 26-7~26-10
regular tables 5-3
Regular Tables format 7-9, 26-7
supporting site design 5-14

HTML pages
importing 4-6

HTML tables
importing 3-8
previewing 5-10

HTML tags
inserting 22-8

HTMLadding 22-2

I
image assets

using 10-13
image file fields

defined 20-9
image file formats 10-2

data publishing 20-9
SiteStyles 12-13

image files
drag-and-drop, 

non-Web-standard 10-5
GIF files, transparent 10-10
non-Web-standard 10-2, 10-4
stacked pages and Assets 

view 25-4
imagemaps

creating 14-13
editing 14-14
hotspots 14-13

images
background 1-16
editing 1-18
from external source 18-15
see also pictures

import template
default MasterBorder 6-3

imported MasterBorders 6-3
importing

assets 3-8
creating new sites, 

guidelines 3-7~3-9
HTML pages 4-6
HTML tables 3-8
images from external data 

sources 20-17
limiting 3-8

page templates 3-13
pages 3-4~3-16
sites 3-1, 3-4~3-16
sites from local drive 3-7
sites from remote location 3-7
sites, existing 3-14
SiteStyles 12-14
templates 3-13
templates into sites 3-11~3-14

importing AutoSite templates 3-13
importing templates

guidelines 3-12~3-13
indenting paragraphs in text 

boxes 8-8
Indexed Sequential Access Method 

drivers 20-11
indexing

pages for search engines 22-4
inserting

ActiveX controls 16-5
columns, tables 10-8
HTML in text boxes 22-10
HTML tags 22-8
Java applets 16-2
Java servlets 16-2
media plug-in files 15-14~15-16
objects into text boxes 7-27
QuickTime movies 15-6~15-9
rows, tables 10-7
Shockwave files 15-2~15-6
sound files 15-11~15-13
variables 8-16
video files 15-9~15-11

inserting actions in scripts 21-22
installing

ActiveX controls 16-5
interactive media, see media files
internal data fields

name, changing 20-10
internal data objects 20-6

adding stacked pages 20-25
internal links 14-2, 14-3
ISAM drivers 20-11

J
Java applets 16-2~16-4
Java file parameters 16-3
Java files 16-2
Java servlets 16-2~16-4

JavaScript
adding to links 14-12

JavaScript expressions 21-23
Joint Photographic Experts Group, 

see JPEG files
JPEG files 10-2
JScript 5-3

publishing 5-5

L
Last button 1-8
launching

HTML editors 1-18
image editors 1-18

Layers, see CSS and Layers
Layout 4-2
Layout area

referencing 19-4
layout methods and design 

priorities 7-34
layout options 7-1
Layout Regions 7-14~7-21

adding objects 7-15
advantages in page layout 7-33
assigning actions 7-20
background color, setting 7-20
creating 7-15
defined 7-14
defining as forms 7-19
forms, minimizing HTML 17-4
grids and guides 7-16
HTML output methods 7-17
limitations in page layout 7-33
making dynamic 7-20
multiple 7-19
Picture background 7-20
setting background 

properties 7-19
Solid Color background 7-20
table formatting preferences 7-18
transparent 7-20

Layouts 4-2
adding HTML/scripts 7-11
advantages in page layout 7-32
appearance 7-2
as forms 17-3
assigning actions 7-13
background color, setting 7-11
background sounds 7-12
Index-7



browser page size 7-6
creating 7-2
defined 7-2
defining as forms 7-10
external HTML 19-9
fitting to objects 7-7
HTML output methods 7-8
limitations in page layout 7-32
making dynamic 7-13
multiple 7-3
naming 7-3
naming requirements 7-4
Picture background 7-12
renaming 7-4
resizing 4-3, 7-5~7-7
selecting 7-2
selecting method 7-31
setting background 

properties 7-11
SiteStyle background color 7-12
size requirements 7-5
Solid Color background 7-12
table formatting preferences 7-9
text-based 7-1

levels of sites 3-8
lines

drawing 11-7
editing 11-9
SiteStyle, editing 12-11

Link icon 14-2
linking

to new browser window 22-9
to/from frameset 23-3

links 14-2~14-12
adding 25-10
adding anchors 14-5
adding HTML 14-12
adding JavaScript 14-12
anchors in frames 6-17
broken, resolving 25-11
Current Page option 14-3
deleting 25-11
editing 14-3, 14-14
external 14-2
external, creating 14-9
external, updating 25-10
file 14-2
file, creating 14-11
file, targeting 24-7

hotspots 14-13
imagemaps 14-13
internal 14-2
internal, creating 14-3
managing 25-9~25-12
removing 14-3
smart 14-2
smart, creating 14-7
smart, targeting to internal 

pages 24-5
smart, types 14-8
specific, targeting 24-3
targeted, scripting 23-9
targeting in AutoFrames 24-2
targeting to external pages 24-5
targeting to internal pages 24-4
text, assigning actions 21-17
untargeted, browser 

refresh 24-10
verifying 25-11
within a frame 6-10
see also anchors

Live Audio 15-11
Live Video 15-9
loading custom color palettes 1-11
Local Stage Server profile 26-10
locating

objects 4-12
locking text box size 5-12, 5-13

M
Machine Data Source, external data 

objects 20-15
Macintosh computers

text size in browsers 5-3
Macromedia Director, see Director
Macromedia Shockwave, see 

Shockwave
Macromedia Web site 15-2
managing

data objects 25-12
file assets 25-3~25-9
links 25-9~25-12
referenced assets 19-9~19-11
script assets 26-29
SiteStyles 12-14
variables 25-12

margins
default 1-16

setting 1-16
MasterBorder property 

(sections) 2-11
MasterBorders 4-2, 6-2~6-9

applying to imported sites 3-10, 
3-16

applying to sections 6-8
AutoFrames 6-9
browser page size 7-6
changing 6-8
changing margins 4-3, 6-5
converted from AutoFrames, 

effect on HTML 22-3
creating 6-6
default in blank site 6-3
DefaultMasterBorder 6-4, 6-6
defaults in import template 6-3
defined 6-1
deleting 6-9
fitting to objects 6-5
illustrated 6-2
imported 6-3
modifying 6-4
Properties palette 6-4
renaming 6-8
resizing 4-3, 6-5
setting frame properties 6-16
ZeroMargins 6-2, 6-9

maximizing text boxes 5-12, 5-13
media files

editing 15-17
replacing 15-17
sample 15-1

media plug-in files
inserting 15-14~15-16

media tools 15-2
menu bar 1-5

illustrated 1-4
Message Board 

component 18-8~18-11
Macintosh Web servers 18-11
restriction on Preview 18-9
Unix servers 18-11

messages
custom, creating 21-18
custom, deleting 21-19
Hide all profiles 21-18

messages, displaying on 
mouse-click 22-8
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I N D E X
Meta tag descriptions 22-4
Microsoft Audio Video Interleaved 

files 15-9
Microsoft Internet Explorer

text line spacing 5-3
.MIDI files 15-11
minimizing HTML file size, 

forms 17-4
modifying

actions 21-26
alt tags 4-10
background color, tables 10-4
Layout Region grid and 

guides 7-16
MasterBorders 6-4
pictures 10-6~10-13
server profiles 26-11, 26-14
table cell properties 10-6
table cell text box properties 10-7
tables 10-6
text styles 8-12
text styles by example 8-12
see also changing, customizing, 

editing
mouse-driven events 21-8
.MOV files 15-7
moving

between pages 4-5
files 3-21
guides 4-4
objects 4-9
pictures 10-11
sites 3-21

moving pages 2-13
Moving Pictures Experts Group 

files 15-9
moving sites

restrictions explained 3-17, 3-21
.MPE/.MPV files 15-9
.MPG/.MPEG files 15-9
mporting

pages 3-1
Multi-Object Palette 4-14
multiple forms on Layout or 

MasterBorder 7-10
multiple Layout Regions 7-19
multiple Layouts 7-3

N
names

assets, custom 25-5
naming

form objects 17-5
Layouts 7-3
pages 2-14
sites 2-4, 3-6

naming requirements for 
Layouts 7-4

navigating
between pages 4-5

navigation bars 13-2
actions 13-3
customizing 13-11
editing 12-9
primary and secondary 13-6
reverting to SiteStyle 13-15
setting background color 13-8
setting button spacing 13-7
setting display options 13-4
setting type 13-6
using 13-3~13-8
see also button navigation bars, 

text navigation bars
Navigation Button (Custom Names 

dialog) 2-16
navigation buttons

stacked pages 20-25
navigation controls, see banners, 

button navigation bars, 
text navigation bars

navigation tools 1-7
Navigation Window button 4-5
nested tables 5-3

optimizing 5-7~5-13
publishing 5-4

Nested Tables (HTML output 
option) 7-9, 7-17, 26-7

NetObjects
Web address xviii

NetObjects Component 
Development Kit 
(CDK) 18-1

NetObjects Fusion
folder structure 1-19
preferences 1-12
Site view 2-1
starting 2-2

views 1-3
NetObjects Fusion components, 

seecomponents 18-1
NetObjects Fusion Connector 

component 
(Lotus) 18-18, 20-2

NetObjects System folder 1-19
Netscape Navigator

ActiveX support 16-5
text line spacing 5-3

new browser instance 24-3
New button 1-4
New External Data Source tool 20-7
New Site command 2-4
newspaper quotes 26-10
Next Page button 4-5
.nft extension 3-2
NFX components, see 

components 18-1
.nod extension 2-2
.nod files

backing up 2-21
non-alphanumeric characters in 

asset file names 26-13, 
26-17

non-alphanumeric characters in 
page names 2-14

numbered lists 8-8

O
object HTML, examples 22-8
object icons

hiding 7-2
Object Initially Visible in 

Browser 21-20
Object initially Visible in Browser 

option 21-6
Object Tree 4-12, 21-10
object-driven events 21-8
objects

accessing/adding HTML 22-6
adding actions 21-5~21-16
adding to table cells 10-6
aligning 4-14
aligning in text boxes 7-28
coding your own 22-11
copying 4-9
distributing 4-14
drag-and-drop 4-8
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editing 4-10
embedded, aligning 7-28
embedded, creating 7-27
embedding 4-11
embedding in text boxes 7-24
embedding with 

drag-and-drop 7-26
finding 1-7
inserting into text boxes 7-27
layered, rearranging 4-13
locating 4-12
making same size 4-15
moving 4-9
optimizing placement on 

page 5-8
overlapping 4-12, 26-8
placing 4-7
renaming 4-12
selecting 4-9
snapping to grids/guides 4-4
wrapping text around 8-13

.OCX files 16-6
ODBC Data Source 

Administrator 20-14
ODBC drivers 20-11
online help xviii
Open Data Base Connectivity 

drivers 20-11
Open Site command 2-6
opening

file assets 25-9
image files in image editor 10-15

opening sites 2-6
optimizing AutoFrames 5-11
orientation, Site view 2-18
outline option

viewing sites with 2-19
Outline view 2-19
output options and design 

priorities 7-34
overlapping objects 4-12, 26-8

P
Page HTML dialog 22-2
page HTML, examples 22-4
page labels

hiding 7-2
page layout

advantages of Layout 
Regions 7-33

advantages of Layouts 7-32
advantages of text boxes 7-31
limitations of Layout 

Regions 7-33
limitations of Layouts 7-32
limitations of text boxes 7-31
selecting method 7-31
using external HTML 7-30
using tables 7-30

page layout options 7-1
page name

setting 13-9
specifying custom 2-15

Page Name property 2-10
page names

character limit 2-15
custom 2-15
editing in Site view 2-14

page navigation buttons, see 
navigation buttons

page properties 2-9
changing 2-9

page size
requirements for browser 

display 7-6
Page tab, Preferences dialog 1-15
page templates

importing 3-13
page templates, provided 3-3
Page Title (Custom Names 

dialog) 2-16
Page Type property 2-10
Page view 1-3, 4-2

displaying pages 4-2
hiding labels, object icons, 

rulers 7-2
illustrated 4-2

page-driven events 21-8
pages

adding 2-12
centering content 22-4
child 2-7
containing file assets, 

displaying 25-6
containing links, 

displaying 25-10
default size 4-3

deleting 2-13
displaying in Page view 4-2
displaying previous 1-8
dynamic 21-2
dynamic, building 21-5
exporting 3-17~3-21
external, targeting links 24-5
importing 3-4~3-16
importing, HTML 4-6
importing/exporting 3-1
indexing for search engines 22-4
internal, targeting links 24-4
internal, targeting smart 

links 24-5
moving 2-13
navigating 4-5
optimizing object placement 5-8
page properties 2-9
parent 2-7
previewing 5-9
referencing Layout area 19-4
renaming 2-14
resizing 4-3
selected 2-7
selecting 2-8
sibling 2-7
transition, creating 22-6
zooming on 4-9
see also stacked pages

paragraph styles, see text styles
paragraphs

formatting 8-6~8-9
indenting 8-8

parameters
customizing 21-13
Java files 16-3

parameters, actions 21-12~21-14
Parent Page button 4-5
parent pages 2-7
Parent Setting (HTML output 

option) 7-17
passwords, forms 17-6
pasting text from Clipboard 8-5
paths

framesets 23-5
paths, relative 23-5
Perl5 CGI script 18-10
permission, publishing 26-19
Index-10



I N D E X
Picture background, Layout 
Regions 7-20

Picture background, Layouts 7-12
Picture Loader component 18-15
Picture Rollover 

component 18-11~18-13
browser requirements 18-11
restriction on Preview 18-11

pictures
adding 10-3~10-5
adding text 10-12
adding to stacked pages 20-26
changing in banners 13-11
changing on one button 13-13
copying 10-11
creating borders 10-9
cropping 10-7
from external source 18-15
image assets 10-13
importing from external 

databases 20-17
inserting in frame 

background 6-18
modifying 10-6~10-13
moving 10-11
opening in image editor 10-15
resizing 10-6
rotating 10-8
tiling 10-7
see also images

placing
copied pictures 10-12
objects 4-7
see also adding, creating

plug-in media files
inserting 15-14~15-16

Plugin.gif icon 15-15
PNG files 10-2
polygons, see shapes
Portable Network Graphics, see PNG 

files
ports, specifying for 

publishing 26-19
position-based forms 17-2
preferences

General 1-12
page 1-15
setting 1-12

Preferences dialog 1-12

Preview
table structure 5-11

preview
choosing browser 1-13

Preview button 1-7
previewing

compared to publishing 26-1
pages 5-9
sites 1-7
table cells 5-9

Previous Page button 4-5
Primary Navigation Bar 12-4
primary navigation bars 13-6
printing

site structure/sections 2-19
processing

data with a CGI script 17-17
form responses 17-17

properties
AutoFrames 6-9
Color (pages) 2-10
Color (sections) 2-11
Comments 2-11
Custom Names (pages) 2-10
Custom Names (sections) 2-11
edit fields 17-6
MasterBorder (sections) 2-11
page 2-9
page and section 2-9
Page Name 2-10
Page Type 2-10
publication, customized 26-23
publication, published date 26-23
publication, suppressing page/

asset 26-24
publication, viewing/

setting 26-23
Publish/Don’t Publish 

(pages) 2-11
Publish/Don’t Publish 

(sections) 2-11
site 2-17
Site view 2-17
Status (pages) 2-10
Status (sections) 2-11
text boxes 8-5

Properties palette 1-5, 4-2
MasterBorders 6-4
Site tab 2-17

Properties palettes
font size 1-13

Protected Director files 15-2
publication properties

customized 26-23
publication, forcing 25-4
Publish Setting (HTML output 

option) 7-8
Publish view 1-4, 26-3
Publish/Don’t Publish property 

(pages) 2-11
Publish/Don’t Publish property 

(sections) 2-11
publishing

aliased folders 26-17~26-20, 
26-22

asset-type directory 
structure 26-4

base directory 26-29
CGI directory 26-18
compared to previewing 26-1
configuring setup 26-4
creating custom folders 26-21
CSS and Layers 5-5
customizing directory 

structure 26-21~26-24
data, see data publishing
deleting folders 26-22
directory structure, 

setting 26-4~26-7
external HTML 19-11
firewalls 26-27
flat directory structure 26-4
guidelines 26-26
HTML comments 26-9
HTML output types 26-7
HTML output, 

setting 26-7~26-10
JScript 5-5
nested tables 5-4
overlapping objects 26-8
overview 26-2
properties, suppressing page/

asset 26-24
properties, viewing/setting 26-23
proxy servers 26-27
quotation marks, selecting 26-10
read-only folders, pages, 

assets 26-23
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rearranging directory 
structure 26-22

regular tables 5-5
remote host 26-29
remote server access 

checklist 26-29~26-31
renaming custom files 26-21
renaming custom folders 26-21
script assets, managing 26-29
server profiles 26-10~26-20
servers port and permission 

settings 26-19
setting method for sites 26-8
site section directory 

structure 26-5
sites 26-24~26-28
special assets 26-28
special character sets 26-9
to UNIX servers 26-17
unmanaged assets 19-13

Q
Quality options, Flash and Splash 

files 15-6
QuickTime movies

inserting 15-6~15-9
QuickTime plug-in 15-6
quotation marks in published 

sites 26-10

R
.RA/.RAM files 15-12
Radio Button tool 17-8
radio buttons 17-4

adding 17-8
Rapid Prototyping Module 

files 15-9
read-only folders, pages, 

assets 26-23
RealAudio files 15-12
RealSpace FlashPix files 15-14
rearranging layered objects 4-13
rectangles, see shapes
referenced HTML

editing 19-13~19-15
referenced HTML, see external 

HTML
referencing

external HTML 19-1

Layout area of pages 19-4
sites 19-2~19-4

regular tables 5-3
publishing 5-5

Regular Tables (HTML output 
option) 7-9, 7-18, 26-7

Relative Alignment 10-13, 11-5, 
12-8

relative paths 23-5
remote host 26-29
Remote Publish Server profile 26-10
remote server access 

checklist 26-29~26-31
removing

columns, tables 10-8
links 14-3
rows, tables 10-8
SiteStyles 12-15

renaming
files 26-21
folders 26-21
Layouts 7-4
MasterBorders 6-8
objects 4-12

renaming pages 2-14
replacing

file assets 25-6
media files 15-17
text 8-20

Reset button 17-12
resizing

columns, tables 10-7
frames 6-17
Layouts 4-3, 7-5~7-7
Layouts to objects 7-7
MasterBorders 4-3, 6-5
MasterBorders to objects 6-5
pages 4-3
pictures 10-6
rows, tables 10-7

rich media, see media files
Rich Music Format files 15-12
.RMF files 15-12
Rotating Picture 

component 18-16~18-17
restriction on Preview 18-16

rotating pictures 10-8
rotating text

in banners and buttons 12-8

in drawn objects 11-5
in pictures 10-13

rounded rectangles, see shapes
Rows (HTML output option) 7-9, 

7-18
rows, tables

inserting 10-7
removing 10-8
resizing 10-7

.RPM files 15-9
rulers

hiding 7-2
showing/hiding 4-5

S
sample media files 15-1
sample sites 3-2~3-4
sample sites, provided 3-4
Samples folder 1-19
saving site files 2-7
saving sites 1-13
Scale options, Flash and Splash 

files 15-6
scripted frames, using 23-3
scripting

custom actions 21-20~21-25
default target frame 23-8
frames, overview 23-3~23-4
targeted links 23-9

scripts
adding 22-2
adding to Layouts 7-11
inserting in actions 21-22
managing assets 26-29

scroll bars
adding to frames 6-17

scrolling lists 17-4, 17-10
scrolling messages 18-5
search engines

directory structure for 
publishing 26-5

indexing pages 22-4
Secondary Navigation Bar 12-4
secondary navigation bars 13-6
section properties 2-9
sections 2-9

applying MasterBorders 6-8
printing structure 2-19

selected page 2-7
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selecting
Layouts 7-2
objects 4-9
table cell 10-5
tables 10-4
text boxes in tables cells 10-5
tools from flyout 1-6

selecting pages 2-8
selecting sections 2-9
Selective Server component 

(Fundere) 18-18, 20-2
server profiles 26-10~26-20

adding 26-11, 26-14
defining for local 

publishing 26-10
defining for remote 

publishing 26-13
modifying 26-11, 26-14
options 26-10

servers
port and permission 

settings 26-19
proxy, publishing with 26-27

server-side imagemaps 14-13
Set Action dialog

Object Tree 21-10
Target Browse 21-10
When field 21-8

setting
background color, navigation 

bars 13-8
banner style 13-9
banner style/orientation 13-10
button navigation bar display 

levels 13-5
button navigation bar style 13-7
Director properties 15-5
Flash file properties 15-5
frame background 6-18
frame properties 6-16
Home page file name 26-12
Layout background color 7-11
Layout background 

properties 7-11
Layout Region background 

color 7-20
Layout Region background 

properties 7-19

Layout Region’s HTML output 
method 7-17

Layout’s HTML output 
method 7-8

margins 1-16
navigation bar button 

spacing 13-7
navigation bar display 

options 13-4
navigation bar type 13-6
page name 13-9
preferences 1-12
publishing method for sites 26-8
publishing properties 26-23
Splash file properties 15-5
table formatting preferences for 

Layout Regions 7-18
table formatting preferences for 

Layouts 7-9
text box properties 8-5
units of measurement 1-15

settings
backing up sites 1-17

shapes
adding text 11-4
drawing 11-2
editing lines of polygons 11-3
varying curve of rounded 

rectangles 11-3
sharing

site files 3-21
Shockwave audio files 15-2
Shockwave files

formats 15-2
inserting 15-2~15-6

Shockwave for Director files 15-2
Shockwave plug-in 15-2
shortcut menus 1-9
Show (HTML Table), Layout 

Properties palette 5-10
showing toolbars 1-6
SHTML extension 2-16
sibling pages 2-7
simple text fields

defined 20-9
single-line text fields see edit fields
site files 2-2

saving to network/another 
computer 2-3

sharing 3-21
see also sites

Site Mapper component 18-6~18-8
restriction on Preview 18-7

site names
character limit 2-4, 3-6

Site Navigation Window 4-6
Site Outline view

sorting 2-20
site section directory structure, 

publishing 26-5
site structure 2-7

collapsing/expanding 2-18
expanding and collapsing 2-18
printing 2-19

Site tab 2-17
site tools 2-8
Site view 1-3, 2-1, 2-5

background color 2-18
collapsing/expanding 

structure 2-18
orientation 2-18

Site view properties 2-17
sites

author name 2-17
backing up 2-21
backing up automatically 1-17
backup settings 1-17
blank, default MasterBorder 6-3
converting 3-7
creating 2-3
creating from existing 3-9
creating from templates 3-4~3-6
creating templates by 

exporting 3-17
distributing 3-21
expanding 3-11
exporting 3-17~3-21
import guidelines, creating new 

sites 3-7~3-9
import limits 3-8
imported, domain names 3-16
importing 3-4~3-16
importing existing sites 3-14
importing from local drive 3-7
importing/exporting 3-1
levels 3-8
moving 3-21
Index-13



moving/copying, restrictions 
explained 3-17, 3-21

naming 2-4, 3-6
opening 2-6
opening last automatically 1-13
outline options 2-19
previewing 1-7
publishing 26-24~26-28
publishing compared to 

preview 26-1
referencing 19-2~19-4
sample 3-2~3-4
samples provided 3-4
saving 2-7
saving automatically 1-13
setting publishing method 26-8
using sites not built with 

NetObjects Fusion 3-14
see also site files

SiteStyle background color, 
Layouts 7-12

SiteStyles 1-4
adding 12-14
adding all 12-15
applying 12-4
components 12-3
creating 12-12
customizing templates 3-19
defined 12-2
editing 12-5~12-12, 12-16
folder structure 12-16
importing 12-14
lines, adding 11-7
lines, editing 12-11
managing 12-14
removing 12-15
text color 12-11
text in banners and buttons 12-7
updating list 12-15

size requirements for Layouts 7-5
Size to Layout, external HTML 19-9
sizing

multiple objects 4-15
text box 7-21~7-24

smart links 14-2
creating 14-7
defined 14-7
stacked pages 20-25
targeting to internal pages 24-5

types 14-8
snapping objects to grids/guides 4-4
Solid Color background, Layout 

Regions 7-20
Solid Color background, 

Layouts 7-12
sorting Site Outline view 2-20
sound files

inserting 15-11~15-13
sounds

background 7-12
file formats 7-12

spaces in asset file names 26-13, 
26-17

spaces in page names 2-14
special character sets 26-9
specifying

custom page names 2-15
specifying action messages 21-10
specifying targets 21-9
specifying trigger events 21-7
spell check 8-18
.SPL files 15-2
Splash files 15-2

setting properties 15-5
SQL data sources

creating external data 
objects 20-14~20-17

stacked pages 20-22~20-26
Add navigation buttons 

option 20-21
adding for internal data 20-25
adding navigation buttons 20-25
adding pictures 20-26
adding text 20-26
defined 20-3
deleting 20-26
designing 20-22
Display all fields option 20-21
image files and Assets view 25-4
using smart links 20-25
see also pages

Standard toolbar 4-15
standard toolbar 1-5
starting

a blank site 2-4
starting NetObjects Fusion 2-2
Status property (pages) 2-10
Status property (sections) 2-11

straight quotes 26-10
structural links, see smart links 14-2
Structured Query Language 

(SQL) 20-14
style elements 12-3
Style view 1-4, 12-2

example of 12-3
Styles Folder 1-19
sub-buttons 18-4
Submit button 17-12
suppressing actions 21-26
suppressing page or asset 

properties 26-24
.SWA files 15-2
.SWF files 15-2
symbols

inserting in text 8-13

T
Tab character in text boxes 8-8
table cells

adding objects 10-6
adding text 10-6
modifying properties 10-6
modifying text box 

properties 10-7
previewing 5-9
selecting 10-5
selecting text boxes 10-5

Table tool 10-3
tables

adding 10-3
defined 10-2
forms 17-3
inserting columns 10-8
inserting rows 10-7
modifying 10-6
modifying cell properties 10-6
modifying cell text box 

properties 10-7
removing columns 10-8
removing rows 10-8
resizing columns and rows 10-7
selecting 10-4
selecting cells 10-5
using 10-2
using fro page layout 7-30

targeting
defined 23-7
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file links 24-7
full browser window 24-8
links in AutoFrames 24-2
links to external pages 24-5
links to internal pages 24-4
new browser window 24-9
smart links to internal pages 24-5
specific links 24-3

targets 21-3
Object Tree 21-10
specifying 21-9

templates 2-3, 3-2~3-4
AutoSite 3-3
Blank Site 3-2
creating sites 3-4~3-6
customizing 3-18~3-20
form templates, provided 3-3
import guidelines 3-12~3-13
importing 3-13
importing into sites 3-11~3-14
page templates, provided 3-3

Templates folder 1-19
text

adding to pictures 10-12
adding to shapes 11-4
adding to stacked pages 20-26
adding to table cells 10-6
adding with drag-and-drop 8-5
adding with Text tool 8-4
alignment 10-13, 11-5, 12-8
banners and buttons, 

SiteStyles 12-7
clearing wrapping objects 8-15
color, SiteStyles 12-11
finding 8-19
formatting 8-6~8-9
pasting from Clipboard 8-5
replacing 8-20
rotating in banners and 

buttons 12-8
rotating in drawn objects 11-5
rotating in pictures 10-13
submitting responses 17-14
symbols 8-13
word count 8-20
wrapping around objects 8-13

text boxes 8-2
advantages in page layout 7-31
aligning objects 7-28

as object 8-3
as text editor 8-2
assigning actions 7-30
defining as forms 7-29
embedding objects 7-24
inserting HTML 22-10
inserting objects 7-27
inserting symbols 8-13
limitations in page layout 7-31
locking minimum size 5-12, 5-13
making dynamic 7-30
maximizing automatically 5-12, 

5-13
minimum height 7-22
modifying properties in table 

cells 10-7
properties 8-5
scaling to browser window 7-23
scaling to Layout 7-23
selecting in table cells 10-5
sizing 7-21~7-24
solid handles 8-3
transparent handles 8-2
using 7-21~7-30
wrapping to browser 

window 5-12, 5-13
text fields

formatted 20-9
multiple-line, adding 17-7
simple 20-9
see also variables

text files
submitting data 17-14

text line spacing in browsers 5-3
text links

assigning actions 21-17
text navigation bar 13-2
text navigation bars 13-2, 13-3

default location 13-2
see also navigation bars

text styles
applying 8-6
creating 8-9
modifying 8-12
modifying by example 8-12

text-based forms 17-2
text-based Layout 7-1
thumbnail 10-3
Ticker Tape component 18-5~18-6

tiling pictures 10-7
Time Based Picture 

component 18-13~18-14
restriction on Preview 18-13

title bar 1-5
illustrated 1-4

toolbars 1-6, 4-2
Advanced 4-16
Components 4-17
flyouts 1-6
Form 4-18
hiding, showing 1-6
illustrated 1-4
Standard 4-15

tools
Data List 20-7
Form Handler tool 17-14
Forms Button tool 17-13
Forms Checkbox tool 17-9
Forms Combo Box tool 17-11
Forms Edit Field tool 17-6
Forms Multi-Line tool 17-7
media 15-2
New External Data Source 20-7
Radio Button tool 17-8
Site 2-8
Zoom In/Out 2-11, 4-9

trademark symbol
inserting in text 8-13

transition pages
creating 22-6

Transparency dropper 10-11
transparent GIF files 10-10
transparent handles 8-2
Transparent Layout Region 

color 7-20
trigger events 21-3

specifying 21-7
Tutorial folder 1-20

U
unit of measurement 1-15
Universal Resource Locators, see  

URLs
UNIX servers

publishing to 26-17
updating

external links 25-10
SiteStyle list 12-15
Index-15



URLs
external links 14-9
protocol 14-10

usage notes 1-19
User Resizable Frame option 6-17
User scrollable option, frames 6-17
User Sites folder 1-20, 2-3
user-defined variables 8-16
using

banners 13-8~13-10
color palettes 1-11
components 18-1
image assets 10-13
navigation bars 13-3~13-8
shortcut menus 1-9
Site Navigation Window 4-6
tables 10-2
text boxes 7-21~7-30

V
variables

adding 25-12
deleting 25-14
editing 25-13
inserting in text 8-16
managing 25-12
user-defined 8-16
see also text fields

verifying file assets 25-8
verifying links 25-11
Vertical Position 10-13, 11-5, 12-8
video file formats 15-9
video files

inserting 15-9~15-11
viewing

publishing properties 26-23
site map 18-6

views 1-3
Assets view 1-4, 25-2
displaying previous 1-8
Page view 1-3, 4-2
Publish view 1-4, 26-3
Site view 1-3, 2-5
Style view 1-4, 12-2

folders
virtual, see aliased folders

virtual folders, see aliased folders
.VIV files 15-9
Vivo Active Producer files 15-9

volume, QuickTime movies 15-8
VRML files 15-14

W
warning icon 4-19
.WAV files 15-11
Web address, NetObjects xviii
Web sites, see NetObjects Web Site
Webstar 2.0 Web server 18-11
When message menus 21-8
window components

illustrated 1-4
window size at startup 1-13
Windows ODBC Data Source 

Administrator 20-14
word count 8-20
wrapping text around objects 8-13
wrapping text boxes to browser 

window 5-12, 5-13
WYSIWYG text in browsers 1-14

Z
ZeroMargins MasterBorder 6-2, 

6-9, 7-24, 7-31, 19-12
selecting 6-4

Zoom tools 2-11, 4-9
Index-16
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